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Office of the City Manager 
Al Zelinka, City Manager 
 

 
 
June 16, 2020 
 
 
 
Capital Improvement Program One-Year Budget for Fiscal Year 2020/21 and Five-Year Plan 
through 2024/25 
 
Honorable Mayor and City Council, 
 
As part of the budget development process, staff prepared a one-year budget and five-year 
plan for the City’s Capital Improvement Program (CIP). The CIP provides approximately $110 
million for the City’s critical and essential infrastructure projects for Fiscal Year (FY) 2020/21.  Over 
the course of five years (FY 2020/21 through FY 2024/25), the City anticipates investing an 
estimated $559 million in our essential assets.   
 
Due to the COVID-19 pandemic and the March 19, 2020, Governor’s Stay at Home Order that 
included directions to hold public meetings only when essential and with numerous safety 
restrictions, the usual two-year budget process was replaced with a single year, Emergency 
Budget process for FY 2020/21, which truncated the budget engagement process.  The FY 
2020/21 Emergency Budget process resulted in a presentation and discussion only with the City 
Council. While the FY 2020/21 CIP and 2020-2025 five-year plan largely represents the City’s 
capital improvement plan developed prior to the onset of the COVID-19 emergency, we are 
considering the FY 2020/21 capital budget to be a plan that includes quarterly intracycle 
budget adjustments and updates as revenue data becomes more readily available and 
predictable to estimate. Throughout the fiscal year, staff will monitor funding sources for planned 
capital projects and evaluate which projects will proceed as planned and which projects may 
need to be delayed due to the impacts of COVID-19. Recommended adjustments to the 
adopted CIP will be submitted for Board, Commission, and Committee discussions before 
providing budget update recommendations to the City Council for its consideration. 
 
The CIP budget has been developed with a thoughtful and conservative approach in order to 
further address the needs of the City and community. It is in this vein that we are carefully 
proceeding through these unprecedented times in order to satisfy the needs of the City with 
the upgrade and replacement of vital infrastructure, but also balancing that with the potential 
for unknown and ongoing impacts to the economic output of the City and the State of 
California. The General Fund is unable to contribute funds for capital projects as it continues to 
face challenges with unknowns from COVID-19 and increasing Public Employee Retirement 
(PERS) costs. Most other revenue sources, such as rate revenues from water, electric, and 
wastewater utilities, are restricted to be used on specific projects within each respective fund. 
The City will continue to aggressively pursue grants and work with local, state and federal 
agencies as well as private partners to fund critical capital projects in our community. 
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Over the past year, the Budget Engagement Commission reviewed Measure Z spending 
initiatives and made recommendations on capital projects in the existing spending plan. Based 
on their input and as a result of the COVID-19 emergency, museum rehabilitation and 
renovation and the construction of a new police headquarters was delayed to FY 2022/23, and 
the programmed capital investment in parking garages was eliminated. Capital projects in 
progress will continue without interruption, including the soon to be completed Downtown Main 
Library and City History Archive, implementation of the City’s new GIS program, and other 
critical technology infrastructure.  
 
The City’s focus during these difficult budgetary times is that of good financial stewardship and 
to remain focused on those vital projects that would provide the most value per dollar invested. 
This CIP document builds on the City’s recent financial successes by incorporating best practices 
recommended by the Government Finance Officers Association (GFOA) and the California 
Society of Municipal Financial Officers (CSMFO). Based on recommendations developed by 
staff during the previous budget cycle, the City Council adopted two new policies to establish 
the framework for future capital budgets. The first policy, Multi-Year Capital Planning, establishes 
guidelines that help the City identify and prioritize expected capital needs based on strategic 
priorities and operational needs, establish project scope and cost, detail estimated amounts of 
funding from various sources, and project future operating and maintenance costs. The second 
policy, Prioritization of CIP, establishes an objective process of prioritizing capital improvement 
projects to ensure consistency with the General Plan, in conjunction with the budget process, 
or otherwise as capital funding becomes available. 
 
With adoption of this CIP, the City will apply for CSMFO’s Excellence in Capital Budgeting Award 
for the second time in the City’s history. The program is specific to the Capital Budget and has 
forty-nine requirements that need to be incorporated to qualify for the award. The award is 
based on best practices and further advances our commitment to be more transparent and 
accountable to the Riverside community. Staff is confident that this CIP document will be a 
valuable tool for understanding the infrastructure priorities, successes and challenges that face 
our City in the upcoming budget cycle and when planning for future years.  
 

 
 
Al Zelinka 
City Manager 
City of Riverside 
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Capital Improvement Program  
The City of Riverside’s Capital Improvement Program (CIP) is a multi-year 
financial plan for the repair, replacement, and/or construction of municipal facilities 
and infrastructure.  The City’s CIP Plan strategically identifies both funded and 
unfunded capital improvement projects over a period of five years. Appropriations 
in the first year of the CIP are allocated to Fiscal Year (FY) 2020/21 projects 
with the adoption of CIP Budget by City Council on June 16, 2020.  
Appropriations in future years will be submitted for Council approval for 
budget adoption. 
 
Capital Improvement Project Defined 
A capital improvement 
project is defined as a 
long-term investment of 
funds to improve, repair, 
or replace an existing 
capital asset and/or 
construct or acquire a 
new capital asset.  A 
capital project is a city 
resource and/or property 
with a monetary value of 
at least $20,000 and an 
initial useful life of at least 
10 years.  For the purpose 
of this CIP, the City’s capital assets include municipal facilities and/or public 
infrastructure broadly categorized as airport; municipal buildings; technology 
infrastructure; parks, recreational, and cultural facilities; transportation 
infrastructure and systems (including streets, railroads, and parking structures); 
public utilities (including electric, water, sewer); and storm drain systems.  
 
Benefits of the Capital Improvement Program 
As stewards of public trust, staff has an obligation to be good custodians of 
the City’s capital assets by keeping them safe and in optimal working 
condition.  In doing this, the municipal facilities and public infrastructure are 
fully utilized to provide exemplary services for the maximum benefit to the 
citizens and the community at large. 
 
The CIP provides the following primary benefits: 

 Enhances the safety and health of the citizens by providing the 
infrastructure for first responders and caregivers that bring aid and care 
where and when it’s most needed; 

5
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 Improves the quality of life of the community by providing fair, 
transparent, and equitable access to services; 

 Improves the livability conditions of the neighborhoods by providing 
mobility to attend events and cultural affairs; 

 Focuses resources on achieving citywide priorities and meeting citizen 
expectations; 

 Provides a transparent and predictable implementation framework for 
the General Plan, Specific Plan, and Citywide Riverside Strategic Plan 
2.1; 

 Fosters inter-departmental coordination of City infrastructure 
investments; and 

 Promotes accountability and provides leverage for the long-term 
planning and investment of public funds for large-scale public 
purposes. 

 
Capital improvement projects typically carry considerable future impact 
because they have an expected life span of 10 years or more.  They are often, 
but not always, financed over a longer period of time, in effect spreading the 
cost of the project across generations of users that benefit from the 
completed project.   
 

 
Timeline for Adoption of the Capital Improvement Program  
The CIP includes a one-year budget and a five-year financial plan for projects 
intended to meet the City’s current or anticipated capital needs, the funding 
sources (if available), and the project delivery timeframe. Capital 

6
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improvement programming is the process by which these capital projects are 
identified, prioritized, and incorporated into the City’s long-range fiscal and 
strategic plans.  
 
The adoption of the CIP is a participatory and transparent process, which is 
aided by publishing the schedule of events early.  Normally, the Capital 
Budget would be presented to the Budget Engagement Commission and City 
Council, both televised to the public, which provide a platform for the 
Riverside community to be part of the process.  Additionally, staff would visit 
each City Ward to discuss budget-related matters, including the CIP.  
However, with this emergency budget the process was truncated in order to 
pass the budget in a timely fashion under existing emergency orders from the 
City Council and City Manager as a result of the unknown financial impacts 
of COVID. 
 
Department Roles and Prioritization of Capital Projects 
The development and adoption of the CIP involved the following 
departments in their respective roles: 
 

 

DEPARTMENT ROLES 

 

Community & Economic 
Development 

 

Reviews projects in the CIP to 
determine compliance with 
the California Environmental 

Quality Act (CEQA) and 
consistency with the General 
Plan; recommends its findings 
to the Planning Commission. 

 

  

Parks, Recreation and 
Community Services  

 

Plans, designs, repairs, 
and/or builds capital 

projects in City parks and 
recreation centers. 

 

Innovation & Technology 
 

Plans, designs, repairs, and/or 
builds capital projects for IT 

design, network 
management, and 

technology implementation in 
City facilities. 

Public Utilities 
 

Plans, designs, repairs, 
and/or builds capital 

projects for the electric and 
water utility facilities and 

infrastructure. 
 

General Services 
 

Plans, designs, repairs, 
and/or builds capital 
projects for the City’s 

airport, municipal 
buildings, and facilities. 

 

 

Public Works 
 

Plans, designs, repairs, and/or 
builds capital projects in the 
public right-of-way, including 

the transportation 
infrastructure, sanitary sewer 
system, storm drain system, 

public parking infrastructure, 
and railroad-related 

infrastructure. 
 

Finance 
 

Coordinates and facilitates 
the CIP budget process by 
compiling financial data 
and project information, 

and preparing the budget 
document for City Council 

adoption. 
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Prioritization Categories 
Prioritization categories provide 
an objective process of prioritizing 
capital projects to ensure 
consistency with the General Plan 
and the strategic goals of the 
City.  The City ranks projects in 
nine prioritization categories 
defined in the Prioritization of 
Capital Improvement Projects 
fiscal policy1 adopted by City 
Council on March 22, 2018. 
Prioritization categories are used 
within the CIP to assigned rankings in order to determine the highest needs for 
upcoming projects and allocation the limited funds that are available.  
 

 
 

Conformance with the General Plan 
The Finance Department, in conjunction with the Community and Economic 
Development Department’s Planning Division, presented all recommended 
FY 2020/21 capital project appropriations to the Planning Commission for 
review. The Planning Commission evaluates project consistency with the 
General Plan and compliance with CEQA. On May 14, 2020, the Planning 
Commission determined that the FY 2020/21 CIP is consistent with the City’s 
General Plan and that the planned CIP projects are exempt from CEQA.  

 
1 https://RiversideCa.gov/Finance/PDF/2018/Multi-Year Capital Planning.pdf 

Risk to Health, Safety 
and Environment 

Regulatory or 
Mandated 

Requirements 

Asset Condition, Annual 
Recurring Costs and 

Asset Longevity 

Community 
Investment and 

Economic Prosperity 

Level and Quality of 
Service 

Sustainability and 
Conservation 

Funding Availability Project Readiness 
Multiple Category  

Benefit and Bundling 
Opportunities 
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The remaining four fiscal years, 2021/22 through 2024/25, reflect staff 
recommendations to fund priority projects and/or are a continuation of 
projects that span more than one year.  These projects are subject to review 
and revision each year by the City Council as part of the CIP mid-cycle 
update. 
 
Amending the Capital Improvement Program Budget 
At any City Council meeting after the adoption of the budget, the City 
Council may amend or supplement the budget by motion adopted by the 
affirmative votes of at least five members.  This vote authorizes the transfer of 
unused balances appropriated for one purpose to another purpose, or to 
appropriate available funds not included in the budget.   
 
Once approved, appropriations for capital projects are continued for the life 
of the project (i.e. through continued appropriations).  Upon completion or 
cancelation of a project, unused funds are returned to fund balance when 
projects are completed and closed, or canceled at the discretion of the City 
Council, by a recommendation of the Department/Project Manager in 
charge of the project.   
 
Document Organization 
The City of Riverside’s Capital Improvement Program includes six primary 
sections: 
 

 Introduction – Contains the City Manager’s Transmittal Letter and the 
Guide to the CIP.  The City Manager’s Transmittal Letter provides an 
executive summary of the CIP and discusses policy, economic, and/or 
legislative issues facing the City and their impact on the budget.  It also 
highlights major capital project priorities and their funding source.  The 
Guide to the CIP defines a capital project, explains the benefits of the 
CIP, outlines the budget process, provides an overview the document’s 
organization, and additional information.   
 

 Financial Summary – Contains an overview of the CIP, provides 
financial highlights, describes major capital revenue sources and basis 
for estimates, includes a financial schedule containing a five-year 
outlook for each fund in the CIP based on revenue and expenditure 
estimates, a schedule of revenue estimates by fund, and detailed 
schedule of expenditures by fund and project category for each 
capital project.   
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 Project Categories – Contains major Project Category Overviews and 
individual project pages.  The Project Category Overviews include: 
general descriptions of the project category, narratives of the budget 
and five-year plan, project highlights, table of key revenue and funding 
sources with discussion of alternative funding, summary schedule of 
funded projects by type of improvement, schedule of the top ten 
unfunded projects in order of priority, and a city map which displays all 
projects in the CIP that are specific to a single location.  Citywide and 
ongoing projects with multiple locations are not mapped. 

 
 Appendix – Contains supplementary information, including a 

comprehensive list of unfunded capital projects, action items from 
oversight boards, and policies. 
 

 Glossary – Contains a list of terms or words found in text or are related 
to the capital budgeting process.   
 

 Index – Index identifies the page numbers of items contained within the 
document.   

 
Project Categories 
Capital projects are grouped into the following eleven major project 
categories: 
 

 Airport - The Airport section includes projects to maintain the Airport, to 
improve safety, and to comply with Federal Aviation Administration 
(FAA) standards and regulations. 

 
 Electric - The Electric section includes projects to construct or maintain 

electric utility infrastructure and facilities. 
 

 Innovation and Technology - The Innovation and Technology (IT) 
section includes projects for IT design, network management, and 
technology implementation in City facilities. 

 
 Municipal Buildings and Facilities - The Municipal Buildings and Facilities 

section includes expenditures for general municipal projects and 
projects not otherwise included in other sections of the CIP.  Projects 
may include new construction of buildings such as police and fire 
stations, libraries, or major repairs, additions, and alterations of existing 
assets. 
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 Parks, Recreation, and Community Services - The Parks, Recreation, and 
Community Services section includes projects to construct, maintain, 
and upgrade parks, game courts and fields, community centers, and 
recreation buildings.  

 
 Public Parking - The Public Parking section includes projects to construct 

new parking facilities and to improve existing facilities. 
 

 Railroad-Related - The Railroad-Related section includes projects 
related to railroad grades, crossings, quit zone improvements, grade 
separations and all other projects that are railroad related. 

 
 Sewer - The Sewer section includes projects to increase system capacity 

for new users, replace aging or obsolete systems, and meet new 
regulatory requirements.  

 
 Storm Drain - The Storm Drain section includes projects that either 

eliminate a nuisance flow or provide additional flood protection. 
 

 Transportation - The Transportation section includes projects to extend 
and widen streets, street resurfacing, construction of curbs, gutters, 
center medians, bikeways and pedestrian facilities, right-of-way 
acquisition, and traffic signal improvements.  

 
 Water - The Water section includes projects to construct or maintain 

water utility infrastructure and facilities. 
 
Generally Accepted Accounting Principles 
Generally Accepted Accounting Principles are a group of accounting 
standards and common industry practices used for financial reporting.  They 
provide a common basis of comparison between financial documents from 
multiple agencies.  The City of Riverside’s CIP document was prepared in 
accordance with generally accepted accounting principles.   
 
Cost Increases and Future Project Inflation 
Any potential cost increases are left to the project managers at the time of 
bidding and acceptance of said bids.  Because all projects are governed by 
contracts, cost increases, both present and future, are already accounted 
during the bidding process and agreed upon contractually.  For unfunded 
projects, estimates are given at project conception and updated, once 
again, upon funds availability and accounted for once the project is slated 
to begin. 
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Financial Overview 
The Capital Improvement Program provides for the appropriation of 
$110,063,415 in FY 2020/21 and includes $449,383,405 planned for the 
remaining four years.  The program currently has $261,963,297 in previously 
appropriated projects that will be continued for a total Capital Improvement 
Program of $821,410,117 through FY 2024/25.   
 
The CIP was developed prior to the onset of the COVID-19 pandemic and 
remains unadjusted for potential COVID-19 impacts on funding sources and 
labor and material resources required to carry out the planned capital 
projects.  However, the City will remain flexible in response to a potential 
downgrades of revenues and will recommend necessary budget adjustments 
throughout the year as these challenges materialize. 
 
Funding for capital projects is provided by a variety of funding sources 
including development impact fees, transportation funds, grants, 
reimbursement agreements, and long-term financing which are restricted for 
the purposes for which they are budgeted.  These funds, for the most part, 
cannot be used for ongoing City operations.   
 
The following is a summary of the Sources and Uses of Funding for the first year 
of the plan: 
 

Sources: 2020/21  
 Electric Utility $ 41,663,797  
 Water Utility 30,616,405  
 Transportation Funds 14,969,492  
 Measure Z Capital 7,237,955  
 Sewer 14,000,000  
 Other 1,575,766  
Total Sources $ 110,063,415  
 
 

  

 
 
 
 
 
 
 
 
 

Electric Utility
$41.7M

Water Utility
$30.6M

Transportation 
Funds
$15.0MMeasure Z 

Capital
$7.2M

Sewer (Bond 
Proceeds)
$14.0M

Other
$1.6M
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Uses: 2020/21  
 Airport  $ 104,225  
 Electric Utility 41,663,797  
 Innovation and Technology 2,909,496  
 Municipal Buildings and Facilities 1,000,000  
 Parks, Recreation, and Community Services 325,000  
 Railroad 772,700  
 Sewer 14,000,000  
 Storm Drain 650,000  
 Transportation 18,021,792  
 Water 30,616,405  
Total Uses $110,063,415  
   

 
 

 
 
 
 
 
 
 
 
 
 
 
 

   

Airport 
$0.1M

Electric Utility
$41.7M

IT
$2.9M

MBF
$1.0M

Parks
$0.3M

Railroad
$0.8M

Sewer
$14.0M

Storm Drain
$0.7M

Transportation
$18.0M

Water
$30.6M
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Five-Year Plan Summary Schedules 
 

FUNDED PROJECTS BY DEPARTMENT 

Department Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

General Services $1,104,225 $1,041,250 $1,005,500 $1,027,500 $1,000,000 $5,178,475 

Innovation and Technology 2,909,496 - - -  -  $2,909,496 

Parks, Recreation, and 
Community Services 325,000  -   -   -   -  $325,000 

Public Utilities 72,280,202 63,766,926 70,851,386 86,587,776 86,907,767 $380,394,057 

Public Works 33,444,492 30,283,200 30,312,800 36,125,600 40,473,700 $170,639,792 

TOTAL $110,063,415 $95,091,376 $102,169,686 $123,740,876 $128,381,467 $559,446,820 

 
FUNDED PROJECTS BY MAJOR PROJECT CATEGORY 

Major Project Category Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Airport  $104,225   $41,250   $5,500   $27,500   -   $178,475  

Electric  41,663,797   42,265,364   41,761,648   56,657,003   57,338,490   $239,686,302  

Innovation and Technology  2,909,496   -   -   -   -   $2,909,496  

Municipal Buildings and Facilities  1,000,000   1,000,000   1,000,000   1,000,000   1,000,000   $5,000,000  

Parks, Recreation, and 
Community Services  325,000   -   -   -   -   $325,000  

Public Parking  -   770,000   -   -   -   $770,000  

Railroad  772,700   788,200   804,000   -   -   $2,364,900  

Sewer  14,000,000   9,000,000   10,583,800   20,350,600   24,698,700   $78,633,100  

Storm Drain  650,000   100,000   100,000   100,000   100,000   $1,050,000  

Transportation  18,021,792   19,625,000   18,825,000   15,675,000   15,675,000   $87,821,792  

Water  30,616,405   21,501,562   29,089,738   29,930,773   29,569,277   $140,707,755  

TOTAL $110,063,415 $95,091,376 $102,169,686 $123,740,876 $126,503,337 $559,446,820 

 
Although Parks, Recreation, and Community Services has limited funding 
identified in the CIP, they are aggressively pursuing alternative funding 
sources for their capital projects.  They submitted applications to be awarded 
Community Development Block Grant (CDBG) funds for multiple projects and 
are waiting to receive results.   
 
Funded Projects by Ward 
The following map identifies the location of all funded, single-location, 
projects in the CIP.  Projects that are located throughout the City (ex. Minor 
Streets Rehabilitation Program) that benefit multiple wards are not included.   
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CITYWIDE MAP OF FUNDED PROJECTS  
(excludes citywide projects) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Note: This map includes all active and new capital improvement projects.  Ongoing and citywide projects are not included on the 
map.  To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.   
 

 
DISTRIBUTION BY WARD 

 

 
Ward Five-Year Total 

 Ward 1  $ 9,270,000 

 Ward 2  750,000 

 Ward 3  628,475 

 Ward 4  800,000 

 Ward 5  100,000 

 Ward 6  985,000 

 Ward 7  8,655,000 

 Citywide  538,258,345 

TOTAL $ 559,446,820 

*Citywide Projects not represented in chart 

$9.3M

$0.8M

$0.6M

$0.8M

$0.1M

$1.0M

$8.7M

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7
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Unfunded Capital Improvement Projects 
The City has identified $1.05 billion in needed projects that currently remain 
unfunded.  Each budget cycle, departments review the estimated project 
cost and adjust the unfunded amount as necessary.  The list will be updated 
as funding becomes available and as new projects are identified.  A 
complete list of these projects is contained in the Appendix A. 
 

UNFUNDED PROJECTS BY DEPARTMENT 
 

Department Estimated 
Project Cost 

Unfunded 
Amount 

General Services $165,997,100 $151,888,381 

Innovation and Technology 31,991,114 26,109,364 

Parks, Recreation, and Community Services 296,149,568 291,652,714 

Public Utilities 299,423,697 158,096,443 

Public Works 448,495,640 423,973,775 

TOTAL $1,242,057,119 $1,051,720,677 

 
Examples of the most significant unfunded projects and their estimated total 
project costs include: 

 Riverside Transmission Reliability Project (RTRP) (Electric Utility) - 
$162,756,354 

 Phase II Grade Separation Program - $75,000,000 
 Tyler/State Route 91 Interchange Improvements - $75,000,000 
 Adams Street/SR-91 Interchange - $72,900,000 
 Third Street Grade Separation at BNSF Railroad Crossing - $45,000,000 
 Advanced Metering Infrastructure – $43,911,000 
 Replace Garages 1 & 2 - $32,000,000 
 Van Buren Widening from Indiana to South City Limit - $26,640,352 
 14th Street Widening, SR91 to MLK Drive - $24,000,000 
 Enterprise Resource Planning System Replacement - $18,000,000 
 Arlington Avenue Widening, Victoria to Alessandro - $16,600,000 
 Eastside Library (New Construction) - $15,000,000 
 North Waterman Treatment Plant - $14,000,000 
 Cable Replacement – Arlington & Arlanza - $12,000,000 
 Local Storm Water Capture Projects - $12,000,000 
 GIS Upgrades/Integrations, Customer Engagement Portal - $10,231,305 
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Funding Sources 
The City employs a combination of approaches to fund capital projects.  For 
many smaller improvement projects, funds are appropriated from cash on 
hand.  Large-scale capital projects are funded through a variety of funding 
sources, including long-term financing, user fees, proceeds from bond issues, 
grants, assessments, impact fees, and certificates of participation (COPs).  
Since the City’s various departments are budgeted within numerous funds, 
each potentially with multiple revenue streams, departments are responsible 
for managing the revenue and expenditure budgets of their projects. 
 
Major Funding Sources for Capital Projects 
Measure Z  
On November 8, 2016, Riverside voters approved Measure Z, a general 
transaction and use tax of 1%, to help pay for critical unfunded City programs 
and services.  Measure Z revenues are anticipated to be $56.2 million in FY 
2020/21. Of this amount, $7.2 million is earmarked for capital projects in FY 
2020/21, and a total of $18.5 million for fiscal years 2021/22 through 2024/25. 
 
Certain Measure Z capital projects, including a new Police Headquarters and 
Museum Rehabilitation and Expansion are expected to be funded with bond 
proceeds from debt planned to be issued in future years.  The annual debt 
service for those bonds will be paid with the amounts allocated in the Measure 
Z Five-Year Plan.   
 
Projects funded by regular annual Measure Z revenues (not bond proceeds) 
include the Arlington Youth Innovation Center, Data Network Replacement 
project, Pavement Rehabilitation, and Pedestrian Facilities Improvement 
Program, and the City Buildings Deferred Maintenance project. 
 
Gas Tax 
The state of California imposes per-gallon excise taxes on gasoline and diesel 
fuel, sales taxes on gasoline and diesel fuel, and registration taxes on motor 
vehicles with allocations dedicated to transportation purposes.  These 
allocations flow through the Highway Users Tax Account (HUTA), the familiar 
gasoline tax revenues that have been in place for decades, and the Road 
Maintenance and Rehabilitation Account (RMRA) which allocates much of 
the revenue from the Road Repair and Accountability Act of 2017 (SB-1) to 
local agencies such as the City of Riverside. 
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Revenue collected as part of SB-
1, which took effect on 
November 1, 2017, includes an 
additional 12 cent per gallon 
increase to the gasoline tax, an 
additional 20 cent per gallon 
increase to diesel fuel excise tax 
(half going to the state Trade 
Corridor Enhancement Account 
(TCEA) and half to the RMRA), 
and an additional vehicle registration tax based on the value of the motor 
vehicle (effective January 1, 2018).  Starting July 1, 2020, there will be an 
additional $100 vehicle registration tax on zero emissions vehicles, which will 
be allocated…. 
 
Gas Tax continues to be the primary source of revenue for transportation 
projects.  Revenue estimates for FY 2020/21 are $14.5 million, which is 3.5% 
higher than FY 2019/20 estimates of $14 million.  The increase is mostly due to 
the appreciation of the crude oil prices and the gasoline derivative which has 
appreciated alongside.  Without the additional funds provided by SB-1, Gas 
Tax revenues would remain relatively flat or down slightly.  Consumer demand 
for fuel-efficient vehicles and fuel prices are major drivers in determining the 
resulting revenue received from this funding source. Potential COVID-19 
impacts could result in the downgrading of projected Gas Tax revenues in the 
event of ongoing reduced demand for fuel.    
 
Measure A 
Voters approved a half-cent 
sales tax in Riverside County for 
transportation in 1988.  Each 
year, the Riverside County 
Transportation Commission 
(RCTC) allocates funds to local 
agencies to be used on specific 
capital projects pre-approved by 
RCTC.  Measure A funds are 
restricted for use on 
transportation projects such as 
major highways, commuter rail, local streets and roads.  The City estimates 
Measure A revenues based on a RCTC’s Measure A Program Allocation 
(Projection) report issued each year.  Estimates are provided through FY 
2024/25. 
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Bond Proceeds 
Issuing bonds provides funds up-front and allows the City to complete projects 
sooner rather than accumulating funds over a longer period of time.  It also 
matches the cost of the projects to the generations that will benefit from 
them.  Projects to be funded with bond proceeds in future years and the 
estimated amount to be used are identified on individual project pages.  
These amounts are not included in the summary schedules throughout the CIP 
since they will not be appropriated with the adoption of the CIP.  Staff will 
request appropriations for bond-funded projects after the bonds are issued 
and approved by City Council. 
 
Grants 
The City aggressively pursues grants to fund capital projects.  Grants are vital 
to fund projects that have no alternative funding source.  The Public Works 
Department recently received $32 million in affordable California Housing & 
Sustainable Communities + Transformative Climate Communities funds, and 
Parks, Recreation & Community Services Department received notification of 
an award of $178,000 from the California Department of Parks and Recreation 
to be used for refurbishments at Bobby Bonds Park, which are included in this 
CIP and future CIP budgets.  
  
The Community Development Block Grant Program provides annual grants to 
address a wide range of needs.  Parks, Recreation, and Community Services 
is awarded funds for multiple capital projects each year and will continue to 
apply in future years.  
 
 

22



Funding Source
Estimated 
Available       
Balance1

Estimated 
Revenue2

Adopted 
Operating 

Expenditures

Adopted 
Capital 

Expenditures

Ending Available 
Balance

General Capital Funds

401 General Fund Capital ($270,472) $1,046,541 $0 ($1,046,541) ($270,472)
420 Measure Z  Capital -                       7,237,955       -                  (7,237,955)      $0

Total General Capital Funds ($270,472) $8,284,496 $0 ($8,284,496) ($270,472)

Transportation Funds

230 Gas Tax $3,705,043 $14,509,047 ($3,087,097) ($11,321,792) $3,805,201
431 Transportation Projects 12,060                 -                  -                  -                  $12,060
432 Measure A 2,797,338            6,649,000       (2,999,240)      (3,647,700)      $2,799,398
433 Transportation DIF 1,970,494            700,000          -                  -                  $2,670,494
434 Transportation Uniform Mitigation Fee (2,020,149)           -                  -                  -                  ($2,020,149)

Total Transportation Funds $6,464,786 $21,858,047 ($6,086,337) ($14,969,492) $7,267,004

Grant Funds

215 Grants and Restricted Programs Fund -                       $2,171,796 ($1,829,150) -                  $342,646

Total Grant Funds $0 $2,171,796 ($1,829,150) $0 $342,646

Enterprise Funds

510 Electric Utility $170,097,418 $435,365,417 ($426,239,669) ($41,663,797) $137,559,369
520 Water Utility 21,431,677          107,116,796   (78,159,623)    (30,616,405)    $19,772,445
530 Airport 735,345               1,546,244       (1,442,019)      (104,225)         $735,345
540 Refuse 3,960,672            25,222,325     (26,649,412)    -                  $2,533,585
550 Sewer 56,422,555          71,210,352     (63,561,324)    (14,000,000)    $50,071,583
560 Special Transit 348,993               5,221,644       (5,221,644)      -                  $348,993
570 Public Parking 1,502,983            7,381,402       (7,049,764)      -                  $1,834,621

Total Enterprise Funds $254,499,643 $653,064,180 ($608,323,455) ($86,384,427) $212,855,941

Other Sources

240 Air Quality Management District $330,497 $650,000 ($421,561) -                  $558,936
410 Storm Drain DIF 294,137               247,500          -                  (100,000)         $441,637
411 Special Capital Improvement (1,606,763)           2,474,588       (2,474,588)      -                  ($1,606,763)
413 Regional Park Special Capital Imp 2,281,918            383,000          -                  (325,000)         $2,339,918
430 Capital Outlay 1,807,647            -                  -                  -                  $1,807,647
456 CFD - Riverwalk Vista 3,991                   -                  -                  -                  $3,991
480 Successor Agency 2007 Bond Fund 923,140               -                  -                  -                  $923,140
640 Central Stores 5,865,323            1,342,638       (1,081,062)      -                  $6,126,899
650 Central Garage 6,165,453            13,496,361     (12,541,447)    -                  $7,120,367

Total Other Sources $16,065,343 $18,594,087 ($16,518,658) ($425,000) $17,715,772

TOTAL $276,759,300 $703,972,606 ($632,757,600) ($110,063,415) $237,910,891

    working capital.

2020/21

Capital Improvement Plan Sources & Uses

2 Enterprise funds include bond proceeds in their estimated revenues.

1 All funds used beginning fund balance as part of the Estimated Available Balance calculation, except Enterprise funds, which used 
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Funding Source

General Capital Funds

401 General Fund Capital
420 Measure Z  Capital 

Total General Capital Funds

Transportation Funds

230 Gas Tax
431 Transportation Projects
432 Measure A
433 Transportation DIF
434 Transportation Uniform Mitigation Fee

Total Transportation Funds 

Grant Funds

215 Grants and Restricted Programs Fund

Total Grant Funds 

Enterprise Funds

510 Electric Utility
520 Water Utility
530 Airport
540 Refuse
550 Sewer
560 Special Transit
570 Public Parking

Total Enterprise Funds

Other Sources

240 Air Quality Management District
410 Storm Drain DIF
411 Special Capital Improvement
413 Regional Park Special Capital Imp
430 Capital Outlay
456 CFD - Riverwalk Vista
480 Successor Agency 2007 Bond Fund
640 Central Stores
650 Central Garage

Total Other Sources 

TOTAL 

Estimated 
Available       
Balance1

Estimated 
Revenue2

Proposed 
Operating 

Expenditures

Proposed 
Capital 

Expenditures

Ending Available 
Balance

($270,472) -                  -                  -                  ($270,472)
-                       5,375,000       -                  (5,375,000)      $0

($270,472) $5,375,000 $0 ($5,375,000) ($270,472)

$3,805,201 $14,939,819 ($3,087,097) ($10,625,000) $5,032,923
12,060                 -                  -                  -                  $12,060

2,799,398            6,714,000       (2,999,490)      (5,413,200)      $1,100,708
2,670,494            720,100          -                  -                  $3,390,594

(2,020,149)           -                  -                  -                  ($2,020,149)

$7,267,004 $22,373,919 ($6,086,587) ($16,038,200) $7,516,136

$342,646 $2,186,266 ($1,869,701) -                  $659,211

$342,646 $2,186,266 ($1,869,701) $0 $659,211

$137,559,369 $450,420,511 ($418,493,431) ($42,265,364) $127,221,085
19,772,445          105,467,931   (79,928,782)    (21,501,562)    $23,810,032

735,345               1,572,291       (1,531,041)      (41,250)           $735,345
2,533,585            25,256,125     (27,690,389)    -                  $99,321

50,071,583          72,173,882     (64,635,195)    (9,000,000)      $48,610,270
348,993               5,477,438       (5,477,438)      -                  $348,993

1,834,621            7,611,776       (7,280,979)      (770,000)         $1,395,418

$212,855,941 $667,979,954 ($605,037,255) ($73,578,176) $202,220,464

$558,936 $650,000 ($421,577) -                  $787,359
441,637               254,550          -                  (100,000)         $596,187

(1,606,763)           2,480,016       (1,808,717)      -                  ($935,464)
2,339,918            383,000          -                  -                  $2,722,918
1,807,647            -                  -                  -                  $1,807,647

3,991                   -                  -                  -                  $3,991
923,140               -                  -                  -                  $923,140

6,126,899            1,342,638       (1,093,708)      -                  $6,375,829
7,120,367            13,678,994     (13,412,705)    -                  $7,386,656

$17,715,772 $18,789,198 ($16,736,707) ($100,000) $19,668,263

$237,910,891 $716,704,337 ($629,730,250) ($95,091,376) $229,793,602

2021/22

Capital Improvement Plan Sources & Uses
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Funding Source

General Capital Funds

401 General Fund Capital
420 Measure Z  Capital 

Total General Capital Funds

Transportation Funds

230 Gas Tax
431 Transportation Projects
432 Measure A
433 Transportation DIF
434 Transportation Uniform Mitigation Fee

Total Transportation Funds 

Grant Funds

215 Grants and Restricted Programs Fund

Total Grant Funds 

Enterprise Funds

510 Electric Utility
520 Water Utility
530 Airport
540 Refuse
550 Sewer
560 Special Transit
570 Public Parking

Total Enterprise Funds

Other Sources

240 Air Quality Management District
410 Storm Drain DIF
411 Special Capital Improvement
413 Regional Park Special Capital Imp
430 Capital Outlay
456 CFD - Riverwalk Vista
480 Successor Agency 2007 Bond Fund
640 Central Stores
650 Central Garage

Total Other Sources 

TOTAL 

Estimated 
Available       
Balance1

Estimated 
Revenue2

Proposed 
Operating 

Expenditures

Proposed 
Capital 

Expenditures

Ending Available 
Balance

($270,472) -                  -                  -                  ($270,472)
-                       5,375,000       -                  (5,375,000)      $0

($270,472) $5,375,000 $0 ($5,375,000) ($270,472)

$5,032,923 $15,383,514 ($3,087,097) ($9,825,000) $7,504,340
12,060                 -                  -                  -                  $12,060

1,100,708            6,780,000       (3,000,740)      (5,429,000)      ($549,032)
3,390,594            740,803          -                  -                  $4,131,397

(2,020,149)           -                  -                  -                  ($2,020,149)

$7,516,136 $22,904,317 ($6,087,837) ($15,254,000) $9,078,616

$659,211 $1,997,220 ($1,673,908) -                  $982,523

$659,211 $1,997,220 ($1,673,908) $0 $982,523

$127,221,085 $470,739,206 ($432,438,797) ($41,761,648) $123,759,846
23,810,032          117,525,870   (84,745,456)    (29,089,738)    $27,500,708

735,345               1,615,682       (1,556,475)      (5,500)             $789,052
99,321                 25,507,887     (28,408,327)    -                  ($2,801,119)

48,610,270          73,315,836     (65,170,238)    (10,583,800)    $46,172,068
348,993               5,637,463       (5,637,463)      -                  $348,993

1,395,418            7,832,430       (7,497,159)      -                  $1,730,689

$202,220,464 $702,174,374 ($625,453,915) ($81,440,686) $197,500,237

$787,359 $656,500 ($421,592) -                  $1,022,267
596,187               261,812          -                  (100,000)         $757,999

(935,464)              2,480,016       (1,810,248)      -                  ($265,696)
2,722,918            363,000          -                  -                  $3,085,918
1,807,647            -                  -                  -                  $1,807,647

3,991                   -                  -                  -                  $3,991
923,140               -                  -                  -                  $923,140

6,375,829            1,342,638       (1,107,792)      -                  $6,610,675
7,386,656            14,007,289     (13,720,207)    -                  $7,673,738

$19,668,263 $19,111,255 ($17,059,839) ($100,000) $21,619,679

$229,793,602 $751,562,166 ($650,275,499) ($102,169,686) $228,910,583

2022/23

Capital Improvement Plan Sources & Uses
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Funding Source

General Capital Funds

401 General Fund Capital
420 Measure Z  Capital 

Total General Capital Funds

Transportation Funds

230 Gas Tax
431 Transportation Projects
432 Measure A
433 Transportation DIF
434 Transportation Uniform Mitigation Fee

Total Transportation Funds 

Grant Funds

215 Grants and Restricted Programs Fund

Total Grant Funds 

Enterprise Funds

510 Electric Utility
520 Water Utility
530 Airport
540 Refuse
550 Sewer
560 Special Transit
570 Public Parking

Total Enterprise Funds

Other Sources

240 Air Quality Management District
410 Storm Drain DIF
411 Special Capital Improvement
413 Regional Park Special Capital Imp
430 Capital Outlay
456 CFD - Riverwalk Vista
480 Successor Agency 2007 Bond Fund
640 Central Stores
650 Central Garage

Total Other Sources 

TOTAL 

Estimated 
Available       
Balance1

Estimated 
Revenue2

Proposed 
Operating 

Expenditures

Proposed 
Capital 

Expenditures

Ending Available 
Balance

($270,472) ($270,472)
-                       3,875,000       -                  (3,875,000)      $0

($270,472) $3,875,000 $0 ($3,875,000) ($270,472)

$7,504,340 $15,840,519 ($3,087,097) ($9,825,000) $10,432,762
12,060                 -                  -                  -                  $12,060

(549,032)              6,846,000       (2,997,740)      (2,975,000)      $324,228
4,131,397            762,127          -                  -                  $4,893,524

(2,020,149)           -                  -                  -                  ($2,020,149)

$9,078,616 $23,448,646 ($6,084,837) ($12,800,000) $13,642,425

$982,523 $1,997,220 ($1,702,934) -                  $1,276,809

$982,523 $1,997,220 ($1,702,934) $0 $1,276,809

$123,759,846 $497,380,831 ($431,435,940) ($56,657,003) $133,047,734
27,500,708          120,887,599   (84,828,502)    (29,930,773)    $33,629,032

789,052               1,660,332       (1,526,720)      (27,500)           $895,164
(2,801,119)           25,762,166     (29,045,933)    -                  ($6,084,886)
46,172,068          74,483,645     (67,535,115)    (20,350,600)    $32,769,998

348,993               5,697,201       (5,697,201)      -                  $348,993
1,730,689            8,059,484       (7,668,724)      -                  $2,121,449

$197,500,237 $733,931,258 ($627,738,135) ($106,965,876) $196,727,484

$1,022,267 $663,065 ($421,608) -                  $1,263,724
757,999               269,291          -                  (100,000)         $927,290

(265,696)              2,480,016       (1,812,241)      -                  $402,079
3,085,918            363,000          -                  -                  $3,448,918
1,807,647            -                  -                  -                  $1,807,647

3,991                   -                  -                  -                  $3,991
923,140               -                  -                  -                  $923,140

6,610,675            1,342,638       (1,120,656)      -                  $6,832,657
7,673,738            14,343,464     (13,948,060)    -                  $8,069,142

$21,619,679 $19,461,474 ($17,302,565) ($100,000) $23,678,588

$228,910,583 $782,713,598 ($652,828,471) ($123,740,876) $235,054,834

2023/24

Capital Improvement Plan Sources & Uses
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Funding Source

General Capital Funds

401 General Fund Capital
420 Measure Z  Capital 

Total General Capital Funds

Transportation Funds

230 Gas Tax
431 Transportation Projects
432 Measure A
433 Transportation DIF
434 Transportation Uniform Mitigation Fee

Total Transportation Funds 

Grant Funds

215 Grants and Restricted Programs Fund

Total Grant Funds 

Enterprise Funds

510 Electric Utility
520 Water Utility
530 Airport
540 Refuse
550 Sewer
560 Special Transit
570 Public Parking

Total Enterprise Funds

Other Sources

240 Air Quality Management District
410 Storm Drain DIF
411 Special Capital Improvement
413 Regional Park Special Capital Imp
430 Capital Outlay
456 CFD - Riverwalk Vista
480 Successor Agency 2007 Bond Fund
640 Central Stores
650 Central Garage

Total Other Sources 

TOTAL 

Estimated 
Available       
Balance1

Estimated 
Revenue2

Proposed 
Operating 

Expenditures

Proposed 
Capital 

Expenditures

Ending Available 
Balance

($270,472) -                  -                  -                  ($270,472)
-                       3,875,000       -                  (3,875,000)      $0

($270,472) $3,875,000 $0 ($3,875,000) ($270,472)

$10,432,762 $16,311,234 ($3,087,097) ($9,825,000) $13,831,899
12,060                 -                  -                  -                  $12,060

324,228               6,913,000       (3,004,380)      (2,975,000)      $1,257,848
4,893,524            784,091          -                  -                  $5,677,615

(2,020,149)           -                  -                  -                  ($2,020,149)

$13,642,425 $24,008,325 ($6,091,477) ($12,800,000) $18,759,273

$1,276,809 $1,997,220 ($1,732,460) -                  $1,541,569

$1,276,809 $1,997,220 ($1,732,460) $0 $1,541,569

$133,047,734 $519,932,561 ($442,374,777) ($57,338,490) $153,267,028
33,629,032          124,663,960   (86,871,244)    (29,569,277)    $41,852,471

895,164               1,706,277       (1,556,558)      -                  $1,044,883
(6,084,886)           26,018,988     (29,753,181)    -                  ($9,819,079)
32,769,998          75,678,051     (68,709,379)    (24,698,700)    $15,039,970

348,993               5,783,449       (5,783,449)      -                  $348,993
2,121,449            8,293,122       (7,821,021)      -                  $2,593,550

$196,727,484 $762,076,408 ($642,869,609) ($111,606,467) $204,327,816

$1,263,724 $669,695 ($421,688) -                  $1,511,731
927,290               276,994          -                  (100,000)         $1,104,284
402,079               2,480,016       (1,815,969)      -                  $1,066,126

3,448,918            363,000          -                  -                  $3,811,918
1,807,647            -                  -                  -                  $1,807,647

3,991                   -                  -                  -                  $3,991
923,140               -                  -                  -                  $923,140

6,832,657            1,342,638       (1,135,680)      -                  $7,039,615
8,069,142            14,687,707     (14,263,004)    -                  $8,493,845

$23,678,588 $19,820,050 ($17,636,341) ($100,000) $25,762,297

$235,054,834 $811,777,003 ($668,329,887) ($128,381,467) $250,120,483

Capital Improvement Plan Sources & Uses

2024/25
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Capital Improvement Projects by Funding Source

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

NICHOLS COMMUNITY CENTER RENOVATION $18,000 -                 -                 -                 -                 -                 $18,000

MOUNT RUBIDOUX TRAIL IMPROVEMENTS 1,394 -                 -                 -                 -                 -                 1,394
Total Funding Source $19,394 $0 $0 $0 $0 $0 $19,394

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

FIRE PLYMOVENT EXHAUST SYSTEM (ALL - EXCEPT 10 & 11) $610,909 -                 -                 -                 -                 -                 $610,909

NICHOLS COMMUNITY CENTER RENOVATION 15,214 -                 -                 -                 -                 -                 15,214

EL DORADO PARK WALKING PATH 6,855 -                 -                 -                 -                 -                 6,855

HUNTER PARK - RAILROAD KIOSK 25,874 -                 -                 -                 -                 -                 25,874

MARTHA MCLEAN ANZA NARROWS - FRISBEE GOLF COURSE 4,902 -                 -                 -                 -                 -                 4,902

GOESKE SENIOR CENTER - RESTROOM RENOVATION 49,588 -                 -                 -                 -                 -                 49,588

MYRA LINN PARK - ACCESS IMPROVEMENTS 1,461 -                 -                 -                 -                 -                 1,461

MYRA LINN PARK - SHADE SAILS 5,357 -                 -                 -                 -                 -                 5,357

MYRA LINN PARK - FITNESS STATIONS 2,639 -                 -                 -                 -                 -                 2,639

LA SIERRA PARK ADA WALKWAY - PHASE I 191,761 -                 -                 -                 -                 -                 191,761

FAIRMOUNT PARK SIGNAGE 186,789 -                 -                 -                 -                 -                 186,789

BORDWELL PARK - FLOOR REPLACEMENT 168,572 -                 -                 -                 -                 -                 168,572

VILLEGAS PARK - WADING POOL 39,678 -                 -                 -                 -                 -                 39,678

MYRA LINN SIDEWALK - COOK AVE 8,805 -                 -                 -                 -                 -                 8,805

LA SIERRA PARK ADA WALKWAY - PHASE II 28,362 -                 -                 -                 -                 -                 28,362

BOBBY BONDS GYM & POOL IMPROVEMENTS 73,689 -                 -                 -                 -                 -                 73,689

CHEECH MARIN CENTER FOR CHICANO ART 10,133,028 -                 -                 -                 -                 -                 10,133,028

SOCAL GAS TEMP RIGHT OF ENTRY 43,983 -                 -                 -                 -                 -                 43,983
Total Funding Source $11,597,465 $0 $0 $0 $0 $0 $11,597,465

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

MISC STREET CONSTRUCTION PROGRAM $312,370 $300,000 $500,000 $500,000 $500,000 $500,000 $2,612,370

CANYON CREST WIDENING 957,409          -                 -                 -                 -                 -                 957,409          

TYLER WIDENING - WELLS TO HOLE 50,000            -                 -                 -                 -                 -                 50,000            

INDIANA WIDENING - PIERCE 615,000          -                 -                 -                 -                 -                 615,000          

JURUPA AVENUE EXTENSION 702,900          -                 -                 -                 -                 -                 702,900          

UP QUIET ZONE - BROCKTON AND PALM 600,000          -                 -                 -                 -                 -                 600,000          

ADAMS STREET/STATE ROUTE 91 INTERCHANGE IMPROVEMENTS 1,530,981       -                 -                 -                 -                 -                 1,530,981       

MAGNOLIA AVENUE WIDENING FROM BUCHANAN STREET TO HOLE 1,665,854       -                 -                 -                 -                 -                 1,665,854       

MISCELLANEOUS TRAFFIC PROJECTS 97,429            75,000            75,000            75,000            75,000            75,000            472,429          

UNDERPASS STORM DRAIN - 14TH ST 17,563            -                 -                 -                 -                 -                 17,563            

CURB AND GUTTER REPAIR PROGRAM 244,333          200,000          200,000          200,000          200,000          200,000          1,244,333       

MINOR STREET REHABILITATION PROGRAM 1,631,140       1,500,000       1,500,000       1,500,000       1,500,000       1,500,000       9,131,140       

SIDEWALK/TRAIL CONSTRUCTION PROGRAM 295,668          300,000          300,000          300,000          300,000          300,000          1,795,668       

SIDEWALK REPAIR PROGRAM 472,783          300,000          300,000          300,000          300,000          300,000          1,972,783       

PEDESTRIAN RAMPS PROGRAM 485,719          300,000          300,000          300,000          300,000          300,000          1,985,719       

CDBG STREET IMPROVEMENTS - MATCHING FUNDS 33,963            150,000          150,000          150,000          150,000          150,000          783,963          

NORTE VISTA SIDEWALK IMPROVEMENTS 1                     -                 -                 -                 -                 -                 1                     

DOWNTOWN BICYCLE & PEDESTRIAN IMPROVEMENTS (306)               -                 -                 -                 -                 -                 (306)               

MINOR STREET PRESERVATION PROGRAM (SLURRY/ARAM) 738,690          500,000          500,000          500,000          500,000          500,000          3,238,690       

SAN ANDREAS DRAINAGE IMPROVEMENTS 24,528            -                 -                 -                 -                 -                 24,528            

INDIAN HILL ROAD SLOPE MITIGATION PROJECT 51,364            -                 -                 -                 -                 -                 51,364            

SB-1 PAVEMENT REHABILITATION, MAINTENANCE PROGRAM 1,995,885       -                 -                 -                 -                 -                 1,995,885       

SB-1 PAVEMENT REHABILITATION, MAINTENANCE PROGRAM $5,205,911 -                 -                 -                 -                 -                 $5,205,911

General Fund
Fund 101

Gas Tax Fund
Fund 230

Grants and Restricted Programs Fund
Fund 215
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Capital Improvement Projects by Funding Source

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

VAN BUREN BLVD PUMP STATION REHAB $153,285 $100,000 -                 -                 -                 -                 $253,285

ADAIR SIDEWALK-JO JO RANDOLPH 64,326            75,000            -                 -                 -                 -                 139,326          

BONITA SIDEWALK-TYLER PENDLETON 58,358            135,000          -                 -                 -                 -                 193,358          

LARCHWOOD PLACE REHAB 659,379          -                 -                 -                 -                 -                 659,379          

SIERRA STREET STORM DRAIN IMPROVEMENTS -                 450,000          -                 -                 -                 -                 450,000          

BERRY RD WIDENING - SELINA STREET TO BUSH AVE -                 -                 800,000          -                 -                 -                 800,000          

VICTORIA AT WASHINGTON SOUTHBOUND MERGE LANE -                 55,000            -                 -                 -                 -                 55,000            

SIDEWALK FRONTING PATRICIA BEATTY -                 125,000          -                 -                 -                 -                 125,000          

RMRA REHAB & TRAFFIC IMPROVEMENTS FY2020/21 -                 6,196,792       -                 -                 -                 -                 6,196,792       

RMRA REHAB & TRAFFIC IMPROVEMENTS FY2021/22 -                 -                 6,000,000       6,000,000       6,000,000       6,000,000       24,000,000     

KNOEFLER - ST. IMPROVEMENTS FROM AMBS DRIVE TO STREET END -                 560,000          -                 -                 -                 -                 560,000          
Total Funding Source $18,664,533 $11,321,792 $10,625,000 $9,825,000 $9,825,000 $9,825,000 $70,086,325

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

MAGNOLIA - BUCHANAN TO 1ST $100,000 -                 -                 -                 -                 -                 $100,000

CITYWIDE BIKE SHARE PROGRAM 10,219            -                 -                 -                 -                 -                 10,219            

DOWNTOWN BICYCLE & PEDESTRIAN IMPROVEMENTS 100                 -                 -                 -                 -                 -                 100                 
Total Funding Source $110,320 $0 $0 $0 $0 $0 $110,320

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

BICYCLE IMPROVEMENTS - IOWA TO MLK $65,000 -                 -                 -                 -                 -                 $65,000

PLAYGROUND IMPROVEMENTS - ORANGE TERRACE 15,016            -                 -                 -                 -                 -                 15,016            

HUNT PARK IMPROVEMENTS 4,809              -                 -                 -                 -                 -                 4,809              

GIS TECHNOLOGY UPGRADE 2,319,463       -                 -                 -                 -                 -                 2,319,463       

DATACENTER/DISASTER RECOVERY CAPITAL IMPROVEMENTS -                 1,046,541       -                 -                 -                 -                 1,046,541       

CORP YARD SECURITY CAMERAS 61,611            -                 -                 -                 -                 -                 61,611            

FIBER OPTIC CONNECTION UPGRADE 29,916            -                 -                 -                 -                 -                 29,916            
Total Funding Source $2,495,815 $1,046,541 $0 $0 $0 $0 $3,542,356

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

MISCELLANEOUS STORM DRAIN CONSTRUCTION $13,512 $100,000 $100,000 $100,000 $100,000 $100,000 $513,512

MONROE STORM DRAIN PROJECT (LINES E2, E3, E5) 11,870,682     -                 -                 -                 -                 -                 11,870,682     

FAIRVIEW & CORNWALL STORM DRAIN PROJECT 391,405          -                 -                 -                 -                 -                 391,405          
Total Funding Source $12,275,600 $100,000 $100,000 $100,000 $100,000 $100,000 $12,775,600

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

FAIRMOUNT PARK GOLF COURSE $25,822 -                 -                 -                 -                 -                 $25,822

MOUNT RUBIDOUX TRAIL IMPROVEMENTS 68,735            -                 -                 -                 -                 -                 68,735            

SAN ANDREAS DRAINAGE IMPROVEMENTS 11,361            -                 -                 -                 -                 -                 11,361            

PARKS MASTER PLAN UPDATE 20,664            -                 -                 -                 -                 -                 20,664            

MT RUBIDOUX SITE AND TRAIL IMPROVEMENTS 78,069            -                 -                 -                 -                 -                 78,069            

TRAILS MASTER PLAN $65,000 -                 -                 -                 -                 -                 $65,000

AQMD Fund
Fund 240

Storm Drain DIF Fund
Fund 410

Regional Park Fund

General Fund Capital
Fund 401

Fund 413

Gas Tax Fund (continued)
Fund 230
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Capital Improvement Projects by Funding Source

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

FAIRMOUNT PARK LAKE EVANS LAKESHORE ACCESS -                 $325,000 -                 -                 -                 -                 325,000          

Total Funding Source $269,650 $325,000 $0 $0 $0 $0 $594,650

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

JO JO WAY SIDEWALKS $10,810 -                 -                 -                 -                 -                 $10,810

MINOR STREETS REHAB - SLURRY 62,633            -                 -                 -                 -                 -                 62,633            

SIDEWALKS - SELKIRK AVE 5,737              -                 -                 -                 -                 -                 5,737              

METRO MUSEUM EXPANSION AND REHAB 10,167            -                 -                 -                 -                 -                 10,167            

POLICE HEADQUARTERS 69,559            -                 -                 -                 -                 -                 69,559            

CITY BUILDINGS DEFERRED MAINTENANCE 245,148          1,000,000       1,000,000       1,000,000       1,000,000       1,000,000       5,245,148       

DATA NETWORK REPLACEMENT 1,748,297       -                 -                 -                 -                 -                 1,748,297       

MEASURE Z PAVEMENT REHABILITATION 4,375,000       -                 -                 -                 -                 -                 4,375,000       

MEASURE Z PAVEMENT REHABILITATION 7,875,000       4,375,000       4,375,000       4,375,000       2,875,000       2,875,000       26,750,000     

EASTSIDE LIBRARY 100,000          -                 -                 -                 -                 -                 100,000          

FIRE STATION DORM IMPROVEMENTS 99,573            -                 -                 -                 -                 -                 99,573            

DATACENTER/DISASTER RECOVERY CAPITAL IMPROVEMENTS -                 1,862,955       -                 -                 -                 -                 1,862,955       

CORP YARD SECURITY CAMERAS 15,798            -                 -                 -                 -                 -                 15,798            

FIBER OPTIC CONNECTION UPGRADE 90,605            -                 -                 -                 -                 -                 90,605            

DOWNTOWN LIBRARY 8,156,580       -                 -                 -                 -                 -                 8,156,580       
Total Funding Source $22,864,908 $7,237,955 $5,375,000 $5,375,000 $3,875,000 $3,875,000 $48,602,863

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

ADAMS STREET/STATE ROUTE 91 INTERCHANGE IMPROVEMENTS $786,302 -                 -                 -                 -                 -                 $786,302

CITYWIDE BIKE SHARE PROGRAM 28,877            -                 -                 -                 -                 -                 28,877            

MAGNOLIA AVENUE WIDENING FROM BUCHANAN STREET TO HOLE 2,027,004       -                 -                 -                 -                 -                 2,027,004       

NORTE VISTA SIDEWALK IMPROVEMENTS 308,907          -                 -                 -                 -                 -                 308,907          

WELLS AND ARLANZA SIDEWALK PROJECT 410,402          -                 -                 -                 -                 -                 410,402          

BNSF/THIRD STREET RAILROAD CROSSING 369,444          -                 -                 -                 -                 -                 369,444          

BNSF RAILROAD CROSSING IMPROVEMENTS - SPRUCE 507,943          -                 -                 -                 -                 -                 507,943          

CENTRAL/CANYON CREST/WATKINS BIKE LANES 942,000          -                 -                 -                 -                 -                 942,000          

PEDESTRIAN & BICYCLE SAFETY PROGRAM 116,620          -                 -                 -                 -                 -                 116,620          
Total Funding Source $5,497,499 $0 $0 $0 $0 $0 $5,497,499

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

ADAIR SIDEWALK-JO JO RANDOLPH $139,326 -                 -                 -                 -                 -                 $139,326

BONITA SIDEWALK-TYLER PENDLETON 193,358          -                 -                 -                 -                 -                 193,358          
Total Funding Source $332,685 $0 $0 $0 $0 $0 $332,685

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

CONTROLLER ASSEMBLY REPLACEMENT $6,590 $70,000 $70,000 $70,000 $70,000 $70,000 $356,590

SPREAD SPECTRUM RADIO REPLACEMENT 12,889            10,000            10,000            10,000            10,000            10,000            62,889            

TRAFFIC SIGNAL LOOP REPLACEMENT PROGRAM $11,557 $25,000 $25,000 $25,000 $25,000 $25,000 $136,557

Measure Z Capital Fund
Fund 420

Capital Outlay Fund

Regional Park Fund (continued)
Fund 413

Transportation Projects Fund
Fund 431

Fund 430

Measure A Fund
Fund 432
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Capital Improvement Projects by Funding Source

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

MISCELLANEOUS SIGNAL REVISIONS PROGRAM $124,985 $100,000 $100,000 $100,000 $100,000 $100,000 $624,985

ARTERIAL INTERCONNECT PROGRAM -                 40,000            40,000            40,000            40,000            40,000            200,000          

CANYON CREST WIDENING 1,650,000       -                 -                 -                 -                 -                 1,650,000       

UP GRADE SEPARATION - MAGNOLIA 124,840          -                 -                 -                 -                 -                 124,840          

TRAFFIC MANAGEMENT CENTER 2,367              50,000            50,000            50,000            50,000            50,000            252,367          

BNSF/UP QUIET ZONE - PANORAMA & CRIDGE 6,624,596       -                 -                 -                 -                 -                 6,624,596       

TYLER WIDENING - WELLS TO HOLE 181                 -                 -                 -                 -                 -                 181                 

INDIANA WIDENING - PIERCE 419,766          -                 -                 -                 -                 -                 419,766          

NEW TRAFFIC SIGNALS PROGRAM 56,465            250,000          250,000          250,000          250,000          250,000          1,306,465       

BNSF QUIET ZONE - MISSION INN, 3RD, & SPRUCE 764,475          772,700          788,200          804,000          -                 -                 3,129,375       

LED SIGNAL LENSES REPLACEMENT PROGRAM 6,798              20,000            20,000            20,000            20,000            20,000            106,798          

JURUPA EXTENSION - RUTLAND TO CREST 300,000          -                 -                 -                 -                 -                 300,000          

MISSION BOULEVARD BRIDGE REPLACEMENT AT SANTA ANA RIVER 791,156          800,000          800,000          800,000          -                 -                 3,191,156       

MARKET STREET BRIDGE REPLACEMENT OVER SANTA ANA RIVER 25,908            900,000          850,000          850,000          -                 -                 2,625,908       

UNIVERSITY AVENUE FIBER OPTIC 50,000            -                 -                 -                 -                 -                 50,000            

UP QUIET ZONE - BROCKTON AND PALM 1,515,551       -                 -                 -                 -                 -                 1,515,551       

MAGNOLIA AVENUE WIDENING FROM BUCHANAN STREET TO HOLE 3,747,087       -                 -                 -                 -                 -                 3,747,087       

MAJOR STREETS REHABILITATION 2,247,746       500,000          2,400,000       2,400,000       2,400,000       2,400,000       12,347,746     

BNSF/THIRD STREET RAILROAD CROSSING 281,630          -                 -                 -                 -                 -                 281,630          

BNSF RAILROAD CROSSING IMPROVEMENTS - SPRUCE 154,943          -                 -                 -                 -                 -                 154,943          

VAN BUREN BLVD WIDENING 46,673            -                 -                 -                 -                 -                 46,673            

CENTRAL/CANYON CREST/WATKINS BIKE LANES 214,251          -                 -                 -                 -                 -                 214,251          

HIGH FRICTION SURFACE AND HAWK SIGNALS 194,485          -                 -                 -                 -                 -                 194,485          

MONROE REHAB-LINCOLN TO ARLINGTON 1,512,502       -                 -                 -                 -                 -                 1,512,502       

SAN ANDREAS DRAINAGE IMPROVEMENTS 4,000              -                 -                 -                 -                 -                 4,000              

IOWA AVENUE WIDENING 350,000          -                 -                 -                 -                 -                 350,000          

INTERCONNECTED TRAFFIC SIGNAL CONTROLLER REPLACEMENT 560,000          -                 -                 -                 -                 -                 560,000          

OPEN STREETS PLANS 60,006            -                 -                 -                 -                 -                 60,006            

LOCAL ROADWAY SAFETY IMPROVEMENT PLAN 28,000            100,000          -                 -                 -                 -                 128,000          

TRAFFIC SIGNAL EMERGENCY VEHICLE REPLACEMENT -                 10,000            10,000            10,000            10,000            10,000            50,000            

BNSF/THIRD STREET GRADE SEPARATION 1,000,000       -                 -                 -                 -                 -                 1,000,000       
Total Funding Source $22,889,447 $3,647,700 $5,413,200 $5,429,000 $2,975,000 $2,975,000 $43,329,347

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

CANYON CREST WIDENING $2,685,000 -                 -                 -                 -                 -                 $2,685,000

MAGNOLIA AVENUE WIDENING FROM BUCHANAN STREET TO HOLE 295,040          -                 -                 -                 -                 -                 295,040          

IOWA AVENUE WIDENING 1,231,376       -                 -                 -                 -                 -                 1,231,376       
Total Funding Source $4,211,416 $0 $0 $0 $0 $0 $4,211,416

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

VAN BUREN-JURUPA TO SANTA ANA RIVER BRIDGE $160,000 -                 -                 -                 -                 -                 $160,000

ADAMS STREET/STATE ROUTE 91 INTERCHANGE IMPROVEMENTS 3,851,111       -                 -                 -                 -                 -                 3,851,111       

IOWA AVENUE WIDENING 2,869,296       -                 -                 -                 -                 -                 2,869,296       

BNSF/THIRD STREET GRADE SEPARATION $3,462,049 -                 -                 -                 -                 -                 $3,462,049
Total Funding Source $10,342,456 $0 $0 $0 $0 $0 $10,342,456

Measure A Fund (continued)
Fund 432

Transportation DIF Fund
Fund 433

TUMF Fund
Fund 434
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Capital Improvement Projects by Funding Source

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

ARLINGTON YOUTH INNOVATION CENTER $201,879 -                 -                 -                 -                 -                 $201,879
Total Funding Source $201,879 $0 $0 $0 $0 $0 $201,879

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

ARLINGTON YOUTH INNOVATION CENTER $383,650 -                 -                 -                 -                 -                 $383,650

VILLEGAS PARK IMPROVEMENTS 182,525          -                 -                 -                 -                 -                 182,525          
Total Funding Source $566,175 $0 $0 $0 $0 $0 $566,175

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

BUILDING & STRUCTURE IMPROVEMENTS $564,874 -                 -                 -                 -                 -                 $564,874

DISTRIBUTION LINE EXTENSIONS 680,509          2,135,897       2,152,064       2,831,267       2,942,653       3,178,956       13,921,346     

LINE REBUILDS 282,943          1,697,787       1,697,787       2,121,787       4,557,834       5,557,834       15,915,972     

STREET LIGHTING 65,111            -                 -                 -                 -                 -                 65,111            

SYSTEM SUBSTATION MODIFICATIONS 49,752            201,414          201,414          223,259          357,547          447,771          1,481,157       

TRANSFORMERS 1,199,237       4,000,000       4,500,000       4,500,000       4,700,000       4,700,000       23,599,237     

CAPACITORS-REGULATORS 245                 -                 -                 -                 -                 -                 245                 

METERS (63,891)          300,000          300,000          300,000          300,000          300,000          1,436,109       

SUBSTATION INNOVATION 2,586              -                 -                 -                 -                 -                 2,586              

SERVICES 300                 400,000          400,000          400,000          400,000          400,000          2,000,300       

SUBSTATION BUS & UPGRADES 6,433,521       6,176,366       6,258,312       1,910,730       6,038,450       2,137,465       28,954,844     

MAJOR OVERHEAD/UNDERGROUND CONVERSIONS 184,571          500,000          500,000          500,000          500,000          500,000          2,684,571       

MAJOR TRANSMISSION LINE PROJECTS 159,529          300,000          300,000          300,000          300,000          300,000          1,659,529       

GENERAL ORDER 165 (GO 165) UPGRADES/REBUILDS/RELOCATION 1,932,968       3,251,297       3,710,554       5,060,145       5,491,648       5,592,151       25,038,763     

GO 165 UPGRADES/LINE REBUILDS/RELOCATE-UNDERGROUND 791,875          -                 -                 -                 -                 -                 791,875          

MAJOR TRACT DISTRIBUTION 326,885          -                 -                 -                 -                 -                 326,885          

SUBSTATION TRANSFORMER ADDITION 4,949,399       3,369,075       3,369,075       3,678,851       6,572,868       8,720,116       30,659,384     

MAJOR FEEDERS 125,930          600,000          600,000          600,000          600,000          600,000          3,125,930       

SOUTHERN CALIFORNIA EDISON (SCE) CONDEMNATION COSTS 3,908              400,000          400,000          400,000          400,000          400,000          2,003,908       

CABLE REPLACEMENT 1,827,292       3,272,770       3,388,424       4,652,465       8,129,335       8,129,335       29,399,621     

CABLE REPLACEMENT - PUBLIC WORKS STREET REHAB 9,135              -                 -                 -                 -                 -                 9,135              

MAJOR STREET LIGHT PROJECTS 12,538,145     600,000          600,000          600,000          600,000          600,000          15,538,145     

NEIGHBORHOOD STREET LIGHT RETROFIT 273,394          -                 -                 -                 1,034,782       1,064,273       2,372,449       

FACILITY COMPLIANCE/UPGRADES 500,000          -                 -                 -                 -                 -                 500,000          

MAJOR 4-12 KV CONVERSION 3,640,850       2,734,064       2,734,064       2,803,117       4,768,975       5,440,698       22,121,768     

DISTRIBUTION AUTOMATION 712,586          340,000          685,000          885,000          685,000          685,000          3,992,586       

BIOGAS TO ENERGY 100,000          -                 -                 -                 -                 -                 100,000          

CITYWIDE COMMUNICATIONS 1,546,530       1,300,000       1,300,000       1,300,000       1,300,000       1,300,000       8,046,530       

SUPERVISORY CONTROL AND DATA ACQUISITION (SCADA) 181,631          600,000          600,000          600,000          600,000          600,000          3,181,631       

RIVERSIDE TRANSMISSION RELIABILITY PROJECT (RTRP) 55,504,933     -                 -                 -                 -                 -                 55,504,933     

RTRP - 230kV REIMBURSABLE 163,562          -                 -                 -                 -                 -                 163,562          

BUSINESS SYSTEM TECHNOLOGY UPGRADES 701,384          1,600,326       965,636          946,925          -                 -                 4,214,271       

GEOGRAPHIC INFORMATION SYSTEM (GIS) UPGRADE -                 503,535          517,886          -                 -                 -                 1,021,421       

DARK FIBER 588,966          -                 -                 -                 -                 -                 588,966          

ICE BEAR UNITS 3,661,980       -                 -                 -                 -                 -                 3,661,980       

ENTERPRISE OPERATION DATA MGMT SYSTEM 89,076            -                 -                 -                 -                 1,001,669       1,090,745       

ADVANCED METERING INFRASTRUCTURE 6,038,290       2,573,624       1,265,943       -                 1,217,391       1,252,087       12,347,335     

OPERATIONAL TECHNOLOGY GOVERNANCE 266,828          889,021          994,812          1,377,776       443,130          455,760          4,427,327       

WORK, ASSET, & INVENTORY MGMT SYSTEM 659,370          671,380          2,071,543       2,367,313       852,174          626,043          7,247,823       

NETWORK COMMUNICATION SYSTEM $6,250 $895,173 $1,150,857 $1,183,657 $1,217,391 $1,252,087 $5,705,415

Electric Fund
Fund 510

Redevelopment Successor Agency 2007 Bond Fund
Fund 480

CFD-Riverwalk Vista Fund
Fund 456
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Capital Improvement Projects by Funding Source

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

LAND MOBILE RADIO -                 -                 $344,106 $353,913 $364,000 $374,374 $1,436,393

OUTAGE MANAGEMENT SYSTEM -                 144,347          471,851          662,848          681,739          701,168          2,661,953       

ADVANCED DISTRIBUTION MANAGEMENT SYSTEM -                 501,297          786,036          965,864          993,391          1,021,703       4,268,291       

MOBILE APPLICATIONS -                 1,706,424       -                 236,731          608,695          -                 2,551,850       

DATA NETWORK REPLACEMENT 554,966          -                 -                 -                 -                 -                 554,966          
Total Funding Source $107,255,419 $41,663,797 $42,265,364 $41,761,648 $56,657,003 $57,338,490 $346,941,721

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

DISTRIBUTION AUTOMATION/RELIABILITY -                 $604,242 $161,120 $591,828 $620,869 $513,356 $2,491,415

SYSTEM EXPANSION (1,069,493)     1,734,262       1,783,689       1,834,524       1,886,808       1,625,678       7,795,468       

METERS 580,443          895,173          920,686          946,925          973,913          1,001,669       5,318,809       

WATER STOCK 19,125            10,880            11,190            11,509            11,837            11,837            76,378            

DISTRIBUTION SYSTEM FACILITIES REPLACEMENTS (994,776)        2,599,532       2,652,243       2,706,457       2,012,216       2,012,216       10,987,888     

MAIN REPLACEMENTS PROGRAM 2,495,045       3,900,782       4,579,715       5,943,769       9,130,432       10,342,235     36,391,978     

STREET IMPROVEMENTS 102,421          -                 -                 -                 -                 -                 102,421          

TRANSMISSION MAINS 1,286,754       10,353,799     6,214,629       6,320,727       9,836,519       5,884,807       39,897,235     

PUMP STATION REPLACEMENTS 3,264,988       -                 -                 -                 -                 -                 3,264,988       

FACILITY REHABILITATION PROGRAM 1,277,100       1,454,657       920,686          1,716,302       1,339,129       1,815,525       8,523,399       

PROPERTY ACQUISITION 3,000              -                 -                 -                 -                 -                 3,000              

RECYCLED WATER (JACKSON ST. PHASE I) 2,434,777       -                 -                 -                 -                 -                 2,434,777       

SEVEN OAKS DAM CONSERVATION - ENHANCED RECHARGE 6,232,741       2,797,417       -                 -                 -                 -                 9,030,158       

AQUIFER STORAGE & RECOVERY SYSTEM 1,613,773       -                 -                 -                 -                 -                 1,613,773       

HYDRANT CHECK VALVES 50,208            97,916            100,707          103,577          106,529          106,529          565,466          

UPPER SANTA ANA RIVER HABITAT CONSERVATION PLAN 190,744          -                 -                 -                 -                 -                 190,744          

ENTERPRISE OPERATION DATA MGMT SYSTEM 47,963            -                 -                 -                 -                 -                 47,963            

ADVANCED METERING INFRASTRUCTURE 1,524,114       2,349,830       1,979,475       1,420,388       2,069,565       626,043          9,969,415       

OPERATIONAL TECHNOLOGY GOVERNANCE 161,331          125,325          128,896          231,998          238,609          245,409          1,131,568       

WORK, ASSET, & INVENTORY MGMT SYSTEM -                 -                 -                 603,665          365,217          751,252          1,720,134       

NETWORK COMMUNICATION SYSTEM 1,162,344       223,793          230,171          710,194          -                 -                 2,326,502       

LAND MOBILE RADIO -                 -                 322,240          -                 -                 -                 322,240          

MOBILE APPLICATIONS -                 -                 -                 503,054          -                 -                 503,054          

SCADA UPGRADE & SYSTEM AUTOMATION 626,733          671,380          920,686          946,925          730,435          1,502,504       5,398,663       

POTABLE/IRRIGATION WELL REPLACEMENT 416,286          2,797,417       575,429          4,497,896       608,695          3,130,217       12,025,940     

DATA NETWORK REPLACEMENT 205,594          -                 -                 -                 -                 -                 205,594          
Total Funding Source $21,631,215 $30,616,405 $21,501,562 $29,089,738 $29,930,773 $29,569,277 $162,338,970

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

AIRPORT RUNWAY 16/34 REHABILITATION -                 $2,475 $41,250 -                 -                 -                 $43,725

AIRPORT TAXIWAY A REHAB 20,000            -                 -                 5,500              27,500            -                 53,000            

TAXIWAY J REHAB -                 82,500            -                 -                 -                 -                 82,500            

AIRPORT EMERGENCY GENERATOR 247,216          16,500            -                 -                 -                 -                 263,716          

AIRPORT RUNWAY 34 WINDSOCK RELOCATION -                 1,100              -                 -                 -                 -                 1,100              

AIRPORT AIRFIELD SIGNAGE -                 1,650              -                 -                 -                 -                 1,650              

DATA NETWORK REPLACEMENT 9,533              -                 -                 -                 -                 -                 9,533              

AIRPORT FACILITIES TERMINAL PATIO DECK 119,568          -                 -                 -                 -                 -                 119,568          

APRON ASPHALT PROJECT PHASE I 100,000          -                 -                 -                 -                 -                 100,000          

AIRPORT CAMERA SYSTEM 4,238              -                 -                 -                 -                 -                 4,238              
Total Funding Source $500,554 $104,225 $41,250 $5,500 $27,500 $0 $679,029

Fund 530

Electric Fund (continued)
Fund 510

Water Fund
Fund 520

Airport Fund

34



Capital Improvement Projects by Funding Source

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

LANDFILL FLARE STATION $160 -                 -                 -                 -                 -                 $160

DATA NETWORK REPLACEMENT 74,553            -                 -                 -                 -                 -                 74,553            
Total Funding Source $74,713 $0 $0 $0 $0 $0 $74,713

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

WQCP - SECURITY SYSTEM UPGRADE $199,787 -                 -                 -                 -                 -                 $199,787

TEQUESQUITE/ARROYO TRUNK LINE 128,174          -                 -                 -                 -                 -                 128,174          

SANTA ANA RIVER TRUNK REPLACEMENT 49,389            -                 -                 -                 -                 -                 49,389            

RWQCP REHABILITATION - PHASE II 30,000            -                 -                 -                 -                 -                 30,000            

WQCP - PLANT EXPANSION PHASE I 1,636,924       -                 -                 -                 -                 -                 1,636,924       

FAIRGROUNDS WASTEWATER 96,963            -                 -                 -                 -                 -                 96,963            

ADMIN BUILDING HVAC REPLACEMENT 167,423          -                 -                 -                 -                 -                 167,423          

TERTIARY SYSTEM REHAB - PHASE I 819,791          -                 -                 -                 -                 -                 819,791          

DEXTER WASTEWATER 126,472          -                 -                 -                 -                 -                 126,472          

PLANT SUP FACILITY AND SYSTEM REHAB 355,027          -                 -                 -                 -                 -                 355,027          

BIO-SOLIDS HANDLING REHABILITATION 911,403          -                 -                 -                 -                 -                 911,403          

WQCP - ARLANZA SEWER TRUNK REHABILITATION 247                 -                 -                 -                 -                 -                 247                 

ARC FLASH STUDY 107,722          -                 -                 -                 -                 -                 107,722          

WASTEWATER LIFT STATIONS 260,133          -                 -                 -                 -                 -                 260,133          

WQCP - COLLECTION SYSTEM MASTER PLAN UPDATE 218,352          -                 -                 -                 -                 -                 218,352          

WOODCREST SEWER CONSTRUCTION- PHASE I 11,064,462     -                 -                 -                 -                 -                 11,064,462     

DATA NETWORK REPLACEMENT 136,688          -                 -                 -                 -                 -                 136,688          

PLANT II ACTIVATED SLUDGE REHAB - PHASE I 431,874          -                 -                 -                 -                 -                 431,874          

SEWER FORCEMAIN REPLACEMENT - MAGNOLIA 555,990          -                 -                 -                 -                 -                 555,990          

SEWER MAINS REHAB FY 2018/19 1,089,550       -                 -                 -                 -                 -                 1,089,550       

SEWER MAINS REHAB FY 2017/18 302,401          -                 -                 -                 -                 -                 302,401          

WQCP - INFLUENT ELECTROMAGNETIC METER REHAB REPLACEMENT 160,838          -                 -                 -                 -                 -                 160,838          

PIERCE ST PUMP STATION REHABILITATION -                 2,000,000       -                 -                 -                 -                 2,000,000       

WESTERN, MLK, & GARDEN HILL LIFT STATION REHAB -                 250,000          1,750,000       -                 -                 -                 2,000,000       

ELIMINATION OF UNIVERSITY KNOLLS PUMP STATION -                 50,000            700,000          -                 -                 -                 750,000          

SEWER MAIN REPLACEMENT – PALM AVE -                 -                 -                 120,000          1,080,000       -                 1,200,000       

SEWER MAIN REPLACEMENT – PALM & RUBIDOUX -                 -                 -                 75,000            675,000          -                 750,000          

SEWER MAIN REPLACEMENT – RUBIDOUX AVE -                 -                 -                 60,000            540,000          -                 600,000          

SEWER MAIN REPLACEMENT – RUTLAND AVE -                 -                 -                 -                 40,000            360,000          400,000          

SEWER MAIN REPLACEMENT – WEST RUTLAND AVE -                 -                 -                 -                 60,000            540,000          600,000          

SEWER MAIN REPLACEMENT – KMART LOT -                 -                 -                 -                 85,000            765,000          850,000          

GOLDEN AVENUE SEWER PIPE REPLACEMENT -                 -                 -                 -                 60,000            540,000          600,000          

SEWER MAIN REPLACEMENT – S.A.R. TRAIL -                 -                 -                 75,000            675,000          -                 750,000          

SEWER PIPE EXPANSION – GREENPOINT AVE -                 -                 -                 2,000              18,000            -                 20,000            

ARLINGTON VALLEY CHANNEL PIPE REPLACEMENT -                 -                 -                 -                 300,000          2,700,000       3,000,000       

SEWER PIPELINE REPLACEMENT – MORRIS ST -                 -                 -                 -                 200,000          1,800,000       2,000,000       

SEWER MAIN REPLACEMENT – MARKET ST -                 -                 -                 25,000            225,000          -                 250,000          

PRIORITY PIPELINE ASSESSMENT & REPAIR -                 2,600,000       2,600,000       2,600,000       2,600,000       2,600,000       13,000,000     

UPGRADE INFLUENT FLOW-METERS TO MAG-METERS -                 -                 500,000          5,726,800       -                 -                 6,226,800       

WQCP HEADWORKS AREA REHABILITATION -                 -                 -                 500,000          12,142,600     -                 12,642,600     

WQCP ACTIVATED TREATMENT TRAIN REHAB -                 -                 -                 -                 500,000          5,489,200       5,989,200       

WQCP PLANT II SLUDGE PUMPS I & II REHAB -                 -                 -                 -                 250,000          2,375,700       2,625,700       

WQCP DAFT REHABILITATION -                 -                 -                 -                 500,000          7,528,800       8,028,800       

WQCP MEMBRANE BIOREACTOR REHABILITATION -                 5,000,000       -                 -                 -                 -                 5,000,000       

WQCP HVAC UPGRADE PHASE II -                 1,700,000       -                 -                 -                 -                 1,700,000       

WQCP WAREHOUSE BUILDING REPLACEMENT -                 -                 100,000          1,400,000       -                 -                 1,500,000       

WQCP DIGESTER NO. V REHABILITATION -                 250,000          2,750,000       -                 -                 -                 3,000,000       

WQCP RING INTERCONNECTION PIPE -                 $2,000,000 -                 -                 -                 -                 $2,000,000

Fund 540

Sewer Fund
Fund 550

Refuse Fund
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Capital Improvement Projects by Funding Source

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

WQCP ELECTRIC SWITCHGEAR REPLACEMENT -                 $150,000 $350,000 -                 -                 -                 $500,000

WQCP SCADA INFRASTRUCTURE REPLACEMENT -                 -                 250,000          -                 -                 -                 250,000          

WQCP WIFI PHASE II -                 -                 -                 -                 400,000          -                 400,000          
Total Funding Source $18,849,608 $14,000,000 $9,000,000 $10,583,800 $20,350,600 $24,698,700 $97,482,708

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

SLOW FILL STATION $7,566 -                 -                 -                 -                 -                 $7,566
Total Funding Source $7,566 $0 $0 $0 $0 $0 $7,566

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

GARAGE LED LIGHTING UPGRADE -                 -                 $190,000 -                 -                 -                 $190,000

STRUCTURAL UPGRADES FOR GARAGES 1 & 2 -                 -                 580,000          -                 -                 -                 580,000          
Total Funding Source $0 $0 $770,000 $0 $0 $0 $770,000

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

DATA NETWORK REPLACEMENT $10,893 -                 -                 -                 -                 -                 $10,893
Total Funding Source $10,893 $0 $0 $0 $0 $0 $10,893

Carryover

Project Name  Amount* 2020/21 2021/22 2022/23 2023/24 2024/25 Total

FLEET METHANE DETECTION SYSTEM $1,247,786 -                 -                 -                 -                 -                 $1,247,786

DATA NETWORK REPLACEMENT 46,301            -                 -                 -                 -                 -                 46,301            
Total Funding Source $1,294,087 $0 $0 $0 $0 $0 $1,294,087

    Total $261,963,297 $110,063,415 $95,091,376 $102,169,686 $123,740,876 $128,381,467 $821,410,117 

* Estimated carryover is calculated using unadited actuals as June 30, 2020 and does not take into account additional accruals and adjusting entires.

Fleet Fund
Fund 650

Central Stores Fund
Fund 640

Special Transit Fund
Fund 560

Public Parking
Fund 570

Sewer Fund (continued)
Fund 550
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Capital Improvement Projects by Project Category

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

AIRPORT RUNWAY 16/34 REHABILITATION $2,475 $41,250 -                 -                 -                 $43,725

AIRPORT TAXIWAY A REHAB -                 -                 5,500             27,500           -                 $33,000

TAXIWAY J REHAB 82,500           -                 -                 -                 -                 $82,500

AIRPORT EMERGENCY GENERATOR 16,500           -                 -                 -                 -                 $16,500

AIRPORT RUNWAY 34 WINDSOCK RELOCATION 1,100             -                 -                 -                 -                 $1,100

AIRPORT AIRFIELD SIGNAGE 1,650             -                 -                 -                 -                 $1,650

Total Project Category $104,225 $41,250 $5,500 $27,500 $0 $178,475

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

DISTRIBUTION LINE EXTENSIONS $2,135,897 $2,152,064 $2,831,267 $2,942,653 $3,178,956 $13,240,837

LINE REBUILDS 1,697,787      1,697,787      2,121,787      4,557,834      5,557,834      $15,633,029

SYSTEM SUBSTATION MODIFICATIONS 201,414         201,414         223,259         357,547         447,771         $1,431,405

TRANSFORMERS 4,000,000      4,500,000      4,500,000      4,700,000      4,700,000      $22,400,000

METERS 300,000         300,000         300,000         300,000         300,000         $1,500,000

SERVICES 400,000         400,000         400,000         400,000         400,000         $2,000,000

SUBSTATION BUS & UPGRADES 6,176,366      6,258,312      1,910,730      6,038,450      2,137,465      $22,521,323

MAJOR OVERHEAD/UNDERGROUND CONVERSIONS 500,000         500,000         500,000         500,000         500,000         $2,500,000

MAJOR TRANSMISSION LINE PROJECTS 300,000         300,000         300,000         300,000         300,000         $1,500,000

GENERAL ORDER 165 UPGRADES/REBUILDS/RELOCATION 3,251,297      3,710,554      5,060,145      5,491,648      5,592,151      $23,105,795

SUBSTATION TRANSFORMER ADDITION 3,369,075      3,369,075      3,678,851      6,572,868      8,720,116      $25,709,985

MAJOR FEEDERS 600,000         600,000         600,000         600,000         600,000         $3,000,000

SOUTHERN CALIFORNIA EDISON (SCE) CONDEMNATION COSTS 400,000         400,000         400,000         400,000         400,000         $2,000,000

CABLE REPLACEMENT 3,272,770      3,388,424      4,652,465      8,129,335      8,129,335      $27,572,329

MAJOR STREET LIGHT PROJECTS 600,000         600,000         600,000         600,000         600,000         $3,000,000

NEIGHBORHOOD STREET LIGHT RETROFIT -                 -                 -                 1,034,782      1,064,273      $2,099,055

MAJOR 4-12 KV CONVERSION 2,734,064      2,734,064      2,803,117      4,768,975      5,440,698      $18,480,918

DISTRIBUTION AUTOMATION 340,000         685,000         885,000         685,000         685,000         $3,280,000

CITYWIDE COMMUNICATIONS 1,300,000      1,300,000      1,300,000      1,300,000      1,300,000      $6,500,000

SUPERVISORY CONTROL AND DATA ACQUISITION (SCADA) 600,000         600,000         600,000         600,000         600,000         $3,000,000

BUSINESS SYSTEM TECHNOLOGY UPGRADES 1,600,326      965,636         946,925         -                 -                 $3,512,887

GEOGRAPHIC INFORMATION SYSTEM (GIS) UPGRADE 503,535         517,886         -                 -                 -                 $1,021,421

ENTERPRISE OPERATION DATA MGMT SYSTEM -                 -                 -                 -                 1,001,669      $1,001,669

ADVANCED METERING INFRASTRUCTURE 2,573,624      1,265,943      -                 1,217,391      1,252,087      $6,309,045

OPERATIONAL TECHNOLOGY GOVERNANCE 889,021         994,812         1,377,776      443,130         455,760         $4,160,499

WORK, ASSET, & INVENTORY MGMT SYSTEM 671,380         2,071,543      2,367,313      852,174         626,043         $6,588,453

NETWORK COMMUNICATION SYSTEM 895,173         1,150,857      1,183,657      1,217,391      1,252,087      $5,699,165

LAND MOBILE RADIO -                 344,106         353,913         364,000         374,374         $1,436,393

OUTAGE MANAGEMENT SYSTEM 144,347         471,851         662,848         681,739         701,168         $2,661,953

ADVANCED DISTRIBUTION MANAGEMENT SYSTEM 501,297         786,036         965,864         993,391         1,021,703      $4,268,291

MOBILE APPLICATIONS 1,706,424      -                 236,731         608,695         -                 $2,551,850

Total Project Category $41,663,797 $42,265,364 $41,761,648 $56,657,003 $57,338,490 $239,686,302

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

DATACENTER/DISASTER RECOVERY CAPITAL IMPROVEMENTS $2,909,496 -                 -                 -                 -                 $2,909,496

Total Project Category $2,909,496 $0 $0 $0 $0 $2,909,496

Electric

Airport

Innovation and Technology
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Capital Improvement Projects by Project Category

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

CITY BUILDINGS DEFERRED MAINTENANCE $1,000,000 $1,000,000 $1,000,000 $1,000,000 $1,000,000 $5,000,000

Total Project Category $1,000,000 $1,000,000 $1,000,000 $1,000,000 $1,000,000 $5,000,000

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

FAIRMOUNT PARK LAKE EVANS LAKESHORE ACCESS $325,000 -                 -                 -                 -                 $325,000

Total Project Category $325,000 $0 $0 $0 $0 $325,000

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

GARAGE LED LIGHTING UPGRADE -                 $190,000 -                 -                 -                 $190,000

STRUCTURAL UPGRADES FOR GARAGES 1 & 2 -                 580,000         -                 -                 -                 $580,000

Total Project Category $0 $770,000 $0 $0 $0 $770,000

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

BNSF QUIET ZONE - MISSION INN, 3RD, & SPRUCE $772,700 $788,200 $804,000 -                 -                 $2,364,900

Total Project Category $772,700 $788,200 $804,000 $0 $0 $2,364,900

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

PIERCE ST PUMP STATION REHABILITATION $2,000,000 -                 -                 -                 -                 $2,000,000

WESTERN, MLK, & GARDEN HILL LIFT STATION REHAB 250,000         1,750,000      -                 -                 -                 $2,000,000

PLANT II ACTIVATED SLUDGE REHAB - PHASE I 50,000           700,000         -                 -                 -                 $750,000

SEWER MAIN REPLACEMENT – PALM AVE -                 -                 120,000         1,080,000      -                 $1,200,000

SEWER MAIN REPLACEMENT – PALM & RUBIDOUX -                 -                 75,000           675,000         -                 $750,000

SEWER MAIN REPLACEMENT – RUBIDOUX AVE -                 -                 60,000           540,000         -                 $600,000

SEWER MAIN REPLACEMENT – RUTLAND AVE -                 -                 -                 40,000           360,000         $400,000

SEWER MAIN REPLACEMENT – WEST RUTLAND AVE -                 -                 -                 60,000           540,000         $600,000

SEWER MAIN REPLACEMENT – KMART LOT -                 -                 -                 85,000           765,000         $850,000

GOLDEN AVENUE SEWER PIPE REPLACEMENT -                 -                 -                 60,000           540,000         $600,000

SEWER MAIN REPLACEMENT – S.A.R. TRAIL -                 -                 75,000           675,000         -                 $750,000

SEWER PIPE EXPANSION – GREENPOINT AVE -                 -                 2,000             18,000           -                 $20,000

ARLINGTON VALLEY CHANNEL PIPE REPLACEMENT -                 -                 -                 300,000         2,700,000      $3,000,000

SEWER PIPELINE REPLACEMENT – MORRIS ST -                 -                 -                 200,000         1,800,000      $2,000,000

SEWER MAIN REPLACEMENT – MARKET ST -                 -                 25,000           225,000         -                 $250,000

PRIORITY PIPELINE ASSESSMENT & REPAIR 2,600,000      2,600,000      2,600,000      2,600,000      2,600,000      $13,000,000

UPGRADE INFLUENT FLOW-METERS TO MAG-METERS -                 500,000         5,726,800      -                 -                 $6,226,800

WQCP HEADWORKS AREA REHABILITATION -                 -                 500,000         12,142,600    -                 $12,642,600

WQCP ACTIVATED TREATMENT TRAIN REHAB -                 -                 -                 500,000         5,489,200      $5,989,200

WQCP PLANT II SLUDGE PUMPS I & II REHAB -                 -                 -                 250,000         2,375,700      $2,625,700

WQCP DAFT REHABILITATION -                 -                 -                 500,000         7,528,800      $8,028,800

WQCP MEMBRANE BIOREACTOR REHABILITATION 5,000,000      -                 -                 -                 -                 $5,000,000

WQCP HVAC UPGRADE PHASE II $1,700,000 -                 -                 -                 -                 $1,700,000

Parks, Recreation, and Community Services

Sewer

Municipal Buildings and Facilities

Railroad-Related

Public Parking
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Capital Improvement Projects by Project Category

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

WQCP WAREHOUSE BUILDING REPLACEMENT -                 $100,000 $1,400,000 -                 -                 $1,500,000

WQCP DIGESTER NO. V REHABILITATION 250,000         2,750,000      -                 -                 -                 $3,000,000

WQCP RING INTERCONNECTION PIPE 2,000,000      -                 -                 -                 -                 $2,000,000

WQCP ELECTRIC SWITCHGEAR REPLACEMENT 150,000         350,000         -                 -                 -                 $500,000

WQCP SCADA INFRASTRUCTURE REPLACEMENT -                 250,000         -                 -                 -                 $250,000

WQCP WIFI PHASE II -                 -                 -                 400,000         -                 $400,000

Total Project Category $14,000,000 $9,000,000 $10,583,800 $20,350,600 $24,698,700 $78,633,100

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

MISCELLANEOUS STORM DRAIN CONSTRUCTION $100,000 $100,000 $100,000 $100,000 $100,000 $500,000

VAN BUREN BLVD PUMP STATION REHABILITATION 100,000         -                 -                 -                 -                 $100,000

SIERRA STREET STORM DRAIN IMPROVEMENTS 450,000         -                 -                 -                 -                 $450,000

Total Project Category 650,000$      100,000$      100,000$      100,000$      100,000$      1,050,000$   

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

MISC STREET CONSTRUCTION PROGRAM $300,000 $500,000 $500,000 $500,000 $500,000 $2,300,000

CONTROLLER ASSEMBLY REPLACEMENT 70,000           70,000           70,000           70,000           70,000           $350,000

SPREAD SPECTRUM RADIO REPLACEMENT 10,000           10,000           10,000           10,000           10,000           $50,000

TRAFFIC SIGNAL LOOP REPLACEMENT PROGRAM 25,000           25,000           25,000           25,000           25,000           $125,000

MISCELLANEOUS SIGNAL REVISIONS PROGRAM 100,000         100,000         100,000         100,000         100,000         $500,000

ARTERIAL INTERCONNECT PROGRAM 40,000           40,000           40,000           40,000           40,000           $200,000

TRAFFIC MANAGEMENT CENTER 50,000           50,000           50,000           50,000           50,000           $250,000

NEW TRAFFIC SIGNALS PROGRAM 250,000         250,000         250,000         250,000         250,000         $1,250,000

LED SIGNAL LENSES REPLACEMENT PROGRAM 20,000           20,000           20,000           20,000           20,000           $100,000

MISSION BLVD BRIDGE REPLACEMENT AT SANTA ANA RIVER 800,000         800,000         800,000         -                 -                 $2,400,000

MARKET STREET BRIDGE REPLACEMENT OVER SANTA ANA RIVER 900,000         850,000         850,000         -                 -                 $2,600,000

MISCELLANEOUS TRAFFIC PROJECTS 75,000           75,000           75,000           75,000           75,000           $375,000

MAJOR STREETS REHABILITATION 500,000         2,400,000      2,400,000      2,400,000      2,400,000      $10,100,000

CURB AND GUTTER REPAIR PROGRAM 200,000         200,000         200,000         200,000         200,000         $1,000,000

MINOR STREET REHABILITATION PROGRAM 1,500,000      1,500,000      1,500,000      1,500,000      1,500,000      $7,500,000

SIDEWALK/TRAIL CONSTRUCTION PROGRAM 300,000         300,000         300,000         300,000         300,000         $1,500,000

SIDEWALK REPAIR PROGRAM 300,000         300,000         300,000         300,000         300,000         $1,500,000

PEDESTRIAN RAMPS PROGRAM 300,000         300,000         300,000         300,000         300,000         $1,500,000

CDBG STREET IMPROVEMENTS - MATCHING FUNDS 150,000         150,000         150,000         150,000         150,000         $750,000

MINOR STREET PRESERVATION PROGRAM (SLURRY/ARAM) 500,000         500,000         500,000         500,000         500,000         $2,500,000

MEASURE Z PAVEMENT REHABILITATION & IMPROVEMENTS 4,375,000      4,375,000      4,375,000      2,875,000      2,875,000      $18,875,000

ADAIR SIDEWALK-JO JO RANDOLPH 75,000           -                 -                 -                 -                 $75,000

BONITA SIDEWALK-TYLER PENDLETON 135,000         -                 -                 -                 -                 $135,000

LOCAL ROADWAY SAFETY IMPROVEMENT PLAN 100,000         -                 -                 -                 -                 $100,000

BERRY RD WIDENING - SELINA STREET TO BUSH AVE -                 800,000         -                 -                 -                 $800,000

VICTORIA AT WASHINGTON SOUTHBOUND MERGE LANE 55,000           -                 -                 -                 -                 $55,000

SIDEWALK FRONTING PATRICIA BEATTY 125,000         -                 -                 -                 -                 $125,000

TRAFFIC SIGNAL EMERGENCY VEHICLE REPLACEMENT 10,000           10,000           10,000           10,000           10,000           $50,000

RMRA TRAFFIC IMPROVEMENTS FY2020/21 6,196,792      -                 -                 -                 -                 $6,196,792

RMRA TRAFFIC IMPROVEMENTS FY2021/22 -                 6,000,000      6,000,000      6,000,000      6,000,000      $24,000,000

KNOEFLER STREET IMPROVEMENTS 560,000         -                 -                 -                 -                 $560,000

Total Project Category $18,021,792 $19,625,000 $18,825,000 $15,675,000 $15,675,000 $87,821,792

Transportation

Storm Drain

Sewer (continued)
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Capital Improvement Projects by Project Category

Project Name 2020/21 2021/22 2022/23 2023/24 2024/25 Total

DISTRIBUTION AUTOMATION/RELIABILITY $604,242 $161,120 $591,828 $620,869 $513,356 $2,491,415

SYSTEM EXPANSION 1,734,262      1,783,689      1,834,524      1,886,808      1,625,678      $8,864,961

METERS 895,173         920,686         946,925         973,913         1,001,669      $4,738,366

WATER STOCK 10,880           11,190           11,509           11,837           11,837           $57,253

DISTRIBUTION SYSTEM FACILITIES REPLACEMENTS 2,599,532      2,652,243      2,706,457      2,012,216      2,012,216      $11,982,664

MAIN REPLACEMENTS PROGRAM 3,900,782      4,579,715      5,943,769      9,130,432      10,342,235    $33,896,933

TRANSMISSION MAINS 10,353,799    6,214,629      6,320,727      9,836,519      5,884,807      $38,610,481

FACILITY REHABILITATION PROGRAM 1,454,657      920,686         1,716,302      1,339,129      1,815,525      $7,246,299

SEVEN OAKS DAM CONSERVATION - ENHANCED RECHARGE 2,797,417      -                 -                 -                 -                 $2,797,417

HYDRANT CHECK VALVES 97,916           100,707         103,577         106,529         106,529         $515,258

ADVANCED METERING INFRASTRUCTURE 2,349,830      1,979,475      1,420,388      2,069,565      626,043         $8,445,301

OPERATIONAL TECHNOLOGY GOVERNANCE 125,325         128,896         231,998         238,609         245,409         $970,237

WORK, ASSET, & INVENTORY MGMT SYSTEM -                 -                 603,665         365,217         751,252         $1,720,134

NETWORK COMMUNICATION SYSTEM 223,793         230,171         710,194         -                 -                 $1,164,158

LAND MOBILE RADIO -                 322,240         -                 -                 -                 $322,240

MOBILE APPLICATIONS -                 -                 503,054         -                 -                 $503,054

SCADA UPGRADE & SYSTEM AUTOMATION 671,380         920,686         946,925         730,435         1,502,504      $4,771,930

POTABLE/IRRIGATION WELL REPLACEMENT 2,797,417      575,429         4,497,896      608,695         3,130,217      $11,609,654

Total Project Category $30,616,405 $21,501,562 $29,089,738 $29,930,773 $29,569,277 $140,707,755

    Total $110,063,415 $95,091,376 $102,169,686 $123,740,876 $128,381,467 $559,446,820 

Water
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Fund 2020/21 2021/22 2022/23 2023/24 2024/25

401 General Fund Capital Projects $1,046,541 -                          -                          -                          -                          
420 Measure Z Capital (transferred from 110) 7,237,955 5,375,000 5,375,000 3,875,000 3,875,000

Total General Funds $8,284,496 $5,375,000 $5,375,000 $3,875,000 $3,875,000

Fund 2020/21 2021/22 2022/23 2023/24 2024/25

230 Gas Tax $14,509,047 $14,939,819 $15,383,514 $15,840,519 $16,311,234

432 Measure A 6,649,000 6,714,000 6,780,000 6,846,000 6,913,000

433 Transportation DIF 700,000 720,100 740,803 762,127 784,091
Total Transporation Funds $21,858,047 $22,373,919 $22,904,317 $23,448,646 $24,008,325

Fund 2020/21 2021/22 2022/23 2023/24 2024/25

215 Grants and Restricted Programs Fund $2,171,796 $2,186,266 $1,997,220 $1,997,220 $1,997,220
Total Grants Funds $2,171,796 $2,186,266 $1,997,220 $1,997,220 $1,997,220

Fund 2020/21 2021/22 2022/23 2023/24 2024/25

510 Electric $435,365,417 $450,420,511 $470,739,206 $497,380,831 $519,932,561

520 Water 107,116,796       105,467,931       117,525,870       120,887,599       124,663,960

530 Airport 1,546,244           1,572,291           1,615,682           1,660,332           1,706,277

540 Refuse 25,222,325         25,256,125         25,507,887         25,762,166         26,018,988

550 Sewer 71,210,352         72,173,882         73,315,836         74,483,645         75,678,051

560 Special Transit 5,221,644           5,477,438           5,637,463           5,697,201           5,783,449

570 Public Parking 7,381,402           7,611,776           7,832,430           8,059,484           8,293,122
Total Enterprise Funds* $653,064,180 $667,979,954 $702,174,374 $733,931,258 $762,076,408

Fund 2020/21 2021/22 2022/23 2023/24 2024/25

240 Air Quality Management District $650,000 $650,000 $656,500 $663,065 $669,695

410 Storm Drain DIF 247,500              254,550              261,812              269,291              276,994              

411 Special Capital Improvement 2,474,588           2,480,016           2,480,016           2,480,016           2,480,016           

413 Regional Park Special Capital Imp 383,000              383,000              363,000              363,000              363,000              

640 Central Stores 1,342,638           1,342,638           1,342,638           1,342,638           1,342,638           

650 Central Garage 13,496,361         13,678,994         14,007,289         14,343,464         14,687,707         
Total Other Funds $18,594,087 $18,789,198 $19,111,255 $19,461,474 $19,820,050

Total Revenue $703,972,606 $716,704,337 $751,562,166 $782,713,598 $811,777,003

* Bond proceeds are included in the Electric and Water funds revenue estimates.  

Grants Funds

Enterprise Funds*

Other Funds

Revenue Summary by Fund

General Funds

Transporation Funds
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      Capital Improvement Program 

Project Category Overview:  Airport 

 

 

Introduction  
The Airport Division of the General Services Department is responsible for 
ensuring safe municipal and corporation aviation operations on more than 
525 acres. The Division oversees the Airport leasing program, which includes 
more than 120 leases, manages the Airport capital improvement program, 
infrastructure maintenance, and provides administration of Federal Aviation 
Administration policies and procedures. With continued economic 
stabilization and anticipated future development at the Airport, failure to 
address an aging airport infrastructure will negatively impact operations, so it 
is of vital importance to continue to maintain capital projects within the 
airport. 
 
 
One-Year Budget and Five-Year Plan 

The five-year capital 
improvement program for the 
Airport totals $178,475. 
Implementation of the CIP is 
consistent with the goals set 
forth in the 2009 Airport Master 
Plan. With steady economic 
recovery, Riverside Municipal 
Airport experienced growth 
with the addition of a seventh 
aviation school providing the 
Inland Empire and surrounding 
counties with the largest 

selection of education in flight, mechanical, and degree programs in the 
region.  
 
Airport CIP projects include airfield projects that are 90% funded through the 
Federal Aviation Administration’s (FAA) Airport Improvement Program. 
Federal funding requests for airfield projects are submitted each year to the 
FAA. The City competes for priority status with other airports for project funding 
in the FAA’s Western-Pacific Region. Other Airport facility projects that do not 
qualify for FAA funding are funded through the Airport’s fund balance and 
operating budget.  
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City of Riverside 

Project Category Overview:  Airport 

 

 

Project Highlights:  
Emergency Generator 
Riverside Municipal Airport is not currently equipped with an emergency 
generator. In the event the City power source is interrupted, airfield lighting 
would be impacted. The propane generator will be installed on a concrete 
pad adjacent to the north side of the lighting vault and enclosed by an 8-foot 
chain-link fence.  
 
Airfield Signage 
Riverside Municipal Airport is equipped with both Siemens and Lumacurve 
airfield signs. Extensive sun exposure has resulted in the fading of several 
taxiway and runway signs impacting airfield safety. The Airfield Signage 
Replacement project will include replacing faded signs and replacing airfield 
lighting with LED technology. 
 
Relocate Runway 34 Windsock 
An unlighted wind cone is located just east of Runway 16 and within the 
Runway Object Free Area (ROFA), referred to as the safety area for Runway 
16/34. The current location serves as an obstacle for planes arriving or 
departing. The windsock will be relocated approximately 50 feet farther east 
and outside of the ROFA. 
 
Taxiway A Design and Rehabilitation 
The rehabilitation of Taxiway A will consist of repairing cracks and sub-base 
failure on the entire 5,401-foot taxiway. Taxiway A runs parallel to Runway 9/27 
located on the north side of the airport and is the main taxiway used for 
landings during crosswinds. Taxiway A has not been extensively repaired since 
initial construction. Taxiway A provides access to Runway 9/27 and tenant 
hangars located on the east side of the airport. Funds used in FY 2020/21 and 
2021/22 are dedicated to project design costs. 
 
Funding for CIP projects is typically derived from federal and state funds 
(Federal Aviation Administration and California Department of Transportation 
(CALTRANS) Division of Aeronautics grant programs. Other funding sources 
include rent revenues from airport buildings, hangars and ground leases, tie-
down fees, and fuel flowage fees.  
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      Capital Improvement Program 

Project Category Overview:  Airport 

 

 

Key Revenues and Funding Sources 

 
Fund Funding Source Adopted 

2020/21 
Proposed 

2021/22 
Proposed 

2022/23 
Proposed 

2023/24 
Proposed 

2024/25 Total 

530 Airport Fund  $104,225 $41,250 $5,500 $27,500 - $178,475 

  TOTAL $104,225 $41,250 $5,500 $27,500 $0 $178,475 

 
 
Projects by Type of Improvement 
 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Airport       

Airport - Taxiway A Rehab - - $5,500 $27,500 - $33,000 

Airport - Taxiway J Rehab 82,500 - - - - $82,500 

Airport Airfield Signage 1,650 - - - - $1,650 

Airport Emergency Generator 16,500 - - - - $16,500 

Runway 16/34 Rehabilitation 2,475 41,250 - - - $43,725 
Airport Runway 34 Windsock 
Relocation 1,100 - - - - $1,100 

TOTAL  $104,225 $41,250 $5,500 $27,500 $0 $178,475 

 
Top Unfunded Projects 
Airport identified four capital projects without a funding source. 
 

Project Name Estimated 
Project Cost 

Unfunded 
Amount 

1. Airport Facilities Terminal Patio Deck $150,000 $16,726 

2. Upgrade Terminal Restrooms ADA 66,600 66,600 

3. Airport - Taxiway J Rehab 1,665,000 1,582,500 

4. Airport Runway 16/34 Rehabilitation 795,000 751,275 

TOTAL $2,676,600 $2,417,101 
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City of Riverside 

Project Category Overview:  Airport 

 

 

Project Map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: This map includes all active and new capital improvement projects. Ongoing and citywide projects are not included on the 
map. To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.  

 
 
Distribution by Ward  

 
Ward Five-Year Total 

Ward 1 $- 

Ward 2 - 

Ward 3 178,475 

Ward 4 - 

Ward 5 - 

Ward 6 - 

Ward 7 - 

All Wards - 

 Total $178,475 

 
 

‐

‐

$0.2M

‐

‐

‐

‐

‐

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7

 All Wards
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  AIRPORT RUNWAY 16/34 REHABILITATION 
PROJECT NUMBER 2666 COUNCIL WARD 3 
PROJECT CATEGORY Airport 
PROJECT LOCATION Riverside Municipal Airport, 6951 Flight Road 
 
PROJECT DESCRIPTION 
Rehabilitation of Runway 16/34 will consist of improving existing infrastructure through 
repairing cracks in pavement, re-paving, and painting the entire 2,850 feet x 50 feet 
runway located on the North-west side of the airport.  Runway 16/34 runs North to 
South and allows aircraft to land during crosswinds.  The runway has not been repaired 
or modified since the initial construction.  City fund portion to be funded by Airport 
Fund Balance. 
 
PROJECT STATUS 
The design phase will occur in FY 2021/22 and the construction phase will occur in FY 
2022/23.  Remaining project funds will be obtained through FAA and State grants and 
will be appropriated toward the project when grants are awarded. Both FAA and State 
design grants are anticipated to be awarded in FY 2021/22 and construction grants 
anticipated to be awarded in FY 2022/23. 
 
OPERATING BUDGET IMPACT 
Following rehabilitation, there will be no significant expenditures from Runway 16/34 
aside from general weed abatement, professional services associated with re-paint of 
runway striping, and annual safety light maintenance, all of which are currently 
budgeted to maintain the existing runway. 
  

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$795,000 $0 $43,725 $751,275 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

530 Airport Fund $2,475 $41,250 - - - $43,725 

 TOTAL $2,475 $41,250 $0 $0 $0 $43,725 

 

49



 

 

GENERAL SERVICES – AIRPORT 
Capital Improvement Program FY 2020/21 - 2024/25 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

 

 

   

 

  AIRPORT - TAXIWAY A REHABILITATION 
PROJECT NUMBER 2667 COUNCIL WARD 3 
PROJECT CATEGORY Airport 
PROJECT LOCATION Riverside Municipal Airport, 6951 Flight Road 
 
PROJECT DESCRIPTION 
Taxiway A was reconstructed in 2007 and runs parallel to Runway 9/27 located on the 
north side of the airport and is the main taxiway used for airport operations. Years of 
weathering and sub-base failure have impacted the surface of the 5,401 feet taxiway 
and have a direct impact on airport operations. Additionally, Taxiway A provides 
access to Runway 9/27 and tenant hangars located on the east side of the airport. 
Without access to Runway 9/27 large planes and jets would not have the ability to take 
off and land at Riverside Municipal Airport impacting the Airport's performance and 
Federal funding. 
 
PROJECT STATUS 
Design phase for the Taxiway A Rehabilitation will take place in FY 2020/21 and 
construction phase in FY 2022/23. Remaining project funds will be obtained through 
FAA and State grants and will be appropriated when the grants are awarded. Both 
FAA and State design grants are anticipated to be awarded in FY 2020/21 and 
construction grants anticipated to be awarded in FY 2022/23. 
 
OPERATING BUDGET IMPACT 
Following rehabilitation, there will be no significant fiscal impact from Taxiway A aside 
from general weed abatement and professional services associated with re-paint of 
taxiway striping, and annual safety-light maintenance, both of which are currently 
budgeted to maintain the existing runway. 
  

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$620,000 $20,000 $600,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

530 Airport Fund - - $5,500 $27,500 - $33,000 

Grant* Federal Capital Grants - - 90,000 450,000 - 540,000 

Grant* State Capital Grants - - 4,500 22,500 - 27,00 
 TOTAL $0 $0 $100,000 $500,000 $0 $600,000 

*Appropriation of funds contingent on grant award.  For planning purposes only.  Not included in in other areas of the CIP. 
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  AIRPORT - TAXIWAY J REHABILITATION 
PROJECT NUMBER 2668 COUNCIL WARD 3 
PROJECT CATEGORY Airport 
PROJECT LOCATION Riverside Municipal Airport, 6951 Flight Road 
 
PROJECT DESCRIPTION 
Taxiway J was developed in 1987 and runs parallel to Runway 16/34 allowing planes to 
land during Santa Ana crosswinds on the southwest side of the airport. Major 
construction to Taxiway J was completed in 2004 with the extension of the taxiway. 
Years of weathering and sub-base failure have impacted the taxiway which is cracked 
and damaged. In addition to providing access to Runway 16/34, Taxiway J provides 
access to tenant hangars located on the north side of the airport. City fund portion to 
be funded by Airport Fund Balance. 
 
PROJECT STATUS 
Design phase will occur in FY 2018/19 and construction phase will occur in FY 2020/21. 
Remaining project funds will be obtained through FAA and State grants and will be 
appropriated toward the project when grants are awarded. Anticipated FAA and 
State design grants awarded in FY 2018/19 with construction in FY 2020/21.  FAA 
determined project is not eligible for federal funding.  Project has been removed from 
Capital Improvement schedule. 
 
OPERATING BUDGET IMPACT 
Following rehabilitation there will be no significant fiscal impact from Taxiway J aside 
from general weed abatement, professional services associated with re-paint of 
taxiway striping, and annual safety-light maintenance, all of which are currently 
budgeted to maintain the existing runway. 
  

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,665,000 $0 $82,500 $1,582,500 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

530 Airport Fund $82,500 - - - - $82,500 

 TOTAL $82,500 $0 $0 $0 $0 $82,500 
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  AIRPORT EMERGENCY GENERATOR 
PROJECT NUMBER 2704 COUNCIL WARD 3 
PROJECT CATEGORY Airport 
PROJECT LOCATION Riverside Municipal Airport, 6951 Flight Road 
 
PROJECT DESCRIPTION 
Riverside Municipal Airport is not currently equipped with an emergency generator.  In 
the event the City power source is interrupted airfield lighting would be impacted.  A 
propane generator will be installed on a concrete pad adjacent to the north side of 
the lighting vault and enclosed by an 8-foot chain-link fence. 
 
PROJECT STATUS 
Design phase for the Airport Emergency Generator will take place in FY 2020/21 and 
will include the use of an on-call consultant to identify power needs and generator 
specifications. 
 
OPERATING BUDGET IMPACT 
Following the installation of the Airport emergency generator, there will be no 
significant fiscal impact outside of annual equipment maintenance which is currently 
absorbed in the Airport operating budget. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$316,500 $300,000 $16,500 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

530 Airport Fund $16,500 - - - - $16,500 

 TOTAL $16,500 $0 $0 $0 $0 $16,500 
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  AIRPORT RUNWAY 34 WINDSOCK RELOCATION 
PROJECT NUMBER 2706 COUNCIL WARD 3 
PROJECT CATEGORY Airport 
PROJECT LOCATION Riverside Municipal Airport, 6951 Flight Road 
 
PROJECT DESCRIPTION 
An unlighted wind cone is located just east of Runway 16 and within the Runway 
Object Free Area (ROFA), which does not comply with FAA guidance set forth in AC 
150/5300-13A, Airport Design. Paragraph 309 of the AC states that the ROFA clearing 
standard requires “clearing the ROFA of above-ground objects protruding above the 
nearest point of the RSA”. The windsock will be relocated approximately 50 feet farther 
east and outside of the ROFA. 
 
PROJECT STATUS 
Design consultant work began in April 2020 and a Request for Bid for construction 
services (Bid No. 7762) posted on May 28, 2020.  Award of Bid for a Construction 
Agreement for the selected vendor is scheduled for the August 18, 2020, City Council 
Meeting.  Construction project estimated to begin in September 2020. 
 
OPERATING BUDGET IMPACT 
Following the installation of the relocated windsock, there will be no significant fiscal 
impact outside of annual equipment maintenance which is currently absorbed in the 
Airport operating budget. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$21,100 $20,000 $1,100 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

530 Airport Fund $1,100 - - - - $1,100 

 TOTAL $1,100 $0 $0 $0 $0 $1,100 

 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 
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  AIRPORT AIRFIELD SIGNAGE 
PROJECT NUMBER 2707 COUNCIL WARD 3 
PROJECT CATEGORY Airport 
PROJECT LOCATION Riverside Municipal Airport, 6951 Flight Road 
 
PROJECT DESCRIPTION 
Riverside Municipal Airport is equipped with both Siemens and Lumacurve airfield signs.  
Extensive sun exposure has resulted in the fading of several taxiway and runway signs 
impacting airfield safety.  The Airfield Signage Replacement project will include 
replacing faded signs and replacing airfield lighting with LED technology. 
 
PROJECT STATUS 
Design phase for the Airfield Signage Replacement will take place in FY 2020/21 and 
will include the use of an on-call consultant to identify power needs, FAA airfield 
requirements, and equipment specifications.  
 
OPERATING BUDGET IMPACT 
Following the installation of the airfield signage, there will be no significant fiscal impact 
outside of annual equipment maintenance which is currently absorbed in the Airport 
operating budget. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$31,650 $30,000 $1,650 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

530 Airport Fund $1,650 - - - - $1,650 

 TOTAL $1,650 $0 $0 $0 $0 $1,650 

 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 
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  AIRPORT FACILITIES TERMINAL PATIO DECK 
PROJECT NUMBER 9034 COUNCIL WARD 3 
PROJECT CATEGORY Airport 
PROJECT LOCATION Riverside Municipal Airport, 6951 Flight Road 
 
PROJECT DESCRIPTION 
The Airport terminal building was originally built in 1968 and featured a patio deck that 
allowed patrons to view runway operations. The patio deck serves as an entrance/exit 
to the terminal building second floor and viewing area for guests with limited mobility.  
Major repairs to the deck were made in 1998 and minor repairs have been made over 
the past five years including the removal of the eastern staircase and rehabilitation of 
the western staircase. Years of sun exposure, termite damage, and aging of the 
structure has resulted in an unusable deck. The current structure requires a seismic 
study and design plan to reconstruct the patio deck. 
 
PROJECT STATUS 
The project is currently on hold due to COVID-19.  
 
OPERATING BUDGET IMPACT 
Minor ongoing maintenance will be required including professional services associated 
with painting of structure, both of which are currently budgeted to maintain the 
existing deck. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$150,000 $133,274 $0 $16,726 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  APRON ASPHALT PROJECT PHASE I 
PROJECT NUMBER 9038 COUNCIL WARD 3 
PROJECT CATEGORY Airport 
PROJECT LOCATION Riverside Municipal Airport, 6951 Flight Road 
 
PROJECT DESCRIPTION 
The Apron Asphalt Project will consist of project phases. Phase One will include the 
Upper Port-A-Port apron which is located on the northeast side of the Air Traffic Control 
tower. The approximate 160,060 square feet apron was originally constructed in 1984 to 
accommodate a multi-unit ground lease housing 17 privately owned hangars and 24 
tie-down spaces. Years of weathering and sub-base failure have impacted the apron 
which is cracked and damaged. City fund portion to be funded by Airport Fund 
Balance. 
 
PROJECT STATUS 
Construction is scheduled to be completed with final invoicing and payments taking 
place in FY 2020/21. 
 
OPERATING BUDGET IMPACT 
Following project completion, there will be no significant fiscal impact to maintain the 
asphalt. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$100,000 $100,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  AIRPORT CAMERA SYSTEM 
PROJECT NUMBER 9039 COUNCIL WARD 3 
PROJECT CATEGORY Airport 
PROJECT LOCATION Riverside Municipal Airport, 6951 Flight Road 
 
PROJECT DESCRIPTION 
The Airport Camera System Project will consist of procurement and installation of 19 
fixed cameras at various locations throughout Riverside Municipal Airport. The cameras 
will aid with maintaining security at the airport in key locations including access gates, 
airport apron, and designated airport facilities.  The objective of the Airport Camera 
System project is to update the existing camera system to current industry standards in 
alignment with the City's existing camera operating system and data firewall. 
 
PROJECT STATUS 
Project completed; final project closeout is in process. 
 
OPERATING BUDGET IMPACT 
Impact to the operating budget would consist of an annual licensing fee estimated at 
$500. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$121,880 $121,880 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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      Capital Improvement Program 

Project Category Overview:  Electric 

 

 

Introduction  
The Electric Public Utilities is responsible for providing electric service to 
customers with a service area population of approximately 327,000 
encompassing 82 square miles.  
 
Electric service is provided to 110,480 metered customers. The Public Utilities 
Department owns, maintains, and operates 99 circuit miles of transmission 
lines, 1,351 circuit miles of distribution lines, 14 substations, and nine power 
generating plants located across three facilities with a total net power output 
of 258 megawatts. 
 
The Department provides the highest quality, reliable electric utility services 
for our customers at the lowest rates possible to benefit the community, while 
maintaining a financially sound utility.  Compared to other local utilities, 
Riverside’s rates are lower, reliability is higher, and more funds are returned to 
the local community in the way of low-income assistance, rebates, and 
community support. The Department is committed to renewable power, 
energy conservation, and community education.  

One-Year Budget and Five-Year Plan 
The five-year Capital Improvement Plan (CIP) for the electric system, totaling 
$239,686,302, is required to implement the ten-year electric infrastructure plan, 
which includes maintaining the most vital infrastructure.  
 
This CIP is supported by the Electric Utility’s proposed rate plan and addresses 
the need to replace and refurbish the most vital portions of Riverside’s aging 
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electric infrastructure from FY 2020/21 through FY 2024/25, including funding 
to replace substation transformers, various overhead equipment such as 
poles and wires, and underground cable, conduits, and switches.  It also 
includes funding to implement various technology, security, and system 
automation tools and applications to improve cyber security and overall 
efficiency. 
 
Project Types: 
Overhead - Projects to rehabilitate and replace overhead equipment, such 
as poles, wires, transformers, and streetlights to improve safety, efficiency and 
reliability of the electric system.  
 
Recurring/Obligation to Serve - Recurring projects related to the Electric 
Utility’s obligation to serve new incoming load requirements. 
 
Substation - Projects related to neighborhood power stations to efficiently 
distribute power throughout the service area. 
 
System Automation - Technology, security, and system automation tools and 
applications to improve cyber security and overall efficiency. 
 
Underground - Projects to rehabilitate and replace underground conduits, 
cables, and related equipment to improve safety, efficiency, and reliability of 
the electric system. 
 
 
Key Revenues and Funding Sources 

The five-year Electric CIP will be supported by various funding sources. The 
majority of the CIP ($194.2 million) will be funded by bond proceeds.  
Approximately $32.8 million will be funded from a combination of rates and 
fund reserves, and $12.7 million will be funded from contributions in aid of 
construction. 
 

Fund Funding Source Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

510 Electric Fund $41,663,797 $42,265,364 $41,761,648 $56,657,003 $57,338,490 $239,686,302 

  TOTAL $41,663,797 $42,265,364 $41,761,648 $56,657,003 $57,338,490 $239,686,302 
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Projects by Type of Improvement 
 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Overhead       
General Order 165 (GO 165) 
Upgrades/Line Rebuilds/Relocate-
Overhead 

$3,251,297  $3,710,554  $5,060,145  $5,491,648 $5,592,151   $23,105,795  

Major 4-12 kV Conversion 2,734,064  2,734,064  2,803,117  4,768,975 5,440,698   $18,480,918  

Neighborhood Street Light Retrofit - - - 1,034,782 1,064,273   $2,099,055  

    Total Overhead $5,985,361  $6,444,618  $7,863,262  $11,295,405 $12,097,122  $ 43,685,768  
Recurring/Obligation to Serve       
Citywide Communications $1,300,000  $1,300,000  $1,300,000  $1,300,000 $1,300,000   $6,500,000  

Major Feeders 600,000  600,000  600,000  600,000 600,000   $3,000,000  
Major Overhead/Underground 
Conversions 500,000  500,000  500,000  500,000 500,000   $2,500,000  

Major Transmission Line Projects 300,000  300,000  300,000  300,000 300,000   $1,500,000  

Meters 300,000  300,000  300,000  300,000 300,000   $1,500,000  

Services 400,000  400,000  400,000  400,000 400,000   $2,000,000  
Southern California Edison (SCE) 
Condemnation Costs 400,000  400,000  400,000  400,000 400,000   $2,000,000  

Supervisory Control and Data 
Acquisition (SCADA) 600,000  600,000  600,000  600,000 600,000   $3,000,000  

Transformers 4,000,000  4,500,000  4,500,000  4,700,000 4,700,000   $22,400,000  
    Total Recurring/Obligation to  
    Serve $8,400,000  $8,900,000  $8,900,000  $9,100,000 $9,100,000  $44,400,000  

Substation       
Substation Bus & Upgrades $6,176,366  $6,258,312  $1,910,730  $6,038,450 $2,137,465   $22,521,323  

Substation Transformer Addition 3,369,075  3,369,075  3,678,851  6,572,868 8,720,116   $25,709,985  

System Substation Modifications 201,414  201,414  223,259  357,547 447,771   $1,431,405  

    Total Substation $9,746,855  $9,828,801  $5,812,840  $12,968,865 $11,305,352   $49,662,713  
System Automation       
Advanced Distribution Manage 
System $501,297  $786,036  $965,864  $993,391 $1,021,703   $4,268,291  

Advanced Metering Infrastructure 2,573,624  1,265,943  - 1,217,391 1,252,087   $6,309,045  

Business System Technology Upgrades 1,600,326  965,636  946,925  - -  $3,512,887  

Distribution Line Extensions 340,000  685,000  885,000  685,000 685,000   $3,280,000  

Distribution Automation 503,535  517,886  - - -  $1,021,421  
Enterprise Operation Data 
Management System - - - - 1,001,669 $1,001,669 

Land Mobile Radio 0  344,106  353,913  364,000 374,374   $1,436,393  

Major Street Light Projects 600,000  600,000  600,000  600,000 600,000   $3,000,000  

Network Communication System 1,706,424  0  236,731  608,695 0   $2,551,850  

Operational Technology Governance 895,173  1,150,857  1,183,657  1,217,391 1,252,087   $5,699,165  

Outage Management System 889,021  994,812  1,377,776  443,130 455,760   $4,160,499  

Substation Bus & Upgrades 144,347  471,851  662,848  681,739 701,168   $2,661,953  
Work, Asset, & Inventory 
Management System 671,380  2,071,543  2,367,313  852,174 626,043   $6,588,453  

    Total Automation $10,425,127  $9,853,670  $9,580,027  $7,662,911 $7,662,911   $45,491,626  
Underground       
Cable Replacement $3,272,770  $3,388,424  $4,652,465  $8,129,335 $8,129,335   $27,572,329  

Distribution Line Extensions 2,135,897  2,152,064  2,831,267  2,942,653 3,178,956   $13,240,837  

Line Rebuilds 1,697,787  1,697,787  2,121,787  4,557,834 5,557,834   $15,633,029  

    Total Underground $7,106,454  $7,238,275  $9,605,519  $15,629,822 $16,866,125   $56,446,195  
TOTAL $41,663,797  $42,265,364  $41,761,648  $56,657,003 $57,338,490  $239,686,302 
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Top Unfunded Projects by Priority 
Electric Utility identified seven capital projects without a funding source. 
 

Project Name Estimated 
Project Cost 

Unfunded 
Amount 

1. RIVERSIDE TRANSMISSION RELIABILITY PROJECT (RTRP) $162,756,354 $60,386,067 
2. GIS UPGRADES/INTEGRATIONS, CUSTOMER ENGAGEMENT PORTAL &OTHER 
SYSTEM AUTOMATION 4,015,000 4,015,000 

3. DISTRIBUTION TRANSFORMER LOAD MANAGEMENT SYSTEM 1,000,000 1,000,000 

4. NEW HUNTER SUBSTATION 28,000,000 28,000,000 

5. ADVANCED METERING INFRASTRUCTURE 27,663,930 12,267,025 

6. CABLE REPLACEMENT - ARLINGTON AND ARLANZA 12,000,000 12,000,000 

7. REMOTE MONITORING OF SUBSTATION TRANSFORMERS AND 69KV EQUIPMENT 8,000,000 8,000,000 

TOTAL $243,435,284 $125,668,092 
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Project Map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: This map includes all active and new capital improvement projects.  Ongoing and citywide projects are not included on the 
map.  To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.   

 
Distribution by Ward  

 
Ward Five-Year Total  

Ward 1 $- 

Ward 2 -   

Ward 3 - 

Ward 4 -  

Ward 5 -   

Ward 6 -   

Ward 7 -  

All Wards $239,686,302  

 Total $239,686,302 

 
 

‐

‐

‐

‐

‐

‐

‐

$239.7M

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7

 All Wards
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  DISTRIBUTION LINE EXTENSIONS 
PROJECT NUMBER 470601E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Installation and extension of primary overhead and underground distribution lines to 
serve new residential, commercial, and industrial customers, as well as existing 
customer upgrades.  Installation and extension of primary overhead and underground 
distribution lines to serve new Electric Vehicle (EV) charging stations.  Design of line 
extensions complements existing facilities and considers overall area electrical load 
requirements. 
 
PROJECT STATUS 
Ongoing installation of new primary distribution lines, which contributes to fulfilling our 
obligation to serve electric load requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $73,103,736 $13,240,837 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $2,135,897 $2,152,064 $2,831,267 $2,942,653 $3,178,956 $13,240,837 

 TOTAL $2,135,897 $2,152,064 $2,831,267 $2,942,653 $3,178,956 $13,240,837 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  LINE REBUILDS 
PROJECT NUMBER 470603E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Replacement for end-of-life distribution line equipment and reconfiguration of 
overhead and underground distribution lines.  Includes replacement of older oil-filled 
underground switches.  Projects reduce hazardous materials, add system flexibility, and 
support electric reliability goals. 
 
PROJECT STATUS 
Ongoing replacement of primary distribution lines, which contributes to fulfilling our 
obligation to serve electric load requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $33,895,624 $15,633,029 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $1,697,787 $1,697,787 $2,121,787 $4,557,834 $5,557,837 $15,633,029 

 TOTAL $1,697,787 $1,697,787 $2,121,787 $4,557,834 $5,557,837 $15,633,029 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  STREET LIGHTING 
PROJECT NUMBER 470607E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Installation of equipment for minor system needs.  This project does not include major 
street light projects.  Design complements existing facilities and considers overall area 
lighting needs and current design standards.  
 
PROJECT STATUS 
Ongoing installation of minor streetlight needs, which contributes to fulfilling our 
obligation to meet lighting standards and contribute to safe environments within the 
city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $6,202,509 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  SYSTEM SUBSTATION MODIFICATIONS 
PROJECT NUMBER 470608E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Projects include modifications, replacements, and improvements of substation 
equipment and protection devices for minor system needs.  This project does not 
include major substation modifications or projects.  Design of substation components 
complements existing facilities and improves overall system operation. 
 
PROJECT STATUS 
Ongoing replacement and minor modifications to substation equipment, which 
contributes to fulfilling our obligation to serve electric load requirements within the city 
service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding *  Five Year Plan REMAINING NEEDED 

Ongoing $3,279,036 $1,431,405 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $201,414 $201,414 $223,259 $357,547 $447,771 $1,431,405 

 TOTAL $201,414 $201,414 $223,259 $357,547 $447,771 $1,431,405 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  TRANSFORMERS 
PROJECT NUMBER 470611E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Enables the purchase of transformers for new residential, commercial, and industrial 
services as well as customer load additions.  Also, includes the purchase and 
installation of transformers to replace existing transformers found to be inoperable or 
damaged.  Analysis of overall area load requirements is considered prior to upgrading 
or replacing transformers. 
 
PROJECT STATUS 
Ongoing purchase of distribution transformers, which contributes to fulfilling our 
obligation to serve electric load requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $41,263,561 $22,400,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $4,000,000 $4,500,000 $4,500,000 $4,700,000 $4,700,000 $22,400,000 

 TOTAL $4,000,000 $4,500,000 $4,500,000 $4,700,000 $4,700,000 $22,400,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  CAPACITORS-REGULATORS 
PROJECT NUMBER 470612E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Includes the purchase and installation of new capacitors and regulator devices to 
maintain electric power quality to Riverside customers.  Locations are prioritized based 
on a comprehensive analysis of power quality modeling and system parameters.  The 
design of these equipment installations complements existing facilities and considers 
overall area electrical requirements. 
 
PROJECT STATUS 
Ongoing purchase and installation of distribution system capacitors and regulators, 
which contributes to fulfilling our obligation to serve electric load requirements within 
the city service area. 
 
OPERATING BUDGET IMPACT 
No impact for ongoing projects. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $509,191 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  METERS 
PROJECT NUMBER 470613E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Includes the purchase and installation of meter equipment for new residential, 
commercial, and industrial services.  This project also includes the purchase and 
installation of meters to replace existing meters that are inoperable or damaged.  
Meters are upgraded to current standards when serviced. 
 
PROJECT STATUS 
Ongoing purchase and installation of meter equipment, which contributes to fulfilling 
our obligation to serve electric load requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $8,379,848 $1,500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $300,000 $300,000 $300,000 $300,000 $300,000 $1,500,000 

 TOTAL $300,000 $300,000 $300,000 $300,000 $300,000 $1,500,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  SUBSTATION INNOVATION 
PROJECT NUMBER 470614E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Advanced substation protection and control devices, enhanced communication and 
monitoring systems, autonomous equipment operation, and secure remote access and 
control. 
 
PROJECT STATUS 
Ongoing purchase and installation of equipment for substation protection, control and 
communication devices which contributes to fulfilling our obligation to serve electric 
load requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
No impact for ongoing projects. 
 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $13,473 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  SERVICES 
PROJECT NUMBER 470615E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Installation of new services to residential, commercial, and industrial customers.  Also 
includes upgraded services to existing customers with increased electrical 
requirements.  Service designs complement existing facilities and considers overall area 
electrical load requirements. 
 
PROJECT STATUS 
Ongoing purchase of electric service equipment, which contributes to fulfilling our 
obligation to serve electric load requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $9,794,201 $2,000,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $400,000 $400,000 $400,000 $400,000 $400,000 $2,000,000 

 TOTAL $400,000 $400,000 $400,000 $400,000 $400,000 $2,000,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  SUBSTATION BUS & UPGRADES 
PROJECT NUMBER 470616E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Replaces aging equipment and installs additional equipment necessary to improve the 
operability and safety of these neighborhood power centers (Substations).  This 
includes system protection, monitoring, automation systems for energized electrical 
components, perimeter walls, property improvements, the addition of new substations, 
and expansion of existing substations. 
 
PROJECT STATUS 
Ongoing replacement and addition of major substation equipment prioritized based 
upon system load growth as well as age and obsolescence of existing equipment. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $62,999,774 $22,521,323 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $6,176,366 $6,258,312 $1,910,730 $6,038,450 $2,137,465 $22,521,323 

 TOTAL $6,176,366 $6,258,312 $1,910,730 $6,038,450 $2,137,465 $22,521,323 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  MAJOR OVERHEAD/UNDERGROUND 
CONVERSIONS 
PROJECT NUMBER 470619E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
These potential conversions optimize opportunities to place various overhead facilities 
underground on a limited basis as a part of other projects.  Electric facilities are 
evaluated for improvements to capacity, configuration, and integration with surround 
facilities during design. 
 
PROJECT STATUS 
Ongoing relocation and upgrade of facilities driven by Public Works street projects 
which contribute to fulfilling our obligation to serve electric load requirements within 
the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $33,778,387 $2,500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $500,000 $500,000 $500,000 $500,000 $500,000 $2,500,000 

 TOTAL $500,000 $500,000 $500,000 $500,000 $500,000 $2,500,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  MAJOR TRANSMISSION LINE PROJECTS 
PROJECT NUMBER 470620E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Modifications and relocations of 69kV transmission lines associated with substation 
power transformer additions.  Transmission facilities are evaluated for improvements 
and system efficiencies during the design of all projects.  Parallel facilities on the same 
route are also considered for improvement to reduce the life cycle cost. 
 
PROJECT STATUS 
Ongoing relocation and upgrade of transmission line facilities driven by substation 
power transformer additions that contribute to fulfilling our obligation to serve electric 
load requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $1,930,671 $1,500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $300,000 $300,000 $300,000 $300,000 $300,000 $1,500,000 

 TOTAL $300,000 $300,000 $300,000 $300,000 $300,000 $1,500,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  GENERAL ORDER 165 (GO 165) UPGRADES/LINE 
REBUILDS/RELOCATION-OVERHEAD 
PROJECT NUMBER 470623E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Rehabilitation or replacement of overhead equipment identified as a result of routine 
facility inspections.  Includes pole replacement and infrastructure 
rehabilitation/replacement.  Priorities are established based on condition assessments 
and relative impact on customers and the system. 
 
PROJECT STATUS 
Ongoing replacement and upgrade of overhead facilities prioritized based upon 
intrusive inspection. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $16,621,879 $23,105,795 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $3,251,297 $3,710,554 $5,060,145 $5,491,648 $5,592,151 $23,105,795 

 TOTAL $3,251,297 $3,710,554 $5,060,145 $5,491,648 $5,592,151 $23,105,795 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  GO 165 UPGRADES/LINE REBUILDS/RELOCATE-
UNDERGROUND 
PROJECT NUMBER 470624E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Rehabilitation or replacement of underground equipment identified as a result of 
routine facility inspections.  Includes infrastructure rehabilitation/replacement.  Priorities 
are established based on condition assessment and relative impact on customers and 
the system. 
 
PROJECT STATUS 
Ongoing replacement and upgrade of underground facilities prioritized based upon 
intrusive inspection. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding *  Five Year Plan REMAINING NEEDED 

Ongoing $871,241 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  MAJOR TRACT DISTRIBUTION 
PROJECT NUMBER 470626E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Construct electric distribution feeders within new residential and commercial tract 
developments.  Additions are designed to supply new customers.  These extensions are 
designed to complement existing facilities and improve overall system operation. 
 
PROJECT STATUS 
Ongoing installation of new primary distribution lines within major tract developments 
which contributes to fulfilling our obligation to serve electric load requirements within 
the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $16,860,561 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  SUBSTATION TRANSFORMER ADDITION 
PROJECT NUMBER 470632E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Install new substation power transformers and associated equipment to support 
upgrades necessitated by load growth and modernization.  This project also includes 
proactive replacement of the oldest power transformers based on condition rating.  
The design of transformer additions complements existing facilities and improves overall 
system operation. 
 
PROJECT STATUS 
Ongoing replacement and addition of substation transformers prioritized based upon 
system load growth as well as age and obsolescence of existing equipment. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding *  Five Year Plan REMAINING NEEDED 

Ongoing $58,950,880 $25,709,985 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $3,369,075 $3,369,075 $3,678,851 $6,572,868 $8,720,116 $25,709,985 

 TOTAL $3,369,075 $3,369,075 $3,678,851 $6,572,868 $8,720,116 $25,709,985 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  MAJOR FEEDERS 
PROJECT NUMBER 470633E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Constructs major overhead and underground feeders for electric capacity in various 
locations.  Projects are associated with substation transformer additions and extensions 
to areas of major load increases.  Designs complement existing facilities and improve 
overall system operations. 
 
PROJECT STATUS 
Ongoing installation of new primary feeder lines which contributes to fulfilling our 
obligation to serve electric load requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $25,677,238 $3,000,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $600,000 $600,000 $600,000 $600,000 $600,000 $3,000,000 

 TOTAL $600,000 $600,000 $600,000 $600,000 $600,000 $3,000,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 

83



 

 

RIVERSIDE PUBLIC UTILITIES - ELECTRIC 
Capital Improvement Program FY 2020/21 - 2024/25 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

  

 

  SOUTHERN CALIFORNIA EDISON (SCE) 
CONDEMNATION COSTS 
PROJECT NUMBER 470634E COUNCIL WARD 1, 2, 4, 5, 6 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Friendly condemnation of existing SCE facilities in areas previously annexed to the City 
limits.  This project includes acquisition of existing electric facilities, easements, and 
associated legal costs. 
 
PROJECT STATUS 
Ongoing costs to purchase electric facilities and easement rights in annexed areas of 
the city formerly served by SCE. 
 
OPERATING BUDGET IMPACT 
No impact for ongoing projects. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $511,980 $2,000,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $400,000 $400,000 $400,000 $400,000 $400,000 $2,000,000 

 TOTAL $400,000 $400,000 $400,000 $400,000 $400,000 $2,000,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  CABLE REPLACEMENT 
PROJECT NUMBER 470635E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Replaces aging electric distribution cable with high potential for failure.   
 
PROJECT STATUS 
Ongoing replacement of underground cable prioritized based upon outage analysis as 
well as age and obsolescence of existing equipment. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $22,272,074 $27,572,329 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $3,272,770 $3,388,424 $4,652,465 $8,129,335 $8,129,335 $27,572,329 

 TOTAL $3,272,770 $3,388,424 $4,652,465 $8,129,335 $8,129,335 $27,572,329 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  CABLE REPLACEMENT - PUBLIC WORKS STREET 
REHAB 
PROJECT NUMBER 470636E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Replaces aging electric distribution cable with high potential for failure in coordination 
with Public Works Street rehabilitation areas. 
 
PROJECT STATUS 
Ongoing replacement of underground cable prioritized based upon schedules of 
Public Works street projects. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $9,154 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 

86



 

 

RIVERSIDE PUBLIC UTILITIES - ELECTRIC 
Capital Improvement Program FY 2020/21 - 2024/25 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

 

 

  

 

  MAJOR STREET LIGHT PROJECTS 
PROJECT NUMBER 470637E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Relocates and optimizes streetlights for road widening projects and as a part of other 
projects.  Project priorities are primarily driven by Public Works schedules.  Also includes 
citywide LED streetlight retrofit. 
 
PROJECT STATUS 
Ongoing relocation and upgrade of streetlight facilities primarily driven by Public Works 
street projects which contribute to fulfilling our obligation to serve electric load 
requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $26,240,539 $3,000,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $600,000 $600,000 $600,000 $600,000 $600,000 $3,000,000 

 TOTAL $600,000 $600,000 $600,000 $600,000 $600,000 $3,000,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  NEIGHBORHOOD STREET LIGHT RETROFIT 
PROJECT NUMBER 470638E COUNCIL WARD 1, 2, 3 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Installation of new concrete street light standards, light fixtures, and power feeds in the 
greater Wood Streets area.  Standards and fixtures are replicas of the 90-year-old 
historical street light system.  New fixtures are light-emitting diode (LED) lights for energy 
efficiency. 
 
PROJECT STATUS 
Ongoing installation and modernization of street light facilities in designated areas. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $4,547,127 $2,099,055 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund - - - $1,034,782 $1,064,273 $2,099,055 

 TOTAL $0 $0 $0 $1,034,782 $1,064,273 $2,099,055 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 

88



 

 

RIVERSIDE PUBLIC UTILITIES - ELECTRIC 
Capital Improvement Program FY 2020/21 - 2024/25 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

 

 

  

 

  MAJOR 4-12 KV CONVERSION 
PROJECT NUMBER 470644E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Upgrades aging and obsolete lower voltage electric distribution facilities (4kV) to 
higher distribution voltage (12kV).  Projects are in the Magnolia and Plaza service 
areas.  Projects are optimized to improve system capacity, and efficiency. 
 
PROJECT STATUS 
Ongoing replacement of 4kV distribution facilities prioritized based upon outage 
analysis as well as age and obsolescence of existing equipment. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $32,044,142 $18,480,918 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $2,734,064 $2,734,064 $2,803,117 $4,768,975 $5,440,698 $18,480,918 

 TOTAL $2,734,064 $2,734,064 $2,803,117 $4,768,975 $5,440,698 $18,480,918 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  DISTRIBUTION AUTOMATION 
PROJECT NUMBER 470655E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Provides for the design and installation of remote sensing devices and remotely 
controlled equipment on the Riverside electric grid.  This new technology equipment 
remotely monitors the electric network and reports information immediately to the 
electric control center.  Remotely controlled equipment reduces personnel costs and 
improves response times to system disturbances. 
 
PROJECT STATUS 
Ongoing purchase and installation of equipment for remote monitoring of the electric 
distribution system which contributes to fulfilling our obligation to serve electric load 
requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $1,807,231 $3,280,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $340,000 $685,000 $885,000 $685,000 $685,000 $3,280,000 

 TOTAL $340,000 $685,000 $885,000 $685,000 $685,000 $3,280,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  CITYWIDE COMMUNICATIONS 
PROJECT NUMBER 470664E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Provides for design and installation of fiber optic extensions between electric facilities 
and fiber network service points.  Individual projects include additions that 
complement existing facilities and improve overall fiber optic system operation.  Also, 
includes cyber-security upgrades of network equipment. 
 
PROJECT STATUS 
Ongoing installation and upgrade of communication equipment which contributes to 
fulfilling our obligation to serve electric load requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $23,858,590 $6,500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $1,300,000 $1,300,000 $1,300,000 $1,300,000 $1,300,000 $6,500,000 

 TOTAL $1,300,000 $1,300,000 $1,300,000 $1,300,000 $1,300,000 $6,500,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  SUPERVISORY CONTROL AND DATA ACQUISITION 
(SCADA) 
PROJECT NUMBER 470672E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Provides for the necessary upgrades to the electronic system which monitors and 
controls the operation of the electric transmission and distribution grid 24 hours a day, 
365 days a year.  This includes physical security upgrades required for regulatory 
compliance as part of system improvements, as well as hardware and network 
upgrades as part of advanced technology improvements. 
 
PROJECT STATUS 
Ongoing installation and upgrade of SCADA monitoring and control equipment and 
technology which contributes to fulfilling our obligation to serve electric load 
requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $9,146,577 $3,000,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $600,000 $600,000 $600,000 $600,000 $600,000 $3,000,000 

 TOTAL $600,000 $600,000 $600,000 $600,000 $600,000 $3,000,000 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  RIVERSIDE TRANSMISSION RELIABILITY PROJECT 
(RTRP) 
PROJECT NUMBER 470685E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
RTRP is a joint project with SCE to address the electrical capacity and reliability needs 
of the City.  As part of RTRP, there was a smaller Sub-Transmission Project (STP) that was 
completed in 2014. 
 
PROJECT STATUS 
Construction of Riverside Energy Resource Center (RECR)-Harvey Lynn drilled pier 
foundations is complete and Bid for Overhead line work is posted. Design of RERC-
Freeman 69kV line is in progress; construction is expected to begin in mid-2021. On 
March 12th, 2020, California Public Utilities Commission (CPUC) approved SCE's 
application for a Certificate of Public Convenience and Necessity (CPCN) for a 230kV 
interconnection (Riverside’s second connection to the State grid).  Project activities 
related to the new 230kV interconnection have started. 
 
OPERATING BUDGET IMPACT 
Operating budget impacts will be quantified and presented to the Board of Public 
Utilities and City Council in Fall 2020. 
  
  

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

162,756,354 $104,240,831 $0 $58,515,523 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 

93



 

 

RIVERSIDE PUBLIC UTILITIES - ELECTRIC 
Capital Improvement Program FY 2020/21 - 2024/25 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

 

 

  

 

  RTRP – 230kV REIMBURSABLE 
PROJECT NUMBER 470686E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
RTRP is a joint project with SCE to address the electrical capacity and reliability needs 
of the City.  Some portion of RTRP licensing costs may be subject to reimbursement by 
SCE. 
 
PROJECT STATUS 
The Certificate of Public Convenience and Necessity (CPCN) approval and California 
Environmental Quality Act (CEQA) process for RTRP is complete. SCE has reimbursed 
the Electric Fund for project costs related to CPCN and CEQA. SCE will be reimbursing 
costs of very few outstanding items in near future and at that point, this project will be 
closed with all remaining funds be transferred to the 470685 RTRP Non-Reimbursable 
accounts to support other components of RTRP project. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing projects. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$22,243,646 $22,243,646 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  CUSTOMER INFORMATION SYSTEM (CIS) UPGRADE 
PROJECT NUMBER 470694E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Customer Information System is a highly integrated enterprise software application 
that is integrated with other applications and serves as the single source of the 
department customer data. This project will upgrade enQuesta and operating systems 
connected to enQuesta – WebConnect and CGI-PragmaCAD. 
 
PROJECT STATUS 
Project scope under development; the upgrade is expected to be completed by June 
30, 2023. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs which are minimal. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$20,623,980 $17,111,093 $3,512,887 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $1,600,326 $965,636 $946,925 - - $3,512,887 

 TOTAL $1,600,326 $965,636 $946,925 $0 $0 $3,512,887 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  GEOGRAPHIC INFORMATION SYSTEM (GIS) 
UPGRADE 
PROJECT NUMBER 470696E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Citywide GIS Technology Upgrade Project (Project) will transition the City from 
CADME to Esri' s ArcGIS platform, a modern GIS system that streamlines and automates 
workflows, enables easy viewing and use of geospatial data, and enhances GIS 
reporting and analytic capabilities. High-level project objectives include transitioning to 
ArcGIS (the newly upgraded platform), integrating with existing and new systems and 
applications, enhancing mapping and analytic capabilities, improving internal and 
external customer experience, and streamlining day-to-day processes. 
 
PROJECT STATUS 
The GIS project is currently 60% complete. All consultants have been selected and the 
architecture and data migration task orders have been completed. In-process tasks 
include migrating the editors, building the new GIS browser, and recreating new paper 
map products.   
 
OPERATING BUDGET IMPACT 
No operating budget impact. 
  
  

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$3,500,000 $3,135,389 $1,021,421 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $503,535 $517,886 - - - $1,021,421 

 TOTAL $503,535 $517,886 $0 $0 $0 $1,021,421 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  DARK FIBER 
PROJECT NUMBER 470698E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Optical fiber infrastructure for telecommunications companies, wireless operators, 
enterprise networks, data centers and others with critical, high capacity needs. 
 
PROJECT STATUS 
Ongoing project providing optical fiber infrastructure to various customers with critical 
high capacity needs. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $593,972 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  ENTERPRISE OPERATION DATA MANAGEMENT 
SYSTEM 
PROJECT NUMBER 470822E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Operation Data Management System (ODMS) receives data from electric delivery 
and generation system instrumentation and data communication, storage, and 
analysis systems.  The data will support advanced monitoring and control systems to 
improve the operational efficiency and capability of the electric delivery systems. 
 
PROJECT STATUS 
Project has been completed.  Ongoing end-user training and maintenance will 
continue to streamline utility operations.  
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $2,599,126 $1,001,669 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund - - - - $1,001,669 $1,001,669 

 TOTAL $0 $0 $0 $0 $1,001,669 $1,001,669 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  ADVANCED METERING INFRASTRUCTURE 
PROJECT NUMBER 470823E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This system automation project for the Advanced Metering Infrastructure (AMI) and 
Meter Data Management System will integrate AMI data and support customer facing 
applications and web integration of the Customer Integration System.  The AMI delivers 
automated meter reading resulting in more efficient consumption management and 
enhanced customer service. 
 
PROJECT STATUS 
The system automation project began in FY 2019/20 and is continuing through CIP five-
year plan. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$27,663,930 $9,087,860 $6,309,045 $12,267,025 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $2,573,624 $1,265,943 - $1,217,391 $1,252,087 $6,309,045 

 TOTAL $2,573,624 $1,265,943 $0 $1,217,391 $1,252,087 $6,309,045 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  OPERATIONAL TECHNOLOGY GOVERNANCE 
PROJECT NUMBER 470824E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Operational Technology Governance project includes planning, management, 
internal controls, and cyber and physical security improvements, as well as planning 
and implementation of a Security Risk Management Program which includes policies, 
tools required to monitor irregular activities on the network, and endpoint devices to 
facilitate proactive response to malicious activities or security-related performance 
issues. 
 
PROJECT STATUS 
Equipment and software solutions for cyber and physical security issues are identified 
through new biannual assessments. 
 
OPERATING BUDGET IMPACT 
The two-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $446,319 $4,160,499 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $889,021 $994,812 $1,377,776 $443,130 $455,760 $4,160,499 

 TOTAL $889,021 $994,812 $1,377,776 $443,130 $455,760 $4,160,499 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  WORK, ASSET, & INVENTORY MANAGEMENT 
SYSTEM 
PROJECT NUMBER 470825E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Work, Asset and Inventory Management System (WIS) is important not only for 
controlling and minimizing stock materials on-hand but for its hand-off of materials 
through the work management system and assigning the cost of materials to assets in 
the asset management system.  The WIS is an integral part of the workflows and 
information needed by the Work Management System and Asset Management 
System.  The system supports management of the Utility's field infrastructure assets (e.g. 
pipes, pumps, valves, connections, etc.) and includes field work orders, asset costs, 
and utilization. 
 
PROJECT STATUS 
Project scope has been defined. Implementation of upgrade-to current work, asset, 
and inventory system to begin in October 2022. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$7,247,823 659,370 $6,588,453 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $671,380 $2,071,543 $2,367,313 $852,174 $626,043 $6,588,453 

 TOTAL $671,380 $2,071,543 $2,367,313 $852,174 $626,043 $6,588,453 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 

101



 

 

RIVERSIDE PUBLIC UTILITIES - ELECTRIC 
Capital Improvement Program FY 2020/21 - 2024/25 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

 

 

 

 

  NETWORK COMMUNICATION SYSTEM 
PROJECT NUMBER 470826E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Network Communications Systems Project will upgrade and create redundancies 
in the communication network to improve the communication backbone and improve 
system functionality, efficiency, reliability, and cybersecurity. 
 
PROJECT STATUS 
Ongoing work continues and the estimated completion window is Spring 2021.  
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$5,705,415 $6,250 $5,699,165 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $895,173 $1,150,857 $1,183,657 $1,217,391 $1,252,087 $5,699,165 

 TOTAL $895,173 $1,150,857 $1,183,657 $1,217,391 $1,252,087 $5,699,165 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  LAND MOBILE RADIO 
PROJECT NUMBER 470827E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
A new Land Mobile Radio (LMR) system is being installed and implemented. LMR is a 
wireless communications system intended for use by terrestrial users in vehicles 
(mobiles) or on foot (portables).  The new system should capitalize on digital 
technology known as frequency division multiple access (FDMA).  The new LMR system 
will supply new antennas to provide citywide coverage, provide a new dispatcher 
console, coexist with the current analog LMR system, be based on FDMA technology, 
support narrow channels, enable trunked modes of operation for both analog and 
digital modulations, have multiple talk groups, and support private calling.  It will also 
be Advanced Encryption and Data Encryption Standard encrypted and be capable 
of Over the Air Programming (OTAP). 
 
PROJECT STATUS 
Installation and integration of the new system is complete. The project will shift into 
maintaining the land-mobile radio system Citywide. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$1,436,393 $0 $1,436,393 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund - $344,106 $353,913 $364,000 $374,374 $1,436,393 

 TOTAL $0 $344,106 $353,913 $364,000 $374,374 $1,436,393 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  OUTAGE MANAGEMENT SYSTEM 
PROJECT NUMBER 470829E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Outage Management System (OMS) will provide a technology solution and system 
that enhances operational efficiency, improves productivity and reliability, and 
increases customer engagement and satisfaction. This system provides real-time 
visibility to the system, which will reduce the time it takes dispatches and 
troubleshooters to locate outages and causes. OMS will integrate with the Advanced 
Distribution Management System to gain additional efficiencies on the electric system 
to increase reliability. 
 
PROJECT STATUS 
Currently finalizing the project scope and schedule to begin procurement. 
 
OPERATING BUDGET IMPACT 
The two-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$2,661,953 $0 $2,661,953 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $144,347 $471,851 $662,848 $681,739 $701,168 $2,661,953 

 TOTAL $144,347 $471,851 $662,848 $681,739 $701,168 $2,661,953 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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ADVANCED DISTRIBUTION MANAGEMENT SYSTEM 
PROJECT NUMBER 470830E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Advanced Distribution Management System (ADMS) is a set of systems used to 
optimize the capability, efficiency, reliability, and security of water and electric delivery 
systems.  For electric delivery systems, ADMS features include voltage optimization (i.e., 
volt-var optimization and conservation voltage regulation/reduction), fault location, 
isolation, and restoration (FLISR), outage management, and state estimation.  ADMS is 
a long-term vision for Riverside Public Utilities. ADMS and OMS will be integrated 
together and provides additional visibility and efficiencies to the electric system to 
increase reliability. 
 
PROJECT STATUS 
Currently finalizing the project scope and schedule to begin procurement. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$4,268,291 $0 $4,268,291 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $501,297 $786,036 $965,864 $993,391 $1,021,703 $4,268,291 

 TOTAL $501,297 $786,036 $965,864 $993,391 $1,021,703 $4,268,291 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$2,551,850 $0 $2,551,850 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

510 Electric Fund $1,706,424 - $236,731 $608,695 - $2,551,850 

 TOTAL $1,706,424 $0 $236,731 $608,695 $0 $2,551,850 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 

MOBILE APPLICATIONS 
PROJECT NUMBER 470831E COUNCIL WARD All Wards 
PROJECT CATEGORY Electric Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Mobile Apps increase operational efficiency and safety by providing real-time 
information to field personnel when and where they need it; ensure system 
configuration and status is always known by the personnel operating the system; 
reduce the need for paper-based maps, plans, and work orders; reduce the as-built 
record-keeping effort, and enable field operation personnel to share real-time 
information with system operators and engineers. 
 
PROJECT STATUS 
Implementation of mobile applications to support work orders and asset management 
planned in 2022. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
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      Capital Improvement Program 

Project Category Overview:  Innovation and 
Technology 

 

 

Introduction  
The Innovation and Technology (IT) Department is responsible for building and 
maintaining the City's data and telephone communications systems, three 
data centers, and all major enterprise software applications.  Technology is 
ubiquitously at the core of virtually every service the City of Riverside delivers.  
It is enabling increased productivity, around the clock operation, faster 
response times, and improved relationships with residents, businesses, 
organizations and visitors. 
 
IT capital improvement projects result in major upgrades to these systems.  
Upgrades can provide new technology which may be more reliable, faster, 
or address cybersecurity issues; increase capacity as data and computing 
needs increase exponentially; and/or provide new software functionalities for 
the public and employees.  
 
One-Year Budget and Five-Year Plan 
During the proposed one-year CIP budget and five-year CIP plan, the IT 
department plans to perform a data network replacement, major upgrade 
to the City's enterprise work order and asset management system, Voice over 
Internet Protocol (VoIP) telecommunications upgrade, and major upgrade to 
the City's enterprise resource management system (financial and human 
resources system).  Innovation and Technology has maintained these 
hardware and software assets, but several are becoming antiquated or 
limiting functionality for users.  At this time, only the Data Network 
Replacement project is being funded, albeit partially, using the City's Measure 
Z one-cent sales tax and funds from benefiting departments.  Portions of the 
project remain unfunded. 
 
Key Revenues and Funding Sources 
The City's Measure Z one-cent sales tax is the primary funding source for the 
Innovation and Technology Department's funded capital improvement 
projects.  Most IT technology improvements have a Citywide benefit, 
including benefitting all of the non-General Fund Departments.  The cost of 
technology improvements are allocated to City funds via a cost-sharing 
methodology developed for each of the technology improvement projects.  
The projects currently scheduled are expected to receive 40% of project costs 
from non-General Fund departments.  As project plans and costs are further 
refined, a specific cost-sharing methodology will be applied based on the 
unique cost drivers of each project and will be equitable to both the General 
Fund and non-General Funds. 
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Fund  Fund 
Description 

Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

401 Capital Outlay $1,046,541 - - - - $1,046,541 

420 Measure Z 1,862,955 - - - - $1,862,955 

  TOTAL $2,909,496 $0 $0 $0 $0 $2,909,496 

 
 
Projects by Type of Improvement 
 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Equipment       
Data Center/Disaster 
Recovery $2,909,496 - - - - $2,909,496 

TOTAL $2,909,496 $0 $0 $0 $0 $2,909,496 

 
Top Unfunded Projects by Priority 
Innovation and Technology identified nine unfunded capital projects with no 
funding. 
  

Project Name Estimated 
Project Cost 

Unfunded 
Amount 

1. Datacenter/Disaster Recovery Capital Improvements $3,099,479 $189,983 

2. Work-Order/Asset Management System Major Upgrade 3,234,900 3,234,900 

3. Data Network Replacement 4,291,735 1,319,481 

4. Voice over IP (VoIP) Telecommunications System Upgrades 965,000 965,000 

5. Voice over IP (VoIP) Telecommunications System - Full Replacement 2,400,000 2,400,000 

6. Enterprise Resource Planning System Replacement 18,000,000 18,000,000 

TOTAL $31,991,114 $26,109,364 
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Project Map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: This map includes all active and new capital improvement projects.  Ongoing and citywide projects are not included on the 
map.  To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.   
 
Distribution by Ward  

 
Ward Five-Year Total  

Ward 1 - 

Ward 2 -   

Ward 3 - 

Ward 4 -  

Ward 5 -   

Ward 6 -   

Ward 7 -  

All Wards $2,909,496  

 Total $2,909,496 
 

‐

‐

‐

‐

‐

‐

‐

$2.9M

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7

 All Wards
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  DATA NETWORK REPLACEMENT 
PROJECT NUMBER 9022 COUNCIL WARD All Wards 
PROJECT CATEGORY Innovation and Technology 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is a hardware replacement project that includes replacing critical components of 
the City’s data network and related equipment. Much of the equipment is a decade 
old and out of manufacturer support, which prevents Innovation and Technology from 
performing routine maintenance and therefore presents cybersecurity and failure risks. 
The City’s network equipment is critical to all enterprise software systems and 
communication Citywide, including Riverside Public Utilities and public safety. 
 
PROJECT STATUS 
Request for Proposal (RFP) No. 1926 for Data Network Refresh services and hardware 
was awarded to Vector Resources, Inc on December 17, 2019. The project has begun 
with weekly project meetings taking place. 
 
OPERATING BUDGET IMPACT 
The project will introduce annually recurring operations and maintenance costs starting 
at $265,800. These costs will be incurred for hardware maintenance and support 
contracts for the new network equipment. Costs are funded by Measure Z through FY 
2020/21. 
 
  
  

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$4,291,735 $2,972,254 $0 $1,319,481 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  GIS TECHNOLOGY UPGRADE 
PROJECT NUMBER 9070 COUNCIL WARD All Wards 
PROJECT CATEGORY Innovation and Technology 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Citywide GIS Technology Upgrade Project (Project) will transition the City from 
CADME to Esri' s ArcGIS platform, a modern GIS system that streamlines and automates 
workflows, enables easy viewing and use of geospatial data, and enhances GIS 
reporting and analytic capabilities. High-level project objectives include transitioning to 
ArcGIS (the new upgraded platform), integrating with existing and new systems and 
applications, enhancing mapping and analytic capabilities, improving internal and 
external customer experience, and streamlining day-to-day processes. 
 
PROJECT STATUS 
The GIS project is currently 60% complete. All consultants have been selected and the 
architecture and data migration task orders have been completed. In-process tasks 
include migrating the editors, building the new GIS browser, and recreating new paper 
map products.   
 
OPERATING BUDGET IMPACT 
No operating budget impact. The City will be using updated systems and software for 
the same price so there is no impact to the current operating budget. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$3,500,001 $3,500,001 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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DATACENTER/DISASTER RECOVERY CAPITAL 
IMPROVEMENTS 
PROJECT NUMBER 9140 COUNCIL WARD All Wards 
PROJECT CATEGORY Innovation and Technology 
PROJECT LOCATION Various 
 
PROJECT DESCRIPTION 
The City's data centers are responsible for remote store, processing, and the distribution 
of large amounts of citywide data (e.g. databases, virtual environment, servers, etc.).  
The City currently maintains a primary datacenter, a secondary datacenter, and a 
disaster recovery site.  This is a hardware replacement project. 
 
PROJECT STATUS 
Innovation and Technology completed a pilot project with a new data center 
architecture for the GIS Technology Upgrade project. Staff has conducted extensive 
research into an enterprise-wide data center architecture that meets the City’s current 
data center computing and storage needs and is cost-effective to implement.  A final 
architecture is designed, and final budgetary quotes are nearly completed. 
 
OPERATING BUDGET IMPACT 
Software licensing fees and maintenance support will cost $250,000 per year for the first 
five years.  The equipment is estimated to have a 5-year lifespan.  Therefore, the 
capital replacement of this equipment will be required in 5-years. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$3,099,479 $0 $2,909,496 $189,983 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

401 General Fund Capital $1,046,541 - - - - $1,046,541 

420 Measure Z Capital 1,862,955 - - - - $1,862,955 

 TOTAL $2,909,496 $0 $0 $0 $0 $2,909,496 
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FIBER OPTIC CONNECTION UPGRADE 
PROJECT NUMBER 9153 COUNCIL WARD All Wards 
PROJECT CATEGORY Innovation and Technology 
PROJECT LOCATION Various City Buildings 
 
PROJECT DESCRIPTION 
This project will upgrade the in-building fiber optic connections at various existing City 
locations. The objective is to upgrade existing in-building fiber in order to provide for 
the higher data transfer throughput required by newer high-speed networking 
equipment, servers, and computer workstations. 
 
PROJECT STATUS 
Request for Bid No. 7726 for in-building fiber-optic connection upgrades at various City 
locations was issued on November 22, 2019. The bid closed on December 17, 2019. On 
April 7, 2020, Council approved the recommendation to award Bid No. 7726 to Vector 
Resources, Inc. The vendor project team is formed, has performed detailed site 
inspections, and is planning the work. 
 
OPERATING BUDGET IMPACT 
This project will replace existing in-building fiber optic cabling at existing City locations 
with newer higher quality cabling. This new cabling has a useful life of 10 or more years 
and does not require any ongoing maintenance. The repair of accidental damage or 
failure to existing cabling is already an Innovation and Technology responsibility; 
therefore, there is no operating budget impact is expected from this project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$120,521 $120,521 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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      Capital Improvement Program 

Project Category Overview:  Municipal Buildings 
and Facilities 

 

 

 
Introduction  
The General Services Department provides safe, clean, well-maintained, and 
functional facilities for the City.  Additionally, the department is responsible for 
maintaining the City’s green vehicle fleet, as well as managing the City’s 
alternative fuel infrastructure and fueling stations. 
 
The core functions of the Municipal Buildings and Facilities are to manage the 
design and construction of new facilities, such as alternative fueling stations, 
libraries, Police and Fire Stations, and oversee major rehabilitation of existing 
buildings such as the Riverside Convention Center, Fox Theater, and Municipal 
Auditorium.  
 
One-Year Budget and Five-Year Plan 
General Services maintains approximately 125 buildings or approximately 1.8 
million square feet.  While the Airport Division is part of the General Services 
Department, the Airport is responsible for its own Capital Improvement 
Program (CIP).  Riverside Public Utilities and Parks, Recreation and Community 
Services Departments prepare CIPs for their facilities and are not part of the 
General Services CIP.  
 
A comprehensive Facility Condition Assessment (FCA) was completed in FY 
2018/19 for all core City facilities, including City Hall, libraries, community 
centers, police facilities, fire stations, the Fox Entertainment Plaza, the Riverside 
Municipal Auditorium and the Riverside Convention Center.  The FCA 
captured condition and life cycle information on all major building systems 
down to the individual component level, such as: site paving, heating and 
cooling systems, roofing, electrical, plumbing, and elevators.  This condition 
data is analyzed to assess, prioritize and plan capital expenditures. 
 
Project Highlights:  
Downtown Library 
The new Downtown library is a three-
story, 42,000 square foot, innovative 
and master planned space that will 
connect with existing developments in 
the area. Construction will be 
completed by December 2020.  The 
new facility replaces the outdated 
library next to the Mission Inn.  It will 
include more community meeting 
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spaces, archives, new programs, creative workspaces, and expanded 
children’s services.  It will also create a catalyst for future positive economic 
activity in Downtown Riverside.  
 
Police Headquarters 
The City is currently working with a consultant on a Siting, Facilities 
Optimization and Operational Study to determine which policing functions 
the headquarters will provide, the efficient size for the headquarters facility 
and optimal location.  The study will be completed by June 2021.  
 
Metropolitan Museum Rehabilitation  
The renovation will bring the Museum into the twenty-first century and provide 
visitors with a modern museum experience in which to learn about the cultural 
and natural history of Riverside and its region.  Phase 1 Design has been 
completed.  Full funding has not been identified to complete the project. 
 
Key Revenues and Funding Sources 

 
Fund Funding Source Adopted 

2020/21 
Proposed 

2021/22 
Proposed 

2022/23 
Proposed 

2023/24 
Proposed 

2024/25 Total 

420 Measure Z Capital $1,000,000 $1,000,000 $1,000,000 $1,000,000 $1,000,000 $6,000,000 

  TOTAL $1,000,000 $1,000,000 $1,000,000 $1,000,000 $1,000,000 $5,000,000 

 
Funding for the non-fleet Municipal Buildings and Facilities CIP comes primarily 
from the General Fund and Measure Z.  While grant funding is limited for facility 
projects, General Service’s staff continually seeks grant funding when 
possible.  Fleet facility 
improvements identified in 
this CIP are funded through 
service rates charged to city 
departments, grants, and 
alternative fuel revenues 
from the public sale of 
compressed natural gas, 
hydrogen, and propane fuel. 
 
It is difficult to develop an 
accurate CIP because 
sources of revenue for the 
General Fund are subject to 
change based on citywide 
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needs.  Additionally, grant funded projects are subject to Federal, State, and 
other agency awards.  
 
Projects by Type of Improvement 
 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Buildings       
City Buildings Deferred 
Maintenance $1,000,000 $1,000,000 $1,000,000 $1,000,000 $1,000,000 $5,000,000 

Fire Plymovent Exhaust System - - - - - $0 

    Total Buildings $1,100,000 $1,000,000 $1,000,000 $1,000,000 $1,000,000 $5,000,000 

TOTAL $1,000,000 $1,000,000 $1,000,000 $1,000,000 $1,000,000 $5,000,000 

 
Top Unfunded Projects by Priority 
General Services has identified eight projects that are currently unfunded. 

 
Project Name Estimated 

Project Cost 
Unfunded 

Amount 
1. Magnolia Station Roof Repair $100,000 $100,000 

2. Arlanza Library Roof Repair 20,000 20,000 

3. Fox Roof Repairs 75,000 75,000 

4. Riverside Municipal Auditorium Roof 50,000 50,000 

5. Orange Station Mechanical Room Repairs 20,000 20,000 

6. Magnolia Shopping Center - Roof 200,000 200,000 

7. Fire Station 2 Roof Replacement 350,000 350,000 

8. Marcy HVAC Replacement 150,000 150,000 

TOTAL $965,000 $965,000 
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Project Map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: This map includes all active and new capital improvement projects.  Ongoing and citywide projects are not included on the 
map.  To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.   

 
Distribution by Ward  

 
Ward Five-Year Total  

Ward 1 $- 

Ward 2 -  

Ward 3 - 

Ward 4 - 

Ward 5 - 

Ward 6 - 

Ward 7 - 

All Wards 5,000,000 

 Total $5,000,000 

  

‐

‐

‐

‐

‐

‐

‐

$5.0M

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7

 All Wards
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  FIRE PLYMOVENT EXHAUST SYSTEM 
PROJECT NUMBER 1675 COUNCIL WARD ALL 
PROJECT CATEGORY Municipal Buildings and Facilities 
PROJECT LOCATION City Wide 
 
PROJECT DESCRIPTION 
This project will install an upgraded diesel exhaust system in multiple fire station 
apparatus bays. The new system will include hoses that connect directly to the fire 
vehicles that collect the exhaust gases and then use a fan system to remove it from the 
building apparatus bays. 
 
PROJECT STATUS 
The bids for the project were sent and will be received in July 2020.  Once evaluated 
and selected, construction should take approximately 8 months. 
 
OPERATING BUDGET IMPACT 
There will be no budgetary impact as this is a replacement for the current operational 
system. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$672,000 $672,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  FLEET METHANE DETECTION SYSTEM 
PROJECT NUMBER 4085 COUNCIL WARD 3 
PROJECT CATEGORY Municipal Buildings and Facilities 
PROJECT LOCATION City Corporation Yard, 8095 Lincoln Avenue 
 
PROJECT DESCRIPTION 
This consists of 3 separate projects 1) Methane Detection system expanding the shop 
capacity for compressed natural gas (CNG) maintenance work, which has been 
completed; and  2) Lincoln CNG Station Expansion:  One two-hose CNG dispenser, 
fueling island with canopy and credit card reader; and 3) Acorn CNG Station 
Expansion:  Four (4) CNG Storage Spheres and two (2) two-hose dispenser. 
 
PROJECT STATUS 
Part 1: Methane detection system – complete. 
Part 2: Lincoln CNG Station Expansion Status:  Bid No. 1619 Rev 1. Issued July 2, 2019.   
Part 3: Acorn CNG Station Expansion Status:  Bid No. 7720 was awarded on April 21, 
2020. 
 
OPERATING BUDGET IMPACT 
No additional budgetary impact. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,734,973 $1,734,973 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  CHEECH MARIN CENTER FOR CHICANO ART 
PROJECT NUMBER 9016 COUNCIL WARD 1 
PROJECT CATEGORY Municipal Buildings and Facilities 
PROJECT LOCATION 3581 Mission Inn Avenue 
 
PROJECT DESCRIPTION 
Reuse and repurpose the existing Downtown library as the new Cheech Marin Center 
for Chicano Art. The facility will be a modern, innovative, active and accessible arts 
center offering a variety of public services including galleries, a café, administrative 
offices, classrooms, and gift store. The Cheech Marin Center for Chicano Art will hold 
an art collection of approximately 700 pieces of paintings and sculptures. 
 
PROJECT STATUS 
Phase One of the project is underway and includes the development of conceptual 
designs for use in private fundraising efforts. Following the completion of conceptual 
designs, awarding of the construction bids are estimated to take place by 
November/December 2020.  Construction is estimated to be complete by November 
2021. 
 
OPERATING BUDGET IMPACT 
Ongoing maintenance will be funded through a privately established foundation. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$10,700,000 $10,700,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 

 

125



 

 

GENERAL SERVICES – MUNICIPAL BUILDINGS AND FACILITIES 
Capital Improvement Program FY 2020/21 - 2024/25 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

   

 

  METRO MUSEUM EXPANSION AND 
REHABILITATION 
PROJECT NUMBER 9017 COUNCIL WARD 1 
PROJECT CATEGORY Municipal Buildings and Facilities 
PROJECT LOCATION 3580 Mission Inn Avenue 
 
PROJECT DESCRIPTION 
The Riverside Metropolitan Museum building was built between 1912 and 1914 as a 
United States Post Office and federal building. It later served as the home of the 
Riverside Police Department with the Museum housed in its basement. Between 1962 
and 1965 the Museum was remodeled into its current configuration, expanding to fill 
the entire building in 1966. Significant renovations have been done since that time. The 
renovation will bring the Museum into the twenty-first century and provide visitors with a 
modern museum experience to learn about the cultural and natural history of Riverside 
and the region.  
 
PROJECT STATUS 
Phase I of the Museum expansion is estimated to be completed by October 2020.  
 
OPERATING BUDGET IMPACT 
Ongoing maintenance after the expansion and rehab will likely be lower than the 
existing facility, so no additional operating impact will be budgeted. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$22,053,000 $99,220 $13,700,000 $8,253,780 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

420* Measure Z (Bond Proceeds) - - $13,700,000 - - $13,700,000 

 TOTAL $0 $0 $13,700,000 $0 $0 $13,700,000 

*Appropriation of funds contingent on bond issuance.  For planning purposes only.  Not included in in other areas of the CIP. 
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  POLICE HEADQUARTERS 
PROJECT NUMBER 9018 COUNCIL WARD 1 
PROJECT CATEGORY Municipal Buildings and Facilities 
PROJECT LOCATION Main Street and Columbia Avenue 
 
PROJECT DESCRIPTION 
The proposed new Police Headquarters will be a ten-acre campus located on the 
corner of Orange Street and Columbia Avenue. The proposed project would develop 
a 50,000 square foot state-of-the-art facility that is designed to meet the administrative 
needs of the Riverside Police Department. The design would be adaptive to meet 
future needs. Additionally, the campus will be designed to accommodate a police 
station, 10,000 square foot community center, future Emergency Operations Center 
expansion, joint police and fire training facility, physical agility training center, and 
secured parking for special operational equipment.  
 
PROJECT STATUS 
Project is in the planning stages. 
 
OPERATING BUDGET IMPACT 
There will be ongoing maintenance associated with the new building; however, 
maintenance costs will be significantly lower than the existing building, so there will be 
no additional budgetary impact. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$35,095,953 $95,953 $35,000,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

420* Measure Z (Bond Proceeds) - - $35,000,000 - - $35,000,000 

 TOTAL $0 $0 $35,000,000 $0 $0 $35,000,000 

*Appropriation of funds contingent on bond issuance.  For planning purposes only.  Not included in in other areas of the CIP. 
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  CITY BUILDINGS DEFERRED MAINTENANCE 
PROJECT NUMBER 9019 COUNCIL WARD All 
PROJECT CATEGORY Municipal Buildings and Facilities 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Maintains the City's existing core government facilities, such as libraries, fire and police 
stations, Museum, and City Hall. Projects include minor capital work that is needed to 
bring the facilities to a safe and acceptable condition such as roof replacements and 
repairs, HVAC system replacements, parking lot overlays and rehabilitation, room 
remodels, floor replacements, etc. 
 
PROJECT STATUS 
Staff continues to identify and prioritize facility needs. Multiple projects are completed 
each year. 
 
OPERATING BUDGET IMPACT 
There should be a slight decrease to the operating budget as most of the projects will 
replace old and aging items that require a high degree of maintenance and repair. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $1,888,934 $5,000,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

420 Measure Z Capital Projects $1,000,000 $1,000,000 $1,000,000 $1,000,000 $1,000,000 $5,000,000 

 TOTAL $1,000,000 $1,000,000 $1,000,000 $1,000,000 $1,000,000 $5,000,000 
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  FIRE STATION 11 DORM IMPROVEMENTS 
PROJECT NUMBER 9132 COUNCIL WARD 4 
PROJECT CATEGORY Municipal Buildings and Facilities 
PROJECT LOCATION 19595 Orange Terrace Parkway 
 
PROJECT DESCRIPTION 
The project consists of demolishing the open dormitory style sleeping quarters, which 
currently consists of six individual beds and nightstands, and constructing five private 
sleeping quarters which can each accommodate one single bed, nightstand, lockers 
and privacy door. Each room will have its own independent ceiling light, wall power 
outlet and heating and air conditioning ventilation. 
 
PROJECT STATUS 
It is anticipated that portions of the project, such as construction of the walls, will be 
competitively bid, with the balance of the work to be performed in house by General 
Services staff. 
 
OPERATING BUDGET IMPACT 
There will no impact on the operating budget. 
 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$100,000 $100,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  DOWNTOWN LIBRARY 
PROJECT NUMBER 9905 COUNCIL WARD 1 
PROJECT CATEGORY Municipal Buildings and Facilities 
PROJECT LOCATION 3911 University Avenue 
 
PROJECT DESCRIPTION 
The new innovative and master-planned Downtown Library will be a three-story, 42,000 
square foot facility that will connect with existing developments in the area to 
maximize visibility and use. The new facility will replace the outdated Library on Mission 
Inn Avenue. It will create additional community meeting space, new historic programs, 
creative workspaces, and expanded children's services. This library will also be a 
catalyst for future positive economic activity in Downtown Riverside. 
 
PROJECT STATUS 
We are at 90% construction completion and expect to be substantially completed by 
the end of December 2020. 
 
OPERATING BUDGET IMPACT 
Ongoing maintenance will likely be lower than the existing facility, so there will be no 
additional budgetary impact 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$41,390,982 $41,390,982 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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      Capital Improvement Program 

Project Category Overview:  Parks, Recreation, and 
Community Services 

 

 

 
Introduction  
The Parks, Recreation and Community Services Department is responsible for 
providing innovative recreational experiences and social enrichment 
opportunities to address the changing needs for people of all ages and 
cultures, in a variety of safe and attractive parks, trails, landscapes, and 
facilities.  One of the Department’s main responsibilities is to plan, design, and 
construct new parks and facilities, as well as renovate and enhance existing 
amenities. 
 
One-Year Budget and Five-Year Plan 
The Parks, Recreation and Community Services Department will be working 
on several previously funded projects.  The most significant project planned in 
the next five years is the design and construction of an ADA accessible 
pedestrian walkway along Dexter Drive in Fairmount Park. 
 
Project Highlights: 
Arlington Youth Innovation Center (AYIC)  
The AYIC is envisioned to offer programs and services oriented toward 
technology education and job skills development to better serve the youth in 
the community.  Based on 2010 census data, the City’s population of residents 
between the ages of 0 to 24 makes up the largest segment by age group with 
the range of 18 to 24 representing 15.5%.  In the Arlington Neighborhood, the 
10 to 19 age group makes up 17.8% of the population.  The construction of 
the new 9000 SF 
facility was 
completed in 
Spring 2020.  
Staff is working 
to implement 
information 
technology 
systems (Wi-Fi, 
Networking, 
Computers, 
etc.) for a 
Spring 2021 
opening, 
pending 
COVID-19 
restrictions. 
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Project Category Overview:  Parks, Recreation, and 
Community Services 
 

 

 

Key Revenues and Funding Sources 

 
Fund Funding Source Adopted 

2020/21 
Proposed 

2021/22 
Proposed 

2022/23 
Proposed 

2023/24 
Proposed 

2024/25 Total 

413 Park Capital 
Improvement $325,000 - - - - $325,000 

 TOTAL $325,000 $0 $0 $0 $0 $325,000 

 
Major revenue sources that the Parks, Recreation and Community Services 
Department typically uses to fund CIP projects include, Federal and State 
Grants, Successor Agency Funds/Redevelopment Bond Funds, Development 
Impact Fees, and Local and Regional Park Funds.  These are restricted funding 
sources and one-time funding sources. 
 
Projects by Type of Improvement 
 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Fairmount Park Lake Evans 
Lakeshore Access $325,000 - - - - $325,000 

TOTAL $325,000 $0 $0 $0 $0 $325,000 

 
The only new project in this budget is the Fairmount Park Lake Evans 
Lakeshore Access.  The department will be executing several previously 
funded projects including completion of the Trails Master Plan Update, 
various additional park ADA improvements and the Design phase for the 
Nichols Community Center Renovation. 
 
Top Unfunded Projects 
Parks and Recreation has identified their top ten unfunded projects. 

 
Project Name Estimated 

Project Cost 
Unfunded 

Amount 
1. Bobby Bonds Park Artificial Turf Refurbishment $700,000 $414,655 

2. La Sierra Park Playground Resurface 150,000 150,000 

3. Bobby Bonds Park - Playground Area Lighting Improvement 35,000 35,000 

4. Fairmount Park -Lake Evans Water Quality (Solarbee) 65,000 65,000 

5. Ward 3 Ada Improvements 70,269 70,269 

6. Citywide Parking Lot Rehabilitation 500,000 500,000 

7. Riverwalk Golden/Schuyler Playground Surfacing 105,321 105,321 

8. Sycamore Highlands Park - Playground Poured-In-Place Surfacing Replacement 35,534 35,534 

9. Park System Ada Improvements 45,000,000 45,000,000 

10. Collett Park Playground Equipment Replacement 295,000 295,000 

TOTAL $46,956,124 $46,670,779 
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      Capital Improvement Program 

Project Category Overview:  Parks, Recreation, and 
Community Services 

 

 

 
Project Map 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: This map includes all active and new capital improvement projects.  Ongoing and citywide projects are not included on the 
map.  To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.   

 
Distribution by Ward  
 

Ward Five-Year Total  

Ward 1 $325,000 

Ward 2                               -  

Ward 3        - 

Ward 4                       -  

Ward 5 - 

Ward 6                               -  

Ward 7                       -  

All Wards                       -  

 Total $325,000 
  

$0.3M

‐

‐

‐

‐

‐

‐

‐

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7

 All Wards
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  NICHOLS COMMUNITY CENTER RENOVATION 
PROJECT NUMBER 2569 COUNCIL WARD 3 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Nichols Park, 5505 Dewey Avenue 
 
PROJECT DESCRIPTION 
Master Plan Design and construction for the Joyce Jackson Community Center. Design 
phase will include issuing an RFP and procuring architectural services for a Community 
Center Master Plan. The Master Plan will entail a complete renovation of the existing 
10,000 square feet facility and expansion of the programmable space by 
approximately 6,000 square feet.  The Master Plan Design will also include a redesign of 
the landscape architectural design services for redesigning the exterior spaces to 
make the building more welcoming and functional. The master plan documents will be 
used to apply for grants or other funding opportunities to complete the construction 
documents and ultimately construct the future $7 million dollar improvement. 
 
PROJECT STATUS 
In Progress - master plan/conceptual design is anticipated to be presented to Council 
by November 2020. Construction documents and construction are currently unfunded. 
 
OPERATING BUDGET IMPACT 
A minor increase in operating costs for maintenance due to additional square footage 
is estimated to be in the range of $5,000 to $10,000 annually based on current janitorial 
rates. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$14,753,460 $138,000 $0 $14,615,460 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  EL DORADO PARK WALKING PATH 
PROJECT NUMBER 2572 COUNCIL WARD 6 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION El Dorado Park 
 
PROJECT DESCRIPTION 
Design and construction of decomposed granite walking/jogging path from Warren 
Street to Temecula Street (Phase I) including demolition of existing turf, minor grading of 
the site, concrete mow curbs, new landscape, irrigation modifications, and other 
associated work. 
 
PROJECT STATUS 
The project is complete. Opened to the public on January 13, 2020. Closeout Phase in 
Progress. 
 
OPERATING BUDGET IMPACT 
No operating impact. The existing site is currently landscaped with turf and is being 
maintained and watered. The installation of a decomposed granite walking path is not 
anticipated to be more costly to maintain. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$122,000 $122,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  HUNTER PARK - RAILROAD KIOSK 
PROJECT NUMBER 2600 COUNCIL WARD 1 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Hunter Park, 1401 Iowa Avenue 
 
PROJECT DESCRIPTION 
Design and construction of Hunter Park Railroad Kiosk include design, demolition, 
landscaping, irrigation, paving, and construction of interpretive signage that will 
provide historical background information about unique miniature steam train railroad 
features at Hunter Park. 
 
PROJECT STATUS 
The project is pending the final installation. 
 
OPERATING BUDGET IMPACT 
No impact to operating budget. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$68,000 $68,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MARTHA MCLEAN ANZA NARROWS – FRISBEE 
GOLF COURSE 
PROJECT NUMBER 2601 COUNCIL WARD 1 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Martha McLean Anza Narrows – 5759 Jurupa Avenue 
 
PROJECT DESCRIPTION 
Design and construction of an 18-hole frisbee golf course at Martha McLean Anza Park.  
The improvements include tees, course map, information board, signage, furniture, and 
minor irrigation and landscape modifications. 
 
PROJECT STATUS 
The project is complete. Opened to the public on March 20, 2019. Closeout phase in 
progress. 
 
OPERATING BUDGET IMPACT 
No operating impact.  The existing site is currently developed and maintained. The 
installation of frisbee golf features are not anticipated to be significantly more costly to 
maintain. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$55,000 $55,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  GOESKE SENIOR CENTER - RESTROOM 
RENOVATION 
PROJECT NUMBER 2602 COUNCIL WARD 3 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Janet Goeske Center, 5257 Sierra Street 
 
PROJECT DESCRIPTION 
Design and construction to renovate existing restroom interior and exterior (tiles 
replacement, paint, partitions, fixtures, signage, ceiling, lights, and other items as 
required) to meet current building codes. 
 
PROJECT STATUS 
The project is funded through a Community Development Block Grant (CDBG) and a 
Memorandum of Understanding (MOU) has been executed.  National Environmental 
Policy Act review has been completed.  Construction is anticipated to be completed 
in December 2020. 
 
OPERATING BUDGET IMPACT 
None to minimal since this is a renovation of an existing amenity. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$50,000 $50,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MYRA LINN PARK - ACCESS IMPROVEMENTS 
PROJECT NUMBER 2604 COUNCIL WARD 6 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Myra Linn Park, 4540 Meredith Street 
 
PROJECT DESCRIPTION 
Design and construction so the facility is compliant with the Americans With Disability 
Act (ADA). The project will also include drainage improvement to the basketball court 
area; including demolition, grading, paving, furniture, drainage, and minor 
landscaping and irrigation modifications. 
 
PROJECT STATUS 
The project is substantially complete. Opened to the public pending COVID-19 
Restrictions. Closeout phase in progress. 
 
OPERATING BUDGET IMPACT 
No operating impact. The existing site is currently developed and maintained. 
Improvements to ADA access and drainage are not anticipated to be more costly to 
maintain. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$38,500 $38,500 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MYRA LINN PARK - SHADE SAILS 
PROJECT NUMBER 2606 COUNCIL WARD 6 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Myra Linn Park, 4540 Meredith Street 
 
PROJECT DESCRIPTION 
Design and construction of shade sails over the age of 5-12 playground.  Shade sails 
are a safety enhancement to provide greater comfort for users during the summer. 
 
PROJECT STATUS 
The project is substantially complete. Opened to the public pending COVID-19 
Restrictions. Closeout phase in progress. 
 
OPERATING BUDGET IMPACT 
No significant operating impact. The existing site is currently developed and being 
maintained. The installation of shade sails is not anticipated to add significantly to 
routine maintenance. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$99,000 $99,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MYRA LINN PARK - FITNESS STATIONS 
PROJECT NUMBER 2608 COUNCIL WARD 6 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Myra Linn Park 
 
PROJECT DESCRIPTION 
Design and installation of four fitness stations strategically located along the walking 
path.  This project will provide an additional amenity for park users who will be able to 
increase their fitness levels and reduce obesity. 
 
PROJECT STATUS 
The project is substantially complete. Opened to the public pending COVID-19 
Restrictions. Closeout phase in progress. 
 
OPERATING BUDGET IMPACT 
No significant operating impact. The existing site is currently developed and being 
maintained. The installation of fitness equipment is not anticipated to add significantly 
to routine maintenance. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$99,000 $99,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  LA SIERRA PARK ADA WALKWAY - PHASE I 
PROJECT NUMBER 2609 COUNCIL WARD 7 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION La Sierra Park, 5215 La Sierra Avenue 
 
PROJECT DESCRIPTION 
Design and construction of pathway that is compliant with the Americans With 
Disabilities Act (ADA) from the Senior Center parking lot to the ballfield and parking lot 
(DG path, concrete, mow curbs, landscape, and furniture). ADA pathway will provide 
improved accessibility to the ballfields. The project scope includes adjusting landscape 
and irrigation, as well as rest areas along the path with trash receptacles and benches. 
 
PROJECT STATUS 
The design phase is expected to be complete by September 2020. 
 
OPERATING BUDGET IMPACT 
No operating impact. Existing site is currently landscaped and being maintained.  
Installation of a decomposed granite walking path is not anticipated to be more costly 
to maintain. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$204,077 $204,077 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  FAIRMOUNT PARK SIGNAGE 
PROJECT NUMBER 2641 COUNCIL WARD 1 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Fairmount Park, 2601 Fairmount Boulevard 
 
PROJECT DESCRIPTION 
Design and construction of wayfinding signage with kiosk, golf course sign, new entry 
sign, traffic, and parking signs. The design will be in accordance with the historic 
character of the original park design. 
 
PROJECT STATUS 
The project is funded through a Community Development Block Grant (CDBG) and a 
Memorandum of Understanding (MOU) has been executed. National Environmental 
Policy Act review has been completed. Design and construction are anticipated to be 
completed in 2020. 
 
OPERATING BUDGET IMPACT 
Updating the Fairmount Park Signage will not significantly impact the operating 
budget. The site is currently developed and maintained. 
 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$190,000 $190,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  BORDWELL PARK - FLOOR REPLACEMENT 
PROJECT NUMBER 2642 COUNCIL WARD 2 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Bordwell Park, 2008 Martin Luther King Boulevard 
 
PROJECT DESCRIPTION 
Replace the existing vinyl composition tile flooring at the Nati Fuentes Centro de Ninos. 
The project will include installing water moisture barrier and flooring in six classrooms 
(5,400 square feet), hallway (2900 square feet), and office area (2200 square feet). 
 
PROJECT STATUS 
The project is substantially complete. Opened to the public pending COVID-19 
Restrictions. Closeout phase in progress. 
 
OPERATING BUDGET IMPACT 
No significant operating impact. The existing site is currently developed and 
maintained.  Replacement of floor is not anticipated to significantly alter routine 
maintenance. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$248,299 $248,299 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  VILLEGAS PARK - WADING POOL DESIGN 
PROJECT NUMBER 2643 COUNCIL WARD 4 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Ysmael Villegas Park, 3091 Esperanza Street 
 
PROJECT DESCRIPTION 
Design of wading pool replacement with a splash pad that is compliant with the 
Americans With Disabilities Act (ADA). Completion of design will facilitate future grant 
application for construction.  Splash pad to include recirculation and filtering 
equipment to meet Health Department requirements, as well as fencing, paving, 
landscape modifications, etc. at Villegas Park which is near the existing pool. 
 
PROJECT STATUS 
Design project is funded through the Community Development Block Grant (CDBG) 
and a Memorandum of Understanding (MOU) has been executed. National 
Environmental Policy Act review has been completed. Design is anticipated to be 
completed by 2020. 
 
OPERATING BUDGET IMPACT 
The completion of the design for the wading pool will not impact the operating 
budget. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$690,000 $40,000 $0 $650,000 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  LA SIERRA PARK ADA WALKWAY - PHASE II 
PROJECT NUMBER 2646 COUNCIL WARD 7 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION La Sierra Park 
 
PROJECT DESCRIPTION 
Design and construction of a pathway around the ballfields that is compliant with the 
Americans With Disabilities Act (ADA). The project will include installing a decomposed 
granite path with mow curbs, landscaping, and site furniture. The ADA compliant 
pathway will provide improved accessibility to the ballfields. The project scope includes 
adjusting landscape and irrigation, as well as rest areas along the path with trash 
receptacles and benches. 
 
PROJECT STATUS 
Preliminary design concepts in progress. Design phase expected to be completed by 
September 2020. 
 
OPERATING BUDGET IMPACT 
No operating impact. The existing site is currently landscaped and is being maintained.  
The installation of a decomposed granite walking path is not anticipated to be more 
costly to maintain. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$30,000 $30,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  BOBBY BONDS PARK ARTIFICIAL TURF 
REFURBISHMENT 
PROJECT NUMBER 2713 COUNCIL WARD 2 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION BOBBY BONDS PARK 
 
PROJECT DESCRIPTION 
Removal and replacement of 85,675 SF of existing artificial turf. Panel seams to be 
hand sewn and field to be restriped for both full team football and soccer games as 
well as 7-man mini soccer games. Life expectancy is approximately 10 years. Regular 
maintenance sweeping of the infill/turf should be completed every 4-6 weeks. 
 
PROJECT STATUS 
Community Development Block Grant has been awarded for this project in the 
amount of $285,345. Department still needs approximately $414,655 in funding to begin 
the project. Department is seeking out additional grant funding to begin the project. 
 
OPERATING BUDGET IMPACT 
No impact to operational budget due to it being existing infrastructure. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$700,000 $285,345 $0 $414,655 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MYRA LINN PARK MASTER PLAN IMPROVEMENTS 
PROJECT NUMBER 3398 COUNCIL WARD 6 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Myra Linn Park 
 
PROJECT DESCRIPTION 
Design and Construction for implementation of the approved park master plan, 
including additional fitness nodes, walking & jogging paths, “mini-pitch” soccer fields, 
pickleball courts, and a splash pad. The plan also includes the revitalization of existing 
features including playgrounds, basketball court, picnic pavilions, and restroom. 
Planting, irrigation modifications, new site furnishings, and minor grading operations will 
be incorporated as necessary. The acquisition of two adjacent residential lots is also 
required to fully implement the master plan. 
 
PROJECT STATUS 
The master plan was approved by Council in July of 2019, including the authorization to 
submit a grant application for the Statewide Park Development and Community 
Revitalization Program. 
 
OPERATING BUDGET IMPACT 
The overall additional operating cost is estimated at $12,000 annually.  The additional 
amenities are expected to increase revenue by approximately $6,000.  The net annual 
deficit of $6,000 can be absorbed by the existing operating budget.  New energy 
conserving improvements; such as LED lighting, low water use planting, and drip 
irrigation will save a few thousand dollars but will be more than offset with the 
additional parkland, water play features, and security cameras. 
  
  
  

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$8,500,000 $0 $8,500,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

Grant* State Capital Grants - 8,500,000 - - - $8,500,000 

 TOTAL $0 $8,500,000 $0 $0 $0 $8,500,000 

*Appropriation of funds contingent on grant award.  For planning purposes only.  Not included in in other areas of the CIP. 
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  GAGE CANAL TRAIL IMPROVEMENTS 
PROJECT NUMBER 4092 COUNCIL WARD All Wards 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Includes multiple phases of development of approximately 6.5 miles of the Gage 
Canal for recreational trail use as well as commuters using active transportation modes 
such as bicycles, skates, and scooters.  The trail will have solar lighting and trees will line 
the corridor to provide shade and to sequester carbon for greenhouse gas reduction 
benefits.  Other support amenities include seating, bike racks, map boards, and signs. 
Interpretive material will be included on the map boards to highlight the historic nature 
of the Gage Canal and its role in the citrus industry in the Inland Empire Region. 
 
PROJECT STATUS 
Phase I has been fully funded through the Urban Greening Grant which includes trail 
improvements, between Palmyrita Avenue on the north end of the City, continuing 
south along the canal to Blaine Street (approximately 2 miles).  The project connects 
the Hunter Business Park area with neighborhoods around the University of California, 
Riverside campus. The design will begin once the agreement is executed by the State. 
 
OPERATING BUDGET IMPACT 
While improvements are being designed to minimize maintenance demands, there will 
be additional operating budget needs.  The AC paving path will be maintained by 
Public Works with in-house crews and an annual cost of $5,000 for materials to patch 
and repair trail as needed.  Landscape operational costs are anticipated to be 
approximately $25,000 per year.  Collaboration with UCR and non-profits to collect 
trash is planned to reduce long term operational costs. 
  

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$13,708,509 $3,708,509 $0 $10,000,000 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  ARLINGTON YOUTH INNOVATION CENTER 
PROJECT NUMBER 8867 COUNCIL WARD 5 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Arlington Park, 3860 Van Buren Boulevard 
 
PROJECT DESCRIPTION 
Design and construction of a new 10,000 square foot Youth Innovation Center (AYIC). 
The project will include classrooms, a computer lab, multi-purpose rooms, a recording 
studio, a new parking lot, and an outdoor amphitheater. The AYIC is envisioned to offer 
a broad range of work skills and educational assistance programs as the Johnny Martin 
Sotelo Youth Opportunity Center (YOC) in the Eastside Neighborhood. The AYIC will 
focus on innovation, technology, and multi-media to complement the arts-focused 
programs at the existing YOC. 
 
PROJECT STATUS 
The project is Complete. Open to the public pending COVID-19 restrictions. Closeout 
phase in progress. 
 
OPERATING BUDGET IMPACT 
Estimated $275,000 additional ongoing funds needed to operate and maintain the 
facility to be paid by revenue generated by the YIC and the General Fund. Ongoing 
needs include approximately 3.0 full-time equivalent personnel to program and 
operate the facility as well as non-personnel (supplies, copy machines, utilities, 
janitorial, etc.). 
  
  

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$7,490,862 $7,490,862 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 

 

153



 

 

PARKS, RECREATION, AND COMMUNITY SERVICES 
Capital Improvement Program FY 2020/21 - 2024/25 
 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

 

 

  MOUNT RUBIDOUX TRAIL IMPROVEMENTS 
PROJECT NUMBER 8952 COUNCIL WARD 1 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Carlson Park/Mt. Rubidoux 
 
PROJECT DESCRIPTION 
Renovation and restoration of the trails on Mt. Rubidoux including hydrologic 
engineering to stabilize the hillside that is severely impacted by erosion due to off-trail 
activity above the historic Carlson Falls. The restoration work will include grading to 
minimize erosion, installation of trail circulation barriers, and signage improvements. 
 
PROJECT STATUS 
Site analysis and management plan development completed. Trail modification work 
in progress. After the initial project scoping in 2013, the erosion and stormwater 
damage on Mt. Rubidoux worsened as the region moved out of drought conditions 
and experienced damaging rain events.  These subsequent rain events led to more 
work than initially scoped in order to control erosion and stabilize the hillside. 
 
OPERATING BUDGET IMPACT 
No significant operating budget impact. The existing site is currently maintained. Site 
improvements are not anticipated to significantly alter routine maintenance. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$534,245 $534,245 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  CARLSON PARK HISTORIC FALLS RESTORATION 
PROJECT NUMBER 8957 COUNCIL WARD 1 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Carlson Park/Mt. Rubidoux 
 
PROJECT DESCRIPTION 
This cultural heritage landmark, constructed in 1923, is deteriorating from stormwater 
run-off from Mt. Rubidoux and erosion due to off-trail activity. Due to the historic 
significance of Carlson Park, as the formal entrance of Riverside, and the community’s 
desire to rehabilitate the features of the park, the Department aims to stabilize the St. 
Francis Falls. This project will assess and protect this historic feature from further 
deterioration. 
 
PROJECT STATUS 
The project has been completed. Closeout phase in progress. 
 
OPERATING BUDGET IMPACT 
Assessing and protecting the waterfall feature from further deterioration is not 
anticipated to have a significant impact on the operating budget. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$25,000 $25,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  PARKS MASTER PLAN UPDATE 
PROJECT NUMBER 9003 COUNCIL WARD All Wards 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Provides professional Planning and Design services for Park Master Plan updates. The 
Master Plan is an essential tool for the Department because it is used to guide decisions 
and actions. The document supports City and community direction, helps achieve the 
objectives and policies of the 2025 General Plan, prioritizes projects and resource 
commitments, and establishes a roadmap to align with City Council goals. 
 
PROJECT STATUS 
The project completed and adopted by City Council. Project closeout in progress. 
 
OPERATING BUDGET IMPACT 
Updating the parks master plan will not have an impact on the operating budget. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$578,000 $578,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  TRAILS MASTER PLAN 
PROJECT NUMBER 9091 COUNCIL WARD All Wards 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The existing Trails Master Plan was completed in 1996 and should be updated every 10 
years or so to adjust for Riverside’s population and built environment growth and 
changes.  The update will include an inventory of trails, analysis, community outreach, 
site assessments, and route network planning, and standard trail design updates. 
 
PROJECT STATUS 
The project has been funded through a grant program and is being completed in 
collaboration with Public Works and Southern California Association of Government in 
an overall effort to prepare an Active Transportation Plan (ATP), Pedestrian Target 
Hardening Plan, and a Complete Streets Ordinance for the City of Riverside.  The study 
is in progress and is anticipated to be completed by the end of 2020. 
 
OPERATING BUDGET IMPACT 
Planning only with no operational impact. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$65,000 $65,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  FAIRMOUNT PARK LAKE EVANS LAKESHORE 
ACCESS 
PROJECT NUMBER 9099 COUNCIL WARD 1 
PROJECT CATEGORY Parks, Recreation, and Community Services 
PROJECT LOCATION Fairmount Park 
 
PROJECT DESCRIPTION 
Phase I - Design and Construction of an ADA Accessible Pedestrian Walkway along 
Dexter Drive from the American Legion (Post 79) to the Isaak Walton Building. 
 
Phase II - Design and Construction of an ADA Accessible Pedestrian Walkway along 
Dexter Drive from Approximately the Isaak Walton Building to the Redwood Drive 
Bridge;  
 
Phase III - Design and Construction of an ADA Accessible Pedestrian Walkway and 
Decking/Railing Expansion along the Redwood Drive Bridge; all phases including Minor 
Grading, Drainage, Foundation Piles, Lighting, and Furnishing Improvements. 
 
 
PROJECT STATUS 
Partial funding in the amount of $325,000 will be allocated in 2020/21 from the Regional 
Fund Account. 
 
OPERATING BUDGET IMPACT 
The addition of the Lakeshore Pedestrian Access will not impact the operating budget. 
Site is currently developed and maintained. 
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$950,000 $0 $325,000 $625,000 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

413 Regional Park Fund $325,000 - - - - $325,000 

 TOTAL $325,000 $0 $0 $0 $0 $325,000 
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      Capital Improvement Program 

Project Category Overview:  Public Parking 

 

 

Introduction  
The Public Parking Services Division promotes and maximizes public parking 
opportunities that contribute to improving the quality of life in residential and 
commercial areas citywide.  This includes administration of contract services 
for the operation and maintenance of the City’s public parking facilities, 
keeping related equipment functional, and managing the program’s 
sustainability while remaining customer friendly.   
 
One-Year Budget and Five-Year Plan 
The downtown area has been growing at 
a significant rate with developments that 
attract employment opportunities and 
community events.  The increased local 
activity has augmented the vehicular 
and pedestrian use of the parking 
facilities that has required additional 
maintenance, security and management 
costs.   
 
A significant portion of the street 
sweeping routes throughout the City have 
not been enforceable while street 
sweeping signage was being audited 
and replaced over the last 2 years.  The 
street sweeping signage audit and 
replacement is expected to be 
completed in Q2 of FY 2020/21.  Due to 
COVID-19 and the Governor’s stay at 
home orders parking enforcement has been relaxed for citing abandoned 
vehicles and commercial vehicles parked in residential areas.  The reduced 
citation revenue from street sweeping enforcement and the stay at home 
order has reduced funding for necessary projects.   
 
Project Highlights:   
City Council approved enhancements within the two-year implementation 
plan on March 21, 2017, which included the replacement of 170 single and 79 
multi-space parking meters that have now reached their end of life and/or 
will no longer meet credit card processing regulations to securely process 
payments.   79 multi-space parking meters have been ordered and the 
estimated delivery/installation is scheduled for Q2 of FY 2020/21.   
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Key Revenues and Funding Sources 
 

Fund Funding Source Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

570 Parking Fund - $770,000 - - - $770,000 

 TOTAL $0 $770,000 $0 $0 $0 $770,000 

 
Funding for the CIP is derived solely from public parking revenues, which 
include on and off-street parking, office space leasing, and parking citations.   
 
Recent state legislation (Assembly Bill 503 and Assembly Bill 516) will have a 
negative effect on parking fine revenues going forward, though the exact 
amount, yet, is unknown.   
 

 Assembly Bill 503 – now requires cities to offer a payment plan.  There 
are anticipated implementation costs in addition to ongoing 
administrative costs associated this program.   

 
 Assembly Bill 516 - authorized the DMV to prefund implementation of a 

new electronic system for dealers to report the sale of vehicles and 
issuance of temporary licenses.  As a result, they have increased their 
administrative service fee for agencies recording a Notice of 
Delinquent Parking.  This is a per vehicle fee.   

 
The department estimates that a combined loss of $200,000 over the next five 
years will be due to increased costs imposed by both legislations.   
 
Projects by Type of Improvement 
 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Garage Led Lighting 
Upgrade - $190,000 - - - $190,000 

Structural Upgrades to 
Garages 1 & 2 - 580,000    $580,000 

TOTAL  $0 $770,000 $0 $0 $0 $770,000 

 
Parking Access and Revenue Control System (PARCS) - Automatically 
controls the vehicle traffic in and out of the garages and manages the 
payments.   The PARCS has become the highest priority for Parking Services 
as the existing systems in the parking garages have failed or are failing, are 
no longer supported by the vendor and are beyond repair.  The garages 
now require attendants to manage the vehicle traffic in and out of the 
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garages.  An RFP was issued for the PARCS system and the proposals are 
currently being evaluated by a panel.  Approval to award the PARCS bid to 
a vendor will be presented to City Council in FY 2020/21. 
 
Replacement of 170 single space parking meters are required as the meters 
will not be supported by the vendor in one year.  The project is under review 
to determine if multi-space parking meters can provide a cost savings and if 
the RFP for the 79 multi-space parking meters can be utilized to expedite 
procurement 
 
Top Unfunded Projects 
Public Works identified one Capital Project for Public Parking without an 
identified funding source. 
 

Project Name Estimated 
Project Cost 

Unfunded 
Amount 

Replace Garages 1 & 2 $32,000,000 $32,000,000 

TOTAL $32,000,000 $32,000,000 
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Project Map 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Note: This map includes all active and new capital improvement projects.  Ongoing and citywide projects are not included on the 
map.  To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.   

 
Distribution by Ward  
 

Ward Five-Year Total  

Ward 1 $770,000 

Ward 2                               -  

Ward 3        - 

Ward 4                       -  

Ward 5                               -  

Ward 6                               -  

Ward 7                       -  

All Wards                       -  

 Total $770,000 

 

$0.8M

‐

‐

‐

‐

‐

‐

‐

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7

 All Wards
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  PARKING ACCESS REVENUE CONTROL SYSTEM 
PROJECT NUMBER 9129 COUNCIL WARD 1 
PROJECT CATEGORY Public Parking 

PROJECT LOCATION Garage 1, Garage 2, Garage 3, Garage 6 and 
Garage 7 

 
PROJECT DESCRIPTION 
The PARCS (Parking Access and Revenue Control System) will be an automated 
entry/exit control system for each garage.  It will provide 24/7 operational capabilities 
and provide a deterrence to after-hours activity as the entry/exit arms can be kept 
down.  It has the capabilities to charge different rates based upon entry and exit times.  
It will be able to capture entry/exit data 24/7 for analytical and marketing purposes. 
 
PROJECT STATUS 
RFP 1955 has been published and the proposals have been received by March 31, 
2020.  The Evaluation panel is being established and the evaluation of the proposals 
are anticipated to begin in August/September 2020. 
 
OPERATING BUDGET IMPACT 
Anticipate no additional operational costs above what is currently spent on this 
equipment. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,000,000 $0 $2,000,000 $0 

 

2-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

570 Public Parking Fund $1,000,000 $1,000,000 - - - $2,000,000 

 TOTAL $1,000,000 $1,000,000 $0 $0 $0 $2,000,000 

*Appropriation of funds contingent on fund health post COVID‐19 parking structure closures. For planning purposes only.  Not included in in other areas of the CIP. 
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  GARAGE LED LIGHTING UPGRADE 
PROJECT NUMBER 9134 COUNCIL WARD 1 
PROJECT CATEGORY Public Parking 
PROJECT LOCATION 3743, 3851, & 3901 Orange St; 3601 Market St. 
 
PROJECT DESCRIPTION 
On March 21, 2017, City Council approved parking rate increases that would be used 
to fund facility enhancements, including upgrading to LED lighting in all City-owned 
parking garages. 
 
PROJECT STATUS 
Project has been placed on hold as parking inventory has been considered for surplus 
and investment into these garages may not make financial sense. 
 
OPERATING BUDGET IMPACT 
Undetermined savings in electricity costs. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$190,000 $0 $190,000 $0 

 

2-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

570 Public Parking Fund - $190,000 - - - $190,000 

 TOTAL $0 $190,000 $0 $0 $0 $190,000 
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  STRUCTURAL UPGRADES TO GARAGES 1 & 2 
PROJECT NUMBER 9135 COUNCIL WARD 1 
PROJECT CATEGORY Public Parking 
PROJECT LOCATION 3743 & 3851 Orange St. 
 
PROJECT DESCRIPTION 
Replace girders, tensioning tendons, and Spalling in Garage 1 and Garage 2 to 
enhance structural support to aging garage infrastructure. 
 
PROJECT STATUS 
No funding is available for repairs and upgrades.  Parking inventory is being considered 
for surplus so financial investments into these facilities do not make sense at the 
moment and will be evaluated on an ongoing basis. 
 
OPERATING BUDGET IMPACT 
Anticipate no additional operational costs above what is currently spent on Garages 1 
& 2. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$580,000 $0 $580,000 $0 

 

2-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

570 Public Parking Fund - $580,000 - - - $580,000 

 TOTAL $0 $580,000 $0 $0 $0 $580,000 
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      Capital Improvement Program 
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Introduction  
Railroad related projects are presented in an individual capital improvement 
program because of the high priority placed on these projects by the City 
Council and the complexity of funding for the projects.  The five-year capital 
improvement program for Railroad Related projects totals $2.4 million.  The 
proposed program is underfunded by $158.9 million.  
 
Railroad related projects are a City Council priority because the projects 
promote public safety, enhance quality of life, and economic vitality.  20 at-
grade BNSF and Union Pacific main line crossings must be mitigated within the 
City.  The estimated cost of grade separating the 20 at-grade crossings is in 
excess of $800 million.  The City’s program to mitigate the adverse impacts of 
the at-grade crossings includes a combination of prioritized grade 
separations, quiet zones to maximize safety, quality of life improvements, and 
economic vitality benefits at a reduced cost.   
 
The City continues to work to obtain state and federal funds for railroad grade 
separation and quiet zone projects.  The CIP includes the design and 
construction of two quiet zone projects.  The grade separations included are 
unfunded and one quiet zone is only partially funded in the five-year period 
of the CIP. 
 
One-Year Budget and Five-Year Plan 
The CIP includes the second phase of the Department’s grade separation 
program which is unfunded.  The City Council already approved Mary Street, 
Third Street, Spruce Street, and Jackson Street for concept design and future 
funding opportunities.  Third Street was identified as the City’s top priority 
grade separation and is included as a separate unfunded project in the CIP.  
A quiet zone for the Union Pacific railroad corridor between Brockton and 
Palm Avenues is included in the CIP along with a partially funded quiet zone 
for the BNSF corridor at Mission Inn Avenue, Third Street, and Spruce Street.   
 
Project Highlights: 
Union Pacific Quiet Zone – Brockton Avenue and Palm Avenue 
The CIP funds the final design, right of way acquisition, and street and rail 
crossing  improvements required to establish a Quiet Zone along the Union 
Pacific Railroad corridor at the Brockton and Palm Avenue rail crossings. The 
quiet zone will be established in accordance with the Federal Railroad 
Administration’s (FRA) Final Rule and eliminate the routine sounding of train 
horns at the rail crossings.   
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BNSF Quiet Zone – Mission Inn Avenue, Third Street, and Spruce Street 
The concept planning and design of the Mission Inn Avenue, Third Street, and 
Spruce Street Quiet Zone is funded during the first two years of the CIP.  
Planned funding for years three to five of the CIP is sufficient to complete 
project design, right-of- way acquisition, and partially fund the street and 
grade crossing improvements required for the quiet zone.   
 
Key Revenues and Funding Sources 

 
Fund Funding Source Adopted 

2020/21 
Proposed 

2021/22 
Proposed 

2022/23 
Proposed 

2023/24 
Proposed 

2024/25 Total 

432 Measure A $772,700 788,200 804,000 - - $2,364,900 

 TOTAL $772,700 $788,200 $804,000 $0 $0 $2,364,900 

 
Local funding for the projects is provided by a ten percent allocation of the 
City’s Local Measure A. Past non-City funding sources for the CIP included 
state and federal grants and private funds from the railroads. 
 
The complexity of funding sources and high cost per grade separation pose 
several challenges for the City.  Available state and federal grant funding 
opportunities are limited and very competitive.  Major non-City funding 
sources for grade separation projects have historically included California 
Public Utilities Commission Section 190 Grade Separation (PUC) funds, federal 
grants, and private funds from railroads.  The State of California’s SB-1 Trade 
Corridor Enhancement Program provides another potential funding source for 
grade separations.  
 
Funding from non-City sources may not be available in a timely manner to 
keep projects moving forward, so the City will need to be prepared to 
advance millions of dollars to projects in anticipation of reimbursement 
revenues that may not be available until years after expenditures are made.  
If any non-City funding sources fail to materialize and alternative funding is not 
obtained, the City may be faced with allocating significant City resources or 
delayed projects. 
 
The City of Riverside is working with the Riverside County Transportation 
Commission and other stakeholders to help influence the debate in 
Sacramento and Washington, DC, and to promote the importance of local 
highway and railroad transportation projects. 
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Projects by Type of Improvement 
 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Railroad       
BNSF Quiet Zone - Mission 
Inn, 3rd, and Spruce $772,700 $788,200 $804,000 - - $2,364,900 

TOTAL $772,700 $788,200 $804,000 $0 $0 $2,364,900 

 
Top Unfunded Projects 
Public Works identified two railroad capital projects without an identified 
funding source. 
 

Project Name Estimated 
Project Cost 

Unfunded 
Amount 

1. BNSF/Third Street Grade Separation $55,500,000 $49,449,275 

2. Phase II Grade Separation Program (Spruce, Jackson and/or Mary) 109,500,000 109,500,000 

TOTAL $165,000,000 $158,949,275 
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Project Map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: This map includes all active and new capital improvement projects.  Ongoing and citywide projects are not included on the 
map.  To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.   

 
Distribution by Ward  

 
Ward Five-Year Total  

Ward 1 $- 

Ward 2 - 

Ward 3 - 

Ward 4 -  

Ward 5 -  

Ward 6 -  

Ward 7  -  

All Wards 2,364,900 

 Total $2,364,900 

 

‐

‐

‐

‐

‐

‐

‐

$2.4M

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7

 All Wards
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  BNSF/UP QUIET ZONE - PANORAMA & CRIDGE 
PROJECT NUMBER 5934 COUNCIL WARD 1, 2, 3 
PROJECT CATEGORY Railroad 

PROJECT LOCATION Panorama Road and Cridge Street Highway-Rail 
crossings 

 
PROJECT DESCRIPTION 
This project will eliminate the routine sounding of train horns by establishing Quiet Zones 
in accordance with the Federal Railroad Administration’s (FRA) Final Rule. The Quiet 
Zones will be along the Union Pacific (UP) Railroad corridor at Panorama Road and the 
Burlington Northern Santa Fe (BNSF) Railway corridor at Cridge Street. The project 
provides for the construction of additional safety improvements consisting of new 
concrete curb, gutter and sidewalk, tactile strips, directional fencing, warning signs, 
and grade crossing warning devices at the Panorama Road and Cridge Street 
highway-rail grade crossings. 
 
PROJECT STATUS 
City design is complete. Waiting for BNSF to submit the Construction and Maintenance 
agreement. This will require Council action. Expect to begin construction in Q3 of FY 
2020/21. 
 
OPERATING BUDGET IMPACT 
Upon project completion, there will be an annual maintenance cost of approximately 
$50,000 per year per crossing required for UP and BNSF to maintain the crossings. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$6,988,733 $6,988,733 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  BNSF QUIET ZONE - MISSION INN, 3RD, & SPRUCE 
PROJECT NUMBER 8610 COUNCIL WARD 1, 2 
PROJECT CATEGORY Railroad 
PROJECT LOCATION BNSF Highway-Rail Crossing Mission Inn, 3rd, & Spruce 
 
PROJECT DESCRIPTION 
This project will eliminate the routine sounding of train horns along the Burlington 
Northern Santa Fe (BNSF) Railway corridor between Mission Inn Avenue and Spruce 
Street by establishing a Quiet Zone in accordance with the Federal Railroad 
Administration’s (FRA) Final Rule.  The project provides for the construction of additional 
safety improvements consisting of new concrete curb, gutter, and sidewalk, tactile 
strips, directional fencing, warning signs, and grade crossing warning devices at Mission 
Inn Avenue, 3rd Street, and Spruce Street highway-rail grade crossings. 
 
PROJECT STATUS 
The project is currently in the preliminary engineering phase. 
 
OPERATING BUDGET IMPACT 
Upon completion, this project will have an annual maintenance cost of approximately 
$50,000 per year per crossing required for BNSF to maintain the crossings. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$3,163,000 $798,100 $2,364,900 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A Capital Outlay $772,700 $788,200 $804,000 - - $2,364,900 

 TOTAL $772,700 $788,200 $804,000 $0 $0 $2,364,900 
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  UP QUIET ZONE - BROCKTON AND PALM 
PROJECT NUMBER 8721 COUNCIL WARD 3 
PROJECT CATEGORY Railroad 

PROJECT LOCATION Brockton Avenue & Palm Avenue Highway-Rail grade 
crossings 

 
PROJECT DESCRIPTION 
This project will eliminate the routine sounding of train horns along the Union Pacific 
(UP) Railroad corridor at Brockton Avenue and Palm Avenue by establishing a Quiet 
Zone in accordance with the Federal Railroad Administration’s (FRA) Final Rule.  The 
project provides for the construction of additional safety improvements consisting of 
new concrete curb, gutter, and sidewalk, raised center medians, tactile strips, warning 
signs, and grade crossing warning devices at the Brockton Avenue and Palm Avenue 
highway-rail grade crossings. 
 
PROJECT STATUS 
The city design is complete. Waiting for BNSF to submit the Construction and 
Maintenance agreement. This will require Council action. Expect to begin construction 
in Q1-2021. 
 
OPERATING BUDGET IMPACT 
Upon completion, this project will have an annual maintenance cost of approximately 
$50,000 per year per crossing required for UP to maintain the crossings. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,288,100 $2,288,100 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

423 Measure A Capital Outlay - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  BNSF/THIRD STREET RAILROAD CROSSING  
PROJECT NUMBER 8914 COUNCIL WARD 1, 2 
PROJECT CATEGORY Railroad 
PROJECT LOCATION Third Street at BNSF Railroad Crossing 
 
PROJECT DESCRIPTION 
The project entails the installation of curb, gutter, and sidewalk along with the new 
concrete crossing panels and warning gates being installed by Burlington Northern 
Santa Fe (BNSF) at the Third Street/BNSF crossing. 
 
PROJECT STATUS 
The project is in the completion phase.  Once the final invoicing is complete, the 
project will be closed. 
 
OPERATING BUDGET IMPACT 
There is no anticipated operating budget impact. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$973,505 $973,505 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  BNSF/THIRD STREET GRADE SEPARATION 
PROJECT NUMBER 9901 COUNCIL WARD 1, 2 
PROJECT CATEGORY Railroad 
PROJECT LOCATION 3rd St at the BNSF crossing between Lime St & Park Ave 
 
PROJECT DESCRIPTION 
This location is along the Burlington Northern Santa Fe Railroad (BNSF) and the project 
will reduce traffic congestion by eliminating the at-grade street intersection with the 
existing railroad lines. The construction of a grade separation will allow for an 
uninterrupted flow of vehicular traffic either above or below the railroad lines. Work 
includes the construction of an underpass for Third Street and the BNSF railroad tracks, 
construction of temporary shoofly tracks, grading, retaining walls, and a multi-track 
concrete bridge structure to provide a four-lane roadway beneath the tracks. 
 
PROJECT STATUS 
The preliminary engineering phase of the project will be complete by December 2020. 
The final engineering and right-of-way acquisition phase will begin in January 2021 and 
be complete by December 2022. Construction is expected to begin in July 2023 and 
be complete by December 2024 pending funding. 
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts anticipated when this project is completed. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$55,500,000 $5,050,725 $1,000,000 $49,449,275 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

434* Transp. Uniform Mitigation Fee Fund $1,000,000 - - - - $1,000,000 

        
 TOTAL $1,000,000 $0 $0 $0 $0 $1,000,000 

*Appropriation of funds contingent on TUMF award.  For planning purposes only.  Not included in in other areas of the CIP. 
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      Capital Improvement Program 

Project Category Overview:  Sewer 

 

 

Introduction  
The Public Works Department, Wastewater Division, has a staff of 
approximately 120 that is responsible for the collection and treatment of 
wastewater for over 93,000 customers within City limits.  The wastewater 
facilities consist of over 800 miles of gravity sewers, 20 wastewater lift stations, 
and the Riverside Regional Water Quality Control Plant (RWQCP), which has 
the capacity to treat 46 million gallons per day.  Additionally, the RWQCP 
provides wastewater treatment for the Edgemont, Jurupa, and Rubidoux 
Community Services Districts, and the unincorporated community of 
Highgrove.   
 
The CIP for the Sewer Fund is based on the current Wastewater Master Plan 
and is comprised of three primary areas related to the collection, 
conveyance, and treatment of sewage.  The three areas are: 
 

• Compliance with Federal and State Regulations - Projects in this 
category keeps the plant and sewer collections system up to date.  The 
RWQCP facility permit to operate is issued by the State Water Resource 
Control Board and other evolving Federal and State regulatory 
requirements. 

 
• Treatment Plant Capacity / Replacements / Structures - Projects are 

designed to increase plant capacity, improve treatment efficiency, 
reduce system maintenance, and replace infrastructure that has 
reached its life expectancy.  

 
• Sewer Collection System Projects – These projects complete upgrades 

to the sewer collection and conveyance system to eliminate the 
possibility of sanitary sewer overflows, increase capacity, replace 
deteriorated pipelines and manholes, and provide upgrades to sewer 
lift/pump stations. 

 
On May 13, 2014, the City Council adopted the Public Works CIP and Rate 
Development Study (2014 Study).  This study included the five-year CIP (FY 
2014/15 to FY 2018/19) and is consistent with current anticipated capital 
needs of the RWQCP and the collection system.  City Council adopted a five-
year sewer rate structure for the period ending in FY 2018/19 to fund the CIP.  
On December 19, 2017, the City Council rescinded the FY 2018/19 8.5% sewer 
service rate increase, so the City enacted the adopted 2014 rate plan from 
(FY 2014/15 to FY 2017/18).  
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City of Riverside 

Project Category Overview:  Sewer 
 

 

 

One-Year Budget and Five-Year Plan 
Funds have been identified and proposed to be added to the following 
projects in the upcoming five years:  
 
Project Highlights: 
Membrane Bioreactor (MBR) Rehabilitation - Installation of an additional 6 
million gallons per day (MGD) of MBR wastewater treatment to increase to 32 
MGD.  
 
Priority Pipeline Assessment & Repair - This Project concentrates on collecting 
videos and assessing the condition of sewer pipes that are older than 50 years 
within the City's service boundary.  The Project will also repair, rehabilitate, or 
replace aging sewer infrastructures--pipelines, manholes, and sewer 
residential laterals. 
 
RWQCP Rehabilitation Phase II – Perform a Preliminary Design Report for 
rehabilitation of the activated sludge system and potential to increase 
Membrane Bio-Reactors (MBR) capacity.  
 
Van Buren Sewer Construction – The project is adding sewer infrastructure 
from Gamble Avenue to King Avenue since it is within the unincorporated 
section County of Riverside. The area does not have any public sewer 
infrastructure in place to provide necessary sewer services. The lack of public 
sewer services is impeding property and business development along this 
stretch of Van Buren Boulevard.   
 
Key Revenues and Funding Sources 

 
Fund Funding Source Adopted 

2020/21 
Proposed 

2021/22 
Proposed 

2022/23 
Proposed 

2023/24 
Proposed 

2024/25 Total 

550 Sewer $14,000,000 $9,000,000 $10,583,800 $20,350,600 $24,698,700 $78,633,100 

 TOTAL $14,000,000 $9,000,000 $10,583,800 $20,350,600 $24,698,700 $78,633,100 

 
Revenues for the Sewer Fund come from sewer rates from the City’s residential 
and non-residential customers.  The Sewer Fund Capital Improvement 
Program is currently funded by sewer rates through the issuance of bond 
proceeds.  
 
On December 19, 2017, based on the positive financial position of the Sewer 
Enterprise Fund presented at the time, City Council rescinded the 8.5% rate 
increase for the fifth year of the plan (FY 2018/19).  With no approved rate 
increases beyond FY 2017/18, this impacts available funding to complete 
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      Capital Improvement Program 

Project Category Overview:  Sewer 

 

 

necessary CIP projects.  Additionally, there is an increased risk of maintaining 
required bond debt coverage and the Sewer Fund Bond Rating.  Without 
future rate increases there will be minimal cash funding available for CIP, 
which will also affect the Sewer Fund Reserve Policy minimum reserve 
balances.    
 
The 2016 Wastewater Master Plan update project was completed in the fall 
of 2019.  A primary goal of the 2019 Master Plan is to develop a cost of service 
and sewer rate plan alternatives for the next five-year planning cycle of FY 
2021/22 through 2025/26. The 2019 Master Plan recommends the following 
capital improvements to ensure regulatory compliance, and repair and/or 
replace aging infrastructure, while providing reliable and cost-effective 
wastewater service. 
 
 
Projects by Type of Improvement 
 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Plant Capacity Replacements       

Upgrade Influent Flow Meters - $500,000  $5,726,800  - -  $6,226,800  

WQCP Activated Treatment 
Rehab - - - 500,000 5,489,200   $5,989,200  

WQCP Daft Rehabilitation - - - 500,000 7,528,800   $8,028,800  

WQCP Digester No. V Rehab 250,000  2,750,000  - - -  $3,000,000  

WQCP Electric Switchgear 
Replacement 150,000  350,000  - - -  $500,000  

WQCP Headworks Area 
Rehabilitation - - 500,000  12,142,600 -  $12,642,600  

WQCP HVAC Upgrade Phase 
II 1,700,000  - - - -  $1,700,000  

WQCP Membrane Bioreactor 
Rehabilitation 5,000,000  - - - -  $5,000,000  

WQCP Plant II Sludge Pumps I 
& II Rehabilitation - - - 250,000 2,375,700   $2,625,700  

WQCP Ring Interconnection 
Pipe 2,000,000  - - - -  $2,000,000  

WQCP SCADA Infrastructure 
Replacement -  250,000  - - -  $250,000  

WQCP Warehouse Building 
Replacement - 100,000  1,400,000  - -  $1,500,000  

WQCP Wi-Fi Phase II - - - 400,000 - $400,000 

    Total Plant Capacity 
    Replacements $9,100,000 $3,950,000 $7,626,800 $13,792,600 $15,393,700 $49,863,100 

Sewer       
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Project Category Overview:  Sewer 
 

 

 

Arlington Valley Channel Pipe 
Replacement - - - $300,000 $2,700,000  $3,000,000  

Golden Avenue Sewer Pipe 
Replacement - - - 60,000 540,000   $600,000  

Pierce St Pump Station 
Rehabilitation 2,000,000  - - - -  $2,000,000  

Plant II Activated Sludge 
Rehab - Phase I 50,000  700,000  - - -  $750,000  

Priority Pipeline Assessment & 
Repair 2,600,000  2,600,000  2,600,000  2,600,000 2,600,000   $13,000,000  

Sewer Main Replacement – 
Kmart Lot - - - 85,000 765,000   $850,000  

Sewer Main Replacement – 
Market St - - 25,000  225,000 -  $250,000  

Sewer Main Replacement – 
Palm & Rubidoux - - 75,000  675,000 -  $750,000  

Sewer Main Replacement – 
Palm Ave - - 120,000  1,080,000 -  $1,200,000  

Sewer Main Replacement – 
Rubidoux Ave - - 60,000  540,000 -  $600,000  

Sewer Main Replacement – 
Rutland Ave - - - 40,000 360,000   $400,000  

Sewer Main Replacement – 
S.A.R. Trail - - 75,000  675,000 -  $750,000  

Sewer Main Replacement – 
West Rutland Ave - - - 60,000 540,000   $600,000  

Sewer Pipe Expansion – 
Greenpoint Ave - - 2,000  18,000 -  $20,000  

Sewer Pipeline Replacement – 
Morris St - - - 200,000 1,800,000   $2,000,000  

Western, MLK, & Garden Hill 
Lift Station Rehab 250,000  1,750,000  - - -  $2,000,000  

    Total Sewer $4,900,000 $5,050,000 $2,957,000 $6,558,000 $9,305,000 $28,770,000 

TOTAL $14,000,000 $9,000,000 $10,583,800 $20,350,600 $24,698,700 $78,633,100 

 
Top Unfunded Projects 
Public Works identified eight sewer capital projects without an identified 
funding source. 

Project Name Estimated 
Project Cost 

Unfunded 
Amount 

1. RWQCP Rehabilitation - Phase II $500,000 $130,837 

2. Dexter Wastewater 1,200,000 1,034,593 

3. Fairgrounds Wastewater 1,200,000 1,031,396 

4. Wastewater Lift Stations 2,000,000 1,715,371 

5. Bio-Solids Handling Rehabilitation 2,840,000 364,010 

6. Tertiary System Rehab - Phase I 4,850,000 3,739,196 

7. Plant II Blower No. II Rehabilitation 1,452,615 405,745 

8. Potable/Recycled Water System Pipeline Rehabilitation - Phase II 1,000,000 1,000,000 

TOTAL $15,042,615 $9,421,148 
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Project Map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: This map includes all active and new capital improvement projects.  Ongoing and citywide projects are not included on the 
map.  To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.   

 
Distribution by Ward  

 
Ward Five-Year Total  

Ward 1 $2,800,000 

Ward 2 750,000 

Ward 3 - 

Ward 4 -  

Ward 5 -  

Ward 6 850,000 

Ward 7 8,020,000 

All Wards 66,213,100 

 Total $78,633,100 

 
 

$2.8M

$0.8M

‐

‐

‐

$0.9M

$8.0M

$66.2M

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7

 All Wards
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SECONDARY SYSTEM UPGRADES 
PROJECT NUMBER 7138 COUNCIL WARD 3 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION 5950 Acorn Street 
 
PROJECT DESCRIPTION 
The Work consists of the construction of a new aeration blower facility, upgrading and 
retrofitting existing aeration basins at Plant 1 and Plant 2 in the City of Riverside Water 
Quality Control Plant. 
 
PROJECT STATUS 
The scope of work was completed for phase 1 of the Secondary System Upgrade. Due 
to the life cycle of secondary system equipment, phase 2 of the Secondary System 
upgrade is currently being discussed as part of the 2016 Master Plan. 
 
OPERATING BUDGET IMPACT 
As this is an ongoing project to upgrade existing equipment and systems, there will not 
be additional O&M expenses incurred. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $13,081,551 $0 Ongoing     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  TEQUESQUITE/ARROYO TRUNK LINE 
PROJECT NUMBER 7709 COUNCIL WARD 1 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Phase I: Tequesquite Park, Phase II: Olivewood Avenue 
 
PROJECT DESCRIPTION 
The existing pipe was constructed in the 1940s and the 1960s.  In 2003, a sewer master 
plan study was completed, and the sewer model indicated that this stretch of the pipe 
is under capacity.  Replaces the old and undersized 21 to 24-inch sewer mains with 36-
inch sewer mains. 
 
PROJECT STATUS 
The Tequesquite Arroyo Trunk Sewer Replacement Phase II was completed on 11/18/19.  
Once final invoices are paid, the project will be closed out. 
 
OPERATING BUDGET IMPACT 
Project is upgrading existing pipeline and will not cause an increase to ongoing 
operating costs once the project is complete. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$26,623,446 $26,623,446 $0 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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RWQCP REHABILITATION - PHASE II 
PROJECT NUMBER 8015 COUNCIL WARD 3 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
The Preliminary Design Report and design of an additional aeration basin for the 
Membrane Bio-Reactors (MBR), additional MBR train and expand Chlorine Contact 
Basin 2 that was mandated by the National Pollutant Discharge Elimination System 
(NPDES) Permit as authorized by the Clean Water Act. 
 
PROJECT STATUS 
The Project is currently being used to fund a portion of the Tertiary Project. The 
contractor has already encumbered $300,000 for this project. 
 
OPERATING BUDGET IMPACT 
The project will not require additional operating impacts as it is intended to rehabilitate 
an existing system. 
    
  
  
 

 
 

☐ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$500,000 $369,163 $0 $130,837     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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FAIRGROUNDS WASTEWATER 
PROJECT NUMBER 8334 COUNCIL WARD 1 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION 3991 Fairgrounds Street 
 
PROJECT DESCRIPTION 
This sewer lift station serves the industrial and residential areas located at the northwest 
quadrant of the SR-60 and SR-215 interchange.  This project proposes to replace and 
upgrade the Fairgrounds sewer lift station located at 3991 Fairgrounds Street. 
 
PROJECT STATUS 
The project is currently under design. 
 
OPERATING BUDGET IMPACT 
Because this is a replacement for an existing infrastructure project, there will be no 
additional operating budgetary impact. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☐ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,200,000 $168,604 $0 $1,031,396     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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TERTIARY SYSTEM REHAB - PHASE I 
PROJECT NUMBER 8613 COUNCIL WARD 3 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
This project is for the rehabilitation of the Tertiary System: replacement troughs, 
inspections, Tertiary Preliminary Design Report, and replacement media beds to cloth 
filters. 
 
PROJECT STATUS 
This project is currently in the design phase. Going out to bid in early 2020 and is part of 
the Wastewater Master Plan. 
 
OPERATING BUDGET IMPACT 
Project will not require additional operating impacts as it is intended to rehab an 
existing system. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$4,850,000 $1,110,804 $0 $3,739,196     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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DEXTER WASTEWATER 
PROJECT NUMBER 8659 COUNCIL WARD 1 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION 2981 Dexter Drive 
 
PROJECT DESCRIPTION 
The lift station serves approximately 45 single residential homes located next to Lake 
Evans.  This project proposes to replace and upgrade the Dexter sewer pump station 
located at 2981 Dexter Drive. 
 
PROJECT STATUS 
The project is currently under design. Awaiting RFP to post for the design of the project. 
 
OPERATING BUDGET IMPACT 
No operating impact.  This project is a rehabilitation of existing facilities and will not 
require additional operation and maintenance costs. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,200,000 $165,407 $0 $1,034,593     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  BIO-SOLIDS HANDLING REHABILITATION 
PROJECT NUMBER 8928 COUNCIL WARD 3 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Rehabilitation of the Water Quality Control Plant (WQCP) bio-solids sludge process and 
building, mandated per National Pollutant Discharge Elimination System (NPDES) Permit 
authorized by the Clean Water Act. 
 
PROJECT STATUS 
Part of Project in Design: Ventilation and Order Control System, Dry Polymer Feed 
System and Strain Presses.  In Planning Stage: Replacement of sludge pumps and 
motors, Waste Activated (WAS) yard piping, sludge upsizing piping, and painting of 
exterior of building. 
 
OPERATING BUDGET IMPACT 
No operating impact.  This project is a rehabilitation of existing facilities and will not 
require additional operation and maintenance costs. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,840,000 $2,475,990 $0 $364,010     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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WASTEWATER LIFT STATIONS 
PROJECT NUMBER 8943 COUNCIL WARD 2, 4 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Various 
 
PROJECT DESCRIPTION 
To ensure reliable and uninterrupted sewage services, this project will replace 
dilapidated mechanical parts, upgrade the electrical, pump control, communication 
systems, and install electrical components to connect to emergency generator power. 
 
Replacement and upgrading of the: 

• Rivercrest Sewer Wastewater Station located at 6013 River Crest Drive 
• Lakewood Sewer Wastewater Station located at 6730 Darkwood Drive 

 
PROJECT STATUS 
The project is currently under design. 
 
OPERATING BUDGET IMPACT 
No additional operating impacts will result from the upgraded wastewater lift stations. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,000,000 $284,629 $0 $1,715,371     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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 WOODCREST SEWER CONSTRUCTION – PHASE I 

PROJECT NUMBER 8969 COUNCIL WARD 4 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Van Buren Boulevard from King Ave. to Wood Rd. 
 
PROJECT DESCRIPTION 
The Van Buren Boulevard corridor between Wood Road and King Avenue is within the 
Woodcrest neighborhood and the City’s sewer service area. The portion between 
Wood Road and Gamble Avenue is within City limits, and from Gamble Avenue to King 
Avenue is within unincorporated County of Riverside. The area does not have any 
public sewer infrastructure in place to provide necessary sewer services. The lack of 
public sewer services is impeding property and business development along this stretch 
of Van Buren Boulevard. In addition, many of the properties are struggling with the 
operation and maintenance of private septic systems. 
 
PROJECT STATUS 
The project is currently under design. 
 
OPERATING BUDGET IMPACT 
Once the project is completed, the maintenance will be part of the Collection groups 
regularly scheduled cleaning tasks. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$13,864,169 $13,864,169 $0 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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 PLANT II BLOWER NO. II REHABILITATION 

PROJECT NUMBER 8977 COUNCIL WARD 3 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION 5950 Acorn Street, WQCP-Blower Building 
 
PROJECT DESCRIPTION 
Procure and install by Design/Build Entity one 600 HP dual-core turbo blower, including 
mechanical, electrical, integration, and structural work. 
 
PROJECT STATUS 
Design/Build Entity will begin work once Notice to Proceed is issued. 
 
OPERATING BUDGET IMPACT 
This is a rehabilitation and replacement project for parts of an existing blower.  No 
additional costs to operations and maintenance once the equipment is repaired. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,452,615 $1,046,870 $0 $405,745     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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PLANT II ACTIVATED SLUDGE REHAB - PHASE I 
PROJECT NUMBER 9045 COUNCIL WARD 3 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Rehabilitation of Plant 2 equipment: valves, pumps, variable-speed motors, electrical 
and instrumentation panels, ventilation systems, and lighting mandated per National 
Pollutant Discharge Elimination System (NPDES). Permit authorized by the Clean Water 
Act.  
 
PROJECT STATUS 
Installation of 36” & 42” Plant 2 Primary Clarifier Discharge Line Rehabilitation – 
Completed Plant 2 Activated Sludge Rehabilitation Sludge Pump Station No.3 Valve 
Replacement - Completed. Plant 2 Aeration Basins Rehabilitation – Ongoing; draining 
of two basins to inspect air injectors and log dams.  
 
OPERATING BUDGET IMPACT 
Project is for rehabilitation purposes and will not require additional budget to maintain. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$650,500 $650,500 $0 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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 PIERCE PUMP STREET STATION REHABILITATION 

PROJECT NUMBER 9100 COUNCIL WARD 7 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Pierce Street & 91 FWY 
 
PROJECT DESCRIPTION 
Rehabilitate the existing Pierce Street Sewer Pump Station.  
 
PROJECT STATUS 
This design for this Project has not been started yet.  
 
OPERATING BUDGET IMPACT 
It is anticipated that once the project is completed, the O&M cost will go down and 
will not require additional budget to maintain. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,000,000 $0 $2,000,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer $2,000,000 - - - - $2,000,000 

 TOTAL $2,000,000 $0 $0 $0 $0 $2,000,000 
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WESTERN, MLK & GARDEN HILL LIFT STATION REHAB 
PROJECT NUMBER 9101 COUNCIL WARD 3, 4, 7 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Multiple 
 
PROJECT DESCRIPTION 
These three sewer lift stations constantly need repair with their electrical and 
mechanical components since the equipment is at the end of their service life.  This 
project will rehabilitate the sewer lift stations and replace dilapidated components to 
ensure reliable services to the residents.  
 
PROJECT STATUS 
The design for the Project has not been started yet.  
 
OPERATING BUDGET IMPACT 
It is anticipated that once the project is completed, the operating budget will 
decrease due to newer equipment with longer service life. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,000,000 $0 $2,000,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer $250,000 $1,750,000 - - - $2,000,000 

 TOTAL $250,000 $1,750,000 $0 $0 $0 $2,000,000 
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ELIMINATION OF UNIVERSITY KNOLLS PUMP 
STATION 
PROJECT NUMBER 9102 COUNCIL WARD 2 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION 899 N. University Drive 
 
PROJECT DESCRIPTION 
This Project proposes to construct approximately 2,400 LF of sewer main to eliminate an 
existing sewer lift station located at 899 N University Dr. (University Knoll sewer lift 
station).  
 
PROJECT STATUS 
Project has not started.  
 
OPERATING BUDGET IMPACT 
It is anticipated that there will be savings to the operating budget once the project is 
completed since maintenance costs for a sewer lift station is greater than the 
maintenance of sewer gravity mains. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$750,000 $0 $750,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer $50,000 $700,000 - - - $750,000 

 TOTAL $50,000 $700,000 $0 $0 $0 $750,000 
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 SEWER MAIN REPLACEMENT – PALM AVE 

PROJECT NUMBER 9103 COUNCIL WARD 1 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Palm Avenue; Beechwood Place to Edgewood Place 
 
PROJECT DESCRIPTION 
This Project proposes to replace approximately 2,640 feet of an existing 10-inch 
diameter pipeline with a 12-inch diameter pipeline.  The existing pipe is currently under-
capacity.  
 
PROJECT STATUS 
Project has not started.  
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,200,000 $0 $1,200,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - $120,000 $1,080,000 - $1,200,000 

 TOTAL $0 $0 $120,000 $1,080,000 $0 $1,200,000 
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SEWER MAIN REPLACEMENT – PALM & RUBIDOUX 
PROJECT NUMBER 9104 COUNCIL WARD 1 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Palm Ave and Rubidoux Ave 
 
PROJECT DESCRIPTION 
This Project proposes to replace approximately 1,500 feet of an existing 12-inch 
diameter sewer pipe with a 15-inch sewer pipe along Palm Ave. and Rubidoux Ave, 
from Brentwood Ave to Rubidoux Ave and from Palm Ave. to 210-feet northwest of 
Virginia Place.  The existing pipe is under capacity.  
 
PROJECT STATUS 
This Project has not started yet.  
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$750,000 $0 $750,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - $75,000 $675,000 - $750,000 

 TOTAL $0 $0 $75,000 $675,000 $0 $750,000 
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SEWER MAIN REPLACEMENT – RUBIDOUX AVE 
PROJECT NUMBER 9105 COUNCIL WARD 1 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Rubidoux Ave between Northview Pl and Grand Ave 
 
PROJECT DESCRIPTION 
This project proposes to replace approximately 1,010 feet of an existing 15-inch 
diameter sewer pipeline with an 18-inch diameter pipeline.  The existing pipe is 
currently under capacity.  
 
PROJECT STATUS 
This Project has not started yet and is part of the Wastewater Master Plan.  
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$600,000 $0 $600,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - $60,000 $540,000 - $600,000 

 TOTAL $0 $0 $60,000 $540,000 $0 $600,000 
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SEWER MAIN REPLACEMENT – RUTLAND AVE 
PROJECT NUMBER 9106 COUNCIL WARD 7 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION West of Rutland Ave from Arlington Ave to Penny Dr 
 
PROJECT DESCRIPTION 
This project proposes to replace approximately 650 feet of an existing 15-inch diameter 
sewer pipeline with an 18-inch diameter pipeline.  The existing pipe is currently under 
capacity.  
 
PROJECT STATUS 
This Project has not started yet.  
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
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PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$400,000 $0 $400,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - - $40,000 $360,000 $400,000 

 TOTAL $0 $0 $0 $40,000 $360,000 $400,000 
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SEWER MAIN REPLACEMENT – WEST RUTLAND AVE 
PROJECT NUMBER 9107 COUNCIL WARD 7 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION West of Rutland Ave from Penny Dr to Bruce Ave 
 
PROJECT DESCRIPTION 
This project proposes to replace approximately 790 feet of an existing 15-inch diameter 
sewer pipeline with a 21-inch diameter pipeline.  The existing pipe is currently under 
capacity.  
 
PROJECT STATUS 
This project has not started yet.  
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☒ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$600,000 $0 $600,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - - $60,000 $540,000 $600,000 

 TOTAL $0 $0 $0 $60,000 $540,000 $600,000 
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SEWER MAIN REPLACEMENT – KMART LOT   
PROJECT NUMBER 9108 COUNCIL WARD 6 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Monticello Ave; from Pembroke Ave to Arlington Ave  
 
PROJECT DESCRIPTION 
This project proposes to replace approximately 1,530 feet of an existing 12-inch 
diameter sewer pipeline with an 18-inch diameter pipeline.  The existing pipe is 
currently under capacity.  
 
PROJECT STATUS 
This project has not started yet.  
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☒ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$850,000 $0 $850,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - - $85,000 $765,000 $850,000 

 TOTAL $0 $0 $0 $85,000 $765,000 $850,000 
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GOLDEN AVENUE SEWER PIPE REPLACEMENT 
PROJECT NUMBER 9109 COUNCIL WARD 6, 7 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Golden between Cochran and Arlington Valley 

Channel 
 
PROJECT DESCRIPTION 
This project proposes to replace approximately 970 feet of an existing 12-inch diameter 
sewer pipeline with an 18-inch diameter pipeline.  The existing pipe is currently under 
capacity.  
 
PROJECT STATUS 
This project has not started yet.  
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☒ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$600,000 $0 $600,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - - $60,000 $540,000 $600,000 

 TOTAL $0 $0 $0 $60,000 $540,000 $600,000 
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SEWER MAIN REPLACEMENT – S.A.R. TRAIL 
PROJECT NUMBER 9110 COUNCIL WARD 1, 3 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION North of Mtn View Ave to Santa Ana River Trail 
 
PROJECT DESCRIPTION 
This project proposes to replace approximately 770 feet of an existing 24-inch diameter 
sewer pipeline with a 27-inch diameter pipeline.  The existing pipe is currently under 
capacity.  
 
PROJECT STATUS 
This project has not started yet.  
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☒ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$750,000 $0 $750,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - $75,000 $675,000 - $750,000 

 TOTAL $0 $0 $75,000 $675,000 $0 $750,000 
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SEWER PIPE EXPANSION – GREENPOINT AVE 
PROJECT NUMBER 9111 COUNCIL WARD 7 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION South of Green Point Ave and Geranium Pl 
 
PROJECT DESCRIPTION 
This project proposes to install 10 feet of 24-inch diameter sewer pipeline to mitigate 
surcharge in an existing 18-inch diameter pipeline under peak flow conditions. 
 
PROJECT STATUS 
This project has not started yet. 
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☒ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$20,000 $0 $20,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - $2,000 $18,000 - $20,000 

 TOTAL $0 $0 $2,000 $18,000 $0 $20,000 
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ARLINGTON VALLEY CHANNEL PIPE REPLACEMENT 
PROJECT NUMBER 9112 COUNCIL WARD 7 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Arlington Valley Channel between Golden Ave and 

Waterwell 
 
PROJECT DESCRIPTION 
This project proposes to replace approximately 2,430 feet of an existing 27-inch 
diameter sewer pipeline with a 33-inch diameter pipeline.  The existing pipe is currently 
under capacity. 
 
PROJECT STATUS 
This project has not started yet. 
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☒ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$3,000,000 $0 $3,000,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - - $300,000 $2,700,000 $3,000,000 

 TOTAL $0 $0 $0 $300,000 $2,700,000 $3,000,000 
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SEWER PIPELINE REPLACEMENT – MORRIS ST 
PROJECT NUMBER 9113 COUNCIL WARD 7 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Along Morris St; from Van Buren Blvd to Doolittle Ave 
 
PROJECT DESCRIPTION 
This project proposes to replace approximately 1,490 feet of an existing 33-inch 
diameter sewer pipeline with a 42-inch diameter pipeline.  The existing pipe is currently 
under capacity. 
 
PROJECT STATUS 
This project has not started yet. 
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☒ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,000,000 $0 $2,000,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - - $200,000 $1,800,000 $2,000,000 

 TOTAL $0 $0 $0 $200,000 $1,800,000 $2,000,000 
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SEWER MAIN REPLACEMENT – MARKET ST 
PROJECT NUMBER 9114 COUNCIL WARD 1 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Market St between 11th and 12th St 
 
PROJECT DESCRIPTION 
This project proposes to replace approximately 380 feet of an existing 12-inch diameter 
sewer pipeline with an 18-inch diameter pipeline.  The existing pipe is currently under 
capacity. 
 
PROJECT STATUS 
This project has not started yet. 
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☒ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$250,000 $0 $250,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - $25,000 $225,000 - $250,000 

 TOTAL $0 $0 $25,000 $225,000 $0 $250,000 
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PRIORITY PIPELINE ASSESSMENT & REPAIR 
PROJECT NUMBER 9115 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This project concentrates on collecting videos and assessing the condition of sewer 
pipes that are older than 50 years within the City's service boundary.  The Project will 
also repair, rehabilitate, or replace aging sewer infrastructures--pipelines, manholes, 
and sewer residential laterals. 
 
PROJECT STATUS 
This project has not started yet. 
 
OPERATING BUDGET IMPACT 
It is anticipated that the operating cost will be lowered once the project is 
implemented since less effort is needed to maintain newer facilities. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☒ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$13,000,000 $0 $13,000,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer $2,600,000 $2,600,000 $2,600,000 $2,600,000 $2,600,000 $13,000,000 

 TOTAL $2,600,000 $2,600,000 $2,600,000 $2,600,000 $2,600,000 $13,000,000 
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UPGRADE FLOW-METERS TO MAG-METERS 
PROJECT NUMBER 9116 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Installation of three (3) Electromagnetic (mag) flow meters in the following trunk sewer 
lines to replace Flo-Dar meters; Acorn, Arlanza, and Santa Ana. The Acorn sewer line 
will be 16-inch diameter mage meter, the Arlanza will be a 36-inch diameter mag 
meter and the Santa Ana sewer line will be a 36-inch mag meter. Construction will be 
onsite of the WQCP. 
 
PROJECT STATUS 
Design funding is set for the fiscal year 2021/2022 by Council. Request for Proposals for 
design will go out late summer of 2021 and design to begin in the late winter of 2021. 
Funding for construction will be in the fiscal year 2022/2023. Bidding for construction will 
begin in mid-summer of 2022 and construction to begin in the summer of 2023. 
 
OPERATING BUDGET IMPACT 
There is no estimated ongoing operating budgetary impact. 
    
  
  
 

 
 

☐ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$6,226,800 $0 $6,226,800 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - $500,000 $5,726,800 - - $6,226,800 

 TOTAL $0 $500,000 $5,726,800 $0 $0 $6,226,800 
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WQCP HEADWORKS AREA REHABILITATION 
PROJECT NUMBER 9117 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
The current headworks area at the RWQCP was constructed in 1999 and consists of the 
screening room, blower room, electrical room, grit chambers, and grit pumping room. 
The headworks area has not received a major mechanical rehabilitation since its 
construction and there are varying levels of deterioration for the mechanical 
components within this process area. The grit chambers and grit pumping room 
underwent a condition assessment in 2017. The findings recommended the 
replacement of mechanical equipment. The project is identified in the June 2019 
update of the Integrated Sewer Master, Volume 7. 
 
PROJECT STATUS 
Design to begin in the Winter of 2022 and construction to begin in the Spring of 2023. 
 
OPERATING BUDGET IMPACT 
Unknown at the present time.  Will be evaluated upon completion and is expected to 
be absorbed in the future maintenance budget. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$12,642,600 $0 $12,642,600 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - $500,000 $12,142,600 - $12,642,600 

 TOTAL $0 $0 $500,000 $12,142,600 $0 $12,642,600 

 

217



 

 

PUBLIC WORKS - SEWER 
Capital Improvement Program FY 2020/21 - 2024/25 

 

Click in white space above this text to insert Picture (Insert > Picture) 
Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

Click in white space above this text to insert Picture (Insert > Picture) 
Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

  

 

 

 

  

 

 

 

WQCP ACTIVATED TREATMENT TRAIN REHAB 
PROJECT NUMBER 9118 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Project requires the replacement of the membrane diffusers and the redwood baffles 
with FRP baffles, repairs on the aeration basin, replace corroded conduits, boxes, and 
conduit clamps with stainless steel parts, replace side‐mounted railings with top‐
mounted railings, repair cracks, and spalls in the concrete walkways, the 
implementation of an aeration basin concrete structure condition assessment, the 
installation of motorized operators on gates and control valves for additional 
automatic control for the aeration basin. (Fi-09) - This project requires the replacement 
of the floating mixers. (Fl-10) - This project requires: the replacement of the VFDs and 
MCCs, the replacement or repair of the corroded roof members near the roof leak, the 
removal of the abandoned WAS pumps, the replacement of the drain pump. 
 
PROJECT STATUS 
The design will begin in the Fall of 2023 and construction to begin in the Summer of 
2024.  
 
OPERATING BUDGET IMPACT 
Unknown at the present time.  Will be evaluated upon completion and will be 
absorbed in the maintenance budget. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$5,989,200 $0 $5,989,200 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - - $500,000 $5,489,200 $5,989,200 

 TOTAL $0 $0 $0 $500,000 $5,489,200 $5,989,200 
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 WQCP PLANT II SLUDGE PUMPS I & II REHAB 

PROJECT NUMBER 9119 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Rehabilitation of Plant 2 equipment: valves, pumps, variable-speed motors, electrical 
and instrumentation panels, ventilation systems, and lighting mandated per National 
Pollutant Discharge Elimination System (NPDES). Permit authorized by the Clean Water 
Act. 
 
PROJECT STATUS 
Design to begin in Fall 2023 and construction in late Fall of 2024. 
 
OPERATING BUDGET IMPACT 
Unknown at the present time.  Will be evaluated upon completion and will be 
absorbed in the maintenance budget. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,625,700 $0 $2,625,700 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - - $250,000 $2,375,700 $2,625,700 

 TOTAL $0 $0 $0 $250,000 $2,375,700 $2,625,700 
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WQCP DAFT REHABILITATION 
PROJECT NUMBER 9120 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
This project requires waste activated sludge thickening equipment to be installed inside 
the existing dewatering building, complete rehabilitation of DAFT No.2, the 
implementation of seismic evaluation of the Dissolved Air Flotation Thickeners (DAFT) 
mechanism connections; (4) demolition of abandoned equipment and of unused 
pump pads, the removal of the unused chemical tank, the upgrade of the ventilation 
system to allow to declassify the electrical room, the installation of a cover for the DAF 
tanks, the replacement of the DAF No. 1 drive, the replacement of the polymer 
pumping systems, the addition of LED lights and replacement of the windows and 
doors of the building. 
 
PROJECT STATUS 
Design to begin in Winter 2023 and construction in late 2024.  
 
OPERATING BUDGET IMPACT 
Unknown at the present time.  Will be evaluated upon completion and will be 
absorbed in the maintenance budget. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$8,028,800 $0 $8,028,800 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - - $500,000 $7,528,800 $8,028,800 

 TOTAL $0 $0 $0 $500,000 $7,528,800 $8,028,800 
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WQCP MEMBRANE BIOREACTOR REHABILITATION 
PROJECT NUMBER 9121 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Installation of an additional 6 million gallons per day (MGD) of Membrane Bioreactors 
(MBR) wastewater treatment. MBR treatment to increase to 32 MGD. Existing MBR's are 
manufactured from Suez Water Technology and Solutions as part of the WQCP 
Rehabilitation and Expansion Project. 
 
PROJECT STATUS 
Summer of 2020 will finalize negotiations of the agreement with Suez for an additional 6 
MGD of MBR's. Spring of 2021 installation of MBR's. 
 
OPERATING BUDGET IMPACT 
Project is for rehabilitation purposes and will not require additional budget to maintain. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$5,000,000 $0 $5,000,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer $5,000,000 - - - - $5,000,000 

 TOTAL $5,000,000 $0 $0 $0 $0 $5,000,000 
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WQCP HVAC UPGRADE PHASE II 
PROJECT NUMBER 9122 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Installation of ducting, heating and cooling control systems, sensors, air handling units 
(motors and blowers) inside the WQCP Administration/Laboratory Building. 
 
PROJECT STATUS 
The design of the project will begin in in Summer of 2020. Construction to begin in late 
2020 and completion in early 2021. 
 
OPERATING BUDGET IMPACT 
The post-installation impact is unknown at the time but should be lower from gained 
efficiencies with the new equipment. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,700,000 $0 $1,700,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer $1,700,000 - - - - $1,700,000 

 TOTAL $1,700,000 $0 $0 $0 $0 $1,700,000 
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WQCP WAREHOUSE BUILDING REPLACEMENT 
PROJECT NUMBER 9123 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Warehouse and Storage Building Replacement - Currently, the WQCP is using two old 
concrete digesters that were built in the 1940s that were converted to a warehouse 
more than thirty years ago. Also, there exists no storage cover to protect the WQCP 
and Collection System portable pumps, generators, equipment, and materials. They 
are susceptible to outside elements. The WQCP and Collections Section will need a 
combined warehouse and storage facility. 
 
PROJECT STATUS 
Design to begin in the Winter of 2021 and construction to begin in the Summer of 2022. 
 
OPERATING BUDGET IMPACT 
Once completed, the building will require minimal upkeep and will be absorbed in the 
current budget. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☐ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,500,000 $0 $1,500,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - $100,000 $1,400,000 - - $1,500,000 

 TOTAL $0 $100,000 $1,400,000 $0 $0 $1,500,000 
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  WQCP DIGESTER NO. V REHABILITATION 
PROJECT NUMBER 9124 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
The Public Works Department is implementing a Renewable Resource Management 
Plan to address regulatory compliance and City sustainability efforts. The existing 
Digester #5 is not being used.  New recycling regulations require the City to divert food 
waste from landfill disposal. The project will allow the Digester to be rehabilitated to 
treat food waste and organic matter for regulatory food waste regulations. 
 
PROJECT STATUS 
Design to begin in the Fall of 2020 and construction to begin in Spring 2021.  
 
OPERATING BUDGET IMPACT 
The project is for rehabilitation purposes and will not require additional budget to 
maintain. 
    
  
  
 

 
 

☐ Risk to Health, Safety  
and Environment 

☐ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$3,000,000 $0 $3,000,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer $250,000 $2,750,000 - - - $3,000,000 

 TOTAL $250,000 $2,750,000 $0 $0 $0 $3,000,000 
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WQCP RING INTERCONNECTION PIPE 
PROJECT NUMBER 9125 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Installation of digester gas clean-up equipment and piping to injection point to 
Southern California Gas Company Natural Gas transmission main. Bio-methane will be 
converted to near quality natural gas to be injected into the Southern California Gas 
Company natural gas transmission main. 
 
PROJECT STATUS 
Design to begin in the Fall of 2020 and construction to begin in Winter 2021.  
 
OPERATING BUDGET IMPACT 
The project will require little to no maintenance once completed. 
    
  
  
 

 
 

☐ Risk to Health, Safety  
and Environment 

☐ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☒ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,000,000 $0 $2,000,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer $2,000,000 - - - - $2,000,000 

 TOTAL $2,000,000 $0 $0 $0 $0 $2,000,000 
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 WQCP ELECTRIC SWITCHGEAR REPLACMENT 

PROJECT NUMBER 9126 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Electrical Switchgear Upgrade and Power Outage Project Study and Rehabilitation 
Project - Project will review and recommend the rehabilitation/replacement of the 
backbone 12kV electrical system, high voltage switchgear, and equipment of the 
WQCP. The study will also recommend any electrical scheme changes during a power 
outage. 
 
PROJECT STATUS 
Study to begin in the Fall of 2021 and any recommended work to begin in early 2022.  
 
OPERATING BUDGET IMPACT 
Project is for rehabilitation purposes and will not require additional budget to maintain. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$500,000 $0 $500,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer $150,000 $350,000 - - - $500,000 

 TOTAL $150,000 $350,000 $0 $0 $0 $500,000 

 

226



 

 

PUBLIC WORKS - SEWER 
Capital Improvement Program FY 2020/21 - 2024/25 

 

Click in white space above this text to insert Picture (Insert > Picture) 
Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

Click in white space above this text to insert Picture (Insert > Picture) 
Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

  

 

 

 

 

 

  WQCP SCADA INFRASTRUCTURE REPLACEMENT 
PROJECT NUMBER 9127 COUNCIL WARD All Wards 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Supervisory Control and Data Acquisition (SCADA) - A control system architecture 
comprising of computers, networked data communications and graphical user 
interfaces (GUI) for high-level process supervisory management, while also comprising 
other peripheral devices like programmable logic controllers (PLC). Within the plant 
and outside sewer lift stations throughout the City, the SCADA system is used to monitor 
and control equipment. 
 
PROJECT STATUS 
Study to begin in late Summer of 2021 and end in early 2022.  
 
OPERATING BUDGET IMPACT 
Project is for rehabilitation purposes and will not require additional budget to maintain. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☒ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$250,000 $0 $250,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - $250,000 - - - $250,000 

 TOTAL $0 $250,000 $0 $0 $0 $250,000 
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WQCP WIFI PHASE II 
PROJECT NUMBER 9128 COUNCIL WARD Citywide 
PROJECT CATEGORY Sanitary Sewer System 
PROJECT LOCATION Water Quality Control Plant (WQCP) 
 
PROJECT DESCRIPTION 
Phase II - Install new infrastructure (fiber, access points, and switches) to support WIFI at 
the WQCP. 
 
PROJECT STATUS 
Design to begin in the late summer of 2023 and construction to begin in early 2024. 
 
OPERATING BUDGET IMPACT 
Project is for rehabilitation purposes and will not require additional budget to maintain. 
    
  
  
 

 
 

☒ Risk to Health, Safety  
and Environment 

☐ Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ Community Investment 
and Economic Prosperity 

☐ Level and Quality  
of Service 

☐ Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 

  

  

  

  

  

 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ Existing Infrastructure / 
Facility 

  

  

  

  

  

  

  

  

  

  

  

 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$400,000 $0 $400,000 $0     
 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

550 Sewer - - - $400,000 - $400,000 

 TOTAL $0 $0 $0 $400,000 $0 $400,000 
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      Capital Improvement Program 

Project Category Overview:  Storm Drain 

 

 

Introduction  
The Storm Drain section of the Public Works department maintains the City’s 
drainage systems in order to facilitate a clean and healthy environment and 
to assist in the prevention of flooding conditions. 
 
One-Year Budget and Five-Year Plan 
The five-year Capital Improvement 
Program for the Storm Drain Fund 
totals $1.05 million.  Storm drain 
improvement projects are 
prioritized in a manner that ensures 
installation of drainage 
improvements in concert with 
street improvement projects, in 
coordination with Riverside County 
Flood Control District projects, and 
in support of economic 
development projects.  
 
Project Highlights:  
The five-year Capital Improvement Program for the Storm Drain Fund totals 
$1.05 million.  Storm drain improvement projects are prioritized in a manner 
that ensures installation of drainage improvements in concert with street 
improvement projects, in coordination with Riverside County Flood Control 
District projects, and in support of economic development projects. 
 
Monroe Storm Drain Project: This project will add another 18 inches to the 
existing 72-inch diameter pipe and catch basins/inlet structures within street 
right-of-way to capture run-off from the green belt area. 
 
Key Revenues and Funding Sources 
 

Fund Funding Source Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

230 Gas Tax $550,000 - - - - $550,000 

410 Storm Drain DIF 100,000 100,000 100,000 100,000 100,000 $500,000 

 TOTAL $650,000 $100,000 $100,000 $100,000 $100,000 $1,050,000 

 
Storm drain capital improvements are funded out of the Storm Drain Fund, 
established by Section 16.08.050 of the Riverside Municipal Code.  The 
revenues are derived from storm drain development impact fees (DIF) 
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City of Riverside 

Project Category Overview:  Storm Drain 

 

 

collected with the issuance of building permits.  The City's storm drain needs 
outweigh the available funding sources at this point. 
 
Projects by Type of Improvement 
 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Storm Drains       

Miscellaneous Storm Drain Construction $100,000 $100,000 $100,000 $100,000 $100,000 $500,000 

Sierra Street Storm Drain Improvements 450,000 - - - - $450,000 

Van Buren Blvd Pump Station Rehab 100,000 - - - - $100,000 

TOTAL $650,000 $100,000 $100,000 $100,000 $100,000 $1,050,000 

 
Top Unfunded Projects 
Public Works identified three storm drain capital projects without an identified 
funding source. 
 

Project Name Estimated Project 
Cost 

Unfunded 
Amount 

1. North Orange St Storm Drain Project $150,000 $150,000 

2. Cypress Ave Storm Drain Project 1,250,000 1,250,000 

3. Fourteenth St Underpass Pump Station Project 3,200,000 3,200,000 

TOTAL $4,600,000 $4,600,000 
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Project Map 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: This map includes all active and new capital improvement projects.  Ongoing and citywide projects are not included on the 
map.  To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.   

 
Distribution by Ward  

 
Ward Five-Year Total  

Ward 1 $- 

Ward 2 - 

Ward 3 450,000 

Ward 4 -  

Ward 5 100,000 

Ward 6 -  

Ward 7  -  

All Wards 500,000 

 Total $1,050,000 

 
 

‐

‐

$0.5M

‐

$0.1M

‐

‐

$0.5M

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7

 All Wards
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  MISCELLANEOUS STORM DRAIN CONSTRUCTION 
PROJECT NUMBER 7001 COUNCIL WARD All Wards 
PROJECT CATEGORY Storm Drain System 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
City funds are allocated to allow for City staff to work on various projects, issues, and 
concerns that present themselves during the year.  The project also includes removal 
and replacement of drainage pipe, culverts, inlet and outlet structures, v-ditch, 
asphalt/earthen swale, catch basins, curbs, gutters, and cross-gutters to provide proper 
drainage and avoid flooding. 
 
PROJECT STATUS 
The Storm Drain section of the Public Works Department continuously maintains the 
City’s drainage system in order to facilitate a clean and healthy environment and to 
assist in the prevention of flooding conditions in a prioritized manner. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project to maintain the City's Storm Drain System.  There are no 
operating budget impacts associated with this ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $785,731 $500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

410 Storm Drain DIF $100,000 $100,000 $100,000 $100,000 $100,000 $500,000 

 TOTAL $100,000 $100,000 $100,000 $100,000 $100,000 $500,000 
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MONROE STORM DRAIN PROJECT (Lines E2, E3, E5) 
PROJECT NUMBER 8997 COUNCIL WARD 5 
PROJECT CATEGORY Storm Drain System 
PROJECT LOCATION Gratton St from Lincoln Ave to Hermosa Dr 
 
PROJECT DESCRIPTION 
This project will add another 18 inches to the existing 72-inch diameter pipe and catch 
basins/inlet structures within street right-of-way to capture run-off from the green belt 
area. 
 
PROJECT STATUS 
This project's design phase is completed.  The project's anticipated construction start is 
by summer 2021 and completion would be summer 2023. Spring 2021 - Advertise the 
Monroe Storm Drain Project for construction bids (The project specifications will restrict 
the storm drain construction within Lincoln Avenue to coincide with the system 
connections related to RPU’s Lincoln Avenue Techite Pipe Replacement Project). 
 
OPERATING BUDGET IMPACT 
Regular maintenance of the catch basin will be required; however, the project will 
eliminate the maintenance currently required during and after storm events resulting in 
a reduction in net operating impacts. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$12,674,370 $12,674,370 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  FAIRVIEW & CORNWALL STORM DRAIN PROJECT 
PROJECT NUMBER 9020 COUNCIL WARD 3 
PROJECT CATEGORY Storm Drain System 
PROJECT LOCATION Fairview Drive and Cornwall Avenue 
 
PROJECT DESCRIPTION 
This project will add new pipe and catch basins at the intersection of Fairview Drive 
and Cornwall Avenue within street right-of-way in order to capture run-off from the 
street. 
 
PROJECT STATUS 
The Project is estimated to be completed in the first quarter of FY 2020/21. 
 
OPERATING BUDGET IMPACT 
Once completed, the storm drain will require annual maintenance which will cost 
approximately $1,500 per year. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$950,500 $950,500 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  VAN BUREN BLVD PUMP STATION REHABILITATION 
PROJECT NUMBER 9073 COUNCIL WARD 5 
PROJECT CATEGORY Storm Drain System 
PROJECT LOCATION Van Buren Blvd underpass at BNSF Railroad 
 
PROJECT DESCRIPTION 
This project will add new pipe and catch basins at the intersection of Fairview Drive 
and Cornwall Avenue within street right-of-way in order to capture run-off from the 
street. 
 
PROJECT STATUS 
This project has not started yet.  
 
OPERATING BUDGET IMPACT 
The project should not have an ongoing budgetary impact as it is replacing current 
infrastructure. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$262,770 $162,770 $100,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $100,000 - - - - $100,000 

 TOTAL $100,000 $0 $0 $0 $0 $100,000 

 

238



 

 

PUBLIC WORKS – STORM DRAIN 
Capital Improvement Program FY 2020/21 - 2024/25 
 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

 

 

 

 

 

  SIERRA STREET STORM DRAIN IMPROVEMENTS 
PROJECT NUMBER 9137 COUNCIL WARD 3 
PROJECT CATEGORY Storm Drain System 
PROJECT LOCATION Sierra St from Streeter Ave to Capistrano Way 
 
PROJECT DESCRIPTION 
The project is to install 900 LF of new 12” to 18” diameter RCP into Sierra Street near 
Streeter Avenue with two catch basins. The project is created due to multiple SRO 
requests for the last few years due to flooding on Sierra Street even with a small rain 
event. The street is not able to carry the capture of the drainage area within. 
 
PROJECT STATUS 
The project is currently in the design phase. Awaiting the lowest responsive bidder’s 
approval for construction. Plan to go to Council in September 2020 with anticipation to 
start construction by end of calendar 2020. 
 
OPERATING BUDGET IMPACT 
The maintenance will be yearly catch basins clean up per NPDES permit. The cost for 
this is currently unknown and will be evaluated upon completion. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$450,000 $0 $450,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $450,000 - - - - $450,000 

 TOTAL $450,000 $0 $0 $0 $0 $450,000 
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      Capital Improvement Program 

Project Category Overview:  Transportation 

 

 

Introduction  
Transportation CIP Projects include the new construction, replacement, 
rehabilitation, and repair of roadways/streets, sidewalk, curb, gutter, and 
traffic signal improvements.  Transportation infrastructure, as in the public right 
of way, is the backbone of the City’s public infrastructure and assets.  This is 
where the residents, visitors, and businesses come to live, work, and play. 
 
One-Year Budget and Five-Year Plan 
The FY 2020/21 to FY 2024/25 CIP is a 
planning document intended to 
prioritize and allocate City funds for 
transportation improvements.  The 
program includes two major 
sections, Streets and Traffic Signals, 
at a total funded cost of $87.8 
million.  The proposed program is 
underfunded by $219 million. 
 
The Traffic Signal Program for FY 
2020/21 through 2024/25 includes 
construction of new traffic signals 
and modifications to existing signals 
to improve safety, traffic flow, and 
reduce delay at intersections. 
 
The Streets Program for FY 2020/21 
through FY 2024/25 is designed to 
meet City Council priorities while reducing the backlog of incomplete 
projects.  The focus of the Streets Program is to rehabilitate local and arterial 
streets to extend their useful life and the repair of curbs, gutters, and sidewalks.  
The program will also construct pedestrian ramps to comply with the 
Americans with Disabilities Act (ADA).  A new Pavement Management 
Program (PMP) is being implemented to assist with prioritizing streets to include 
the rehabilitation and preservation projects.  The PMP is designed to optimize 
funding available to maintain the roadways in the most cost effective and 
efficient manner.    
 
Project Highlights:  
Traffic Management Center 
This is an ongoing project to monitor real time traffic in order to refine and 
produce signal timing plans, improve vehicular mobility, and make necessary 
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traffic signal timing adjustments based on observation of City streets via CCTV 
cameras. 
 
Arterial Interconnect Project 
The Arterial Interconnect Project includes the maintenance and replacement 
of traffic signal interconnect cabling, modems and other related equipment 
used to facilitate communication between traffic signals and the Traffic 
Management Center (TMC).  This project can be used to provide 
interconnect at new locations and establish communications with the TMC.   
 
Sidewalk Fronting Patricia Beatty 
The project will install approximately 210 feet of sidewalk and small retaining 
wall to provide a walkway for parents & students near Patricia Beatty 
Elementary School. The project would additionally install a rectangular rapid 
flashing beacon lighted pedestrian sign that connects to Patricia Beatty's 
Easterly walkway. The project is currently in the design phase. 
 
Mission Boulevard Bridge Replacement at Santa Ana River 
This project provides for the reconstruction of the Mission Bridge spanning over 
1,100 feet across the Santa Ana River between the cities of Riverside and 
Jurupa Valley.  The new bridge will be constructed along the same alignment 
as the existing bridge but will be wider than the existing bridge allowing for 
bike lanes and a sidewalk for pedestrian use.  The project is being led by the 
County of Riverside and the City of Riverside will only be responsible to provide 
its fair share contribution to satisfy the local match requirements. 
 
Market Boulevard Bridge Replacement at Santa Ana River 
The existing Market Street Bridge over the Santa Ana River is an important 
transportation link between the Cities of Riverside and Jurupa Valley. This 12-
span steel plate girder bridge is 1,195 feet long and was constructed in 1953. 
It will be replaced with a new 4 lane bridge including standard shoulders and 
a dedicated multi-purpose pedestrian lane. 
 
Key Revenues and Funding Sources 
 

Fund Funding Source Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

230 Gas Tax $10,771,792 $10,625,000 $9,825,000 $9,825,000 $9,825,000 $50,871,792 

420 Measure Z Capital 4,375,000 4,375,000 4,375,000 2,875,000 2,875,000 $18,875,000 

432 Measure A 2,875,000 4,625,000 4,625,000 2,975,000 2,975,000 $18,075,000 

 TOTAL $18,021,792 $19,625,000 $18,825,000 $15,675,000 $16,675,000 $87,821,792 
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State Gas Tax, Local Measure A, and City Development Impact fees are the 
primary sources of revenues for the projects.  Additional rehabilitation and 
safety funds will be generated with the City’s Measure Z sales tax revenues 
and California’s Senate Bill 1 Rehabilitation Gas Tax Revenues.     
 
Furthermore, the City issued certificates of participation (COP) in 2013 that 
provided funding for a backlog of street paving projects.  The COP debt will 
be repaid in future years from local transportation funds.  The debt service 
obligation will reduce available funds for transportation projects by $3 million 
per year for the twenty-year repayment term.   
 
Projects by Type of Improvement 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Bicycle/Pedestrian       

Knoefler Street Improvements $560,000 - - - - $560,000 

Pedestrian Ramps Program 300,000 300,000 300,000 300,000 300,000 $1,500,000 

Sidewalk Repair Program 300,000 300,000 300,000 300,000 300,000 $1,500,000 

Sidewalk/Trail Construction at 
Various Locations Program 300,000 300,000 300,000 300,000 300,000 $1,500,000 

Total Bicycle/Pedestrian $1,460,000 $900,000 $900,000 $900,000 $900,000 $5,060,000 

Bridge       
Market Street Bridge 
Replacement over the Santa Ana 
River 

$900,000 $850,000 $850,000 - - $2,600,000 

Mission Boulevard Bridge 
Replacement at Santa Ana River 800,000 800,000 800,000 - - $2,400,000 

    Total Bridge $1,700,000 $1,650,000 $1,650,000 $0 $0 $5,000,000 

Other Projects       
Local Roadway Safety 
Improvement Plan $100,000 - - - - $100,000 

    Total Other Projects $100,000 $0 $0 $0 $0 $100,000 
Street Maintenance       

Adair Sidewalk-Jo Jo Randolph $75,000 - - - - $75,000 

Berry Rd Widening - Selina Street 
to Bush Ave - 800,000 - - - $800,000 

Bonita Sidewalk-Tyler Pendleton 135,000 - - - - $135,000 

CDBG Matching Funds 150,000  150,000  150,000  150,000 150,000   750,000  

Curb and Gutter Repair Program 200,000  200,000  200,000  200,000 200,000   1,000,000  

Major Streets Rehabilitation 500,000  2,400,000  2,400,000  2,400,000 2,400,000   10,100,000  
Measure Z Pavement 
Rehabilitation and Improvement 4,375,000  4,375,000  4,375,000  2,875,000 2,875,000   18,875,000  

Minor Street Preservation 
(Slurry/Aram) Program 500,000  500,000  500,000  500,000 500,000   2,500,000  

Minor Street Rehabilitation 
Program 1,500,000  1,500,000  1,500,000  1,500,000 1,500,000   7,500,000  

Miscellaneous Street Construction 
Program 300,000  500,000  500,000  500,000 500,000   2,300,000  

    Total Street Maintenance $7,735,000 $10,425,000 $9,625,000 $8,125,000 $8,125,000 $44,035,000 

Traffic Improvements       
Interconnected Traffic Signal 
Controller Replacement - - - - - $0 

Miscellaneous Traffic Projects 
Program 75,000 75,000 75,000 75,000 75,000 $375,000 
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RMRA Traffic Improvements 
Fy2020/21 6,196,792  0  0  0 0  $6,196,792  

RMRA Traffic Improvements 
Fy2021/22 0  6,000,000  6,000,000  6,000,000 6,000,000   $24,000,000  

Sidewalk Fronting Patricia Beatty 125,000  0  0  0 0   $125,000  

Traffic Signal Emergency Vehicle 
Replacement 10,000  10,000  10,000  10,000 10,000   $50,000  

Victoria At Washington 
Southbound Merge Lane 55,000  0  0  0 0   $55,000  

    Total Traffic Improvements $6,461,792 $6,085,000 $6,085,000 $6,085,000 $6,085,000 $30,801,792 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Traffic Signal Interconnections       
Arterial Interconnect Project 
Program $40,000 $40,000 $40,000 $40,000 $40,000 $200,000 

Traffic Management Center 
Program 50,000 50,000 50,000 50,000 50,000 $250,000 

    Total Traffic Signal 
Interconnections $90,000 $90,000 $90,000 $90,000 $90,000 $450,000 

Traffic Signal Maintenance       
Controller Assembly Replacement 
Program $70,000 $70,000 $70,000 $70,000 $70,000 $350,000 

LED Signal Lenses Replacement 
Program 20,000 20,000 20,000 20,000 20,000 $100,000 

Spread Spectrum Radio 
Replacement Program 10,000 10,000 10,000 10,000 10,000 $50,000 

Traffic Signal Loop Replacement 
Program 25,000 25,000 25,000 25,000 25,000 $125,000 

    Total Traffic Signal 
Maintenance $125,000 $125,000 $125,000 $125,000 $125,000 $625,000 

Traffic Signal Modifications       
Miscellaneous Signal Revisions 
Program $100,000 $100,000 $100,000 $100,000 $100,000 $500,000 

    Total Traffic Signal Modifications $100,000 $100,000 $100,000 $100,000 $100,000 $500,000 

New Traffic Signals       
New Traffic Signals (Prioritized 
Locations-One Per Year) Program $250,000 $250,000 $250,000 $250,000 $250,000 $1,250,000 

    Total New Traffic Signals $250,000 $250,000 $250,000 $250,000 $250,000 $1,250,000 

TOTAL $18,021,792 $19,625,000 $18,825,000 $15,675,000 $15,675,000 $87,821,792 

 
Top Unfunded Projects by Priority 

Project Name Estimated 
Project Cost 

Unfunded 
Amount 

1. Adams Street/State Route 91 Interchange Improvements $72,900,000 $65,700,000 
2. Van Buren Widening, Indiana To South City Limit 26,640,352 26,640,352 
3. Tyler/State Route 91 Interchange Improvements 75,000,000 75,000,000 
4. Canyon Crest Widening 8,104,673 2,700,000 
5. Arlington Avenue at Chadbourne Avenue Traffic Signal 325,000 325,000 
6. University Avenue Fiber Optic 450,000 400,000 
7. 14th Street Widening, SR-91 To Martin Luther King 24,000,000 24,000,000 
8. Citywide Striping Removal 70,000 70,000 
9. Miscellaneous Signal Cabinet Replacement 225,000 225,000 
10. Miscellaneous Guardrail Repair 30,000 30,000 

TOTAL $207,745,025 $195,090,352 
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Project Map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: This map includes all active and new capital improvement projects.  Ongoing and citywide projects are not included on the 
map.  To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.   

 
Distribution by Ward  

 
Ward Five-Year Total  

Ward 1 $5,375,000 

Ward 2 - 

Ward 3 - 

Ward 4 800,000 

Ward 5 - 

Ward 6 135,000 

Ward 7 635,000 

All Wards 80,876,792 

 Total $87,821,792 
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  MISC STREET CONSTRUCTION PROGRAM 
PROJECT NUMBER 5070 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
City funds are allocated for work on various projects, issues, and concerns that present 
themselves during the year. These projects include removal and replacement of non-
compliant pedestrian ramps as well as damaged curbs, gutters, cross-gutters, 
driveways, and sidewalks adjacent to the street in order to provide proper drainage 
and remain in compliance with the Americans With Disability Act (ADA). 
 
PROJECT STATUS 
This is an ongoing maintenance project used year-round to replace pedestrian ramps, 
curbs, gutters, cross-gutters, driveways, and sidewalks. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project to maintain the City's sidewalks, curbs, gutters, driveways, 
cross-gutters, and pedestrian ramps.  There are no operating budget impacts 
associated with this ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $2,849,200 $2,300,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $300,000 $500,000 $500,000 $500,000 $500,000 $2,300,000 

 TOTAL $300,000 $500,000 $500,000 $500,000 $500,000 $2,300,000 

 

249



 

 

PUBLIC WORKS – TRANSPORTATION 
Capital Improvement Program FY 2020/21 - 2024/25 
 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

   

 

  CONTROLLER ASSEMBLY REPLACEMENT 
PROJECT NUMBER 5183 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Traffic Signal Maintenance Crew performs regular maintenance on 375 traffic 
signal controllers. They most frequently respond to locations where the signal cabinet 
has been struck by a vehicle. 
 
PROJECT STATUS 
This is an ongoing project for the replacement of traffic signal cabinets due to 
unexpected knock downs and the replacement of old cabinets with newer models 
that are more compatible with new signal equipment. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project to replace traffic signal cabinets in order to keep traffic 
signals throughout the City functional.  There are no operating budget impacts 
associated with this ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $691,492 $350,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $70,000 $70,000 $70,000 $70,000 $70,000 $350,000 

 TOTAL $70,000 $70,000 $70,000 $70,000 $70,000 $350,000 
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  SPREAD SPECTRUM RADIO REPLACEMENT 
PROJECT NUMBER 5846 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is a recurring project of the Traffic Management Center (TMC) to upgrade or 
replace traffic signal radios and related components for communication with the City’s 
375 signalized intersections. 
 
PROJECT STATUS 
This is an ongoing maintenance project used year-round to replace existing and install 
new radios for communication between signals and the Traffic Management Center. 
 
OPERATING BUDGET IMPACT 
The installation of the cameras will result in a net decrease in overall operating budget 
impacts because minor maintenance and timing adjustments can be completed 
throughout the City from the Traffic Management Center. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $66,640 $50,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $10,000 $10,000 $10,000 $10,000 $10,000 $50,000 

 TOTAL $10,000 $10,000 $10,000 $10,000 $10,000 $50,000 
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  TRAFFIC SIGNAL LOOP REPLACEMENT PROGRAM 
PROJECT NUMBER 5847 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This program is to replace faulty or damaged traffic signal loop detectors throughout 
the City. The City maintains an on-call contract with Smithson Electric for this work. 
 
PROJECT STATUS 
This is an ongoing maintenance project used year-round to replace damaged and/or 
faulty loop detectors.  
 
OPERATING BUDGET IMPACT 
This is an ongoing project to replace damaged or faulty loop detectors.  There are no 
operating budget impacts associated with this ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $266,228 $125,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $25,000 $25,000 $25,000 $25,000 $25,000 $125,000 

 TOTAL $25,000 $25,000 $25,000 $25,000 $25,000 $125,000 

 

252



 

 

PUBLIC WORKS – TRANSPORTATION 
Capital Improvement Program FY 2020/21 - 2024/25 
 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

p 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

   

 

  MISCELLANEOUS SIGNAL REVISIONS PROGRAM 
PROJECT NUMBER 5861 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is a recurring project to complete traffic signal modifications, rewire aging 
conductors, and upgrade signals throughout the City. 
 
PROJECT STATUS 
This is an ongoing maintenance project used year-round to install enhancements to 
signalized intersections to improve vehicular and pedestrian mobility. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project to improve traffic signals throughout the City.  There are no 
operating budget impacts associated with the completion of this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $1,950,293 $500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $100,000 $100,000 $100,000 $100,000 $100,000 $500,000 

 TOTAL $100,000 $100,000 $100,000 $100,000 $100,000 $500,000 
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  ARTERIAL INTERCONNECT PROGRAM 
PROJECT NUMBER 5862 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Maintenance and replacement of traffic signal interconnect cabling, modems, and 
other related equipment used to facilitate communication between traffic signals and 
the Traffic Management Center (TMC). This project can be used to provide 
interconnect at new locations and establish communications with the TMC. The City 
has approximately 150 traffic signals making use of traditional arterial interconnect to 
communicate with the TMC. Interconnect is used along major roadways such as 
Magnolia Avenue, Tyler Street, La Sierra Avenue, Victoria Avenue, Van Buren 
Boulevard, Alessandro Boulevard, Central Avenue, Fourteenth Street, and University 
Avenue, along with locations on intersecting roadways.  
 
PROJECT STATUS 
This is an ongoing project for the maintenance and replacement of traffic signal 
interconnect components. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project to maintain the traffic signal interconnect system. There are 
no operating budget impacts associated with this ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $554,384 $200,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $40,000 $40,000 $40,000 $40,000 $40,000 $200,000 

 TOTAL $40,000 $40,000 $40,000 $40,000 $40,000 $200,000 
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  CANYON CREST WIDENING 
PROJECT NUMBER 5876 COUNCIL WARD 2 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Canyon Crest Dr. between Via Vista & Country Club 
 
PROJECT DESCRIPTION 
This project provides for the construction of street widening improvements on the 
eastern side of Canyon Crest Drive between Via Vista Drive and Country Club Drive. 
This project will provide two travel lanes and two bike lanes in each direction, as well as 
provide asphalt resurfacing improvements for the existing pavement. The 
improvements generally include new concrete curb, gutter, and sidewalk on the 
eastern side along with new drought-tolerant landscaped medians.  
 
PROJECT STATUS 
The project is currently on hold due to the adjacent developer no longer being 
committed to the project. The adjacent development was to dedicate the necessary 
right-of-way in exchange for the City constructing the street improvements. The City 
only has funds available for the street improvement and not for acquiring right-of-way. 
Additionally, environmental permits will need to be obtained.  
 
OPERATING BUDGET IMPACT 
There are no anticipated operating budget impacts associated with the completion of 
this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$8,104,673 $5,404,673 $0 $2,700,000 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  TRAFFIC MANAGEMENT CENTER 
PROJECT NUMBER 5931 COUNCIL WARD 1 
PROJECT CATEGORY Transportation 
PROJECT LOCATION City Hall 4th Floor, all signalized intersections 
 
PROJECT DESCRIPTION 
The Traffic Management Center (TMC) manages traffic operations throughout the City. 
It is the hub for the City’s camera and connected traffic signal infrastructure. The 
project covers both equipment and staff time. 
 
PROJECT STATUS 
This is an ongoing project to monitor real-time traffic in order to refine and produce 
signal timing plans, improve vehicular mobility, and make necessary traffic signal timing 
adjustments based on observation of City streets via CCTV cameras. 
 
OPERATING BUDGET IMPACT 
There are no net operating budget impacts associated with this ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $1,892,009 $250,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $50,000 $50,000 $50,000 $50,000 $50,000 $250,000 

 TOTAL $50,000 $50,000 $50,000 $50,000 $50,000 $250,000 
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  JURUPA AVENUE EXTENSION  
PROJECT NUMBER 5984 COUNCIL WARD 7 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Jurupa Ave from Van Buren Blvd to Rutland Ave 
 
PROJECT DESCRIPTION 
This project included the construction of the Jurupa Avenue Extension as a four-lane 
divided arterial between Van Buren Boulevard to 610 feet westerly, and a two-lane 
roadway across the former Hole Lake culvert to Rutland Avenue, with curb, gutter, and 
sidewalk, landscaped median, and parkways, bike lanes, street lights, underground 
electrical facilities, and potable and reclaimed water lines.  The project will also 
provide habitat mitigation services as required for the completion of the Jurupa 
Avenue Extension project completed in 2012.  The services agreement will terminate 
when the restoration improvements have been installed and established, and the 
endowment paid to the Riverside-Corona Resource Conservation District (RCRCD) for 
perpetual maintenance.  
 
PROJECT STATUS 
The construction of this project has been completed.  However, in September 2015, the 
City and RCRCD entered into a Services Agreement for the habitat mitigation services.  
RCRCD is responsible for restoring the habitat areas impacted by the completion of the 
project as well as preserving the restored areas in perpetuity.  The anticipated 
completion date for the mitigation of this project is June 2023.  
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts associated with the completion of this project. 
  
  
  

☐ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$6,174,673 $6,174,673 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  NEW TRAFFIC SIGNALS PROGRAM 
PROJECT NUMBER 8341 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The City of Riverside Traffic Division maintains a priority list for the installation of new 
traffic signals. The City has identified locations that would benefit from the installation of 
traffic signals and uses the priority list as a means to equitably schedule the funding of 
new signal installations.  
 
PROJECT STATUS 
This is an ongoing project for the installation of new traffic signals.  The City of Riverside 
Traffic Division is planning to install a traffic signal at the intersection of Cole Ave and 
Krameria Ave (subject to change) which is currently an all-way stop-controlled 
intersection.  
 
OPERATING BUDGET IMPACT 
The operating budget impact of a new traffic signal is approximately $3,000 per year 
for each signal. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $540,102 $1,250,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $250,000 $250,000 $250,000 $250,000 $250,000 $1,250,000 

 TOTAL $250,000 $250,000 $250,000 $250,000 $250,000 $1,250,000 
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  VAN BUREN-JURUPA TO SANTA ANA RIVER 
BRIDGE 
PROJECT NUMBER 8409 COUNCIL WARD   3, 7   
PROJECT CATEGORY Transportation 
PROJECT LOCATION Van Buren Boulevard and Jurupa 
 
PROJECT DESCRIPTION 
This project will widen the easterly side of Van Buren Boulevard from approximately 300-
feet north of Jurupa Avenue to the Santa Ana River Bridge.  Work includes the 
construction of concrete curb, gutter, sidewalk, asphalt pavement, provision of bike 
lanes, and the installation of streetlights.  The Project will also restripe northbound Van 
Buren from south of Jurupa Avenue to the Santa Ana River Bridge.  
 
PROJECT STATUS 
The project is still in the design phase due to a lack of funding. Currently, there is 
$160,000 of TUMF funding available. The project is fully funded by WRCOG. The 
construction phase is expected to be $1,951,000.  
 
OPERATING BUDGET IMPACT 
There are no projected operational impacts since this widens the street and shouldn't 
require maintenance. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,700,261 $749,261 $1,951,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

434* TUMF Fund $1,951,000 - - - - $1,951,000 

 TOTAL $1,951,000 $0 $0 $0 $0 $1,951,000 

*Appropriation of funds contingent on TUMF award.  For planning purposes only.  Not included in in other areas of the CIP. 
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  LED SIGNAL LENSES REPLACEMENT PROGRAM 
PROJECT NUMBER 8619 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing project to perform regular maintenance of the 400 traffic signals to 
ensure that the LED signal lenses are in working order.  
 
PROJECT STATUS 
This is an ongoing project to replace LED lenses as part of regular maintenance or that 
have been physically damaged.  
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts associated with this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $80,000 $100,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $20,000 $20,000 $20,000 $20,000 $20,000 $100,000 

 TOTAL $20,000 $20,000 $20,000 $20,000 $20,000 $100,000 
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  MISSION BOULEVARD BRIDGE REPLACEMENT AT 
SANTA ANA RIVER 
PROJECT NUMBER 8629 COUNCIL WARD 1 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Mission Boulevard Bridge over the Santa Ana River 
 
PROJECT DESCRIPTION 
This project provides for the reconstruction of the Mission Bridge spanning over 1,100 
feet across the Santa Ana River between the cities of Riverside and Jurupa Valley.  The 
new bridge will be constructed along the same alignment as the existing bridge but will 
be wider than the existing bridge allowing for bike lanes and a sidewalk for pedestrian 
use.  The County of Riverside is taking the lead on this project and the City of Riverside 
will only be responsible to provide its fair share contribution to Riverside County in order 
to satisfy the local match requirements.  
 
PROJECT STATUS 
The project is being managed by the County of Riverside and is currently in the Design 
Phase. Construction is anticipated to be completed in 2023.  
 
OPERATING BUDGET IMPACT 
There are no additional operating impacts anticipated with the completion of this 
project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,400,000 $1,000,000 $2,400,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $800,000 $800,000 $800,000 - - $2,400,000 

 TOTAL $800,000 $800,000 $800,000 $0 $0 $2,400,000 
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  MARKET STREET BRIDGE REPLACEMENT OVER THE 
SANTA ANA RIVER 
PROJECT NUMBER 8699 COUNCIL WARD 1 
PROJECT CATEGORY Transportation 

PROJECT LOCATION Market Street Bridge Replacement over the Santa Ana 
River 

 
PROJECT DESCRIPTION 
The existing Market Street Bridge over the Santa Ana River is an important 
transportation link between the Cities of Riverside and Jurupa Valley. This 12-span steel 
plate girder bridge is 1,195 feet long and was constructed in 1953. It will be replaced 
with a new 4 lane bridge including standard shoulders and a dedicated multi-purpose 
pedestrian lane.  The County of Riverside is taking the lead on this project and the City 
of Riverside will only be responsible to provide its fair share contribution to Riverside 
County in order to satisfy the local match requirements.  
 
PROJECT STATUS 
The County of Riverside is currently in the PA&ED phase which is scheduled for 
completion in 2019.  Construction is anticipated to be completed in 2024.  
 
OPERATING BUDGET IMPACT 
There are no additional operating impacts anticipated with the completion of this 
project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,700,000 $100,000 $2,600,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $900,000 $850,000 850,000 - - $2,600,000 

 TOTAL $900,000 $850,000 $850,000 $0 $0 $2,600,000 
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  UNIVERSITY AVENUE FIBER OPTIC 
PROJECT NUMBER 8711 COUNCIL WARD 1, 2 
PROJECT CATEGORY Transportation 

PROJECT LOCATION University Avenue between Market Street and W 
Campus Drive 

 
PROJECT DESCRIPTION 
This project will install approximately 2.6 miles of fiber optic cabling to enable high-
speed communications for the 16 traffic signals along University Avenue.  
 
PROJECT STATUS 
The project will be designed internally and is currently going to Council for additional 
funding. The Project Manager is requesting additional Measure A funding for the 
project but we are waiting on Caltrans to decide how they want to administer the 
program.  
 
OPERATING BUDGET IMPACT 
There are no anticipated operating budget impacts associated with the completed of 
this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$450,000 $50,000 $0 $400,000 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 

 

263



 

 

PUBLIC WORKS – TRANSPORTATION 
Capital Improvement Program FY 2020/21 - 2024/25 
 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

   

 

 

 

ADAMS STREET/STATE ROUTE 91 INTERCHANGE 
IMPROVEMENTS 
PROJECT NUMBER 8821 COUNCIL WARD 3, 4, 5 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Adams Street at the SR-91 
 
PROJECT DESCRIPTION 
This project includes the reconfiguration of Adams Street interchange at the SR-91 to 
reduce traffic congestion. 
 
PROJECT STATUS 
The project is in the Project Approval and Environmental Document phase (PA & ED) to 
prepare technical studies in compliance with the National Environmental Policy Act 
(NEPA) for the two build and one no-build alternative.  Caltrans will review and 
approved the NEPA studies, reports, and documents.  The PA & ED phase is anticipated 
to be completed in Spring 2023. 
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts associated with the completion of this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$72,900,000 $7,200,000 $0 $65,700,000 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  CITYWIDE BIKE SHARE PROGRAM 
PROJECT NUMBER 8823 COUNCIL WARD 1 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Downtown 
 
PROJECT DESCRIPTION 
This project is for the planning and implementation of a bike-share program in the 
Downtown area.  
 
PROJECT STATUS 
Project construction is completed, the contract for operations is ongoing. Submitted 
the final invoice for reimbursement with Caltrans. Once reimbursement is received 
project will be closed out. 
 
OPERATING BUDGET IMPACT 
Any operating impact will be included in current the O&M budget without any 
additional impact. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$303,000 $303,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MAGNOLIA AVENUE WIDENING FROM 
BUCHANAN STREET TO HOLE AVENUE 
PROJECT NUMBER 8824 COUNCIL WARD 6, 7 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Magnolia Ave from Buchanan St and Hole Ave 
 
PROJECT DESCRIPTION 
This project provides for the construction of street widening improvements within the 
existing medians to provide a third vehicular lane to the State Route 91 on- and off-
ramps from Buchanan Street and Banbury Drive. Additionally, the project will provide 
beautification improvements to the remaining portions of the existing medians and 
maintenance improvements to the existing roadway between Buchanan Street and 
Hole Avenue. The project will also include Riverside Public Utilities Water and Electric 
facilities. 
 
PROJECT STATUS 
The Notice to Proceed was issued on March 2, 2020, for Bid 7631. The project has 200 
working days. 
 
OPERATING BUDGET IMPACT 
There are no net operating budget impacts associated with this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$11,150,209 $11,150,209 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MISCELLANEOUS TRAFFIC PROJECTS 
PROJECT NUMBER 8832 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Miscellaneous Traffic Projects encompass a variety of traffic improvements across 
Riverside.  This project is used to install signing and striping improvements to improve 
safety and traffic flow, refresh faded striping, replaced damaged signs, modify parking 
restrictions, repair damaged sections of guard rail, adjust median noses, install roadside 
and overhead signs to facilitate access to Riverside landmarks and attractions, and is a 
means to make neighborhood traffic improvements in response to resident requests. 
 
PROJECT STATUS 
This is an ongoing project to make roadway improvements throughout the City. Traffic 
will continue to deploy similar solutions Citywide to enhance safety & operations.  
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts anticipated with the completion of this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $292,524 $375,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $75,000 $75,000 $75,000 $75,000 $75,000 $375,000 

 TOTAL $75,000 $75,000 $75,000 $75,000 $75,000 $375,000 
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  MAJOR STREETS REHABILITATION 
PROJECT NUMBER 8880 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This project provides for the systematic resurfacing (asphalt overlay) of all arterial streets 
throughout the City at prescribed intervals. These intervals vary depending on the age 
of the street and traffic volume. The project also includes removal and replacement of 
non-compliant pedestrian ramps and damaged curbs, gutters, cross-gutters, driveways 
and sidewalks adjacent to the street to provide proper drainage and ADA 
compliance. 
 
PROJECT STATUS 
This is an ongoing project to systematically resurface all arterials throughout the City. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project and there are no anticipated operating budget impacts. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $6,465,774 $10,100,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $500,000 $2,400,000 $2,400,000 $2,400,000 $2,400,000 $10,100,000 

 TOTAL $500,000 $2,400,000 $2,400,000 $2,400,000 $2,400,000 $10,100,000 
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  CURB AND GUTTER REPAIR PROGRAM 
PROJECT NUMBER 8883 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This project provides for the repair of concrete curbs and gutters throughout the City. 
The project will remove and reconstruct curbs and gutters that are damaged and/or 
uplifted, mostly from tree roots. 
 
PROJECT STATUS 
This is an ongoing project to repair curb and gutter throughout the City. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project with no anticipated operating budget impacts. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $1,063,506 $1,000,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $200,000 $200,000 $200,000 $200,000 $200,000 $1,000,000 

 TOTAL $200,000 $200,000 $200,000 $200,000 $200,000 $1,000,000 
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  MINOR STREET REHABILITATION PROGRAM 
PROJECT NUMBER 8884 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This program provides the asphalt concrete pavement rehabilitation of minor streets 
throughout the City. This program also includes removal and reconstruction of non-
compliant pedestrian ramps and repair of curbs, gutters, driveways, and sidewalks 
adjacent to the street to provide proper drainage, ADA compliance, and better ride 
quality. 
 
PROJECT STATUS 
This is an ongoing project to improve minor streets throughout the City. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project with no anticipated operating budget impacts. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $9,850,384 $7,500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $1,500,000 $1,500,000 $1,500,000 $1,500,000 $1,500,000 $7,500,000 

 TOTAL $1,500,000 $1,500,000 $1,500,000 $1,500,000 $1,500,000 $7,500,000 
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  SIDEWALK/TRAIL CONSTRUCTION PROGRAM 
PROJECT NUMBER 8885 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This project provides for the construction of concrete sidewalks and trails to provide 
improved pedestrian access and circulation.  
 
PROJECT STATUS 
This is an ongoing project to construct a sidewalk and trails.  
 
OPERATING BUDGET IMPACT 
This is an ongoing project with no anticipated operating budget impacts. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $767,535 $1,500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $300,000 $300,000 $300,000 $300,000 $300,000 $1,500,000 

 TOTAL $300,000 $300,000 $300,000 $300,000 $300,000 $1,500,000 
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  SIDEWALK REPAIR PROGRAM 
PROJECT NUMBER 8886 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This program provides the repair for concrete sidewalks throughout the City. The 
program will remove and reconstruct sidewalks that are damaged and/or uplifted, 
mostly from tree roots.  
 
PROJECT STATUS 
This is an ongoing project to repair sidewalks throughout the City.  
 
OPERATING BUDGET IMPACT 
This is an ongoing project with no anticipated operating budget impacts. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $1,963,853 $1,500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $300,000 $300,000 $300,000 $300,000 $300,000 $1,500,000 

 TOTAL $300,000 $300,000 $300,000 $300,000 $300,000 $1,500,000 
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  PEDESTRIAN RAMPS PROGRAM 
PROJECT NUMBER 8887 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This project provides for the construction of new pedestrian ramps and detectable 
warning surfaces along arterial and collector streets to provide improved pedestrian 
access to sidewalks. 
 
PROJECT STATUS 
This is an ongoing project to construct pedestrian ramps and detectable warning 
surfaces. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project to improve pedestrian access to sidewalks.  There are no 
anticipated operating budget impacts associated with this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $1,595,350 $1,500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $300,000 $300,000 $300,000 $300,000 $300,000 $1,500,000 

 TOTAL $300,000 $300,000 $300,000 $300,000 $300,000 $1,500,000 
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  CDBG STREET IMPROVEMENTS - MATCHING FUNDS 
PROJECT NUMBER 8888 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The federal Community Development Block Grant (CDBG) program is a flexible 
program that provides viable urban communities with resources to address 
development needs and is administered by the City’s Community Development 
Department for eligible areas throughout the City.  This project provides matching 
funds for various systematic street improvement projects awarded to Public Works 
under the CDBG program including construction of asphalt resurfacing, construction of 
pedestrian ramps with detectable warning surfaces to provide improved pedestrian 
access to sidewalks, and construction of new sidewalks to provide improved 
pedestrian access and circulation. 
 
PROJECT STATUS 
This is an ongoing project to support sidewalk improvements funded by the Community 
Development Block Grant (CDBG). 
 
OPERATING BUDGET IMPACT 
This is an ongoing project to support CDBG funded street improvements.  There are no 
operating budget impacts associated with this project. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $1,418,797 $750,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $150,000 $150,000 $150,000 $150,000 $150,000 $750,000 

 TOTAL $150,000 $150,000 $150,000 $150,000 $150,000 $750,000 
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  NORTE VISTA SIDEWALK IMPROVEMENTS 
PROJECT NUMBER 8889 COUNCIL WARD 7 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Gaylord St, Jones Ave, Chadbourne Ave, Bushnell Ave 
 
PROJECT DESCRIPTION 
The project proposes to widen one side of the pavement section and install, curb, 
gutter, streetlights, driveway approaches, ADA ramps, and sidewalk in order to resolve 
drainage issues on 2.9 miles of residential streets. 
 
PROJECT STATUS 
The project is complete. Still waiting on reimbursement from two agencies before the 
project is closed. 
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts associated with the completion of this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$3,701,492 $3,701,492 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 

 

275



 

 

PUBLIC WORKS – TRANSPORTATION 
Capital Improvement Program FY 2020/21 - 2024/25 
 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

   

 

  WELLS AND ARLANZA SIDEWALK PROJECT 
PROJECT NUMBER 8890 COUNCIL WARD 6 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Babb Ave, Kent Ave, Ivanhoe Ave, and Challen Ave 
 
PROJECT DESCRIPTION 
This project proposes to construct a sidewalk on one side of the residential streets 
between Philbin Avenue and Wells Avenue. The Streets included in the project are 
Babb Avenue, Kent Avenue, Ivanhoe Avenue, and Challen Avenue. 
 
PROJECT STATUS 
Construction was completed on January 18, 2019. Final invoice sent to Caltrans in 
February 2020. Awaiting payment. 
 
OPERATING BUDGET IMPACT 
There are no additional operating impacts anticipated with the completion of this 
project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,892,291 $1,892,291 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  DOWNTOWN BICYCLE & PEDESTRIAN 
IMPROVEMENTS 
PROJECT NUMBER 8891 COUNCIL WARD 1 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Downtown 
 
PROJECT DESCRIPTION 
The Public Works Department worked with local neighborhoods, businesses, the Bicycle 
Advisory Committee, and the Riverside County Transportation Commission (RCTC) to 
identify biking and walking components near the Downtown area to promote an 
active lifestyle. The ATP project focused on improving sidewalk and Class II bike lane 
connectivity and deploying select project components to promote increased walking 
and biking such as new and updated crosswalks and bicycle amenities. 
 
PROJECT STATUS 
The project is nearing completion of construction with only a few items remaining for 
completion by the contractor. 
 
OPERATING BUDGET IMPACT 
Once the project is completed, the anticipated operating budget impact will be 
approximately $10,000 per year to maintain the pedestrian signals and the information 
kiosks. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,186,005 $1,186,005 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MINOR STREET PRESERVATION PROGRAM 
(SLURRY/ARAM) 
PROJECT NUMBER 8894 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This program provides for the asphalt concrete pavement preservation and resurfacing 
of Minor Streets throughout the City. This program will use slurry seal and/or other 
preservation methods as determined to accomplish this goal. 
 
PROJECT STATUS 
This is an ongoing project to preserve and resurface minor streets throughout the City. 
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts associated with this ongoing project. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $3,574,971 $2,500,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $500,000 $500,000 $500,000 $500,000 $500,000 $2,500,000 

 TOTAL $500,000 $500,000 $500,000 $500,000 $500,000 $2,500,000 
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  VAN BUREN BLVD WIDENING 
PROJECT NUMBER 8926 COUNCIL WARD 4 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Van Buren Blvd from Washington to Wood 
 
PROJECT DESCRIPTION 
The project proposes to widen Van Buren Boulevard from King Avenue to Bountiful 
Street, a total distance of approximately 2.5 miles, to improve traffic operations within 
the corridor segment.  The project would widen Van Buren Boulevard from four lanes to 
six lanes and add right turn pockets at major intersections, new driveways, and 
sidewalk.  The County of Riverside is taking the lead on this project and the City of 
Riverside will only be responsible to provide its fair share contribution to the County of 
Riverside. 
 
PROJECT STATUS 
Preliminary Engineering is complete. The County of Riverside is currently in the design 
phase for this project but it is on hold because the construction funds are not fully 
funded. RCTC does not want to purchase Right of Way until Construction funds are 
identified. Riverside is fully funded for matching purposes.  
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts anticipated with the completion of this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$453,478 $453,478 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  CENTRAL/CANYON CREST/WATKINS BIKE LANES 
PROJECT NUMBER 8935 COUNCIL WARD 1, 2, 3, 5 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Active Transportation Program (ATP) funded this project to install cycle tracks, bike 
lanes, HAWK pedestrian signals, and “sharrows” for bicyclists throughout the City. 
 
PROJECT STATUS 
The project has been approved by RCTC and is currently in the environmental review 
stage. A scope change is being processed for the project, as a portion of the initial 
grant proposal, the Pine St. Traffic Circles, will be relocated to another City roadway 
following additional outreach. 
 
OPERATING BUDGET IMPACT 
Once the project is completed, the anticipated operating budget impact will be 
approximately $6,000 per year to maintain the HAWK pedestrian signals. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,157,000 $1,157,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  HIGH FRICTION SURFACE AND HAWK SIGNALS 
PROJECT NUMBER 8936 COUNCIL WARD 1, 3, 4, 7 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Various 
 
PROJECT DESCRIPTION 
Highway Safety Improvement Program (HSIP) grant-funded project to install segments 
of high friction surface treatment, perform signal timing in the downtown, and install 
two HAWK pedestrian signals.  
 
PROJECT STATUS 
PS&E has been completed for the project. The project applied for construction 
allocation in December of 2019 and is awaiting approval from Caltrans. 
 
OPERATING BUDGET IMPACT 
Once the project is completed, the anticipated operating budget impact will be 
approximately $6,000 per year to maintain the HAWK pedestrian signals. 
 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,293,000 $195,000 $0 $1,098,000 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MONROE REHAB-LINCOLN TO ARLINGTON 
PROJECT NUMBER 8937 COUNCIL WARD 5, 6 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Monroe St. from Arlington Ave. to Lincoln Ave. 
 
PROJECT DESCRIPTION 
This project provides for the asphalt concrete pavement rehabilitation of Monroe Street 
between Arlington Avenue and Lincoln Avenue.  The project also includes removal 
and replacement of non-compliant pedestrian ramps and damaged curbs, gutters, 
cross-gutters, driveways, and sidewalks adjacent to the street to provide proper 
drainage and ADA compliance.  
 
PROJECT STATUS 
The project was separated into multiple phases. Phase 1 will include Monroe Rehab 
(Magnolia to California), minor streets rehab, and median improvements.  Phase 2 just 
had the pre-construction phase completed and will be starting construction soon. 
Phase 3 is currently in the design phase. 
 
OPERATING BUDGET IMPACT 
The completion of this project will not result in a net increase in operating budget 
impacts. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$2,456,500 $2,456,500 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  SAN ANDREAS DRAINAGE IMPROVEMENTS 
PROJECT NUMBER 8959 COUNCIL WARD 1 
PROJECT CATEGORY Transportation 

PROJECT LOCATION Northwest of intersection of Sand Andreas and 
Glenwood 

 
PROJECT DESCRIPTION 
This project proposes flattening the existing slopes, excavation, and construction of a 
retention basin, basin outlet storm drainpipe, and maintenance access road.  It also 
includes hydroseeding, vegetation, and riprap.  
 
PROJECT STATUS 
The project is completed. Waiting on final invoicing before closing the project.  
 
OPERATING BUDGET IMPACT 
There are no anticipated operating budget impacts associated with this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$675,000 $675,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  INDIAN HILL ROAD SLOPE MITIGATION PROJECT 
PROJECT NUMBER 8990 COUNCIL WARD 1 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Indian Hill Rd east of Ladera Ln and Indian Hills Rd 
 
PROJECT DESCRIPTION 
The project proposes to construct 100 linear feet of soldier pile retaining wall with 
remedial grading including excavation and fill on Indian Hill Road to support the 
roadway within street right of way. The proposed Improvements include pile, steel 
beam, lagging and street rehabilitation. 
 
PROJECT STATUS 
Project is completed. Waiting on final invoicing before the project is closed. 
 
OPERATING BUDGET IMPACT 
There are no anticipated operating budget impacts with the completion of this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$505,000 $505,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  IOWA AVENUE WIDENING 
PROJECT NUMBER 8998 COUNCIL WARD 2 
PROJECT CATEGORY Transportation 

PROJECT LOCATION Iowa Ave between Martin Luther King Blvd and 
University Ave 

 
PROJECT DESCRIPTION 
The project includes the widening of Iowa Avenue between University Avenue and 
Martin Luther King Boulevard to provide 2 travel lanes in each direction including a 
dedicated cycle track section between Martin Luther King Boulevard and Everton 
Place.  The project will also provide new utility infrastructure including storm drain, 
sanitary sewer, underground electric, and domestic water.  The project will provide for 
new landscape and irrigation for the new parkways, medians, and a cycle track buffer 
strip. 
 
PROJECT STATUS 
The project is currently in the design phase and right of way is currently being 
negotiated with the adjacent property owners and developments. 
 
OPERATING BUDGET IMPACT 
There are no additional operating impacts anticipated with the completion of this 
project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$4,932,704 $4,932,704 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  ACTIVE TRANSPORTATION MASTER PLAN 
PROJECT NUMBER 9023 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The City of Riverside Citywide Active Transportation Plan will provide a conceptual, 
multi-modal planning foundation for the City's future bicycle and pedestrian 
improvement projects.  The planning process will integrate existing network, modeled, 
and survey data to fully assess needs and demands, and produce a design toolbox 
and complete proposed active transportation network.  The final plan will be reviewed 
by relevant advisory committees and boards, and ultimately adopted by the City 
Council. 
 
PROJECT STATUS 
The project was selected to be funded as part of the Southern California Association of 
Government’s Phase II of the 2016 Sustainability Planning Grant program.  The project is 
ongoing, and SCAG is managing the contract. The City of Riverside has already 
provided $125,000 in matching funds. 
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts associated with the development of the 
Active Transportation Master Plan. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$125,000 $125,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  INTERCONNECTED TRAFFIC SIGNAL CONTROLLER 
REPLACEMENT 
PROJECT NUMBER 9024 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Along interconnected arterials citywide 
 
PROJECT DESCRIPTION 
The project will replace the City’s 247 interconnected traffic signal controllers and 
replace / upgrade the City’s current central traffic control system. 
 
PROJECT STATUS 
The project was selected to be funded through the State Highway Safety Improvement 
Program and is anticipated to begin in the Summer of 2020. Currently undergoing the 
RFA process with Caltrans. 
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts associated with the completion of this project. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$1,119,800 $560,000 $0 $559,800 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MEASURE Z PAVEMENT REHABILITATION AND 
PEDESTRIAN FACILITIES IMPROVEMENT PROGRAM 
FY 2018/19 
PROJECT NUMBER 9026 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This program provides the asphalt concrete pavement rehabilitation of arterial and 
minor streets throughout the City.  This program also includes removal and 
reconstruction of non-compliant pedestrian ramps and repair of curbs, gutters, 
driveways, and sidewalks adjacent to the street to provide proper drainage, ADA 
compliance, and better ride quality.  Other improvements will include pedestrian 
improvements including new sidewalk and minor widening when required. 
 
PROJECT STATUS 
This is an ongoing project to complete pavement rehabilitation of arterial and minor 
streets throughout the City. 
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts anticipated with the completion of this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$4,375,000 $4,375,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

420 Measure Z – Capital - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  MEASURE Z PAVEMENT REHABILITATION & 
IMPROVEMENTS 
PROJECT NUMBER 9027 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This program provides the asphalt concrete pavement rehabilitation of arterial and 
minor streets throughout the City.  This program also includes removal and 
reconstruction of non-compliant pedestrian ramps and repair of curbs, gutters, 
driveways, and sidewalks adjacent to the street to provide proper drainage, ADA 
compliance, and better ride quality.  Other improvements will include pedestrian 
improvements including new sidewalk and minor widening when required. 
 
PROJECT STATUS 
This is an ongoing project to complete pavement rehabilitation of arterial and minor 
streets throughout the City. 
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts anticipated with the completion of this project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $7,875,000 $18,875,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

420 Measure Z – Capital $4,375,000 $4,375,000 $4,375,000 $2,875,000 $2,875,000 $18,875,000 

 TOTAL $4,375,000 $4,375,000 $4,375,000 $2,875,000 $2,875,000 $18,875,000 
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  SB-1 PAVEMENT REHABILITATION, MAINTENANCE, 
AND SAFETY IMPROVEMENTS PROGRAM  
FY 2018/19 
PROJECT NUMBER 9028 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This program provides the asphalt concrete pavement rehabilitation of arterial and 
minor streets throughout the City.  This program also includes removal and 
reconstruction of non-compliant pedestrian ramps and repair of curbs, gutters, 
driveways, and sidewalks adjacent to the street to provide proper drainage, ADA 
compliance, and better ride quality.  Other improvements will include traffic safety 
improvements including HAWK signal pedestrian signals, crosswalk improvements, and 
new traffic signal installations. 
 
PROJECT STATUS 
This is an ongoing project to provide pavement rehabilitation for arterial and minor 
streets throughout the City. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project and there are no anticipated operating budget impacts. 
 
  
  
  

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $5,509,763 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  SB-1 PAVEMENT REHABILITATION, MAINTENANCE, 
AND SAFETY IMPROVEMENTS PROGRAM  
PROJECT NUMBER 9029 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This program provides the asphalt concrete pavement rehabilitation of arterial and 
minor streets throughout the City.  This program also includes removal and 
reconstruction of non-compliant pedestrian ramps and repair of curbs, gutters, 
driveways, and sidewalks adjacent to the street to provide proper drainage, ADA 
compliance, and better ride quality.  Other improvements will include traffic safety 
improvements including HAWK signal pedestrian signals, crosswalk improvements, and 
new traffic signal installations. 
 
PROJECT STATUS 
This is an ongoing project to provide pavement rehabilitation for arterial and minor 
streets throughout the City. 
 
OPERATING BUDGET IMPACT 
This is an ongoing project and there are no anticipated operating budget impacts. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $5,393,516 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  ADAIR SIDEWALK-JO JO RANDOLPH 
PROJECT NUMBER 9082 COUNCIL WARD 7 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Adair Avenue  
 
PROJECT DESCRIPTION 
The Adair Avenue Sidewalk Improvements project proposes to construct new concrete 
sidewalks on one side of Adair Avenue from Jo Jo Way to Randolph Street in the 
Arlanza neighborhood of the City of Riverside (see Exhibit A). Adair Avenue has existing 
concrete curbs and gutters but is missing sidewalks. The project includes the 
reconstruction of residential driveways that do not meet current City and ADA 
(Americans with Disabilities Act) standards. The proposed project is necessary to 
provide a safe pedestrian walkway from this residential neighborhood to schools and 
key destinations such as parks and retail centers. Construction of the sidewalk will 
eliminate the need for pedestrians to walk in the street or parkway and will improve 
their safety. 
 
PROJECT STATUS 
The project is currently partially funded by RCTC under SB 821 Bicycle and Pedestrian 
grants. The project is currently in the design phase. 
 
OPERATING BUDGET IMPACT 
Operating impacts will be included as part of O&M Street Maintenance. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$300,000 $225,000 $75,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $75,000 - - - - $75,000 

 TOTAL $75,000 $0 $0 $0 $0 $75,000 
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  BONITA SIDEWALK-TYLER PENDLETON 
PROJECT NUMBER 9083 COUNCIL WARD 6 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Bonita Sidewalk-Tyler/Pendleton 
 
PROJECT DESCRIPTION 
The Bonita Avenue Sidewalk Improvements project proposes to construct new 
concrete sidewalks on one side of Bonita Avenue from Tyler Street to Pendleton Street 
in the La Sierra neighborhood of the City of Riverside (see Exhibit A). Bonita Avenue has 
existing concrete curbs and gutters but is missing sidewalks. The project includes the 
reconstruction of residential driveways that do not meet current City and ADA 
(Americans with Disabilities Act) standards. 
 
PROJECT STATUS 
Project is partially funded by SB 821 and the other half is Local match. 
 
OPERATING BUDGET IMPACT 
Operating impacts will be included as part of O&M Street Maintenance. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$420,000 $285,000 $135,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $135,000 - - - - $135,000 

 TOTAL $135,000 $0 $0 $0 $0 $135,000 
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  LARCHWOOD PLACE RECONSTRUCTION - 
BROCKTON AVE TO END OF STREET 
PROJECT NUMBER 9084 COUNCIL WARD 1 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Larchwood-Brockton Ave. to end of Larchwood Pl. 
 
PROJECT DESCRIPTION 
Project to repair 1290' of concrete on Larchwood to Westerly Brockton Avenue to 
remove existing concrete pavement, remove invasive trees, reconstruct concrete 
driveways, curb & gutters, pedestrian ramp and construct storm drain improvements. 
 
PROJECT STATUS 
The project was approved and fully funded on May 19, 2020 and is currently in the 
design phase. 
 
OPERATING BUDGET IMPACT 
No operating impacts expected once project is completed. 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$700,000 $700,000 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
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  LOCAL ROADWAY SAFETY IMPROVEMENT PLAN 
PROJECT NUMBER 9088 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Development of a Local Roadway Safety Plan to identify transportation safety 
countermeasures along Riverside roadways. 
 
PROJECT STATUS 
The application for grant funds for the LRSP were approved at the 11/5/2019 City 
Council meeting; the City received news that it had been selected for grant award, 
and Traffic Engineering has submitted the Request for Allocation Paperwork. 
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts associated with the development of the 
Active Transportation Master Plan. 
 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$128,000 $28,000 $100,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $100,000 - - - - $100,000 

 TOTAL $100,000 $0 $0 $0 $0 $100,000 

 

295



 

 

PUBLIC WORKS – TRANSPORTATION 
Capital Improvement Program FY 2020/21 - 2024/25 
 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

 

   

 

  BERRY RD WIDENING - SELINA STREET TO  
BUSH AVE 
PROJECT NUMBER 9138 COUNCIL WARD 4 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Berry Rd between Selina St & Bush Ave 
 
PROJECT DESCRIPTION 
Berry Road is a 2-lane minor street and is 34-feet wide except between Selina St. and 
Bush Ave. This project proposed to widen the section between Selina and Bush from 20-
feet to 34-feet to match the rest of the road. It includes new sidewalk construction on 
the south side of the street. 
 
PROJECT STATUS 
The project has not started yet. 
 
OPERATING BUDGET IMPACT 
No operational impacts to the budget since maintenance of the road will be handled 
through the O&M budget. 
 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$800,000 $0 $800,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax - $800,000 - - - $800,000 

 TOTAL $0 $800,000 $0 $0 $0 $800,000 
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  VICTORIA AT WASHINGTON SOUTHBOUND  
MERGE LANE 
PROJECT NUMBER 9142 COUNCIL WARD 3, 4 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Southwest Corner of Victoria Ave. at Washington St. 
 
PROJECT DESCRIPTION 
Project to install a merge lane for southbound Victoria at Washington along with 
striping improvements at the intersection. 
 
PROJECT STATUS 
The project was identified by the Transportation Committee at the 4/11/19 meeting as 
a tool to mitigate congestion issues at the intersection of Victoria Avenue at 
Washington Street. 
 
OPERATING BUDGET IMPACT 
There are no operating budget impacts associated with the completion of this project. 
 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$55,000 $0 $55,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $55,000 - - - - $55,000 

 TOTAL $55,000 $0 $0 $0 $0 $55,000 
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  SIDEWALK FRONTING PATRICIA BEATTY 
PROJECT NUMBER 9143 COUNCIL WARD 1 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Southerly frontage of Patricia Beatty Elementary School 
 
PROJECT DESCRIPTION 
Project will install an approximately 210-foot section of sidewalk and small retaining wail 
to provide a walkway for parents & students near Patricia Beatty Elementary School. 
The project would additionally install a rectangular rapid flashing beacon lighted 
pedestrian sign that connects to Patricia Beatty's Easterly walkway. 
 
PROJECT STATUS 
The project is currently being designed internally and will be done as part of a larger 
sidewalk project. 
 
OPERATING BUDGET IMPACT 
Once the project is completed there will be ongoing maintenance costs to installed 
components which will be included in the O&M budget once the project is complete. 
 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$125,000 $0 $125,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $125,000 - - - - $125,000 

 TOTAL $125,000 $0 $0 $0 $0 $125,000 
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  ACTIVE TRANSPORTATION PROGRAM CYCLE V 
PROJECT NUMBER 9144 COUNCIL WARD 6, 7 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Misc. Locations  
 
PROJECT DESCRIPTION 
This project will complete improvements in the neighborhoods surrounding the 'Five 
Points' intersection. Anticipated project components include the installation of new 
sidewalk segments, bicycle lane enhancements, high visibility, and diagonal 
crosswalks, and trail improvements along the Arlington Channel. 
 
PROJECT STATUS 
Project will be submitted for grant award in June of 2020 and is under active 
development. 
 
OPERATING BUDGET IMPACT 
Once the project is completed there will be ongoing maintenance costs to install 
components that have yet to be identified. 
 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$5,000,000 $0 $5,000,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

430* Capital Outlay - $5,000,000 - - - $5,000,000 

 TOTAL $0 $5,000,000 $0 $0 $0 $5,000,000 

*Appropriation of funds contingent on grant award.  For planning purposes only.  Not included in in other areas of the CIP. 
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  TRAFFIC SIGNAL EMERGENCY VEHICLE 
REPLACEMENT 
PROJECT NUMBER 9146 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The City's Traffic Signal Maintenance Shop repairs and maintains 'Opticom' emergency 
vehicle preemption devices at traffic signals, these devices allow both Fire and 
Ambulance vehicles to receive a green light in their direction of travel. This project 
would create a budget for the replacement of such devices as they reach the end of 
their useful service life. 
 
PROJECT STATUS 
The project would fund ongoing replacement of failing Opticom preemption units.  
 
OPERATING BUDGET IMPACT 
If funded, this would be an ongoing project with no impact on the operating budget. 
 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☐ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $0 $50,000 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

432 Measure A $10,000 $10,000 $10,000 $10,000 $10,000 $50,000 

 TOTAL $10,000 $10,000 $10,000 $10,000 $10,000 $50,000 

 

300



 

 

PUBLIC WORKS – TRANSPORTATION 
Capital Improvement Program FY 2020/21 - 2024/25 
 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

 

   

 

  RMRA TRAFFIC IMPROVEMENTS FY2020/21 
PROJECT NUMBER 9150 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Road Maintenance and Rehabilitation - The use of RMRA local streets and road funds is 
similar but, not identical, to HUTA use rules. Pursuant to Streets and Highways Code 
Section 2030, RMRA local streets and roads allocations must be used for projects “that 
include, but are not limited to,” the following: (1) road maintenance and rehabilitation; 
(2) safety projects; (3) railroad grade separations; (4) traffic control devices; (5) 
complete street components, “including active transportation purposes, pedestrian 
and bicycle safety projects, transit facilities, and drainage and storm-water capture 
projects in conjunction with any other allowable project.”  
 
PROJECT STATUS 
These are annual projects funded by gas tax dollars and will be done throughout the 
year. The various projects are defined in the project description and will go to the 
Council as needed. 
 
OPERATING BUDGET IMPACT 
No operating impacts for these projects as they are maintained by annual Gas Tax 
funding. 
 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$6,196,792 $0 $6,196,792 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $6,196,792 - - - - $6,196,792 

 TOTAL $6,196,792 $0 $0 $0 $0 $6,196,792 
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  RMRA REHAB & TRAFFIC IMPROVEMENTS  
PROJECT NUMBER 9151 COUNCIL WARD All Wards 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Road Maintenance and Rehabilitation - The use of RMRA local streets and road funds is 
similar but, not identical, to HUTA use rules. Pursuant to Streets and Highways Code 
Section 2030, RMRA local streets and roads allocations must be used for projects “that 
include, but are not limited to,” the following: (1) road maintenance and rehabilitation; 
(2) safety projects; (3) railroad grade separations; (4) traffic control devices; (5) 
complete street components, “including active transportation purposes, pedestrian 
and bicycle safety projects, transit facilities, and drainage and storm-water capture 
projects in conjunction with any other allowable project.” 
 
PROJECT STATUS 
These are annual projects funded by gas tax dollars and will be done throughout the 
year. The various projects are defined in the project description and will go to the 
Council as needed. 
 
OPERATING BUDGET IMPACT 
No operating impacts for these projects as they are maintained by annual Gas Tax 
funding. 
 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☒ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

Ongoing $0 $24,000,000 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax - $6,000,000 $6,000,000 $6,000,000 $6,000,000 $24,000,000 

 TOTAL $0 $6,000,000 $6,000,000 $6,000,000 $6,000,000 $24,000,000 
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  KNOEFLER STREET IMPROVEMENTS 
PROJECT NUMBER 9155 COUNCIL WARD 7 
PROJECT CATEGORY Transportation 
PROJECT LOCATION Knoefler Drive from Ambs Drive to End of Street 
 
PROJECT DESCRIPTION 
The project will install 1800 linear foot of new curb and gutter both sides and one side 
sidewalk on Knoefler Drive from Ambs Drive to End of Street in La Sierra neighborhood - 
ward 7. The project will alleviate flooding damages to the property in any rain event. 
The project anticipates starting in Fall 2020 and is completed by Spring 2021.  The 
project will install 1800 linear foot of new curb and gutter both sides and one side 
sidewalk on Knoefler Drive from Ambs Drive to End of Street in La Sierra neighborhood. 
 
PROJECT STATUS 
This project has not started yet. 
 
OPERATING BUDGET IMPACT 
Operating impacts will be included as part of O&M Street Maintenance. 
 
 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☐ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding Five Year Plan REMAINING NEEDED 

$560,000 $0 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

230 Gas Tax $560,000 - - - - $560,000 

 TOTAL $560,000 $0 $0 $0 $0 $560,000 
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      Capital Improvement Program 

Project Category Overview:  Water 

 

 

Introduction  
The Public Utilities Department is responsible for providing water service to 
customers with a service area population of approximately 327,000, 
encompassing 74 square miles.    
  
Water service is provided to 65,800 metered customers.  The Department 
maintains its own distribution system, which contains approximately 1,000 
miles of pipeline ranging from 2 inches to 72 inches in diameter, 56 domestic 
wells, 16 active reservoirs, with a capacity of 109 million gallons (equivalent 
to an emergency supply of 3 days), and 14 miles of canals in Riverside.  The 
Department is responsible for providing adequate water supplies to its 
customers at the lowest possible cost.  This includes assuring continued access 
to water resources while maintaining a high quality water supply and a 
reliable water distribution system.  The Department is committed to keeping 
Riverside “water independent” and free of reliance on imported water 
supplies while ensuring improved reliability.  

One-Year Budget and Five-Year Plan 

The five-year Capital Improvement Program (CIP) for the water system of 
$140,707,755 is required to implement the ten-year water infrastructure plan, 
which includes maintaining the most vital infrastructure. 
  
This CIP is supported by the Water Utility’s proposed rate plan and addresses 
the need to replace and refurbish the most vital portions of Riverside’s aging 
water infrastructure from FY 2020/21 through FY 2024/25. It includes funding to 
replace existing leaking and/or undersized mains, refurbish wells and booster 
stations, expand the use of recycled water, and participate in enhanced 
recharge of the Seven Oaks Dam Conservation Project.  Additional funding 
is also allocated for the implementation of various technology, security and 
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system automation tools, and applications to improve cybersecurity and 
overall efficiency. 
 
Project Type: 
Distribution Facilities – Water distribution and distribution network edge 
equipment to deliver and meter water throughout system. 
 
Distribution Pipelines – Neighborhood pipelines 6" to 12" diameter for water 
service and firefighting. 
 
Reservoir Projects – System storage for emergency, operational and system 
efficiency improvements. 
 
System Automation – Technology, security and system automation tools and 
applications to improve cyber security and overall efficiency. 
 
Transmission Pipelines – Arterial pipelines 16" to 72" diameter for water supply 
from San Bernardino and Riverside basins and in system transmission. 
 
Water Supply – Projects to increase water supply through direct supplement 
and augmentation of groundwater basins. 
 
Well Projects – Water supply wells in Riverside and San Bernardino 
groundwater basins. 
 
Key Revenues and Funding Sources 

The five-year Water CIP will be supported by various funding sources.   The 
majority of the CIP, $111.7 million will be funded by bond proceeds.   
Approximately $24.0 million will be funded from rates and reserves, and $5 
million will be funded from contributions in aid of construction.   
 
 

Fund Funding Source Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

520 Water Fund $30,616,405 $21,501,562 $29,089,738 $29,930,773 $28,692,773 $139,831,294 

  TOTAL $30,616,405 $21,501,562 $29,089,738 $29,930,773 $29,569,277 $140,707,755 
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Projects by Type of Improvement 
 

Project Type/Project Name Adopted 
2020/21 

Proposed 
2021/22 

Proposed 
2022/23 

Proposed 
2023/24 

Proposed 
2024/25 Total 

Distribution Facilities       

Meters $895,173  $920,686  $946,925  $973,913 $1,001,669  $4,738,366  

Pump Station Replacements - - - - - $0 

    Total Distribution Facilities $895,173 $920,686 $946,925 $973,913 $1,001,669 $4,738,366 

Distribution Pipelines       
Distribution System Facilities 
Replacements $2,599,532  $2,652,243  $2,706,457  $2,012,216 $2,012,216   $11,982,664  

Hydrant Check Valves 97,916  100,707  103,577  106,529 106,529   $515,258  

Main Replacements Program 3,900,782  4,579,715  5,943,769  9,130,432 10,342,235   $33,896,933  

System Expansion 1,734,262  1,783,689  1,834,524  1,886,808 1,625,678   $8,864,961  

Water Stock 10,880  11,190  11,509  11,837 11,837   $57,253  

    Total Distribution Pipelines $8,343,372  $9,127,544  $10,599,836  $13,147,822 $14,098,495   $55,317,069  

System Automation       
Advanced Metering 
Infrastructure $2,349,830  $1,979,475  $1,420,388  $2,069,565 $626,043   $8,445,301  

Distribution 
Automation/Reliability 604,242  161,120  591,828  620,869 513,356   $2,491,415  

Land Mobile Radio - 322,240  - - -  $322,240  

Mobile Applications - - 503,054  - -  $503,054  

Network Communication 
System 223,793  230,171  710,194  - -  $1,164,158  

Operational Technology 
Governance 125,325  128,896  231,998  238,609 245,409   $970,237  

SCADA Upgrade & System 
Automation 671,380  920,686  946,925  730,435 1,502,504   $4,771,930  

Work, Asset, & Inventory 
Management System - - 603,665  365,217 751,252   $1,720,134  

    Total System Automation $3,974,570  $3,742,588  $5,008,052  $4,024,695 $3,638,564   $20,388,469  

Transmission Pipelines       

Transmission Mains $10,353,799  $6,214,629  $6,320,727  $9,836,519 $5,884,807  $38,610,481 

    Total Transmission Pipelines $10,353,799  $6,214,629  $6,320,727  $9,836,519 $5,884,807  $38,610,481  

Water Supply       

Recycled Water Projects - - - - - $0 
Seven Oaks Dam Conservation 
Projects 2,797,417 - - - - $2,797,417 

    Total Water Supply $2,797,417 $0 $0 $0 $0 $2,797,417 

Well Projects       

Facility Rehabilitation Program $1,454,657  $920,686  $1,716,302  $1,339,129 $1,815,525   $7,246,299  

Potable/Irrigation Well 
Replacement 2,797,417  575,429  4,497,896  608,695 3,130,217   $11,609,654  

    Total Well Projects $4,252,074  $1,496,115  $6,214,198  $1,947,824 $4,945,742   $18,855,953  

TOTAL $30,616,405  $21,501,562  $29,089,738  $29,930,773 $29,569,277  $140,707,755 
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Top Unfunded Projects by Priority 
Water Utility identified eight capital projects without an identified funding 
source. 
 

Project Name Estimated 
Project Cost 

Unfunded 
Amount 

1. HCP (West) $6,500,000 $6,500,000 

2. Palm Meadows and Garner B Treatment Plant  3,500,000 3,500,000 

3. Seven Oaks Dam Recharge - Active Recharge Program 5,000,000 5,000,000 

4. Additional Well Replacements 6,000,000 6,000,000 

5. JW North Treatment Plant Upgrade 1,000,000 1,000,000 

6. Recycled Water (Jackson St. Phase I - Facilities and Site Conversions) 12,741,343 1,021,240 

7. Victoria Ave Transmission Main 5,000,000 5,000,000 

8. Advanced Metering Infrastructure 16,247,070 6,277,655 

TOTAL $55,988,413 $34,298,895 
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Project Map 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: This map includes all active and new capital improvement projects.   Ongoing and citywide projects are not included on the 
map.   To view additional information and detailed maps, please visit the City’s website at https://riverside.openbook.questica.com.    
 
Distribution by Ward  

 
Ward Five-Year Total  

Ward 1 $- 

Ward 2 -   

Ward 3 - 

Ward 4 -  

Ward 5 - 

Ward 6 -   

Ward 7 -  

All Wards 140,707,755  

 Total $140,707,755 
 

‐

‐

‐

‐

‐

‐

‐

$140.7M

 Ward 1

 Ward 2

 Ward 3

 Ward 4

 Ward 5

 Ward 6

 Ward 7

 All Wards
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  DISTRIBUTION AUTOMATION/RELIABILITY 
PROJECT NUMBER 470655W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Provides for the ongoing design and installation of remote sensing devices and 
remotely controlled equipment on the Riverside water system.  This new technology 
equipment remotely monitors the water system and reports information immediately to 
water control center.  Remotely controlled equipment reduces personnel costs and 
improves response times to system disturbances. 
 
PROJECT STATUS 
Ongoing purchase and installation of equipment for remote monitoring of the water 
production and distribution system. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $0 $2,491,415 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $604,242 $161,120 $591,828 $620,869 $513,356 $2,491,415 

 TOTAL $604,242 $161,120 $591,828 $620,869 $513,356 $2,491,415 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  SYSTEM EXPANSION 
PROJECT NUMBER 470701W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing program that includes design and construction of new water system 
infrastructure (water mains, valves, fire hydrants and services) to serve new residential 
and commercial developments. 
 
PROJECT STATUS 
Ongoing program which designs and constructs new water infrastructure as needed to 
support development within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $37,073,397 $8,864,961 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $1,734,262 $1,783,689 $1,834,524 $1,886,808 $1,625,678 $8,864,961 

 TOTAL $1,734,262 $1,783,689 $1,834,524 $1,886,808 $1,625,678 $8,864,961 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  METERS 
PROJECT NUMBER 470702W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing program that involves replacement of approximately 4,000 small 
meters and replacement or refurbishment of over 80 large meters per year. 
 
PROJECT STATUS 
Ongoing purchase and installation of meter equipment which contributes to fulfilling 
our obligation to serve electric load requirements within the city service area. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $9,943,792 $4,738,366 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $895,173 $920,686 $946,925 $973,913 $1,001,669 $4,738,366 

 TOTAL $895,173 $920,686 $946,925 $973,913 $1,001,669 $4,738,366 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  WATER STOCK 
PROJECT NUMBER 470705W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing program that involves the purchase of outstanding shares of the 
Gage Canal Co. water stock as they become available. 
 
PROJECT STATUS 
Ongoing program to purchase outstanding shares of the Gage Canal Co. water stock 
as they become available. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $1,398,967 $57,253 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $10,880 $11,190 $11,509 $11,837 $11,837 $57,253 

 TOTAL $10,880 $11,190 $11,509 $11,837 $11,837 $57,253 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  DISTRIBUTION SYSTEM FACILITIES REPLACEMENTS 
PROJECT NUMBER 470706W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing program to replace old and inoperable water appurtenances 
including water services, fire hydrants, valves, air valves and other inoperable or 
damaged items. 
 
PROJECT STATUS 
Ongoing replacement of water appurtenances which supports the Department’s Asset 
Management program. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $26,192,884 $11,982,664 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $2,599,532 $2,652,243 $2,706,457 $2,012,216 $2,012,216 $11,982,664 

 TOTAL $2,599,532 $2,652,243 $2,706,457 $2,012,216 $2,012,216 $11,982,664 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  MAIN REPLACEMENTS PROGRAM 
PROJECT NUMBER 470707W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing program that involves the design and construction of various water 
distribution mains to replace high priority leaking and undersized water mains 
throughout the water system. 
 
PROJECT STATUS 
Ongoing replacement of water mains to replace aged and leaking mains. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $111,980,151 $33,896,933 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $3,900,782 $4,579,715 $5,943,769 $9,130,432 $10,342,235 $33,896,933 

 TOTAL $2,801,087 $3,807,860 $5,650,782 $6,329,715 $7,693,769 $26,283,213 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  TRANSMISSION MAINS 
PROJECT NUMBER 470735W COUNCIL WARD 3, 4, 5 and 6 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing program that involves the design and construction of water 
transmission mains to replace Techite pipe, and aged and undersized existing 
transmission mains throughout the water system. 
 
PROJECT STATUS 
Ongoing replacement of water transmission mains to replace Techite pipeline, and 
aged and undersized transmission mains. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $27,493,323 $38,610,481 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $10,353,799 $6,214,629 $6,320,727 $9,836,519 $5,884,807 $38,610,481 

 TOTAL $10,353,799 $6,214,629 $6,320,727 $9,836,519 $5,884,807 $38,610,481 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  PUMP STATION REPLACEMENTS 
PROJECT NUMBER 470802W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing program that involves the design and construction of pump stations 
to replace or rehabilitate existing deficient and aged pump stations throughout the 
water system. 
 
PROJECT STATUS 
Ongoing program to replace or rehabilitate existing pump stations which are deficient 
or aged based on priority. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $11,238,375 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  FACILITY REHABILITATION PROGRAM 
PROJECT NUMBER 470803W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing program that involves the rehabilitation of existing water facilities 
including pumps, motors, wells, reservoirs, canals, facility automation, site security and 
site landscaping. 
 
PROJECT STATUS 
Ongoing rehabilitation/replacement of existing water facilities which support the 
Department's Asset Management program. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $43,689,015 $7,246,299 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $1,454,657 $920,686 $1,716,302 $1,339,129 $1,815,525 $7,246,299 

 TOTAL $1,454,657 $920,686 $1,716,302 $1,339,129 $1,815,525 $7,246,299 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  RECYCLED WATER (JACKSON ST. PHASE I – 
FACILITIES AND SITE CONVERSIONS) 
PROJECT NUMBER 470811W COUNCIL WARD 3, 5, 6 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Various 
 
PROJECT DESCRIPTION 
Provides for the design and construction of necessary facilities to produce and pump 
recycled water at the City's Regional Water Quality Control Plant in addition to the on-
site recycled water infrastructure and retrofit work to convert customers over to 
recycled water use. 
 
PROJECT STATUS 
Pipeline construction is completed. Customer site conversion work is in progress with 
estimated completion in Fall 2021. 
 
 
OPERATING BUDGET IMPACT 
Operational impacts are currently being assessed. 
 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$12,741,343 $11,720,103 $0 $1,021,240 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  SEVEN OAKS DAM CONSERVATION – ENHANCED 
RECHARGE  
PROJECT NUMBER 470813W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Four miles northeast of Redlands, near Mentone 
 
PROJECT DESCRIPTION 
Multi-agency effort which provides for the design and construction of projects to 
capture and divert local storm water for groundwater recharge on property owned or 
controlled by the San Bernardino Valley Water Conservation District to increase 
available groundwater supplies. 
 
PROJECT STATUS 
Phase IA of the Enhanced Recharge Project was completed in the spring of 2018.  
Phase IB of the project is expected to begin construction in early 2021. 
 
OPERATING BUDGET IMPACT 
Annual maintenance costs are being finalized among the partner agencies in a formal 
agreement and will be going to each agency for approval. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$17,271,501 $14,474,084 $2,797,417 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $2,797,417 - - - - $2,797,417 

 TOTAL $2,797,417 $0 $0 $0 $0 $2,797,417 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  AQUIFER STORAGE & RECOVERY SYSTEM 
PROJECT NUMBER 470814W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Interagency project to provide additional water supply through the recharge of water 
in the Bunker Hill Basin. 
 
PROJECT STATUS 
In coordination with outside agencies to reevaluate the project and wait for the 
completion of the Upper Santa Ana Habitat Conservation Plan. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $2,061,487 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 

324



 

 

RIVERSIDE PUBLIC UTILITIES - WATER 
Capital Improvement Program FY 2020/21 - 2024/25 
 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

   

 

  HYDRANT CHECK VALVES 
PROJECT NUMBER 470815W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing program to install check valves on critical fire hydrants at various 
locations throughout the City. 
 
PROJECT STATUS 
Ongoing program to purchase and install fire hydrant check valves as needed at 
critical locations. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $325,982 $515,258 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $97,916 $100,707 $103,577 $106,529 $106,529 $515,258 

 TOTAL $97,916 $100,707 $103,577 $106,529 $106,529 $515,258 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  UPPER SANTA ANA RIVER HABITAT 
CONSERVATION PLAN 
PROJECT NUMBER 470819W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Interagency project to mitigate the endangered Santa Ana Sucker along with twelve 
other covered species to allow for construction of water supply projects on a regional 
scale.  This project will also create a mitigation bank to be used by each of the thirteen 
partner agencies. 
 
PROJECT STATUS 
Ongoing coordination with outside agencies to establish a mitigation bank for sensitive 
wildlife habitat to facilitate construction of water supply projects. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☐ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $325,000 $0 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  ENTERPRISE OPERATION DATA MANAGEMENT 
SYSTEM 
PROJECT NUMBER 470822W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Operational Data Management System (ODMS) receives data from water delivery 
and operation systems and data communication, storage, and analysis systems. The 
data will support advanced monitoring and control systems to improve the operational 
efficiency and capability of the water delivery system. 
 
PROJECT STATUS 
Project has been completed.  Ongoing end-user training and maintenance will 
continue to streamline utility operations. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$1,399,528 $1,399,528 $0 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

  - - - - - $0 

 TOTAL $0 $0 $0 $0 $0 $0 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  ADVANCED METERING INFRASTRUCTURE 
PROJECT NUMBER 470823W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Advanced Metering Infrastructure (AMI) and Meter Data Management System to 
integrate AMI data and support customer facing applications and web integration of 
Customer Integration System.  Delivers automated meter reading resulting in more 
efficient consumption management and enhanced customer service. 
 
PROJECT STATUS 
This project is on hold pending completion of Electric’s AMI project. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☒ 
Sustainability and 
Conservation 

☐ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$16,247,070 $1,524,114 $8,445,301 $6,277,655 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $2,349,830 $1,979,475 $1,420,388 $2,069,565 $626,043 $8,445,301 

 TOTAL $2,349,830 $1,979,475 $1,420,388 $2,069,565 $626,043 $8,445,301 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  OPERATIONAL TECHNOLOGY GOVERNANCE 
PROJECT NUMBER 470824W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Operational Technology planning, management, Internal controls, and cyber & 
physical security improvements.  Oversee RPU's operational technology roadmap to 
effective plan and execute technology projects over the next 5-10 years, and to 
continue to strengthen our cyber and physical security programs to ensure the safety 
and security of RPU systems, equipment, facilities, data and people. 
 
PROJECT STATUS 
Equipment and software solutions for cyber and physical security issues identified 
through new biannual assessments. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☐ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $161,331 $970,237 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $125,325 $128,896 $231,998 $238,609 $245,409 $970,237 

 TOTAL $125,325 $128,896 $231,998 $238,609 $245,409 $970,237 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 

329



 

 

RIVERSIDE PUBLIC UTILITIES - WATER 
Capital Improvement Program FY 2020/21 - 2024/25 
 

 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

Click in white space above this text to insert Picture (Insert > Picture) 

Move Picture position with Crop Tool (Picture Tools > Format > Crop) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

   

 

   

 

  WORK, ASSET, & INVENTORY MANAGEMENT 
SYSTEM 
PROJECT NUMBER 470825W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Work, Asset and Inventory  Management System (WIS) is important not only for 
controlling and minimizing stock materials on hand, but it is important for its hand-off of 
materials through the work management system and assigning the cost of materials to 
assets in the asset management system.  The WIS is an integral part of the workflows 
and information needed by the Work Management System and Asset Management 
System. The system supports management of the Utility's field infrastructure assets (e.g. 
pipes, pumps, valves, connections, etc.) and includes field work orders, asset costs and 
utilization. 
 
PROJECT STATUS 
The project scope has been defined. Implementation of upgrade to current WIS to 
begin in October 2022. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$1,720,134 $0 $1,720,134 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund - - $603,665 $365,217 $751,252 $1,720,134 

 TOTAL $0 $0 $603,665 $365,217 $751,252 $1,720,134 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  NETWORK COMMUNICATION SYSTEM 
PROJECT NUMBER 470826W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
The Network Communications Systems Project will upgrade and create redundancies 
in the communication network to improve the communication backbone and improve 
system functionality, efficiency, reliability, and cybersecurity. 
 
PROJECT STATUS 
Estimated completion by Spring 2021. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$2,880,776 $1,716,618 $1,164,158 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $223,793 $230,171 $710,194 - - $1,164,158 

 TOTAL $223,793 $230,171 $710,194 $0 $0 $1,164,158 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  LAND MOBILE RADIO 
PROJECT NUMBER 470827W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
A new Land Mobile Radio (LMR) system is being installed and implemented. LMR is a 
wireless communications system intended for use by terrestrial users in vehicles 
(mobiles) or on foot (portables).  The new system should capitalize on digital 
technology known as frequency division multiple access (FDMA).  The new LMR system 
will supply new antennas to provide citywide coverage, provide a new dispatcher 
console, coexist with the current analog LMR system, be based on FDMA technology, 
support narrow channels, enable trunked modes of operation for both analog and 
digital modulations, have multiple talk groups, and support private calling.  It will also 
be Advanced Encryption and Data Encryption Standard encrypted and be capable 
of Over the Air Programming (OTAP). 
 
PROJECT STATUS 
Phase II to be started in FY 2021/22. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$322,240 $0 $322,240 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund - $322,240 - - - $322,240 

 TOTAL $0 $322,240 $0 $0 $0 $322,240 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  MOBILE APPLICATIONS 
PROJECT NUMBER 470831W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Mobile Apps increase operational efficiency and safety by providing real-time 
information to field personnel when and where they need it; ensure system 
configuration and status is always known by the personnel operating the system; 
reduce the need for paper-based maps, plans, and work orders; reduce the as-built 
record keeping effort; and enable field operation personnel to share real time 
information with system operators and engineers. 
 
PROJECT STATUS 
Implementation of mobile applications to support work orders and asset management 
planned in 2022. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☐ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$503,054 $0 $503,054 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund - - $503,054 - - $503,054 

 TOTAL $0 $0 $503,054 $0 $0 $503,054 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  SCADA UPGRADE & SYSTEM AUTOMATION 
PROJECT NUMBER 470832W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
Provides for the necessary upgrades to the water system which monitors and controls 
operation of the water transmission and distribution 24 hours a day, 365 days a year.  
This includes physical security upgrades required for regulatory compliance as part of 
system improvements.  Also includes hardware and network upgrades as part of 
advanced technology improvements. 
 
PROJECT STATUS 
Upgrade to the current version of Water SCADA system. The project is currently in the 
bidding process and estimated to take three (3) years to complete. 
 
OPERATING BUDGET IMPACT 
The one-year operating budget and five-year plan include ongoing annual 
maintenance costs. 
  
  
  
 

☒ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☒ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☒ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

$5,424,706 $652,776 $4,771,930 $0 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $671,380 $920,686 $946,925 $730,435 $1,502,504 $4,771,930 

 TOTAL $671,380 $920,686 $946,925 $730,435 $1,502,504 $4,771,930 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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  POTABLE/IRRIGATION WELL REPLACEMENT 
PROJECT NUMBER 470833W COUNCIL WARD All Wards 
PROJECT CATEGORY Water Utility 
PROJECT LOCATION Citywide 
 
PROJECT DESCRIPTION 
This is an ongoing program that involves the construction of new and/or replacement 
potable/irrigation well facilities. 
 
PROJECT STATUS 
Ongoing program to design and construct new wells to replace existing aged or under 
producing water supply wells. 
 
OPERATING BUDGET IMPACT 
Not identifiable for ongoing project. 
  
  
  
 

☐ 
Risk to Health, Safety  
and Environment 

☐ 
Regulatory or Mandated 
Requirements 

☒ 
Asset Condition, Annual 
Recurring Costs and 
Asset Longevity 

☒ 
Community Investment 
and Economic Prosperity 

☒ 
Level and Quality  
of Service 

☐ 
Sustainability and 
Conservation 

☒ Funding Availability 

☐ Project Readiness 

☒ 
Multiple Category  
Benefit and Bundling 
Opportunities 
 

PRIORITIZATION 
CATEGORIES 

NEW OR EXISTING 
☒ New Infrastructure / Facility  

☐ 
Existing Infrastructure / 
Facility 

PROJECT FUNDING OVERVIEW 
Total Project Cost Prior Years Funding * Five Year Plan REMAINING NEEDED 

Ongoing $3,018,659 $11,609,654 Ongoing 

 

1-YEAR BUDGET AND 5-YEAR PLAN 

Fund Funding Source 2020/21 2021/22 2022/23 2023/24 2024/25 TOTAL 

520 Water Fund $2,797,417 $575,429 $4,497,896 $608,695 $3,130,217 $11,609,654 

 TOTAL $2,797,417 $575,429 $4,497,896 $608,695 $3,130,217 $11,609,654 
 

* Prior Years Funding includes appropriations and adjustments to appropriations through June 2020. 
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PRIORITY 
ORDER PROJECTS BY CATEGORY

TOTAL ESTIMATED 
PROJECT COST

UNFUNDED 
AMOUNT

Airport
1 AIRPORT FACILITIES TERMINAL PATIO DECK $150,000 $16,726 
2 UPGRADE TERMINAL RESTROOMS ADA 66,600 66,600
3 AIRPORT - TAXIWAY J REHAB 1,665,000 1,582,500
4 AIRPORT RUNWAY 16/34 REHABILITATION 795,000 751,275

Total $2,676,600 $2,417,101

Municipal Buildings and Facilities
1 MAGNOLIA STATION ROOF REPAIR $100,000 $100,000 
2 ARLANZA LIBRARY ROOF REPAIR 20,000 20,000
3 FOX ROOF REPAIRS 75,000 75,000
4 RIVERSIDE MUNICIPAL AUDITORIUM ROOF 50,000 50,000
5 ORANGE STATION MECHANICAL ROOM REPAIRS 20,000 20,000
6 MAGNOLIA SHOPPING CENTER - ROOF 200,000 200,000
7 FIRE STATION 2 ROOF REPLACEMENT 350,000 350,000
8 MARCY HVAC REPLACEMENT 150,000 150,000
9 ORANGE STATION BASEMENT ELEVATOR 100,000 100,000
10 CITYWIDE ADA FACILITY IMPROVEMENTS - IDENTIFIED CITYWIDE 100,000 100,000
11 RMA ADA ELEVATOR 100,000 100,000
12 SECURITY SYSTEMS - ALL 100,000 100,000
13 MAGNOLIA STN SECURITY CAMERA'S 40,000 40,000
14 FIRE STATION 9 - SECURITY FENCING 40,000 40,000
15 FOX THEATER CARPET REPLACEMENT 350,000 350,000
16 RIVERSIDE MUNICIPAL AUDITORIUM HVAC 125,000 125,000
17 CONVENTION CENTER COOLING TOWER REPLACEMENT 57,000 57,000
18  LINCOLN SEC IMPROVEMENTS CAMERAS & CARD READERS 35,000 35,000
19 CITY HALL - INSTALL FIRE SUPPRESSION SYSTEM IN BASEMENT (IT SYSTEM) 250,000 250,000
20 CORP YARD EV CHARGERS 41,000 41,000
21 FOX PILLAR CRACKS 25,000 25,000
22 FIRE STATION 10 - SECURITY FENCING 40,000 40,000
23 POLICE DEPARTMENT AVIATION FUEL TANK REPLACEMENT 220,000 220,000
24 POLICE DEPARTMENT MAGNOLIA SPRINKLER LINE REMOVAL AND SECURITY IMPROVEMENTS 40,000 40,000
25 METRO MUSEUM EXPANSION AND REHABILITATION 22,053,000 8,253,780
26 EASTSIDE LIBRARY 15,000,000 15,000,000
27 FIRE STATION 4, 7, 8 - TRANSFER SWITCH REPLACEMENT 141,000 141,000
28 CORPORATION YARD PARKING LOT REPAVING - PHASE III 1,200,000 1,200,000
29 MAGNOLIA STN SLURRY EMP PARKING 75,000 25,000
30 LINCOLN ABOVE GROUND GAS TANK 200,000 200,000
31 CONVENTION CENTER CARPET REPLACEMENT 350,000 350,000
32 MAGNOLIA SHOPPING CENTER - PARKING LOT REHAB 800,000 800,000
33 MUNI AUDITORIUM - CARPET REPLACEMENT & WOOD FLOOR REPAIR 150,000 150,000
34 MAGNOLIA STATION REMEDIAL WORK 25,000 25,000
35 LINCOLN PARKING LOT 400,000 400,000
36 FIRE STATION 11, 12, 13 - APPARATUS DOOR REPLACEMENT 80,472 80,472
37 FIRE STATION 10 APPARATUS BAY EXPANSION 75,000 75,000
38 RIVERSIDE MUNICIPAL AUDITORIUM RIGGING/STAGE SAFETY 100,000 100,000
39 MAG & LINC STATION FLOORING 180,000 180,000
40 CONVENTION CENTER INTERNET TECHNOLOGY 100,000 100,000
41 MAGNOLIA SHOPPING CENTER - COMMON AREA REPAIRS 50,000 50,000
42 MAGNOLIA SHOPPING CENTER - UNDERGROUND WATER LINE REPLACEMENT 100,000 100,000
43 RIVERSIDE MUNICIPAL AUDITORIUM STAGE LIFT 100,000 100,000
44 HARADA HOUSE - ROBINSON HOUSE REHAB 450,028 450,028
45 HARADA HOUSE RESTORATION AND HISTORIC PRESERVATION 4,320,000 4,320,000
46 FIRE STATION 2 - BATTALION OFFICE & BATH REMODEL 40,000 40,000
47 RIVERSIDE MUNICIPAL AUDITORIUM ELECTRICAL UPGRADE 200,000 200,000
48 FIRE STATION 12 CARPET/FLOORING 25,000 25,000
49 FIRE STATION 10 - BATH, KITCHEN & REC ROOM REMODEL 125,000 125,000
50 FIRE STATION 12 - KITCHEN REMODEL 20,000 20,000
51 FIRE STATION 9 KITCHEN REMODEL, CARPET AND PAINT 100,000 100,000
52 MUNICIPAL AUDITORIUM - NEW ELECTRONIC SIGN 50,000 50,000
53 FIRE EOC DATA CTR SPRINKLER REMOVAL/SEC IMPR 480,000 480,000
54 FIRE STATION 3 METAL PARKING STRUCTURE/COVER 178,000 178,000
55 LINCOLN STATION - PARKING COVER 40,000 40,000
56 MAGNOLIA STN PERIMETER WALL EXT $50,000 $50,000 
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PRIORITY 
ORDER PROJECTS BY CATEGORY

TOTAL ESTIMATED 
PROJECT COST

UNFUNDED 
AMOUNT

Capital Improvement Program
Unfunded Needs Projects Summary

Municipal Buildings and Facilities (continued)
57 MAGNOLIA STN ALUMINIUM COVER FOR VEHICLES $25,000 $25,000 
58 CASA BLANCA LIBRARY CARPET 50,000 50,000
59 CONVENTION CENTER ANNEX/EXPANSION/EVENTS CENTER 80,000,000 80,000,000
60 HERITAGE HOUSE RENOVATION 960,000 960,000
61 MUNI AUDITORIUM - ELEVATOR/LIFT FOR ADA ACCESS TO THIRD FLOOR 300,000 300,000
62 RUMSEY 2 - FIRE PANEL, HVAC, COMPACT SHELVING, SPRINKLER RETROFIT 510,000 510,000
63 RUMSEY 1 - HVAC SYSTEM UPGRADE AND SPRINKLER RETROFIT 225,000 225,000
64 CONVENTION CENTER PLAZA LIGHTING 50,000 50,000
65 METRO MUSEUM SOROPTOMIST STONES RELOCATION 50,000 50,000
66 MUSEUM STORAGE COLLECTION FACILITY 16,000,000 16,000,000
67 RIVERSIDE MUNICIPAL AUDITORIUM REFURBISHMENT 265,000 265,000
68 DOWNTOWN PARKING GARAGE 15,000,000 15,000,000

Total $163,320,500 $149,471,280

Innovation and Technology
1 DATACENTER/DISASTER RECOVERY CAPITAL IMPROVEMENTS $3,099,479 $189,983 
2 WORK-ORDER/ASSET MANAGEMENT SYSTEM MAJOR UPGRADE 3,234,900 3,234,900
3 DATA NETWORK REPLACEMENT 4,291,735 1,319,481
4 VOICE OVER IP (VOIP) TELECOMMUNICATIONS SYSTEM UPGRADES 965,000 965,000
5 VOICE OVER IP (VOIP) TELECOMMUNICATIONS SYSTEM - FULL REPLACEMENT 2,400,000 2,400,000
6 ENTERPRISE RESOURCE PLANNING SYSTEM REPLACEMENT 18,000,000 18,000,000

Total $31,991,114 $26,109,364

Parks, Recreation, and Community Services
1 BOBBY BONDS PARK ARTIFICIAL TURF REFURBISHMENT $700,000 $414,655 
2 LA SIERRA PARK PLAYGROUND RESURFACE 150,000 150,000
3 BOBBY BONDS PARK - PLAYGROUND AREA LIGHTING IMPROVEMENT 35,000 35,000
4 FAIRMOUNT PARK -LAKE EVANS WATER QUALITY (SOLARBEE) 65,000 65,000
5 WARD 3 ADA IMPROVEMENTS 70,269 70,269
6 CITYWIDE PARKING LOT REHABILITATION 500,000 500,000
7 RIVERWALK GOLDEN/SCHUYLER PLAYGROUND SURFACING 105,321 105,321
8 SYCAMORE HIGHLANDS PARK - PLAYGROUND POURED-IN-PLACE SURFACING REPLACEMENT 35,534 35,534
9 PARK SYSTEM ADA IMPROVEMENTS 45,000,000 45,000,000
10 COLLETT PARK PLAYGROUND EQUIPMENT REPLACEMENT 295,000 295,000
11 DARIO VASQUEZ PARK - PLAYGROUND SURFACING REPLACEMENT 100,000 100,000
12 FAIRMOUNT PARK LAKE DREDGING 400,000 400,000
13 MOUNTAIN VIEW PARK - PLAYGROUND POURED-IN-PLACE SURFACING REPLACEMENT 125,000 125,000
14 RIVERWALK PLAYGROUND SURFACING 105,321 105,321
15 BORDWELL PARK - ADDITIONAL ADA PARKING STALLS 25,000 25,000
16 MOUNT RUBIDOUX PARK - TRAILS AND FIREBREAK REPAIR AND MODIFICATION 108,000 108,000
17 BOBBY BONDS PARKS CESAR CHAVEZ COMMUNITY CENTER RESTROOM RENOVATION 150,000 150,000
18 BORDWELL PARK BASKETBALL REPLACEMENT 165,000 165,000
19 CASTLEVIEW PARK - PLAYGROUND SURFACING REPLACEMENT 100,000 100,000
20 MOUNT RUBIDOUX PARK SHADE STRUCTURES 175,000 175,000
21 FAIRMOUNT PARK LAKE EVANS LAKESHORE ACCESS 950,000 625,000
22 BORDWELL PARK ADA WALKWAY 32,000 32,000
23 DON LORENZI PARK ADA IMPROVEMENTS 80,000 80,000
24 FAIRMOUNT PARK - RENOVATE THE OLD BLDG. FOR BIKE RENTAL 35,000 35,000
25 NICHOLS PARK IMPROVEMENTS 647,500 647,500
26 VILLEGAS PARK - COMMUNITY CENTER AREA ROOF REPLACEMENT. - NEEDED IN YEAR 2020. 210,000 210,000
27 BERGAMONT PARK - REPLACE PLAYGROUND EQUIPMENT AND SURFACE 350,000 350,000
28 BOBBY BONDS PARK - YOUTH OPPORTUNITY CENTER ROOF SKYLIGHT REPAIR 35,500 35,500
29 CITYWIDE WATER CONSERVATION PROJECTS 500,000 500,000
30 COLLETT PARK - SHADE SHELTER WOOD LATTICE ROOF REPLACEMENT - THREE TOTAL 32,000 32,000
31 DON DERR PARK - BASKETBALL COURT RESURFACING 30,000 30,000
32 DON JONES PARK - REMOVE AND REPLACE EXISTING CONCESSION BUILDING 450,000 450,000
33 DON LORENZI PARK RESTROOM 412,000 412,000
34 ISLANDER PARK WADING POOL REPLACEMENT 375,000 375,000
35 LINCOLN PARK BASKETBALL COURT IMPROVEMENTS 25,000 25,000
36 WHITE PARK ADA CONCRETE REPLACEMENT 150,000 150,000
37 ANDULKA PARK WADING POOL 375,000 375,000
38 ARLINGTON HEIGHTS SPORTS PARK WADING POOL FILTRATION SYSTEM 375,000 375,000
39 BRYANT PARK TENNIS COURT LIGHTING $190,000 $190,000
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AMOUNT
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Parks, Recreation, and Community Services (continued)
40 CITYWIDE PARK LAND ACQUISITION $110,000 $110,000
41 CITYWIDE PARK LAND ACQUISITION II 30,000,000 30,000,000
42 CITYWIDE AUTOMATIC DOOR LOCKING SYSTEM 280,000 280,000
43 DOTY TRUST PARK WADING POOL 325,000 325,000
44 FAIRMOUNT PARK SPLASH PAD POOL FILTRATION SYSTEM 325,000 325,000
45 INDIAN HILL ACQUISITION 375,000 375,000
46 ORANGE TERRACE PARK WADING POOL 325,000 325,000
47 PATTERSON PARK MASTER PLAN IMPROVEMENTS 7,200,000 7,200,000
48 BORDWELL PARK - MODERNIZE PARK RESTROOMS (KANSAS SIDE) 150,000 150,000
49 CITYWIDE POOL REFURBISHMENT 1,300,000 1,300,000
50 FAIRMOUNT PARK - SPOILS AREA - INVASIVE SPP. CLEARANCE 75,000 75,000
51 FAIRMOUNT PARK ARMORY CONVERSION 250,000 250,000
52 GOESKE SENOR CENTER PARKING LOT IMPROVEMENTS 50,000 50,000
53 HUNT PARK - POOL FILTER REPLACEMENTS (3 TANKS) 46,500 46,500
54 HUNTER PARK - INSTALLATION OF PLAYGROUND SHADE 75,000 75,000
55 ISLANDER PARK - POOL FILTER TANK REPLACEMENT (3 TANKS) 45,000 45,000
56 RUTLAND PARK - PAR COURSE REPLACEMENT WITH NEW EQUIPMENT 50,000 50,000
57 SHAMEL PARK - POOL FILTER REPLACEMENT(3 TANKS) 46,000 46,000
58 VILLEGAS PARK - WADING POOL 690,000 650,000
59 CASTLEVIEW PARK - DESIGN AND CONSTRUCTION OF PARK. 11,506,000 11,506,000
60 CITYWIDE - TRAILS - GAGE CANAL TRAIL IMPROVEMENTS 13,708,509 10,000,000
61 CITYWIDE COMMUNITY CENTER WI-FI 156,000 156,000
62 DON JONES PARK DECOMPOSED PATH 450LF 50,000 50,000
63 DON JONES PARK DECOMPOSED PATH 650LF 75,000 75,000
64 DON JONES PARK FENCE ADJUSTMENT 84,000 84,000
65 FAIRMOUNT PARK WILDERNESS AREA IMPROVEMENTS 1,500,000 1,500,000
66 HOLE LAKE FUTURE PARK SITE 12,000,000 12,000,000
67 MARTHA MCLEAN DESIGN STUDY 50,000 50,000
68 LOW PARK MASTERPLAN 5,100,000 5,100,000
69 BERGAMONT PARK - PLAYGROUND SHADE SAILS 85,000 85,000
70 BOBBY BONDS PARK - CESAR CHAVEZ ROOF REPLACEMENT 335,000 335,000
71 DON DERR PARK RESTROOM & CONCESSION BUILDING REPLACEMENT 1,100,000 1,100,000
72 FAIRMOUNT PARK - BOATHOUSE DECK REPAIRS 150,000 150,000
73 FAIRMOUNT PARK - GOLF COURSE - ADD 50' NETTING ALONG FREEWAY (2000 LF) 300,000 300,000
74 FAIRMOUNT PARK - GOLF COURSE - NEW 75' NET/POST ALONG FIELD LANE (450 LF) 204,077 204,077
75 FAIRMOUNT PARK - LAKE EVANS SPILLWAY IMPROVEMENTS, EROSION CONTROL 150,000 150,000
76 FAIRMOUNT PARK - ROAD MAINTENANCE ON DEXTER EAST SIDE OF LAKE 225,000 225,000
77 FAIRMOUNT PARK - ROAD MAINTENANCE ON OTHER STREETS 225,000 225,000
78 FAIRMOUNT PARK - STORM DRAIN CLEARING - UNIVERSAL PLAYGROUND PARKING LOT 75,000 75,000
79 FAIRMOUNT PARK GOLF COURSE NET REPLACEMENT 65,000 65,000
80 GOESKE PARK - SENIOR CENTER - REPLACE SKYLIGHT AND REPAIR ROOF 75,000 75,000
81 NICHOLS COMMUNITY CENTER RENOVATION 14,753,460 14,615,460
82 ORANGE TERRACE PARK - COMMUNITY CENTER GYM FLOOR REPAIR AND REFINISH 204,077 204,077
83 TAFT PARK - SHADE STRUCTURE FOR PLAYGROUND 95,000 95,000
84 ARLINGTON PARK SHADE STRUCTURE II 94,000 94,000
85 ARLINGTON PARK SHADE STRUCTURE 115,000 115,000
86 CARLSON PARK IRRIGATION 125,000 125,000
87 COLLETT PARK IMPROVEMENTS 90,000 90,000
88 LA SIERRA PARK EXERCISE STATIONS 125,000 125,000
89 AIRPORT PARK 1,500,000 1,500,000
90 REID PARK BASKETBALL HOOP ADJUSTMENT SYSTEM 25,000 25,000
91 SYCAMORE CANYON WILDERNESS PARK 1,929,000 1,929,000
92 SYCAMORE HIGHLANDS PARK WADING POOL 325,000 325,000
93 VILLEGAS PARK MP PHASE II EXERCISE STATIONS 175,000 175,000
94 FAIRMOUNT PARK - LOCOMOTIVE REPAIRS/PAINTING (SPECIALTY PAINT) 100,000 100,000
95 FAIRMOUNT PARK - REPAIR PLASTER/PAINT OLD RR BUILDING 25,000 25,000
96 FAIRMOUNT PARK SPRING BROOK WASH RENOVATION 975,000 975,000
97 LA SIERRA PARK - LA SIERRA COMMUNITY CENTER HVAC REPLACEMENT 51,500 51,500
98 LA SIERRA PARK - LA SIERRA COMMUNITY CENTER PAINT INTERIOR AND EXTERIOR 36,000 36,000
99 LINCOLN PARK - PLAYGROUND LIGHTING 45,000 45,000
100 ORANGE TERRACE PARK COMMUNITY CENTER FLOOR REPLACEMENT 103,000 103,000
101 REID PARK - COMMUNITY CENTER RENOVATION 850,000 850,000
102 BORDWELL PARK - DESIGN AND CONSTRUCTION OF GYMNASIUM $4,738,000 $4,738,000
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Parks, Recreation, and Community Services (continued)
103 CARLSON PARK ST. FRANCIS FALLS RESTORATION $600,000 $600,000
104 CITYWIDE - TRAILS - MWD BOX SPRINGS FEEDER TRAIL IMPROVEMENTS 5,900,000 5,900,000
105 CITYWIDE - TRAILS - SEVEN MILE TRAIL IMPROVEMENTS 19,625,000 19,625,000
106 DON JONES PARK EXERCISE STATIONS 120,000 120,000
107 DON LORENZI PARK EXERCISE PATH 115,000 115,000
108 DOTY TRUST PARK - SLOPE STABILIZATION AT BACK OPEN SPACE TRAIL CONNECTIONS. 60,000 60,000
109 FAIRMOUNT PARK - GOLF COURSE - EXPAND AND RENOVATE CART PATHS 250,000 250,000
110 FAIRMOUNT PARK LANDSCAPE AND TURF CONVERSION 125,000 125,000
111 FAIRMOUNT PARK - NORTH HILL (CURB AND GUTTER, SIDEWALK, TRAIL, PICNIC TABLE) 750,000 750,000
112 ISLANDER PARK IMPROVEMENTS 3,500,000 3,500,000
113 SWANSON PARK - SMALL PLAYGROUND FEATURES 250,000 250,000
114 FAIRMOUNT PARK - LAWN BOWLING BUILDING REPLACEMENT AND SITE IMPROVEMENTS 650,000 650,000
115 FAIRMOUNT PARK - REPAIR RUN OFF CATCH BASIN/WATER RETENTION AREA 300,000 300,000
116 HUNT PARK - PAINT COMMUNITY CENTER INTERIOR 25,000 25,000
117 HUNT PARK - REPLACE ONE PARTITION USED TO ACCOMMODATE RENTALS AND CLASSES 30,000 30,000
118 LINCOLN PARK - SECURITY CAMERAS 75,000 75,000
119 MARTHA MCLEAN PARK - REMOVE AND REPLACE EXISTING RESTROOM 575,000 575,000
120 ORANGE TERRACE PARK PARTITION 30,000 30,000
121 SHAMEL PARK SHAMEL POOL BUILDING 1,250,000 1,250,000
122 SHAMEL PARK WADING POOL REPLACEMENT 425,000 425,000
123 TAFT PARK - REPLACEMENT OF EXISTING PLAYGROUND EQUIPMENT 500,000 500,000
124 ANDULKA PARK - DRAINAGE AND LANDSCAPING IMPROVEMENTS AROUND TENNIS COURTS 100,000 100,000
125 BOBBY BONDS PARK - CESAR CHAVEZ AUDITORIUM - ACOUSTICS AND SOUND SYSTEM 103,000 103,000
126 BOBBY BONDS PARK - CESAR CHAVEZ AUDITORIUM - STAGE LIGHTING 77,000 77,000
127 DON LORENZI PARK FITNESS EQUIPMENT 135,000 135,000
128 DON LORENZI PARK PLAYGROUNDS 650,000 650,000
129 FAIRMOUNT PARK - DESIGN AND CONSTRUCT NEW VISITOR CENTER 2500 SF 500,000 500,000
130 FAIRMOUNT PARK COURT PARKING LOT 250,000 250,000
131 FAIRMOUNT PARK HISTORIC CORE PHASE III 2,250,000 2,250,000
132 FAIRMOUNT PARK - GOLF COURSE - PITCH AND PUTT COURSE 950,000 950,000
133 GOESKE SENIOR CENTER IMPROVEMENTS 25,000 25,000
134 GOLDEN STAR PARK 8,880,000 8,880,000
135 HIGHLAND PARK - COMMUNITY CENTER AND SITE IMPROVEMENTS 1,750,000 1,750,000
136 HIGHLAND PARK - PLAYGROUND IMPROVEMENTS 250,000 250,000
137 HIGHLAND PARK - WALKING PATH AROUND PARK WITH AREA LIGHTING 275,000 275,000
138 HOLE LAKE FUTURE PARK SITE - TRAIL HEAD IMPROVEMENTS ON 7.7 AC 850,000 850,000
139 HUNTER PARK IMPROVEMENTS 65,000 65,000
140 LINCOLN PARK FRUIT TREE GROVE GARDEN IMPROVEMENTS 65,000 65,000
141 MISSION RANCH PARK DESIGN AND CONSTRUCTION 13,000,000 13,000,000
142 MOUNT VERNON FUTURE PARK 4,000,000 4,000,000
143 REID PARK CLUBHOUSE IMPROVEMENTS 120,000 120,000
144 REID PARK IMPROVEMENTS 28,125,000 28,125,000
145 RYAN BONAMINIO PARK AT TEQUESQUITE ARROYO  SPLASH PAD 550,000 550,000
146 VILLEGAS PARK MP PHASE II JOGGING PATH 900,000 900,000
147 VILLEGAS PARK - MP PHASE II FIELD IMPROVEMENTS 105,000 105,000
148 FAIRMOUNT PARK - FAIRMOUNT/HISTORIC CORE PHASE II (RESTROOM REPLACEMENT) 700,000 700,000
149 FAIRMOUNT PARK - IZAAK WALTON KITCHEN AND RESTROOM MODERNIZATION 75,000 75,000
150 FAIRMOUNT PARK - LAKE EVANS WEIR BOX REPAIR 115,000 115,000
151 FAIRMOUNT PARK - R&R ROSE GARDEN GAZEBO AND ARCHES 75,000 75,000
152 FAIRMOUNT PARK SECURITY CAMERA SYSTEM 200,000 200,000
153 HUNT PARK - ADD EXTERIOR PAINTING OF COMMUNITY CENTER, POOL BLDG & PARK RESTROOM 75,000 75,000
154 REID PARK - CLUBHOUSE KITCHEN IMPROVEMENTS 85,000 85,000
155 THUNDERSKY PARK - REPLACEMENT OF EXISTING PLAYGROUND EQUIPMENT 500,000 500,000
156 CITYWIDE ACTION SKATE PARKS 6,000,000 6,000,000
157 FAIRMOUNT PARK - DEXTER PARKING LOT(NW OF LAKE EVANS) & LIGHTS W/120 SPACES 504,000 504,000
158 FAIRMOUNT PARK - FAIRMOUNT PARK BANKS INTERSECTION/PEDESTRIAN ACCESS 350,000 350,000
159 FAIRMOUNT PARK HISTORICE CORE PHASE I 1,250,000 1,250,000
160 FAIRMOUNT PARK - KITCHEN UPGRADE AT THE BOATHOUSE 65,000 65,000
161 FAIRMOUNT PARK - MARKET STREET FRONTAGE IMPROVEMENT - ENHANCE ENTRY AT REDWOOD. 65,000 65,000
162 FAIRMOUNT PARK PEDESTRIAN SIDEWALK 60,000 60,000
163 GOESKE SENIOR CENTER EXERCISE ROOM REPLACEMENT 30,000 30,000
164 LA SIERRA PARK COMMUNITY CENTER IMPROVEMENTS 90,000 90,000
165 MARTHA MCLEAN PARK - VARIOUS IMPROVEMENTS THROUGHOUT PARK $2,250,000 $2,250,000
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Parks, Recreation, and Community Services (continued)
166 MOUNT RUBIDOUX PARK - SAN ANDREAS AVE. STREETSCAPE AND DRAINAGE IMPROVEMENTS $175,000 $175,000
167 MOUNT VERNON OPEN SPACE - TRAIL IMPROVEMENTS INCLUDING IMPROVEMENTS ON PARK SITE 1,700,000 1,700,000
168 RYAN BONAMINIO PARK AT TEQUESQUITE ARROYO SIGNAGE 125,000 125,000
169 SWANSON PARK IMPROVEMENTS 100,000 100,000
170 VILLEGAS PARK - MP PHASE II 85,000 85,000
171 VILLEGAS PARK - MP PHASE II - SYNTHETIC SOCCER FIELD TO REPLACE EXISTING FIELD 1,500,000 1,500,000
172 MOUNTAIN VIEW PARK CAMERA SYSTEM 30,000 30,000
173 ARLANZA COMMUNITY GARDEN IMPROVEMENTS 120,000 120,000
174 CHALLEN PARK IMPROVEMENTS 1,875,000 1,875,000
175 FAIRMOUNT PARK - FUTURE QUARRY AREA IMPROVEMENTS 1,500,000 1,500,000
176 FAIRMOUNT PARK DRIVING RANGE IMPROVEMENTS 45,000 45,000
177 FAIRMOUNT PARK - MARKET STREET FRONTAGE IMPROVEMENT - NEW DECORATIVE FENCING 100,000 100,000
178 FAIRMOUNT PARK - SCOUT CAMP RENOVATION (ROPES CHALLENGE COURSE) 220,000 220,000
179 GOESKE PARK - SENIOR CENTER - NEW SENIOR PLAYGROUND AND FITNESS EQUIPMENT 375,000 375,000
180 GOESKE SENIOR CENTER - DESIGN AND CONSTRUCTION TO ADD KITCHEN AC - REVIEW SCOPE 42,000 42,000
181 GOESKE SENIOR CENTER - NEW MARQUEE - LED MOTION SIGN - REVIEW SCOPE 85,000 85,000
182 LA SIERRA PARK - PICNIC SHELTER FENCING AT $200/L.F. BY 400' 80,000 80,000
183 NORTH PARK - STAGE OR AREA TO ALLOW MUSIC, EATING LUNCH, READING, ETC.  WI-FI 100,000 100,000
184 ORANGE TERRACE PARK COMMUNITY CENTER KITCHEN UPGRADES 125,000 125,000
185 TEQUESQUITE OPEN SPACE IMPROVEMENTS 2,750,000 2,750,000
186 TEQUESQUITE OPEN SPACE IMPROVEMENTS II 3,200,000 3,200,000
187 VILLEGAS PARK - MP PHASE II JOGGING PATH 85,000 85,000
188 ARLINGTON HEIGHTS SPORTS PARK 75,000 75,000
189 ARLINGTON PARK - CHALLENGE COURSE - PRO 4000 WITH 40 YARD DASH 410,000 410,000
190 BORDWELL PARK - CHALLENGE COURSE - PRO 4000 WITH 40 YARD DASH 350,000 350,000
191 HUNT PARK FENCING 100,000 100,000
192 NORTH PARK - FENCE ALONG PARKING LOT TO ISOLATE PARK 100,000 100,000

Total $296,149,568 $291,652,714

Electric
1 RIVERSIDE TRANSMISSION RELIABILITY PROJECT (RTRP)* $162,756,354 $58,515,523
2 GIS UPGRADES/INTEGRATIONS, CUSTOMER ENGAGEMENT PORTAL &OTHER SYSTEM AUTOMATION 4,015,000 4,015,000
3 DISTRIBUTION TRANSFORMER LOAD MANAGEMENT SYSTEM 1,000,000 1,000,000
4 NEW HUNTER SUBSTATION 28,000,000 28,000,000
5 ADVANCED METERING INFRASTRUCTURE 27,663,930 12,267,025
6 CABLE REPLACEMENT - ARLINGTON AND ARLANZA 12,000,000 12,000,000
7 REMOTE MONITORING OF SUBSTATION TRANSFORMERS AND 69KV EQUIPMENT 8,000,000 8,000,000

Total $243,435,284 $123,797,548

Water
1 HCP (WEST) $6,500,000 $6,500,000
2 PALM MEADOWS AND GARNER B TREATMENT PLANT 3,500,000 3,500,000
3 SEVEN OAKS DAM RECHARGE - ACTIVE RECHARGE PROGRAM 5,000,000 5,000,000
4 ADDITIONAL WELL REPLACEMENTS 6,000,000 6,000,000
5 JW NORTH TREATMENT PLANT UPGRADE 1,000,000 1,000,000
6 RECYCLED WATER (JACKSON ST. PHASE I - FACILITIES AND SITE CONVERSIONS) 12,741,343 1,021,240
7 VICTORIA AVE TRANMISSION MAIN 5,000,000 5,000,000
8 ADVANCED METERING INFRASTRUCTURE 16,247,070 6,277,655

Total $55,988,413 $34,298,895

Public Parking
1 REPLACE GARAGES 1 & 2 $32,000,000 $32,000,000

Total $32,000,000 $32,000,000

Railroad
1 BNSF/THIRD STREET GRADE SEPARATION $55,500,000 $49,449,275
2 PHASE II GRADE SEPARATION PROGRAM (SPRUCE, JACKSON AND/OR MARY) 109,500,000 109,500,000

Total $165,000,000 $158,949,275
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Sewer
1 RWQCP REHABILITATION - PHASE II $500,000 $130,837
2 DEXTER WASTEWATER 1,200,000 1,034,593
3 FAIRGROUNDS WASTEWATER 1,200,000 1,031,396
4 WASTEWATER LIFT STATIONS 2,000,000 1,715,371
5 BIO-SOLIDS HANDLING REHABILITATION 2,840,000 364,010
6 TERTIARY SYSTEM REHAB - PHASE I 4,850,000 3,739,196
7 PLANT II BLOWER NO. II REHABILITATION 1,452,615 405,745
8 POTABLE/RECYCLED WATER SYSTEM PIPELINE REHABILITATION - PHASE II 1,000,000 1,000,000

Total $15,042,615 $9,421,148

Storm Drain
1 NORTH ORANGE ST STORM DRAIN PROJECT $150,000 $150,000
2 CYPRESS AVE STORM DRAIN PROJECT 1,250,000 1,250,000
3 FOURTEENTH ST UNDERPASS PUMP STATION PROJECT 3,200,000 3,200,000

Total $4,600,000 $4,600,000

Transportation
1 ADAMS STREET/STATE ROUTE 91 INTERCHANGE IMPROVEMENTS $72,900,000 $65,700,000
2 VAN BUREN WIDENING, INDIANA TO SOUTH CITY LIMIT 26,640,352 26,640,352
3 TYLER/STATE ROUTE 91 INTERCHANGE IMPROVEMENTS 75,000,000 75,000,000
4 CANYON CREST WIDENING 8,104,673 2,700,000
5 ARLINGTON AVENUE AT CHADBOURNE AVENUE TRAFFIC SIGNAL 325,000 325,000
6 UNIVERSITY AVENUE FIBER OPTIC 450,000 400,000
7 14TH STREET WIDENING, SR 91 TO MARTIN LUTHER KING 24,000,000 24,000,000
8 CITYWIDE STRIPING REMOVAL 70,000 70,000
9 MISCELLANEOUS SIGNAL CABINET REPLACEMENT 225,000 225,000
10 MISCELLANEOUS GUARDRAIL REPAIR 30,000 30,000
11 MISCELLANEOUS SIGNAL REWIRES 80,000 80,000
12 MARKET STREET DIAGONAL CROSSWALKS 30,000 30,000
13 MISSION INN AVE AT MAIN ST PED MALL LED LIGHT STRIP 100,000 100,000
14 NEW HAWK SIGNAL 135,000 135,000
15 VAN BUREN AT VICTORIA SIGNAL POLE REPLACEMENT 100,000 100,000
16 MISCELLANEOUS BRIDGE REPAIR 100,000 100,000
17 ARLINGTON AVENUE WIDENING, ADAMS TO VAN BUREN 1,500,000 1,500,000
18 ARLINGTON AVENUE WIDENING, VICTORIA TO ALESSANDRO 16,600,000 16,600,000
19 CHICAGO MEDIANS - LE CONTE TO MARTIN LUTHER KING 1,800,000 1,800,000
20 EUCALYPTUS AVE AND GEORGIA ST WIDENING IMPROVEMENTS 375,000 375,000
21 IRVING ST WIDENING ACROSS FROM HATHORNE ELEMENTARY 200,000 200,000
22 COLE AVENUE AT KRAMERIA AVENUE TRAFFIC SIGNAL 325,000 325,000
23 HIGH FRICTION SURFACE AND HAWK SIGNALS 1,293,000 1,098,000
24 PEDESTRIAN MALL LIGHTING UPGRADE -10TH ST. TO 5TH ST. 250,000 250,000
25 JACKSON & INDIANA SOUTHBOUND RIGHT TURN LANE 75,000 75,000
26 TRAFFIC SIGNAL POLE REPLACEMENT & RELOCATION 250,000 250,000
27 TRAFFIC SIGNAL REWIRING 80,000 80,000
28 TRAFFIC SIGNAL EQUIPMENT UPDATE 65,000 65,000
29 TRAFFIC SIGNAL REPLACEMENT 250,000 250,000
30 PERGOLA RESTORATION PROJECT AT VARIOUS LOCATIONS 500,000 500,000

Total $231,853,025 $219,003,352

TOTAL UNFUNDED NEEDS $1,242,057,119 $1,051,720,677

*  RTRP funding was approved by RPU Board in August 2020 and is going before City Council in September 2020.
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City of Riverside 
MULTI-YEAR CAPITAL PLANNING FISCAL POLICY 

Approved by the City Council on March 20, 2018 

PURPOSE: 

A Capital Plan (Capital Improvement Program) is a multi-year financial plan that lists and describes 
capital projects a local government plans to undertake, indicates how projects will be funded and 
projects the effect of the plan on key financial variables.  

A Capital Project results in the acquisition or increased value of a capital asset (e.g. land, land 
improvements, infrastructure and equipment, etc.).  

The Government Finance Officers Association (GFOA) recommends that state and local governments 
prepare and adopt comprehensive, fiscally sustainable, multi-year capital plans. A multi-year capital 
plan is intended to identify and prioritize expected capital needs based on strategic priorities and 
operational needs, establish project scope and cost, detail estimated amounts of funding from various 
sources, and project future operating and maintenance costs. 

POLICY: 

The City shall adopt a multi-year Capital Plan spanning at least five years in conjunction with the 
biennial budget and five-year financial planning processes. The Capital Plan should include all of the 
City’s planned capital projects. To qualify as a capital project, the asset or improvement should have: 1) 
monetary value (cost) of at least $20,000; and 2) useful life of at least 10 years. 

The Capital Plan should incorporate the following elements as relevant and appropriate: 

a. Assessment of the physical condition of existing capital assets;

b. Economic development projections, strategic plans, comprehensive plans, facility master plans
and regional plans, including changes in federal, state, and county policy and regulations;

c. Prioritization of capital needs based on established policy; and

d. Financial strategies and sources of funding: 1) for the acquisition or improvements associated
with the project, and 2) for the subsequent annual operation and maintenance costs of the
capital asset throughout its life.
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City of Riverside 
PRIORITIZATION OF CAPITAL IMPROVEMENT PROJECTS 

FISCAL POLICY  

Approved by the City Council on March 20, 2018 

PURPOSE: 

The Government Finance Officers Association (GFOA) recommends that state and local governments 
establish an objective process for prioritizing capital improvement projects, to give decision-makers a 
basis for choosing the most compelling projects for funding and implementation.  

POLICY: 

The City shall adopt an objective process of prioritizing capital improvement projects to ensure 
consistency with the General Plan, and in conjunction with the biennial budget process or 
otherwise as capital funding becomes available, using the following factors: 

1. Risk to Health, Safety and Environment:

a. Avoids or minimizes the risk to health, safety and environment associated with the
infrastructure based on condition assessment of the asset, or the lack of an asset, that
may include the age, size, material, capacity, and history of failure of the infrastructure;
and

b. Urgency of the project to reduce the potential hazards to the public, property and
environment.

2. Regulatory or Mandated Requirements:

a. By legal mandate or consent decree;

b. By other regulatory requirements (project specific or programmatic), and

c. Must comply with court orders and settlements or avoids plausible legal claims.

3. Asset Condition, Annual Recurring Costs and Asset Longevity:

a. Existing conditions and capacity to meet the basic level of service is deficient;

b. Avoids potential failure due to substandard conditions;

c. Improves the overall reliability of the capital asset and infrastructure system;

d. Major implications of delaying the project such as significant future costs, or negative
community impacts;

e. Extent to which reduces City operations and maintenance expenditures; and

f. Increases the longevity of the capital asset or extends the useful life of the asset in the
long term.
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4. Community Investment and Economic Prosperity:

a.  Contributes toward economic development and revitalization efforts;

b.  Reduces or avoids impacts to the community when infrastructure fails;

c. Benefits under-served communities including those with low income households, low
community engagement and low mobility or access to transportation systems; and

d. Located in a census tract that is deemed eligible for Community Development Block
Grant (CDBG) funds.

5. Level and Quality of Service:

a. Improves existing conditions and capacity to meet the minimum level and quality of
services that is deficient;

b.  Addresses an infrastructure or facility deficit identified in a community plan; and

c. Addresses the need to install new facilities or improve existing facilities to provide
access to City services

6. Sustainability and Conservation:

Improves the health of the community and natural environment through sustainable 
designs with improved regional air quality and reduced greenhouse gas emission that 
contributes to climate change. 

7. Funding Availability:

Rank is increased based on assessment of the amount of funding needed to complete 
the current project phase and the entire project.  

8. Project Readiness:

a. Ready to enter the phase corresponding to the funding proposed;

b. Delivered most expeditiously shall be preferred; and

c. Complex environmental issues or known significant legal challenges shall be scored lower
than projects without said complications.

9. Multiple Category Benefit and Bundling Opportunities:

a. Fulfills the prioritization factors described above across multiple scoring categories;

b. Reduces construction costs by potentially bundling with adjacent projects; and

c. Provides for partnering or bundling opportunities with other local, state, or federal agencies
(e.g. leverages shared resources).

Implementation of this Policy is not intended to release or alter the City’s current or future obligations to 
complete specific capital improvement projects by specified deadlines, as may be imposed by court 
order, or order of any federal, state or local regulatory agency. 
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    Planning Commission  
Memorandum 

 
Community & Economic Development Department    Planning Division 

3900 Main Street, Riverside, CA 92522 | Phone: (951) 826-5371 | RiversideCA.gov 
 

Page 1 May 14, 2020 
PSP20-0009 

PLANNING COMMISSION HEARING DATE: MAY 14, 2020 
AGENDA ITEM NO.: 5  

PROPOSED PROJECT  

RECOMMENDATIONS 

Staff recommends that the Planning Commission: 

1. DETERMINE that PSP20-0009, review of the City of Riverside’s capital improvement projects 
for FY 2020/21, is not subject to the California Environmental Quality Act (CEQA) review, 
pursuant to CEQA Guidelines Section 15061(b)(3) as this action is not considered a 
“project” as defined by Section 15378(b)(4), and a determination of consistency has no 
potential to result in a direct or indirect physical change in the environment; 

2. FIND that the capital improvement projects added or modified for FY 2020/21 are 
consistent with the City’s General Plan 2025; and 

3. REPORT to the City Council that the capital improvement projects added or modified for 
FY 2020/21 are consistent with the City’s General Plan 2025. 

BACKGROUND 

California Government Code Section 65401 requires that the Planning Commission review the 
City’s Capital Improvement Program (CIP) for the upcoming fiscal year to evaluate conformity 
with the General Plan and report its finding to the City Council. The City of Riverside Charter and 
the Riverside Municipal Code also require that the Planning Commission review the City’s 
proposed CIP and report its findings to the City Council.  

The City’s CIP is prepared to coincide with the City’s budget period. It is anticipated that City 
Council will consider the FY 2020/21 budget and CIP in June 2020.  

The Planning Commission reviewed the FY 2018/19 and FY 2019/20 on March 22, 2018 and 
reported to the City Council that the projects were in conformance with the General Plan. As part 
of the mid-cycle budget review in 2019, the Planning Commission reviewed the CIP for FY 2019/20 

Case Number PSP20-0009 

Request Review of the City of Riverside’s Capital Improvement Program (CIP) for FY 
2020/2021, for consistency with General Plan 2025 

Applicant City of Riverside Finance Department 

Project Location Citywide 

Wards Citywide 

Staff Planner 
David Murray 
Principal Planner 
951-826-5773; dmurray@riversideca.gov 
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on May 2, 2019 and reported to City Council that the projects were in conformance with the 
General Plan. 

PROPOSAL 

Staff is requesting that the Planning Commission review the Capital Improvement Program (CIP) 
projects for FY 2020/21 and determine that the new or modified projects are consistent with the 
City’s General Plan 2025 (General Plan).  

The CIP project list for FY 2020/2021 includes: fifty-one (51) projects not previously reviewed by the 
Planning Commission for General Plan consistency, two (2) projects that were previously reviewed 
but modified for this fiscal year, and seventy (70) projects previously reviewed that have not been 
modified (Exhibit 1). 

PROJECT ANALYSIS  

The CIP is updated every fiscal year with some projects carrying over to the next budget period, 
some projects modified, and some added. The Planning Commission is responsible for reviewing 
only those CIP projects that have been added or modified. Exhibit 1 includes a list of all capital 
improvement projects anticipated for fiscal year 2020/2021 and identifies: 1) projects previously 
reviewed by the Planning Commission; and 2) new or modified requiring a determination of 
consistency with detailed descriptions of these projects included in Exhibit 2.  

Planning Division staff has reviewed the listed projects for conformance with City’s General Plan 
2025, as noted by the following Objectives and Policies supporting the proposed projects. 

OVERARCHING OBJECTIVES AND POLICIES 

Policy LU-10.2: Review the Capital Improvement Program of the City and local public works 
projects of other local agencies within the corporate boundaries of Riverside annually for 
consistency with this General Plan, pursuant to Government Code Sections 65401 et. seq. and City 
Code Title 19, 19.050.030 (B). 

Policy LU-10.3: Time the provision of capital improvements to ensure that all necessary public 
services and facilities for an area planned for new urban development are in place when 
development in the area occurs. 

AIRPORT 

Objective LU-23: Enhance and ensure the long-term viability of Riverside Municipal Airport by 
developing facilities that efficiently serve present and anticipated future needs and encouraging 
increased business and corporate usage. 

Policy CCM-11.3: Ensure that Riverside Municipal Airport continues to serve general aviation 
needs. 

MUNICIPAL BUILDINGS AND FACILITIES 

Objective LU-26: Ensure that a network of modern, effective and adequate community facilities 
are equitably distributed across the entire City. 
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INNOVATION AND TECHNOLOGY  

Objective PF-7: Ensure that Riverside residents, the business community and educational 
institutions have easy access to state-of-the-art internet services and modern telecommunications 
technology. 

PUBLIC PARKING 

Objective CCM-13: Ensure that adequate on- and off-street parking is provided throughout 
Riverside. 

Policy PF-7.1: Provide innovative, targeted technology projects and related economic 
development incentives. 

PARKS, RECREATION, AND COMMUNITY SERVICES 

Objective LU-26: Ensure that a network of modern, effective and adequate community facilities 
are equitably distributed across the entire City. 

Objective PF-10: Meet the varied recreational and service needs of Riverside's diverse population. 

Policy AQ-1.26: Require neighborhood parks and community centers near concentrations of 
residential areas to include pedestrian walkways and bicycle paths to encourage non-motorized 
travel. 

ELECTRIC 

Objective PF-6: Provide affordable, reliable and, to the extent practical, environmentally sensitive 
energy resources to residents and businesses. 

Policy PF-6.2: Ensure that adequate back-up facilities are available to meet critical electric power 
needs in the event of shortages or temporary outages. 

SEWER 

Objective PF-3: Maintain sufficient levels of wastewater service throughout the community. 

Policy PF-3.1: Coordinate the demands of new development with the capacity of the wastewater 
system. 

Policy PF-3.3: Pursue improvements and upgrades to the City’s wastewater collection facilities 
consistent with current master plans and the City’s Capital Improvement Program. 

STORM DRAIN 

Objective PF-4: Provide sufficient levels of storm drainage service to protect the community from 
flood hazards and minimize the discharge of materials into the storm drain system that are toxic, 
or which would obstruct flows. 

Policy PF-4.1: Continue to fund and undertake storm drain improvement projects as identified in 
the City of Riverside Capital Improvement Plan. 
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Policy PF-4.3: Continue to routinely monitor and evaluate the effectiveness of the storm drain 
system and make adjustments as needed. 

TRANSPORTATION 

Policy CCM-2.1: Complete the Master Plan of Roadways shown on Figure CCM-4 (Master Plan of 
Roadways). 

Policy CCM-10.1: Ensure the provision of bicycle facilities consistent with the Bicycle Master Plan. 

Policy CCM-10.3: Provide properly designed pedestrian facilities for the disabled and senior 
population to ensure their safety and enhanced mobility as users of streets, roads and highways 
emphasizing “complete streets” principles 

Policy CCM-10.11: Provide sufficient paved surface width to enable bicycle traffic to share the 
road with motor vehicles where traffic volumes and conditions warrant. 

Policy PS-5.1: Enhance and maintain pedestrian safety through the inclusion of well-designed 
streets, sidewalks, crosswalks, traffic control devices and school routes throughout the City. 
Reasonable means of pedestrian accessibility shall be an important consideration in the approval 
of new development. 

ENVIRONMENTAL REVIEW 

This proposal is not subject to the California Environmental Quality Act (CEQA) review under CEQA 
Guidelines Section 15061(b)(3) because the consistency review is not a “project”, per 15378(b)(4), 
and because a determination of consistency has no potential to result in a direct or indirect 
physical change in the environment.  

APPEAL INFORMATION 

Actions by the City Planning Commission, including any environmental finding, may be appealed 
to the City Council within ten calendar days after the decision. Appeal filing and processing 
information may be obtained from the Planning Division, 3rd Floor, City Hall. 

EXHIBITS LIST  

1. CIP Project Summary List for FY 2020/21 and FY 2021/22  
2. CIP New Project Descriptions  

 

 
Prepared by: David Murray, Principal Planner 
Approved by:  Mary Kopaskie-Brown, City Planner 
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No.

CY 
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Previously 
Reviewed by 

Planning 
Commission? 

(Yes/No)
Airport

1 AIRPORT - AIRFIELD SIGNAGE No
2 AIRPORT - TAXIWAY A REHAB No
3 AIRPORT EMERGENCY GENERATOR No
4 AIRPORT RUNWAY 34 WINDSOCK RELOCATION No

Municipal Buildings and Facilities
6 5 CITY BUILDINGS DEFERRED MAINTENANCE Yes

6 DOWNTOWN PARKING GARAGE No
9 7 METRO MUSEUM EXPANSION AND REHAB Yes

Innovation and Technology
8 DATA CENTER/DISASTER RECOVERY CAPITAL IMPROVEMENTS No

11 9 DATA NETWORK REPLACEMENT Yes
10 FIBER OPTIC CONNECTION UPGRADE No
11 GIS TECHNOLOGY UPDATE No

Public Parking
12 PARCS - PARKING ACCESS REVENUE CONTROL SYSTEMS No

Parks, Recreation and Community Services
13 FAIRMOUNT PARK LAKE EVANS LAKESHORE ACCESS No

Electric
52 14 ADVANCED DISTRIBUTION MANAGEMENT SYSTEM Yes
14 15 ADVANCED METERING INFRASTRUCTURE Yes
46 16 BUSINESS SYSTEM TECHNOLOGY UPGRADES Yes
16 17 CABLE REPLACEMENT Yes
18 18 CITYWIDE COMMUNICATIONS Yes
19 19 DISTRIBUTION AUTOMATION Yes
20 20 DISTRIBUTION LINE EXTENSIONS Yes
15 21 GENERAL ORDER 165 (GO 165) UPGRADES/LINE REBUILDS/RELOCATION-OVERHEAD Yes
47 22 GEOGRAPHIC INFORMATION SYSTEM (GIS) UPGRADE Yes
50 23 LAND MOBILE RADIO Yes
22 24 LINE REBUILDS Yes
23 25 MAJOR 4-12 KV CONVERSION Yes
24 26 MAJOR FEEDERS Yes
25 27 MAJOR OVERHEAD/UNDERGROUND CONVERSIONS Yes
26 28 MAJOR STREET LIGHT PROJECTS Yes
28 29 MAJOR TRANSMISSION LINE PROJECTS Yes
29 30 METERS Yes

31 MOBILE APPLICATIONS No
31 32 NETWORK COMMUNICATION SYSTEM Yes
32 33 OPERATIONAL TECHNOLOGY GOVERNANCE Yes
51 34 OUTAGE MANAGEMENT SYSTEM Yes
33 35 SERVICES Yes
43 36 SOUTHERN CALIFORNIA EDISON (SCE) CONDEMNATION COSTS Yes
35 37 SUBSTATION BUS & UPGRADES Yes
37 38 SUBSTATION TRANSFORMER ADDITION Yes
38 39 SUPERVISORY CONTROL AND DATA ACQUISITION (SCADA) Yes
39 40 SYSTEM SUBSTATION MODIFICATIONS Yes
40 41 TRANSFORMERS Yes
41 42 WORK, ASSET, & INVENTORY MANAGEMENT SYSTEM Yes

Water
53 43 ADVANCED METERING INFRASTRUCTURE Yes
69 44 DISTRIBUTION AUTOMATION/RELIABILITY Yes

Capital Improvement Program
Budgeted Projects Summary 

2020/21 & 2021/22
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Capital Improvement Program
Budgeted Projects Summary 
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54 45 DISTRIBUTION SYSTEM FACILITIES REPLACEMENTS Yes
55 46 FACILITY REHABILITATION PROGRAM Yes
56 47 HYDRANT CHECK VALVES Yes
74 48 LAND MOBILE RADIO Yes
57 49 MAIN REPLACEMENTS PROGRAM Yes
58 50 METERS Yes
59 51 NETWORK COMMUNICATION SYSTEM Yes
60 52 OPERATIONAL TECHNOLOGY GOVERNANCE Yes
61 53 POTABLE/IRRIGATION WELL REPLACEMENT Yes
64 54 SCADA UPGRADE & SYSTEM AUTOMATION Yes
65 55 SEVEN OAKS DAM CONSERVATION-ENHANCED RECHARGE Yes
66 56 SYSTEM EXPANSION Yes
67 57 TRANSMISSION MAINS Yes
68 58 WATER STOCK Yes

Railroad
77 59 BNSF QUIET ZONE - MISSION INN, 3RD & SPRUCE Yes
78 60 BNSF/THIRD STREET GRADE SEPARATION Yes

Sewer
61 ACTIVATED TRAIN PLNT 2 REHB No
62 ADMIN HVAC PHASE 2 No
63 DIGESTER 5 REHAB No
64 DIVERT FLOW FROM 18" TO 24" PIPE No
65 ELEC SWCHGEAR UPGRD PWR OUTAGE No
66 ELIMINATE OF UNIVERSITY KNOLLS PUMP STATION No
67 HEADWRKS RPLC/REHAB No
68 INFLUENT FLW-MTR PROJ MAG-MTR No
69 MBR CAP INC UP 6MGD (32 MGD) No
70 PIERCE ST STATION REHABILITATION No
71 PRIORITY PIPELINE/MH PACP 5&4 No
72 REPLACE 24" SWR MAIN TO 27" PIPE No
73 REPLACE SEWER MAIN PALM AVE No
74 REPLACE SWR MAIN KMART PRK LOT No
75 REPLACE SWR MAIN PALM/RUBIDOUX No
76 REPLACE SWR MAIN RUB/NRTH V/GRND No
77 REPLACE SWR MAIN RUT/PENN/BRUCE No
78 REPLACE SWR PIPE GOLDEN AVE No
79 RNG INTERCON PIPE - 50% GRANT REIMB No
80 RPLC PIPELINE ARLIN VALLEY CHAN No
81 RPLC SWR MAIN MORRIS/DOOLITT No
82 RPLC SWR MAIN MRKT/11TH/12TH No
83 RPLC SWR MAIN RUTL/ARL/PENNY No
84 SCADA MSTR PLAN WQCP & LFTSTNS No
85 SLUDGE PUMP STNS REHB 1&2 No
86 WAREHOUSE & STOR BUILD RPLMNT No
87 WASTE ACT SLDG THICKENING PROJ No
88 WESTERN, MLK2, GARDEN PUMP STATION REHAB No
89 WQCP-WIFI PHASE II No

Storm Drain
93 90 MISCELLANEOUS STORM DRAIN CONSTRUCTION PROGRAM Yes

91 VAN BUREN BLVD PUMP STATION REHAB No
92 SIERRA STREET STORM DRAIN IMPROVEMENTS No
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Transportation
93 ADAIR SIDEWALK-JO JO RANDOLPH No

97 94 ARTERIAL INTERCONNECT PROJECT PROGRAM Yes
95 BATTERY BACKUP MAINTENANCE No
96 BERRY RD WIDENING - SELINA STREET TO BUSH AVE No
97 BONITA SIDEWALK-TYLER PENDLETON No

99 98 CDBG MATCHING FUNDS Yes
100 99 CONTROLLER ASSEMBLY REPLACEMENT PROGRAM Yes
101 100 CURB AND GUTTER REPAIR PROGRAM Yes

101 KNOEFLER - ST. IMPRV AMBS/EOS No
105 102 LED SIGNAL LENSES REPLACEMENT PROGRAM Yes

103 LOCAL ROADWAY SAFETY IMPROVEMENT PLAN No
106 104 MAJOR STREETS REHABILITATION Yes

105 MARKET STREET BRIDGE REPLACEMENT OVER THE SANTA ANA RIVER Yes
107 106 MEASURE Z PAVEMENT REHABILITATION AND PEDESTRIAN FACILITIES IMPROVEMENT PROGRAM Yes
108 107 MINOR STREET PRESERVATION (SLURRY/ARAM) PROGRAM Yes
109 108 MINOR STREET REHABILITATION PROGRAM Yes
110 109 MISCELLANEOUS SIGNAL REVISIONS PROGRAM Yes
111 110 MISCELLANEOUS STREET CONSTRUCTION PROGRAM Yes
112 111 MISCELLANEOUS TRAFFIC PROJECTS PROGRAM Yes
113 112 MISSION BOULEVARD BRIDGE REPLACEMENT AT SANTA ANA RIVER Yes
114 113 NEW TRAFFIC SIGNALS (PRIORITIZED LOCATIONS-ONE PER YEAR) PROGRAM Yes
115 114 PEDESTRIAN RAMPS PROGRAM Yes
117 115 SB-1 PAVEMENT REHABILITATION, MAINTENANCE, AND SAFETY IMPROVEMENTS PROGRAM Yes

116 SIDEWALK FRONTING PATRICIA BEATTY + RRFB No
118 117 SIDEWALK REPAIR PROGRAM Yes
119 118 SIDEWALK/TRAIL CONSTRUCTION AT VARIOUS LOCATIONS PROGRAM Yes
120 119 SPREAD SPECTRUM RADIO REPLACEMENT PROGRAM Yes

120 TRAFFIC SIGNAL EMERGENCY VEHICLE REPLACEMENT No
122 121 TRAFFIC SIGNAL LOOP REPLACEMENT PROGRAM Yes

122 VAN BUREN-JURUPA TO SAR BRIDGE Yes
123 VICTORIA AT WASHINGTON SOUTHBOUND MERGE LANE No
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No.

Funded Projects by Category Description

1 AIRPORT - AIRFIELD SIGNAGE Riverside Municipal Airport is equipped with both Siemens and Lumacurve airfield signs.  
Extensive sun exposure has resulted in the fading of several taxiway and runway signs 
impacting airfield safety.  The Airfield Signage Replacement project will include replacing 
faded signs and replacing airfield lighting with LED technology.

2 AIRPORT - TAXIWAY A REHAB Taxiway A was reconstructed in 2007 and runs parallel to Runway 9/27 located on the north 
side of the airport and is the main taxiway used for airport operations. Years of weathering 
and sub-base failure have impacted the surface of the 5,401 feet taxiway and has a direct 
impact on airport operations. Additionally, Taxiway A provides access to Runway 9/27 and 
tenant hangars located on the east side of the airport. Without access to Runway 9/27 large 
planes and jets would not have the ability to take off and land at Riverside Municipal Airport 
impacting the Airport's performance and Federal funding.

3 AIRPORT EMERGENCY GENERATOR Riverside Municipal Airport is not currently equipped with an emergency generator.  In the 
event the City power source is interrupted airfield lighting would be impacted.  The propane 
generator will be installed on a concrete pad adjacent to the north side of the lighting vault 
and enclosed by a 8-foot chain-link fence.

4 AIRPORT RUNWAY 34 WINDSOCK 
RELOCATION

An unlighted wind cone is located just east of Runway 16 and within the Runway Object Free 
Area (ROFA), which does not comply with FAA guidance set forth criteria set forth in AC 
150/5300-13A, Airport Design. Paragraph 309 of the AC states that the ROFA clearing standard 
requires “clearing the ROFA of above-ground objects protruding above the nearest point of 
the RSA.” The windsock will berelocated approximately 50 feet farther east and outside of the 
ROFA

6 DOWNTOWN PARKING GARAGE Multi-level parking structure with approximately 500 parking spaces at $30,000 per space, 
including land acquisition (location TBD).

8 DATA CENTER/DISASTER RECOVERY 
CAPITAL IMPROVEMENTS

The City's datacenters are responsible for remote store, processing and the distribution of large 
amounts of citywide data (e.g. databases, virtual environment, servers, etc.).  The City 
currently maintains a primary datacenter, a secondary datacenter, and disaster recovery site.  
This request is to fund a hardware replacement project.

10 FIBER OPTIC CONNECTION UPGRADE This project will upgrade the in-building fiber optic connections at various City locations.

11 GIS TECHNOLOGY UPDATE The Citywide GIS Technology Upgrade Project ( Project) will transition the City from CADME to 
Esri' s ArcGIS platform, a modern GIS system that streamlines and automates workflows, 
enables easy viewing and use of geospatial data, and enhances GIS reporting and analytic 
capabilities. High- level project objectives include transitioning to ArcGIS ( the new upgraded 
platform), integrating with existing and new systems and applications, enhancing mapping 
and analytic capabilities, improving internal and external customer experience, and 
streamlining day-to-day processes.

12 PARCS - PARKING ACCESS REVENUE 
CONTROL SYSTEMS

New garage technology to integrate with other mobility improvements

13 FAIRMOUNT PARK LAKE EVANS 
LAKESHORE ACCESS

Phase I - Design and Construction of an ADA Accessible Pedestrian Walkway (1,050 LF) along 
Dexter Drive from Approximately the American Legion (Post 79) to the Isaak Walton Building,  
including Minor Grading, Drainage, Landscaping, Irrigation, Lighting, and Furnishing 
Improvements. Estimated Cost - $300,00Phase II - Design and Construction of an ADA 
Accessible Pedestrian Walkway (1,000 LF) along Dexter Drive from Approximately the Isaak 
Walton Building to the Redwood Drive Bridge,  including Minor Grading, Drainage, 
Landscaping, Irrigation, Lighting, and Furnishing Improvements. Estimated Cost - 
$300,000Phase III - Design and Construction of an ADA Accessible Pedestrian Walkway (400 LF) 
and Decking/Railing Expansion (1,000 SF) along the Redwood Drive Bridge, including Minor 
Grading, Drainage, Foundation Piles, Lighting, and Furnishing Improvements. Estimated Cost - 
$350,000

16 BUSINESS SYSTEM TECHNOLOGY 
UPGRADES

SCOPE CHANGE: Ongoing upgrades to various business technology projects within Riverside 
Public Utilities.

Capital Improvement Program
Budgeted Projects Descriptions - New and Modified

2020/21 & 2021/22

Airport

Municipal Buildings and Facilities

Innovation and Technology

Public Parking

Parks, Recreation and Community Services

Electric
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31 MOBILE APPLICATIONS Mobile Apps increase operational efficiency and safety by providing real-time information to 
field personnel when and where they need it; ensure system configuration and status is always 
known by the personnel operating the system; reduce the need for paper-based maps, plans, 
and work orders; reduce the as

‑

built record-keeping effort, and enable field operation 
personnel to share real-time information with system operators and engineers.

37 SUBSTATION BUS & UPGRADES SCOPE CHANGE: Replaces aging equipment and installs additional equipment necessary to 
improve the operability and safety of these neighborhood power centers (Substations).  This 
includes system protection, monitoring, automation systems for energized electrical 
components, perimeter walls, property improvements, addition of new substations, and 
expansion of existing substations.

61 ACTIVATED TRAIN PLNT 2 REHB (Fl-08) - Project requires the replacement of the membrane diffusers and the redwood baffles 
with FRP baffles, repairs on the aeration basin, replace corroded conduits, boxes, and conduit 
clamps with stainless steel parts, replace side

‑

mounted railings with top

‑

mounted railings, 
repair cracks and spalls in the concrete walkways,the implementation of an aeration basin 
concrete structure condition assessment, the installation of motorized operators on gates and 
control valves for additional automatic control for the aeration basin. (Fi-09) - This project 
requires the replacement of the floating mixers. (Fl-10) - This project requires: the replacement 
of  the VFDs and MCCs, the replacement or repair of the corroded roof members near the 
roof leak, the removal of the abandoned WAS pumps, the replacement of the drain pump.

62 ADMIN HVAC PHASE 2 Phase II - Installation of ducting, heating and cooling control systems, sensors, air handling 
units (motors and blowers) inside the WQCP Administration/Laboratory Building.

63 DIGESTER 5 REHAB Rehabilitation of Digester No.5: 1.1 million gallons capacity to be used for food waste 
digestion, rehabilitate the digester walls by pressure grouting epoxy in to cracks, blast and 
recoat interior walls, reseal dome, repair of interior steel structural members, surface applied 
water proofing, replace mixers, motors, pumps, mechanical piping and electrical upgrade to 
code. Seismic code upgrade to foundation and interior walls.

64 DIVERT FLOW FROM 18" TO 24" PIPE GM-9 - This Project proposes to install 10 feet of  24-inch diameter sewer pipeline to mitigate 
surcharge in an existing 18-inch diameter pipeline under peak flow conditions.

65 ELEC SWCHGEAR UPGRD PWR OUTAGE Electrical Switchgear Upgrade and Power Outage Project Study and Rehabilitation Project - 
Project will review and recommend the rehabilitation/replacement of the backbone 12kV 
electrical system, high voltage switchgear and equipment of the WQCP. The study will also 
recommend any electrical scheme changes during a power outage.

66 ELIMINATE OF UNIVERSITY KNOLLS PUMP 
STATION

RR-9  - This Project proposes to construct approximately 2,400 LF of sewer main to eliminate an 
existing sewer lift station located at 899 N University Dr. (University Knoll sewer lift station)

67 HEADWRKS RPLC/REHAB Fl-02-05 Headworks: 
(Fl-02) - Project requires: replacement of the metal ducts in the screening room, the 
replacement of all electrical components, the replacement of the bar screens and slide 
gates, installation of permanent stairs and landings for the grit classifiers and elevated 
equipment, the replacement of the damaged hatch to the grit room, installation of fall 
protection for the opening, the replacement of  the plate covers with traffic

‑

rated hatches 
and install vehicle bollards, replacement of corroded septage receiving station components. 
(Fl-03) - Project requires the replacement of the shaftless screw screening conveyers. 
(Fl-04) -Project requires the installation of a bypass structure. 
(Fl-05) - This project requires the replacement of, Grit snails, grit classifiers (slurry cups), and grit 
conveyor, Grit pumps, Motor Control Center (MCC).

68 INFLUENT FLW-MTR PROJ MAG-MTR Fl01 - Installation of three (3) Electromagnetic (Mag) flow meters in the following trunk sewer 
lines to replace Flo-Dar meters; Acorn, Arlanza and Santa Ana. The Acorn sewer line will be 16-
inch diameter mage meter, the Arlanza will be a 36-inch diameter mag meter and the Santa 
Ana sewer line will be a 36-inch mag meter. Construction will be onsite of the WQCP.

69 MBR CAP INC UP 6MGD (32 MGD) Installation of an additional 6 million gallons per day (MGD) of Membrane Bioreactors (MBR) 
waste water treatment. MBR treatment to increase to 32 MGD .Existing MBR's are 
manufactured from Suez Water Technology and Solutions as part of the WQCP Rehabilitation 
and Expansion Project.

Sewer
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70 PIERCE ST STATION REHABILITATION RR-8 - Rehabilitate the existing Pierce Street Sewer Pump Station
71 PRIORITY PIPELINE/MH PACP 5&4 PR14&15 - This Project concentrate on collecting videos and assess the conditions of sewer 

pipes that are older than 50 years old within the City's service boundary.  The Project will also 
repair, rehabilitate, or replace aging sewer infrastructures--pipelines, manholes, and sewer 
residential laterals.

72 REPLACE 24" SWR MAIN TO 27" PIPE GM-8-This Project proposes to replace approximately 770 feet of an existing 24-inch diameter 
sewer pipeline with 27-inch diameter pipeline.  The existing pipe is currently undercapacity

73 REPLACE SEWER MAIN PALM AVE GM-4A - This Project proposes to replace approximately 2,640 feet of an existing 10-inch 
diameter pipeline with 12-inch diameter pipeline.  The existing pipe is currently undercapacity.

74 REPLACE SWR MAIN KMART PRK LOT GM-6-This Project proposes to replace approximately 1,530 feet of an existing 12-inch 
diameter sewer pipeline with 18-inch diameter pipeline.  The existing pipe is currently 
undercapacity.

75 REPLACE SWR MAIN PALM/RUBIDOUX GM-4B-This Project proposes to replace approximately 1,500 feet of an existing 12-inch 
diameter sewer pipe with 15-inch sewer pipe along Palm Ave. and Rubidoux Ave, from 
Brentwood Ave to Rubidoux Ave and from Palm Ave. to 210-feet northwest of Virginia Place.  
The existing pipe is undercapacity

76 REPLACE SWR MAIN RUB/NRTH V/GRND GM4C - This Project proposes to replace approximately 1,010 feet of an existing 15-inch 
diameter sewer pipeline with 18-inch diameter pipeline.  The existing pipe is currently 
undercapacity.

77 REPLACE SWR MAIN RUT/PENN/BRUCE GM-5B -  This Project proposes to replace approximately 790 feet of an existing 15-inch 
diameter sewer pipeline with 21-inch diameter pipeline.  The existing pipe is currently 
undercapacity.

78 REPLACE SWR PIPE GOLDEN AVE GM-7- This Project proposes to replace approximately 970 feet of an existing 12-inch diameter 
sewer pipeline with 18-inch diameter pipeline.  The existing pipe is currently undercapacity.

79 RNG INTERCON PIPE - 50% GRANT REIMB Installation of digester gas clean-up equipment and piping to injection point to Southern 
California Gas Company Natural Gas transmission main. Bio-methane will be converted to 
near quality natural gas to be injected in to the Southern California Gas Company natural gas 
transmission main.

80 RPLC PIPELINE ARLIN VALLEY CHAN GM11-This Project proposes to replace approximately 2,430 feet of an existing 27-inch 
diameter sewer pipeline with 33-inch diameter pipeline.  The existing pipe is currently 
undercapacity.

81 RPLC SWR MAIN MORRIS/DOOLITT GM-14-This Project proposes to replace approximately 1,490 feet of an existing 33-inch 
diameter sewer pipeline with 42-inch diameter pipeline.  The existing pipe is currently 
undercapacity.

82 RPLC SWR MAIN MRKT/11TH/12TH GM15-This Project proposes to replace approximately 380 feet of an existing 12-inch diameter 
sewer pipeline with 18-inch diameter pipeline.  The existing pipe is currently undercapacity.

83 RPLC SWR MAIN RUTL/ARL/PENNY GM5A - This Project proposes to replace approximately 650 feet of an existing 15-inch 
diameter sewer pipeline with 18-inch diameter pipeline.  The existing pipe is currently 
undercapacity.

84 SCADA MSTR PLAN WQCP & LFTSTNS Supervisory Control and Data Acquisition (SCADA)  - A control system architecture comprising 
of computers, networked data communications and graphical user interfaces(GUI) for high-
level process supervisory management, while also comprising other peripheral devices like 
programmable logic controllers (PLC). Within the plant and outside sewer lift stations through 
out the City, the SCADA system is used to monitor and control equipment.

85 SLUDGE PUMP STNS REHB 1&2 Fl15-16 Plant 2 Sludge Pumps Stations 1 & 2 Rehabilitation:
(Fl-15) Install fall protection around all access hatches, cover the scum pits and improve the 
grating for traffic loads, remove the abandoned steam generator, improve site lighting in 
stairways, replacing the MCC, bring the electrical components up to code and relocate 
them out of the pump room, replace pumps, motors, piping and valves, paint the room, 
recoat all piping, replace ventilation, add a lifting crane. 
(Fi-16) Walls have exposed aggregate. Poor ventilation has caused significant corrosion issues.

86 WAREHOUSE & STOR BUILD RPLMNT Warehouse and Storage Building Replacement - Currently, the WQCP is using two old 
concrete digesters that were built in the 1940's that were converted to a warehouse more 
than thirty years ago. Also, there exist no storage cover to protect the WQCP and Collection 
System portable pumps, generators, equipment and materials. They are susceptible to the 
outside elements. The WQCP and Collections Section will need a combined warehouse and 
storage facility.

358



CY 
Ref 
No.

Funded Projects by Category Description

Capital Improvement Program
Budgeted Projects Descriptions - New and Modified

2020/21 & 2021/22

87 WASTE ACT SLDG THICKENING PROJ Fl-17 Waste Activated Sludge:
(Fl-17) - This project requires waste activated sludge thickening equipment to be installed 
inside the existing dewatering building, complete rehabilitation of DAFT No.2, the 
implementation of a seismic evaluation of the Dissolved Air Flotation Thickeners (DAFT) 
mechanism connections; (4) demolition of abandoned equipment and of unused pump 
pads, the removal of the unused chemical tank, the upgrade of the ventilation system to 
allow to declassify the electrical room, the installation of a cover for the DAF tanks, the 
replacement of the DAF No. 1 drive, the replacement of the polymer pumping systems, the 
addition of LED lights and replacement of the windows and doors of the building.

88 WESTERN, MLK2, GARDEN PUMP STATION 
REHAB

PR10,11,12  - These three sewer lift stations constantly need repair with their electrical and 
mechanical components since these equipment are at the end of their service life.  This 
Project will rehabilitate the sewer lift stations and replace dilapidated components to ensure 
reliable services to the residents.

89 WQCP-WIFI PHASE II Phase II - Install new infrastructure (fiber, access points and switches) to support WIFI at the 
WQCP.

91 VAN BUREN BLVD PUMP STATION REHAB This project will update the existing storm drain pump station

92 SIERRA STREET STORM DRAIN 
IMPROVEMENTS

The project is to install 900 LF of new 12” to 18” diameter RCP into Sierra Street near Streeter 
Avenue with two catch basins. The project is created due to multiple SRO requests since last 
few years due to flooding in the Sierra street even with small rain event. The street is not able 
to carry the capture of drainage area within.

93 ADAIR SIDEWALK-JO JO RANDOLPH The Adair Avenue Sidewalk Improvements project proposes to construct new concrete 
sidewalks on one side of Adair Avenue from Jo Jo Way to Randolph Street in the Arlanza 
neighborhood of the City of Riverside (see Exhibit A). Adair Avenue has existing concrete curbs 
and gutters but is missing sidewalks. The project includes the reconstruction of residential 
driveways that do not meet current City and ADA (Americans with Disabilities Act) standards. 
The proposed project is necessary to provide a safe pedestrian walkway from this residential 
neighborhood to schools and key destinations such as parks and retail centers. Construction 
of the sidewalk will eliminate the need for pedestrians to walk in the street or parkway, and 
will improve their safety.

95 BATTERY BACKUP MAINTENANCE The Adair Avenue Sidewalk Improvements project proposes to construct new concrete 
sidewalks on one side of Adair Avenue from Jo Jo Way to Randolph Street in the Arlanza 
neighborhood of the City of Riverside (see Exhibit A). Adair Avenue has existing concrete curbs 
and gutters but is missing sidewalks. The project includes the reconstruction of residential 
driveways that do not meet current City and ADA (Americans with Disabilities Act) standards. 
The proposed project is necessary to provide a safe pedestrian walkway from this residential 
neighborhood to schools and key destinations such as parks and retail centers. Construction 
of the sidewalk will eliminate the need for pedestrians to walk in the street or parkway, and 
will improve their safety.

96 BERRY RD WIDENING - SELINA STREET TO 
BUSH AVE

This project proposes to widen Berry Road between Selina Street and Bush Ave

97 BONITA SIDEWALK-TYLER PENDLETON The Bonita Avenue Sidewalk Improvements project proposes to construct new concrete 
sidewalks on one side of Bonita Avenue from Tyler Street to Pendleton Street in the La Sierra 
neighborhood of the City of Riverside (see Exhibit A). Bonita Avenue has existing concrete 
curbs and gutters but is missing sidewalks. The project includes the reconstruction of residential 
driveways that do not meet current City and ADA (Americans with Disabilities Act) standards.

101 KNOEFLER - ST. IMPRV AMBS/EOS The project will install 1800 linear foot of new curb and gutter both sides and one side 
sidewalk on Knoefler Drive from Ambs Drive to End of Street in La Sierra neighborhood - ward 
7. 
Project will alleviate flooding damages to the property in any rain event. The project 
anticipate to start in fall 2020 and end by spring 2021.  The project will install 1800 linear foot of 
new curb and gutter both sides and one side sidewalk on Knoefler Drive from Ambs Drive to 
End of Street in La Sierra neighborhood - ward 7.

103 LOCAL ROADWAY SAFETY IMPROVEMENT 
PLAN

Development of a Local Roadway Safety Plan to identify transportation safety 
countermeasures along Riverside roadways.

Storm Drain

Transportation
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116 SIDEWALK FRONTING PATRICIA BEATTY + 
RRFB

Project will install an approximately 210 foot section of sidewalk and small retaining 
wail to provide a walkway for parents & students near Patricia Beatty Elementary 
School. The project would additionally install a rectangular rapid flashing beacon 
lighted pedestrian sign that connects to Patricia Beatty's Easterly walkway.

120 TRAFFIC SIGNAL EMERGENCY VEHICLE 
REPLACEMENT

The City's Traffic Signal Maintenance Shop repairs and maintains 'Opticom' 
emergency vehicle preemption devices at traffic signals, these devices allow both 
Fire and Ambulance vehicles to receive a green light in their direction of travel. This 
project would create a recurring maintenance budget for the replacement of such 
devices as they reach the end of their useful service life.

123 VICTORIA AT WASHINGTON SOUTHBOUND 
MERGE LANE

Project to install a merge lane for southbound Victoria at Washington along with 
striping improvements at the intersection.

360



City ofArts & Innovation

PLANNING COMMISSION

MINUTES

THURSDAY, MAY 14, 2020, 9: 00 A.M. 

VIRTUAL MEETING

PUBLIC COMMENT VIA TELEPHONE

3900 MAIN STREET

PRESENT: Commissioners: R. Kirby, C. Roberts, R. Rubio, K. Parker, S. Mill, L. Allen, J. and
A. Villalobos

ABSENT: Teunissen ( illness), Rubio ( left early) 

STAFF: M. Kopaskie- Brown, P. Brenes, D. Murray, C. Assadzadeh, S. Watson, J. EgOez, 
K. Smith, N. Mustafa, C. Scully, F. Andrade

Chair Kirby called the meeting to order at 9: 00 a. m. He asked for a moment of silence in

honor of former Planning Commissioner Bob Stockton who recently passed. 

ORAL COMMUNICATIONS FROM THE AUDIENCE

There were no public comments at this time. 

PUBLIC HEARINGS

PLANNING CASE P19- 0873 - CONDITIONAL USE PERMIT- 7750 LINCOLN AVENUE, WARD 4

Proposal by Craig Valle of Morgan Truck Body, LLC to consider a Conditional Use Permit
to permit a vehicle repair facility. Candice Assadzadeh, Senior Planner presented the

staff report. Janelle Rodriguez, representing Morgan Truck Body, LLC on behalf of Craig
Valle, stated they were in agreement with the recommended conditions of approval. 
There were no public comments. The public hearing was closed. Following discussion it
was moved by Commissioner Mill and seconded by Commissioner Roberts to: 1) 

Determine that this proposed project is exempt from the California Environmental Quality
Act ( CEQA) review pursuant to Section 15301 ( Existing Facilities) as this project will not

have a significant effect on the environment; and 2) Approved Planning Case P19- 0873, 
based on the findings outlined in the staff report and subject to the recommended

conditions. Chair Kirby advised of the appeal period. 

The Planning Commission decision is final unless appealed to City Council. 

Motion Carried: 7 Ayes, 0 Noes, 1 Absent, 0 Abstention

AYES: Allen, Roberts, Rubio, Mill, Villalobos, Parker, Kirby
NOES: None

ABSENT: Teunissen

ABSTENTION: None
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PLANNING COMMISSION

MINUTES

THURSDAY, MAY 14, 2020, 9: 00 A.M. 

VIRTUAL MEETING

PUBLIC COMMENT VIA TELEPHONE

3900 MAIN STREET

PLANNING CASES P20- 0243 and P20- 0244 - TWO- YEAR TIME EXTENSION OF PLANNING

CASES P09-0808 CONDITIONAL USE PERMIT AND P09-0809 DESIGN REVIEW - 2340

FOURTEENTH STREET, WARD 2

Proposal by Andrew Walcker of Overland Development Co., on behalf of a Community
of Friends, to consider a two-year time extension of Planning Cases P09- 0808 (Conditional
Use Permit) and P09- 0809 ( Design Review) to construct a senior housing facility. Judy
EgOez, Associate Planner, presented the staff report. Andrew Walcker on behalf of

Community Friends, stated they were in agreement with the recommended conditions
of approval. There were no public comments. The public hearing was closed. Following
discussion it was moved by Commissioner Mill and seconded by Commissioner Villalobos
to: 1) Determine that the project is exempt from the California Environmental Quality Act
CEQA) subject to Section 15061( b) (3) ( Common Sense Rule) of the CEQA Guidelines, as

it can be seen with certainty that the proposed time extensions will have no significant
effect on the environment; and 2) Approved Planning Cases P20- 0243 ( Time Extension - 
Conditional Use Permit) and P20- 0244 ( Time Extension - Design Review), based on the

findings outlined in the staff report and subject to the recommended conditions. Chair

Kirby advised of the appeal period. 

The Planning Commission decision is final unless appealed to City Council. 

Motion Carried: 7 Ayes, 0 Noes, 1 Absent, 0 Abstention

AYES: Allen, Roberts, Rubio, Mill, Villalobos, Parker, Kirby
NOES: None

ABSENT: Teunissen

ABSTENTION: None
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MINUTES

THURSDAY, MAY 14, 2020, 9: 00 A.M. 

VIRTUAL MEETING

PUBLIC COMMENT VIA TELEPHONE

3900 MAIN STREET

PLANNING CASE P20- 0241 - ZONING CODE AMENDMENT, CHAPTER 19. 58 ( PARKING & 

LOADING) - CITYWIDE, ALL WARDS

Proposal by City of Riverside to consider a Zoning Code Amendment to modify Chapter
19. 580 ( Parking & Loading) to include parking exemption provisions for Cultural

Resources, as defined in Title 20 of the Riverside Municipal Code. Scott Watson, Historic

Preservation Officer, presented the staff report. There were no public comments. The

public hearing was closed. Following discussion it was moved by Commissioner Villalobos
and seconded by Commissioner Mill to recommend that the City Council: 1) Determine

that the project is exempt from the California Environmental Quality Act pursuant to
Section 15061( b)( 3) ( Common Sense Rule), as the proposed project will not have a

significant effect on the environment; and 2) Approve Planning Case P20- 0241 ( Zoning
Code Text Amendment), based on the findings outlined in the staff report and subject to

the recommended conditions. Chair Kirby advised of the appeal period. 

City Council public hearing required for final approval. 

Motion Carried: 7 Ayes, 0 Noes, 1 Absent, 0 Abstention

AYES: Allen, Roberts, Rubio, Mill, Villalobos, Parker, Kirby
NOES: None

ABSENT: Teunissen

ABSTENTION: None
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MINUTES

THURSDAY, MAY 14, 2020, 9: 00 A.M. 

VIRTUAL MEETING

PUBLIC COMMENT VIA TELEPHONE

3900 MAIN STREET

DISCUSSION CALENDAR

PLANNING CASE PSP20- 0009 - 2020/ 2021 CAPITAL IMPROVEMENT PLAN, CITYWIDE, ALL

WARDS

Proposal by City of Riverside for the annual review of projects included in fiscal year
2020/ 2021 Capital Improvement Program, and determination that the projects are

consistent with General Plan 2025 pursuant to California Government Code Section

65401. Dave Murray, Principal Planner, presented the staff report. There were no public
comments. Following discussion it was moved by Commissioner Parker and seconded by
Commissioner Rubio to: 1) Determine that PSP20- 0009, review of the City of Riverside' s
capital improvement projects for FY 2020/ 21, is not subject to the California Environmental

Quality Act ( CEQA) review, pursuant to CEQA Guidelines Section 15061 ( b) (3) as this

action is not considered a " project" as defined by Section 15378( b) (4), and a

determination of consistency has no potential to result in a direct or indirect physical
change in the environment; 2) Find that the capital improvement projects added or

modified for FY 2020/ 21 are consistent with the City' s General Plan 2025; and 3) Report to
the City Council that the capital improvement projects added or modified for FY 2020/ 21
are consistent with the City' s General Plan 2025. Chair Kirby advised of the appeal
period. 

This item will be reviewed by the City Council for final approval. 

Motion Carried: 7 Ayes, 0 Noes, 1 Absent, 0 Abstention

AYES: Allen, Roberts, Rubio, Mill, Villalobos, Parker, Kirby
NOES: None

ABSENT: Teunissen

ABSTENTION: None
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PLANNING COMMISSION

MINUTES

THURSDAY, MAY 14, 2020, 9: 00 A.M. 

VIRTUAL MEETING

PUBLIC COMMENT VIA TELEPHONE

3900 MAIN STREET

VEHICLE MILES TRAVELED ( VMT) THRESHOLDS FOR CEQA ASSESSMENT OF

TRANSPORTATION IMPACTS

Chair Kirby asked the Commission for a motion to waive the Sunshine Ordinance and
accept the new information, not available at the time of publication. Motion by
Commissioner Mill and Seconded by Vice -Chair Parker to accept the new information. 
The vote was unanimous and the motion carried. Nathan Mustafa, City Traffic Engineer

Mobility Manager, presented the staff report. Public Comment: Lou Monville Building
Industry Association of Riverside County, spoke in support of Alternative B and referenced
their letter dated May 13, 2020. Cindy Roth, Riverside Chambers of Commerce, thanked
the Commission for their moment of silence in honor of Bob Stockton. Mr. Stockton was

the Chair of the Economic Council and had planned to be on this call to address the

Commission today. She spoke in support of Alternative B. 

Commissioner Rubio left the meeting at this time. 

Following discussion, it was moved by Commissioner Mill and seconded by Commissioner
Parker to recommend that the City Council: 1) Adopt a resolution approving Vehicle
Miles Traveled thresholds for California Environmental Quality Act compliance related to
transportation analysis in accordance with Threshold Alternative B. 2) Recommend that

the City Council request that staff conduct a workshop to educate the development
community in the application of new vehicle miles traveled thresholds, and mitigation
measures for vehicle miles traveled related impacts. 

Commissioner Mill commented that he supported alternative B as it is consistent with the

neighboring jurisdictions. Alternative B will help the City meet its RHNA numbers, and
provide more senior and affordable housing. Alternative A would make it extremely
difficult for development outside the City' s transit corridor and would be cost prohibitive
for developers to develop affordable housing. 

This item will be reviewed by the City Council for final approval. 

Motion Carried: 5 Ayes, 1 Noes, 2 Absent, 0 Abstention

AYES: Allen, Roberts, Mill, Parker, Kirby
NOES: Villalobos

ABSENT: Rubio, Teunissen

ABSTENTION: None
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PLANNING COMMISSION

MINUTES

THURSDAY, MAY 14, 2020, 9: 00 A.M. 

VIRTUAL MEETING

PUBLIC COMMENT VIA TELEPHONE

3900 MAIN STREET

CONSENT CALENDAR

The Consent Calendar was unanimously approved as presented below affirming the
actions appropriate to each item. 

MINUTES

The minutes of the meetings of April 30, 2020, were approved as presented. 

PLANNING COMMISSION ATTENDANCE - The Commission excused the absence of

Commissioner Kirby from the meeting of April 30, 2020 due to illness. 

Motion Carried: 6 Ayes, 0 Noes, 2 Absent, 0 Abstention

AYES: Allen, Roberts, Mill, Villalobos, Parker, Kirby
NOES: None

ABSENT: Rubio, Teunissen

ABSTENTION: None

COMMUNICATIONS

ITEMS FOR FUTURE AGENDAS AND UPDATE FROM CITY PLANNER

Ms. Kopaskie- Brown advised the Commission of upcoming City Council and Planning
Commission items. 

ADJOURNMENT

The meeting was adjourned at 10: 16 a. m. to the meeting of May 28, 2020 at 9: 00 a. m. 

The above actions were taken by the City Planning Commission on May 14, 2020. There is now a
l0 -day appeal period that ends on May 25, 2020. During this time, any interested person may
appeal this action to the City Council by submitting a letter of appeal and paying the appeal
fee. In the absence of an appeal or referral, the Commission' s decisions and conditions

become final after 5: 00 p. m. on May 25, 2020. 
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      Capital Improvement Program 

Capital Improvement Program Glossary 
 

 

 

Airport Fund (530) – Fund used to account for the operations of the Riverside 
Municipal Airport.  The Airport Fund is an enterprise fund.  
 
Air Quality Management District Fund (240) – Fund used to account for motor 
vehicle registration fees (California Assembly Bill 2766) received from the State.  
These funds are restricted for use towards the implementation of programs 
and projects that will reduce motor vehicle air pollution.  This fund is also used 
to account for qualified air pollution reduction programs funded by the South 
Coast Air Quality Management District (SCAQMD). 
 
Appropriation – A City Council authorization to permit the City to incur 
obligations to make expenditures for specific purposes. 
 
Assessed Valuation – A value that is established by the County of Riverside for 
real and personal property for use as a basis for levying property taxes. 
 
Assessment District: A separate local government entity formed to provide 
specific local public services. Assessment districts can be established to 
provide a single service such as sewage treatment or to provide multiple 
services such as police and fire protection, parks and recreation facilities, and 
water distribution systems.  Property owners within the assessment district’s 
boundary pay into the district in direct proportion to the benefits or services 
they receive.  
 
Bond – A long-term “IOU” or promise to pay a sum of money on a specific 
date, at a specific interest rate.  The most common types of bonds are general 
obligation, revenue, and special improvement district bonds. 
 
Bond Refinancing – The payoff and re-issuance of bonds to obtain lower 
interest rates and/or terms that are more favorable. 
 
Budget – A financial plan for a specified period of time that matches planned 
revenues and expenditures to municipal services and/or capital 
improvements. 
 
Budget Calendar – The schedule of major events in the development of the 
budget, including budget hearings, budget deliberations, proposed budget, 
and the adoption of the final budget. 
 
Capital – Assets that add to the long-term net worth of the City. 
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Capital Improvements – Construction or major repair of municipal buildings 
and facilities, such as City Hall, libraries, parks, recreational facilities, the 
museum, storm drains, the airport, streets, the sewer system, electric and water 
utilities, etc. 
 
Capital Improvement Program (CIP) – A multi-year financial plan in which 
needed improvements to the City’s facilities and infrastructure are identified, 
priced, and prioritized. 
 
Capital Outlay Fund (430) – Fund used to account for the construction and 
installation of street and highway capital improvements. 
 
Capital Project – Major construction, acquisition, or renovation activities that 
add value to the City’s physical assets or significantly increase asset 
functionality. 
 
Central Garage Fund (650) – Fund used to account for the maintenance and 
repair of all City-owned vehicles and motorized equipment. 
 
Central Stores Fund (640) – Fund used to account for the operations of the 
City’s centralized supplies inventory, including receiving and delivery services 
provided to City departments. 
 
Certificates of Participation – Lease financing agreements in the form of tax-
exempt securities similar to bonds. 
 
Community Development Block Grant Fund (220) – Federal funds are 
allocated to local government, usually through a local clearinghouse 
(Riverside County Economic Development Agency), based on a formula, and 
are required to be applied for and used within a broad functional area such 
as community development.  
 
Debt Service – The cost of paying principal and interest on borrowed money 
according to a predetermined schedule. 
 
Department – An organizational unit comprised of programs or divisions, such 
as Human Resources, Police, or Public Works. 
 
Electric Fund (510) – Fund used to account for the operations of the Electric 
Utility.  The majority of funding for capital expenditures will be from bond 
proceeds.  Additional funding will be from the use of reserves, rates, and 
contributions in aid of construction.  The Electric Fund is an enterprise fund. 
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Capital Improvement Program Glossary 
 

 

 

 
Enterprise Funds – Used to account for operations that are financed and 
operated in a manner similar to private sector enterprises.  Costs of providing 
goods or services are recovered primarily through user charges. 
 
Expenditure – The cost for personnel, materials, equipment, and contractual 
obligations required for a department to operate or for a capital program to 
be completed. 
 
Fee – A general term used for any charge levied by the City for providing a 
service or permitting an activity. 
 
Fiscal Year – A 12-month period designated for accounting and budgeting 
purposes (July 1 through June 30 for the City of Riverside). 
 
Fixed Assets – Resources owned by the City intended for long-term use, such 
as land, buildings, and machinery. 
 
Fund – An accounting entity with a self-balancing set of accounts recording 
financial resources and transactions for specific activities. 
 
Fund Balance – Fund balance is the difference between assets and liabilities. 
 
Funded Capital Projects – Projects for which funding is currently available and 
identified. 
 
Gas Tax Fund (230) – Fund used to account gas tax revenue allocated to the 
City from the State of California.  The funds are dedicated to local 
transportation capacity improvements and restricted to research, planning, 
construction, improvement, maintenance and operations of public streets 
and highways or public mass transit.  
 
General Fund (101) – Used to account for all financial resources except those 
required to be accounted for in another fund. 
 
General Obligation Bond – A bond backed by the full faith, credit, and taxing 
power of the City. 
 
Infrastructure – The physical assets of a City (e.g., streets, water, sewer, public 
buildings, and parks). 
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Measure A Fund (432) – State funds are generated from the one-half percent 
sales tax levied throughout Riverside County to carry out transportation 
projects.  Funds are restricted to fund a comprehensive program of roadway 
and transit improvements including: highway, street, and road construction; 
highway, street, and road maintenance; bus and light rail capital and 
operations; improved transportation services for elderly and handicapped 
persons; and transportation-related air quality programs.  Original Measure A 
expired in 2009 but a measure was placed on the November 2004 ballot to 
renew the Measure A for 30 more years after the original measure expired.  
After voters passed the new Measure A with more than 75% of voter approval, 
the “new” Measure A took effect in April 2009. 
 
Measure Z Capital Fund (420) - Fund used to account for capital projects 
funded by Measure Z sales tax revenue.   
 
Operating Budget – That portion of the budget which deals with recurring 
expenditures, such as salaries, utilities, postage, printing, and fuels. 
 
Operating Budget Impact – Recurring operating expenditures/savings 
resulting from the completion of a capital improvement project.   
 
Public Parking Fund (570) – Fund used to account for the operations of the 
City’s parking facilities.  The Public Parking Fund is an enterprise fund.   
 
RDSA RORF – Arlington Bond Fund (471) – Redevelopment Successor Agency 
(RDSA) Redevelopment Obligation Retirement Fund (RORF), which is a 
requirement of the legislation dissolving California Redevelopment Agencies.  
Assets and liabilities of each former Redevelopment Project Area are now 
housed in individual RORFs. 
 
Regional Park Special Capital Improvements Fund (413) – 
Regional park improvements are funded though the Regional Park Fund.  A 
portion of Development Fees charged when properties are developed is 
dedicated to the funding of regional parks and recreational facilities.  Fees 
are dependent on development so the CIP only shows funded projects for 
which fee revenues are already available or that are annual funding 
obligations.  As funding becomes available, the Parks, Recreation, and 
Community Services Department requests that the City Council appropriate 
funds for projects contained in the Unfunded Capital Projects list.  Projects are 
not programmed based on anticipated revenues. 
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Restricted Non-City Funds – Restricted Non-City Funds are funds requested 
from non-City sources that have not yet been guaranteed.  These funds are 
project-specific and must be utilized for the project for which they are 
designated. 
 
Revenue – Sources of income that finance the operations of the government. 
 
Revenue Bonds – A bond backed by revenues generated from the project(s) 
to be constructed. 
 
Riverside County Transportation Commission (RCTC) – RCTC is the regional 
planning organization responsible for the distribution of Federal, State, and 
Local transportation funds. 
 
Sewer Fund (550) – Fund used to account for the operations of the City’s sewer 
department.  The Sewer Fund is an enterprise fund.   
 
Special Capital Improvement Fund (411) – Fund used to account for capital 
projects to construct parks and recreational facilities funded by impact fees. 
 
Special Revenue Funds – Fund type used to account for the proceeds from 
specific revenue sources that are restricted for a specific purpose. 
 
Special Transit Fund (560) – Fund used to account for expenditures related to 
the City’s fleet of mini-buses that are used to transport senior citizens and 
disabled persons. 
 
Storm Drain Development Impact Fee (DIF) Fund (410) – Capital expenditures 
for the construction and improvement of storm drains are budgeted in the 
Storm Drain Fund.  Revenues are from Storm Drain Fees, which are charged 
when property is developed.  The funds are dedicated to storm drain 
infrastructure projects.  This fund is also used to account for the National 
Pollution Discharge Elimination System (NPDES).  Funds are used for storm drain 
maintenance and inspection as required for California storm water permits 
funded by a special assessment district of Riverside County. 
 
Transportation Projects Fund (431) – Fund used to account for the operations 
of the City’s Senior Citizens’ and Handicapped Transportation System in 
accordance with Article 4 of the Transportation Development Act of 1971 
(California Senate Bill 325).  The Federal Trans Administration Funds are also 
accounted for in this fund. 
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Transportation Development Impact Fee (DIF) Fund (433) – Revenues for this 
fund are collected from property developments.  This one-time charge is 
collected over the course of development.  Funds are dedicated to offset 
costs for transportation and flood control improvements.  
 
Transportation Uniform Mitigation Fees (TUMF) Fund (434) – Under TUMF, 
developers of residential, industrial and commercial property pay a 
development fee to fund transportation projects that will be required 
because of the growth the projects create.  The Western Riverside Council of 
Governments oversees the allocation of TUMF fees to cities for funding local 
transportation projects.  
 
Unfunded Capital Projects – Projects for which funding is currently unavailable. 
 
Water Fund (520) – Fund used to account for the operations of the Water Utility.  
The majority of funding for capital expenditures will be from bond proceeds.  
Additional funding will be from the use of reserves, rates, and contributions in 
aid of construction.  The Water Fund is an enterprise fund. 
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Revenue Sources 

 

 

AIRPORT FUND (530) 
Capital expenditures for the Riverside Municipal Airport are budgeted in the 
Airport Fund, which is an enterprise fund.  
 
AIR QUALITY MANAGEMENT DISTRICT FUND (240) 
State funds are available from a portion of the motor vehicle registration fees 
(California Assembly Bill 2766) that are restricted for use towards the 
implementation of programs and projects that will reduce motor vehicle air 
pollution.  This fund is also used to account for qualified air pollution reduction 
programs funded by the South Coast Air Quality Management District 
(SCAQMD). 
 
CAPITAL OUTLAY FUND (430) 
This fund is used to account for the construction and installation of street and 
highway capital improvements. 
 
CENTRAL GARAGE/FLEET FUND (650) 
This fund is used to account for the maintenance and repair of all City-owned 
vehicles and motorized equipment. 
 
CENTRAL STORES FUND (640) 
Used to account for the operations of the City’s centralized supplies inventory, 
including receiving and delivery services provided to City departments. 
 
COMMUNITY DEVELOPMENT BLOCK GRANT (220) 
Federal funds are allocated to local government, usually through a local 
clearinghouse (Riverside County Economic Development Agency), based on 
a formula, and are required to be applied for and used within a broad 
functional area such as community development.  
 
ELECTRIC FUND (510) 
Capital expenditures for the City’s Electric Utility are budgeted in the Electric 
Fund (510), which is an enterprise fund.  The majority of funding for capital 
expenditures will be from bond proceeds.  Additional funding will be from the 
use of reserves, rates, and contributions in aid of construction. 
 
GENERAL FUND (101) 
Major support for the General Fund comes from sales tax, property tax, fees 
for services rendered, utility users’ tax, Transient Occupancy Tax (TOT), and 
transfers from the Electric and Water Funds.  Projects supported by this fund 
are budgeted on an availability of funds basis and funded from general 
revenues.  The General Fund is used to record only current revenues and 
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Revenue Sources 
 

 

 

current expenses; it does not recognize long-term assets and liabilities.  This 
fund provides traditional governmental services such as public safety, library, 
and recreational services. 
 
GRANT FUND (215) 
Contributions of cash or other assets from another governmental agency or 
other organization to be used or expended for a specific purpose, activity, or 
facility. 
 
GAS TAX FUND (230) 
Revenue for this fund is generated by the State of California’s tax on gasoline 
sales.  The funds are dedicated to local transportation capacity 
improvements and restricted to research, planning, construction, 
improvement, maintenance and operation of public streets and highways or 
public mass transit.  
 
LOCAL PARK SPECIAL CAPITAL IMPROVEMENTS FUND (411) 
This fund is used to account for capital projects to construct parks and 
recreational facilities funded by impact fees. 
 
MEASURE A FUND (432) 
State funds are generated from the one-half percent sales tax levied 
throughout Riverside County to carry out transportation projects.  Funds are 
restricted to fund a comprehensive program of roadway and transit 
improvements including: highway, street, and road construction; highway, 
street, and road maintenance; bus and light rail capital and operations; 
improved transportation services for elderly and handicapped persons; and 
transportation-related air quality programs.  Original Measure A expired in 
2009 but a measure was placed on the November 2004 ballot to renew the 
Measure A for 30 more years after the original measure expired.  After voters 
passed the new Measure A with more than 75% of voter approval, the “new” 
Measure A took effect in April 2009. 
 
MEASURE Z CAPITAL FUND (420) 
This fund is used to account for capital projects funded by Measure Z, which 
was approved by Riverside voters on November 8, 2016.  Revenues from the 
1% use tax will be used on capital projects such as the new Downtown Library, 
Police Headquarters, Museum Expansion, and Downtown Parking Garage. 
 
PUBLIC PARKING FUND (570) 
Capital expenditures for the construction of parking facilities are budgeted in 
the Public Parking Fund (570), which is an enterprise fund.  This fund is also used 
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to account for expenditures related to parking facilities operated by the City 
in Downtown Riverside.  Revenue sources include: 

 Rent Revenues – revenue from rented facilities 
 Garage, Lot and Meter Fees – fees charged for parking 
 Parking Fines – fines assessed for parking violations 
 Bond Proceeds – proceeds from the sale of revenue bonds 

 
RDSA RORF – ARLINGTON BOND FUND (471) 
Redevelopment Successor Agency (RDSA) Redevelopment Obligation 
Retirement Fund (RORF), which is a requirement of the legislation dissolving 
California Redevelopment Agencies.  Assets and liabilities of each former 
Redevelopment Project Area are now housed in individual RORFs. 
 
REFUSE COLLECTION FUND (540) 
This fund is used to account for the operation of the City’s solid waste and 
sanitation program, which provides for the collection and disposal of solid 
waste.  Revenues are collected on a user charge basis to residents and 
businesses. 
 
REGIONAL PARK SPECIAL CAPITAL IMPROVEMENTS FUND (413) 
Regional park improvements are funded though the Regional Park Fund.  A 
portion of Development Fees charged when properties are developed is 
dedicated to the funding of regional parks and recreational facilities.  Fees 
are dependent on development so the CIP only shows funded projects for 
which fee revenues are already available or that are annual funding 
obligations.  As funding becomes available, the Parks, Recreation, and 
Community Services Department requests that the City Council appropriate 
funds for projects contained in the Unfunded Capital Projects list.  Projects are 
not programmed based on anticipated revenues. 
 
SEWER SERVICE FUND (550) 
Capital expenditures for the construction and improvement of the City’s 
sewer system are budgeted in the Sewer Fund (550), which is an enterprise 
fund.  In addition to capital expenditures, operational expenditures related to 
the operations and maintenance of the City’s sewer system are budgeted in 
the Sewer Fund.  Revenue sources include: 

 Sewer Connection Fees – fees charged when property is developed 
that are dedicated to the funding of sewer infrastructure projects 

 Service Charges – funds that are generated from service charges to 
users of the City’s sewer system 
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 Community Services District (CSD) Payments – payments from 
Community Services Districts for which the City provides sewage 
treatment services 

 State Revolving Loans – low interest loans provided by the State to fund 
capital improvements 

 Bond Proceeds – proceeds from the sale of revenue bonds 
 
SPECIAL CAPITAL IMPROVEMENTS FUND (411) 
This fund is used to account for the acquisition, construction, ad installation of 
capital improvements and a Community Facilities District within the City. 
 
SPECIAL TRANSIT FUND (560) 
This fund is used to account for expenditures related to the City’s fleet of mini-
buses that are used to transport senior citizens and disabled persons. 
 
STORM DRAIN DEVELOPMENT IMPACT FEE (DIF) FUND (410) 
Capital expenditures for the construction and improvement of storm drains 
are budgeted in the Storm Drain Fund.  Revenues are from Storm Drain Fees, 
which are charged when property is developed.  The funds are dedicated to 
storm drain infrastructure projects.  This fund is also used to account for the 
National Pollution Discharge Elimination System (NPDES).  Funds are used for 
storm drain maintenance and inspection as required for California storm 
water permits funded by a special assessment district of Riverside County. 
 
TRANSPORTATION FUND (431) 
This account is to account for the operations of the City’s Senior Citizens’ and 
Handicapped Transportation System in accordance with Article 4 of the 
Transportation Development Act of 1971 (California Senate Bill 325).  The 
Federal Trans Administration Funds are also account for in this fund. 
 
TRANSPORTATION DEVELOPMENT IMPACT FEE (DIF) FUND (433) 
Revenues for this fund are collected from property developments.  This one-
time charge is collected over the course of development.  Funds are 
dedicated to offset costs for transportation and flood control improvements.  
 
TRANSPORTATION UNIFORM MITIGATION FEES (TUMF) FUND (434) 
Under TUMF, developers of residential, industrial and commercial property pay 
a development fee to fund transportation projects that will be required 
because of the growth the projects create.  The Western Riverside Council of 
Governments oversees the allocation of TUMF fees to cities for funding local 
transportation projects.  
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WATER FUND (520) 
Capital expenditures for the City’s Water Utility are budgeted in the Water 
Fund, which is an enterprise fund.  The majority of funding for capital 
expenditures will be from bond proceeds.  Additional funding will be from the 
use of reserves, rates, and contributions in aid of construction.   
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9155    Knoefler Street Improvements ................................................................. 303 
9901    BNSF Third Street Grade Separation ....................................................... 179 
9905    Downtown Library  .................................................................................... 130 
470601E     Distribution Line Extensions  ................................................................. 67 
470603E     Line Rebuilds ......................................................................................... 68 
470607E     Street Lighting  ...................................................................................... 69 
470608E     System Substation Modifications  ....................................................... 70 
470611E     Transformers  ......................................................................................... 71 
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470613E     Meters  ................................................................................................... 73 
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470623E     General Order 165 (GO 165) Upgrades/Line Rebuilds/Relocation  
                   Overhead ............................................................................................. 79 
470624E     GO 165 Upgrades/Line Rebuilds/Relocate - Underground  .......... 80 
470626E     Major Tract Distribution  ...................................................................... 81 
470632E     Substation Transformer Addition  ....................................................... 82 
470633E     Major Feeders  ..................................................................................... 83 
470634E     Southern California Edison (SCE) Condemnation Costs ................ 84 
470635E     Cable Replacement  .......................................................................... 85 
470636E     Cable Replacement – Public Works Street Rehab  ........................ 86 
470637E     Major Street Light Projects  ................................................................. 87 
470638E     Neighborhood Street Light Retrofit  .................................................. 88 
470644E     Major 4-12 kV Conversion  .................................................................. 89 
470655E     Distribution Automation/Reliability  ................................................... 90 
470655W    Distribution Automation/Reliability  ................................................. 313 
470664E     Citywide Communications  ............................................................... 91 
470672E     Supervisory Control and Data Acquisition (SCADA)  ...................... 92 
470685E     Riverside Transmission Reliability Project (RTRP)  .............................. 93 
470686E     RTRP – 230kV Reimbursable  ............................................................... 94 
470694E     Customer Information System (CIS) Upgrade  ................................. 95 
470696E     Geographic Information System (GIS) Upgrade  ............................ 96 
470698E     Dark Fiber  ............................................................................................. 97 
470701W    System Expansion  ............................................................................. 314 
470702W    Meters  ................................................................................................ 315 
470705W    Water Stock  ....................................................................................... 316 
470706W    Distribution System Facilities Replacements  .................................. 317 
470707W    Main Replacements Program  ......................................................... 318 
470735W    Transmission Mains  ............................................................................ 319 
470802W    Pump Station Replacements  .......................................................... 320 
470803W    Facility Rehabilitation Program  ....................................................... 321 
470811W    Recycled Water (Jackson St. Phase I – Facilities and Site Conver- 
                   sions) ................................................................................................... 322 
470813W    Seven Oaks Dam Conservation – Enhanced Recharge  ............. 323 
470814W    Aquifer Storage & Recovery System  .............................................. 324 
470815W    Hydrant Check Valves  ..................................................................... 325 
470819W    Upper Santa Ana River Habitat Conservation Plan  ..................... 326 
470822E     Enterprise Operation Data Mgmt System  ....................................... 98 
470822W    Enterprise Operation Data Mgmt System  ..................................... 327 
470823E     Advanced Metering Infrastructure  .................................................. 99 
470823W    Advanced Metering Infrastructure  ................................................ 328 
470824E     Operational Technology Governance  ......................................... 100 
470824W    Operational Technology Governance  ......................................... 329 
470825E     Work, Asset, and Inventory Management System  ....................... 101 

393



City of Riverside 

Project Number Index 

 
 

470825W    Work, Asset, and Inventory Mgmt System  ...................................... 330 
470826E     Network Communication System  ................................................... 102 
470826W    Network Communication System  ................................................... 331 
470827E     Land Mobile Radio  ........................................................................... 103 
470827W    Land Mobile Radio  ........................................................................... 332 
470829E     Outage Management System  ........................................................ 104 
470830E     Advanced Distribution Management System  ............................... 105 
470831E    Mobile Applications  ........................................................................... 106 
470831W    Mobile Applications  .......................................................................... 333 
470832W    SCADA Upgrade & System Automation  ........................................ 334 
470833W    Potable/Irrigation Well Replacement  ............................................ 335  

394


	Title Page
	Table of Contents
	Introduction
	City Manager Transmittal Letter
	Guide to the CIP
	Financial Summary - Title Page
	Financial Summary
	CIP Sources & Uses
	CIP Projects by Funding Source
	CIP Projects by Project Category
	Revenue Summary by Fund
	Airport - Title Page
	Airport - Project Category Overview
	Airport - Project Pages
	Electric - Title Page
	Electric - Project Category Overview
	Electric - Project Pages
	IT - Title Page
	IT - Project Category Overview
	IT - Project Pages
	MBF - Title Page
	MBF - Project Category Overview
	MBF - Project Pages
	PRCS - Title Page
	PRCS - Project Category Overview
	PRCS - Project Pages
	Public Parking - Title Page
	Public Parking - Project Category Overview
	Public Parking - Project Pages
	Railroad - Title Page
	Railroad - Project Category Overview
	Railroad - Project Pages
	Sewer - Title Page
	Sewer - Project Category Overview
	Sewer - Project Pages
	Storm Drain - Title Page
	Storm Drain - Project Category Overview
	Storm Drain - Project Pages
	Transportation - Title Page
	Transportation - Project Category Overview
	Transportation - Project Pages
	Water - Title Pages
	Water - Project Category Overview
	Water - Project Pages
	Appendix
	Appendix A - Unfunded Capital Projects
	Appendix B - Capital Fiscal Policies
	Appendix C - Planning Commission Items
	Glossary
	Glossary Revenue Sources
	Index
	Alphabetical Index
	Numerical Index



